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Disk Encryption Frequently Asked Questions  (continued)

Q Is it possible to stop encrypting the data?
A Utility>Admin>Disk encryption, select the “Off” radio button.  
The process to unencrypt may take up to 15 minutes.  

Q Is there a step I need to take every day to encrypt new data?
A No, the encryption will happen in the background without the 
need for any additional manual steps.  

Q The encryption was done it took nearly 90 minutes, is this 
going to happen every time the data is encrypted?
A No, after the initial encryption process is completed, new data 
will be encrypted automatically.

Q How does this protect the patient data? 
A The data is unreadable by anyone who attempts to use the 
system without entering the password or recovery key.  

Q I am using the system portable with Power Assistant, do I 
have to enter the password or recovery key after each exam?
A No, the password or recovery key will only need to be entered 
at each full boot up.  

Q I do not have Power Assistant but I take the system portable 
occasionally do I need to enter the recovery key or password 
each time?
A Yes, the recovery key or password must be entered each time 
the system is turned on. If the USB with Recovery key is 
connected with each start up you will not need to manually enter 
the password or recovery key.  
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Disk Encryption Frequently Asked Questions  (continued)

Q The USB recovery key has been lost, how do I unlock the 
system? 
A Manually enter the password or recovery key, then create a 
new USB key from the Disk Encryption page.  

Q The USB recovery key and the password has been lost how 
do I unlock the disk?
A Contact your service, the system will need a base image and 
application reload. Create a new encryption key. *Note the 
patient data on the system is not recoverable from this scenario.  
Always store patient data to a PACS or backup to external 
media. 

Q If it is not possible to unlock the data can I still scan and what 
cannot be used? 
A Yes: Unless the “Require Pre-Boot PIN/Password” Encryption 
policy option is selected, Live scan, measurement, “Save As” 
can be used to store on other media (USB, printer, etc). You can 
not access patient information, cannot access system Archive, 
cannot create an exam, cannot store to the hard drive, and 
DICOM Transfer is not possible. 
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Audit Report and System Log Server Configuration

Figure 10-94. Audit Report

Table 10-156:  Audit Report

Preset Parameter Description

Report Filter: Specify the following criteria. 

Search Type Select the type of search. 

Date Range Specify the “From” and “To” date range.  

Status Specify the status. 

Anonymize Indicate whether to anonymize the report (remote patient data). 

Generate Report Press to generate the report. 

Report Information: Generated report information. 

Report File Path The location where to place the generated report. 

Report Status Report status. 
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Audit Report and System Log Server Configuration  (continued)

The Audit Report System Log Server Configuration page allows 
you to customize where to draw information from for the Audit 
Report.

You are also able to connect the LOGIQ Totus to a centralized 
logging database at your institution to monitor for pattern 
analysis. This way, if your system is compromised, the data can 
be analyzed for incident response. 

This centralizes all the system’s data in the customer’s data 
center -- It’s like a DICOM connection page, but connects logs to 
a central location. 

Figure 10-95. System Log Server Configuration

Table 10-157:  System Log Server Configuration

Preset Parameter Description

Connection.

IP Address of the Server The Server’s IP address

TCP Listener Port Transfer Control Protocol Listener Port. This is the port which we transfer 
logging data to use the syslog data protocol. It can be done by UDP or TCP, 
depending on the configuration of the customer logging server. 
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UDP Listener Port User Datagram Protocol Listener Port. This is the port which we transfer 
logging data to use the syslog data protocol. It can be done by UDP or TCP, 
depending on the configuration of the customer logging server.

Mode of Transfer Mode of transferring the data to the server (UDP, TCP, or TLS). 

Windows Event Log 

Type of Logs to transfer • Application Logs
• Security Logs

Source of application event 
log to transfer: (Add * for 
no filter)

• Add Source: The user needs to specify where to draw data from for the 
audit report. 

• Delete Source: Delete the event log source from the application. 

Transfer

Send Time Period (Sec): How often the system will attempt to contact the logging server to send logs.

Number of days of Historic 
data to send: 

If logging server connectivity has not been available, how many days of 
history should be sent when it is restored? 

EventLog Batch Send Size When sending historic data, how much to send in each transaction – this can 
help manage network traffic and server load, not typically necessary to 
change this. 

Table 10-157:  System Log Server Configuration

Preset Parameter Description
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Imaging Preset Manager

Overview

The Imaging Preset Manager allows you to: 

• Create and Edit User Presets

• Update User Presets

• Rename User Presets

• Delete User Presets

• Arrange presets on the Touch Panel

• Share User Presets across LOGIQ Totus systems

• Export User Presets

• Import User Presets

• Configure MyPreset for probe

• Update MyPreset Config for each probe if desired. Need 
for each probe separately. See ‘Arranging MyPreset 
Tab’ on page 4-29 for more information.

Creating a User-Defined Application Preset

To create a User-Defined Application Preset, 

1. From the Touch Panel, select the Probe icon at the top of 
the Touch Panel.  

2. Select the Application you want to use as a basis for the 
new Application Preset. 

You are now ready to create your own user preset. 
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Creating a User-Defined Application Preset  (continued)

3.  Press Save. A pop-up menu appears: The Create New 
Application menu appears.

Figure 10-96. Create New User Pop-up Menu

4. Select Create New. The Create New Application menu 
appears. 

NOTE: The new user application is based upon the current exam  
and application, plus any modifications you have made, 
including the comment library and M&A calcs. 

NOTE: The name of the new application cannot include spaces or 
symbols. However, the name can include numbers and 
letters. 

NOTE: There is no limit to the number of user-defined application 
presets you can create for each exam category; you do not 
need to map all created presets to the Touch Panel. 

After you select to create the new preset, the Imaging Preset 
Manager screen appears. The preset you just created now 
appears in the Available Imaging Presets column. You’ll notice 
that it has the name you assigned it (“GE HealthCare”). 
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Arranging Presets on the Touch Panel

On this screen, you specify where you want the new user (and 
existing) presets to appear on the exam’s Touch Panel screen. 

 Figure 10-97. Steps to Add a User Preset

You can move the location of where the application appears on 
the Touch Panel via the Imaging Preset Manager (accessed 
from the Utility Touch Panel). 

To reposition an application on the Touch Panel grid,   

1. Select the Application to copy. Right click and select Create 
New. 

2. Provide the new name. 

3. The Imaging Preset Manager page appears (number not 
shown above). 

4. Position the new application to appear at the desired Touch 
Panel location. 

5. The new application appears on the Touch Panel. 
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Updating User Presets

You can edit, reset to factory default, or delete any user preset 
you create, as long as you have selected it in the “Available 
Imaging Presets” column on the left.

Editing Imaging Parameters

To view/edit the parameters for the user-defined preset,

1. Adjust the image while in the user preset you want to edit. 

2. Press the probe at the top of the Touch Panel screen. 

3. Press Save-->Overwrite [Preset Name]. 

4. From the Utility--> Imaging menus. 

To view/edit the parameters for the user defined preset

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to view/edit from Available Imaging Presets 
Column.

2. Press Edit. The Imaging page appears. 

3. Edit the presets as necessary and press Save.

or

1. Adjust the image while in the user preset you want to edit. 

2. Press the probe.

3. Press Save-->Overwrite [Preset Name].

Renaming a User Preset

To rename a user preset, 

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to rename. 

2. Press Rename. The Rename Preset pop-up menu appears. 

3. Type the new name and press Rename. 
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Deleting a User Preset

To delete a user preset, 

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to delete. 

2. Press Delete. The Delete Preset pop-up menu appears. 

3. Confirm that you want to delete this user preset and press 
OK. 
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Sharing User Presets between LOGIQ Totus Systems

You can share the user presets you have created between 
LOGIQ Totus systems by exporting/importing the preset(s) you 
want to share.   

To move a user preset from one LOGIQ Totus to another LOGIQ 
Totus system (same software level), first export the user 
preset(s) you wish to share. 

Exporting User Presets

To export a user preset (or presets), 

1. Activate the Imaging Preset Manager from the Utility Touch 
Panel.

2. Insert the media. 

3. Press Export (on the bottom). 

4. An Export Presets pop-up menu appears that indicates: 

a. destination location (USB Flash Drive/Hard Disk Drive 
drive location). 

b. preset directory where the preset should be saved 
(Preset Export). 

c. available presets on the scanner. 

Select the name for the Preset Directory from the Preset 
Directory pull-down. 

5. Select the User Defined Presets under Available presets on 
Scanner and press Export. 

6. Upon a successful Export, an informational message will 
pop-up indicating that “1 preset successfully exported.” 
Press Ok. Then press Exit to close the Export Presets 
pop-up menu. 

7. Press F3 to Eject the media. Take the media to the other 
LOGIQ Totus and follow the Importing User Presets 
instructions below. 
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Importing User Presets

To import a User Preset, 

1. Activate the Imaging Preset Manager from the Utility Touch 
Panel.

2. Insert the media (Flash Drive, USB Hard Drive). 

3. Press Import. The Import Presets pop-up appears and 
displays the Source Directory and Available Imaging 
Presets.    

4. Select the “User Defined Presets” under Available Imaging 
Presets and press Import. 

If these presets are already on this LOGIQ Totus, you will be 
asked whether you want to: 

• Overwrite this preset (Yes, Yes to All, No, or No to All). 

• Rename this preset (Type the new name and press 
Rename). 

• Cancel

5. Upon a successful Import, an informational message will 
pop-up indicating that “1 preset successfully imported.” 
Press Ok. Then press Exit to close the Import Presets 
pop-up menu. 

6. Press F3 to Eject the media. 

Retain Field of View

Selecting Retain Field of View ensures that the Imaging 
Parameters shown in the table below stay constant over Probe 
and Preset changes.

Table 10-158:  Retain Field of View

Mode Probe Retain Field of View Imaging Parameters

B-Mode, Harmonics, 
Contrast and B-Flow

Convex and Sector Depth, Tilt, Zoom, Width

Linear Virtual Convex, Zoom, Depth, Steer

Color Flow Mode Convex and Sector ROI Size/Position

Linear ROI Size/Position, CF Virtual Convex, CF Steer

Doppler Mode Doppler Cursor Position
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Backup and Restore

Overview

The Backup/Restore function enables the user to copy and 
restore system presets, settings and service configurations, and 
enables the user to configure several units with identical 
configurations (providing the units have the same software 
version).

Depending on the system, you can use either a USB Flash 
Drive, or USB Hard Disk for system backup/restore.

To minimize accidental loss of data, backup system presets, 
settings and service configurations, DAILY to formatted media 
and/or to the local hard drive (manually or automatically). 
Presets and service configurations can be restored to the local 
hard drive using the restore procedure.

NOTE: To perform backup and restore procedures, you must login with 
administrator privileges.
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Backup 

Media Backup

1. Insert media into the drive or USB device into a USB port.

2. On the Touch Panel, press Utility.

3. On the Utility Touch Panel, press System.

4. On the monitor display, select Backup/Restore.

The Backup/Restore screen is displayed.

 Figure 10-98. System/Backup/Restore Preset Menu

5. In the Backup field, select User Defined Configuration and/
or Service to copy system presets, settings and service 
configurations.

6. Select USB Drive F to save data in the Backup To/Restore 
From field.
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Media Backup  (continued)

7. Select Backup.

The system performs the backup. As it proceeds, status 
information is displayed on the Backup/Restore screen.

8. At the end of the process, the Backup completed message 
is displayed on the monitor.

Press Eject (F3) to eject media/disconnect USB device.

9. Make sure to physically label the media. An identification of 
the system should also be noted on the media and a backup 
log should be kept.

Store the media in a safe place.

Local Backup

Select Backup Automatically under Local Backup to 
automatically backup User Defined configurations to the system 
hard drive when the configuration is changed and saved. 

Select Manual Backup to manually backup User Defined 
configurations to the system hard drive. 

Backup Automatically

1. Check Backup Automatically under Local and Cloud 
Backup.

2. Select Local Backup under Backup To/Restore From.

3. Press Save.

User Defined Configuration files are automatically backed 
up to Local Backup, when configuration is changed and then 
saved.

Manual Backup

1. Select Local Backup under Backup To/Restore From.

2. Press Backup under Backup.
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Restore from Media or Local Backup

1. On the Touch Panel, press Utility.

2. On the Utility Touch Panel, press System.

3. On the monitor display, select Backup/Restore.

The Backup/Restore screen displays. (See Figure 10-98 on 
page 10-190.)

4. In the Restore list, select User Defined Configuration and/or 
Service to restore system presets, settings and/or service 
configurations. 

5. If restoring from Media: Ensure the appropriate source 
device is selected in the Media field and select Restore 
from Media.

If restoring from Local Backup: Select Restore from 
Local Backup.

The system performs the restore. As it proceeds, status 
information displays on the Backup/Restore screen.

6. The LOGIQ Totus restarts automatically when Restore is 
done. 

WARNING The restore procedure overwrites the existing database on the 
local hard drive. Make sure to insert the correct media.You 
cannot restore system presets, settings and service 
configurations between systems with different software 
versions. To minimize accidental loss of data, perform backup 
of the patient archives stored on the local hard drive 
periodically. 
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Preset Synchronization Using Media

The procedure for preset synchronization of several scanners 
using media is as follows:

1. Make a backup of the user-defined configurations on a 
removable media from a fully configured LOGIQ Totus 
system.

2. Restore user-defined configurations from the removable 
media to another LOGIQ Totus system (you can restore all 
the user-defined presets or select specific presets to restore 
via Detailed Restore).

NOTE: User Defined Configurations are compatible with LOGIQ E10, 
E10s and Fortis, EXCEPT for Imaging preset.
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Search

Utility Parameter Search

Opens up a search window to find a parameter on the utility 
pages. 

To search for a utility parameter, 

1. Press Search from the Utility Touch Panel or from another 
Utility page. 

2. Type in the search string. For instance, if you’re searching 
for Zoom you would just type ‘zoom’. 

3. A list of possible matches appears to the right. Select the 
correct match. 

NOTE: You cannot perform a search on the Measure, Reports, Imaging 
Preset Manager, Scan Assistant, or Service Utility pages. 
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Chapter 11

Probes and Biopsy

This chapter consists of the information of each probe 
and describes some special concerns, biopsy kits and 
accessories as well as basic procedures for attaching a 
biopsy guide to the different types of probes.  
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Probe Overview

Ergonomics

Probes have been ergonomically designed to:

• Handle and manipulate with ease

• Connect to the system with one hand

• Be lightweight and balanced

• Have rounded edges and smooth surfaces.

• Stand up to typical wear by cleaning and disinfectant 
agents, contact with approved gel, etc.

Cables have been designed to:

• Connect to system with appropriate cable length

Supported Probes

Introduction

The LOGIQ Totus supports the following types of probes: 

• Matrix Array probes

• Convex Array probes

• Linear Array probes

• Micro Convex Array probes

• Sector Phased Array probes

• Split Crystal

• Volume Probes (4D)

CAUTION
Probes for transvaginal and transrectal applications require 
special handling. Transvaginal/transrectal examinations and 
probe insertions should be performed only by personnel with 
adequate training. Refer to the user documentation enclosed 
with these probes.
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Probe Description

Table 11-1:  Probe Applications and Features  

Probe
Clinical 

Applications
Capabilities and 

Features Illustration

C1-6-D • Abdomen (incl. 
Pleural)

• OB/GYN 
• Pediatric
• Peripheral Vascular
• General 

musculoskeletal

• Easy3D/Avanced3D
• Tru3D
• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• Contrast
• B-Flow/Hybrid B-Flow
• CrossXBeam
• Shear Wave and Strain 

Elastography
• UGAP
• MVI/Contrast MVI
• Biopsy

C1-6VN-D • Easy3D/Avanced3D
• Tru3D
• V-Nav
• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• Contrast
• B-Flow/Hybrid B-Flow
• CrossXBeam
• Shear Wave and Strain 

Elastography
• UGAP
• MVI/Contrast MVI
• Biopsy
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C2-7-D • Abdomen
• Pediatric

• Easy3D/Avanced3D
• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• CrossXBeam
• Contrast
• B-Flow
• Biopsy

C2-7VN-D • Easy3D/Avanced3D
• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• CrossXBeam
• Contrast
• V-Nav
• Tru3D
• B-Flow
• Biopsy

C3-10-D • Neonatal
• Pediatric
• Neonatal transcranial
• Peripheral Vascular
• Small Parts 
• Abdomen

• Easy3D/Avanced3D
• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• CrossXBeam
• Contrast
• B-Flow
• V-Nav
• Tru3D

IC5-9-D • OB/GYN
• Urology

• Easy3D/Avanced3D
• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• Contrast
• Shear Wave and Strain 

Elastography (GYN and 
Urology only)

• V-Nav
• Tru3D
• Biopsy

Table 11-1:  Probe Applications and Features (Continued) 

Probe
Clinical 

Applications
Capabilities and 

Features Illustration
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9L-D • Peripheral Vascular
• Abdomen (incl. 

Pleural)
• OB/GYN
• Small Parts
• Pediatrics
• Neonatal
• Neonatal transcranial
• General 

musculoskeletal
• Superficial 

musculoskeletal
• Breast

• Easy3D/Avanced3D
• PDI
• M-Mode
• LOGIQView
• Virtual Convex
• Contrast
• CrossXBeam
• B-Flow/Hybrid B-Flow
• MVI/Contrast MVI
• Shear Wave and Strain 

Elastography
• V-Nav
• Tru3D
• Biopsy

L6-24-D 
(May not be 
available in all 
countries.)

• Musculoskeletal
• Small Parts
• Neonatal Abdomen
• Neonatal 

Transcranial
• Breast
• Peripheral Vascular
• Abdomen

• LOGIQView
• Virtual Convex
• CrossXBeam
• B-Flow/Hybrid B-Flow
• MVI
• PDI

L3-12-D • Vascular 
• Abdomen (incl. 

Pleural)
• OB
• Small Parts
• General 

musculoskeletal
• Superficial 

musculoskeletal
• Neonatal
• Neonatal transcranial
• Pediatrics
• Breast

• Easy3D/Avanced3D
• PDI
• M-Mode
• LOGIQView
• Virtual Convex
• Contrast
• CrossXBeam
• B-Flow/Hybrid B-Flow
• MVI/Contrast MVI
• Strain and Shear Wave 

Elastography
• Biopsy

Table 11-1:  Probe Applications and Features (Continued) 

Probe
Clinical 

Applications
Capabilities and 

Features Illustration
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ML6-15-D • Abdomen
• Small Parts
• Peripheral Vascular
• Pediatrics
• Neonatal
• Neonatal transcranial
• General 

musculoskeletal
• Superficial 

musculoskeletal
• Breast

• Easy3D/Avanced3D
• PDI
• M-Mode
• LOGIQView
• Virtual Convex
• Contrast
• CrossXBeam
• B-Flow/Hybrid B-Flow
• MVI/Contrast MVI
• Shear Wave and Strain 

Elastography
• V-Nav
• Tru3D
• Biopsy

M5Sc-D • Adult cardiac
• Pediatric cardiac
• Adult cephalic
• Abdomen (incl. 

Pleural)

• Easy3D/Avanced3D
• PDI
• M-Mode
• Anatomical M-Mode
• Curved Anatomical 

M-Mode
• Color M
• LOGIQView
• Virtual Convex
• Contrast
• Anatomical M-Mode
• B-Flow
• CW
• TVI/TVD
• V-Nav
• Tru3D
• Biopsy

6S-D • Pediatric cardiac
• Pediatric abdomen 

(incl. Pleural) 

• Easy3D/Avanced3D
• PDI
• M-Mode
• Anatomical M-Mode
• Curved Anatomical 

M-Mode
• Color M
• LOGIQView
• Virtual Convex
• CW
• TVI/TVD

Table 11-1:  Probe Applications and Features (Continued) 

Probe
Clinical 

Applications
Capabilities and 

Features Illustration
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RAB6-D • OB/GYN
• Abdomen
• Pediatric
• Neonatal

• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• Contrast
• CrossXBeam
• Realtime 4D
• Static3D
• Biopsy

RIC5-9-D • OB/GYN
• Urology

• PDI
• M-Mode
• Anatomical M-Mode
• LOGIQView
• Contrast
• CrossXBeam
• Realtime 4D
• Static3D
• BetaView
• Biopsy

12S-D • Pediatrics
• Pediatric cardiac
• Neonatal cardiac

• CW
• Virtual Convex
• PDI
• M-Mode
• Anatomical M-Mode
• Curved Anatomical 

M-Mode
• Color M
• TVI/TVD
• Easy3D/Advanced3D

P2D • Adult cardiac
• Pediatric cardiac
• Peripheral vascular
• Adult cephalic

• CW

P6D • Adult cardiac
• Pediatric cardiac
• Peripheral vascular
• Adult cephalic

• CW

Table 11-1:  Probe Applications and Features (Continued) 

Probe
Clinical 

Applications
Capabilities and 

Features Illustration
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Vscan Air CL 
(Curved array 
transducer)

• Abdomen
• Cardiac
• MSK
• OB
• Vascular
• Lung

• B-Mode
• Color Folw
• Easy3D
• LOGIQView

Vscan Air CL 
(Linear array 
transducer)

• Vascular
• Nerves
• Small Parts
• MSK
• Lung
• Neo Head

• B-Mode
• Color Folw
• Easy3D

• LOGIQView

Table 11-1:  Probe Applications and Features (Continued) 

Probe
Clinical 

Applications
Capabilities and 

Features Illustration



Probe Overview

LOGIQ Totus – User Manual 11-9
5929163-1EN Rev. 3

Beta View

Beta View enables you to steer the probe head in elevation 
direction without moving the probe. This feature is available on 
the 4D RIC5-9-D probe during live scanning and is especially 
useful during an endovaginal or neonatal head exams. 

The Beta View Touch Panel control appears on the B-Mode 
Touch Panel when you select either of these two probes. You 
can adjust the Beta View control Right/Left or Up/Down. When 
you press down on the Beta View control, the probe head 
re-centers itself. 

Beta View is not available while the image is Frozen, during an 
image Recall, during a Biopsy procedure, or during Volume 
Navigation. When these controls are selected, the Beta View 
Touch Panel control is hidden and unavailable. 
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Probe orientation

Each probe is provided with an orientation marking. This mark is 
used to identify the end of the probe corresponding to the side of 
the image having the orientation mark on the display. 

Figure 11-1. Orientation Marking on Probe (Example)

Figure 11-2. Probe orientation marker on the display

1. Orientation Mark

Probe Naming Conventions

Table 11-2:  Probe Naming Convention

Real Time 4D Type Application Frequency Connector Type

“R” C=Convex
L=Linear
M=Matrix
S=Sector

AB=Abdominal
IC=Intracavitary

“1-5” D=DLP
RS= RS Connector 
with RS-DLP Adapter
LC=Long Cord
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Probe Safety

Care and Handling

The following recommendations help to reduce preventable 
probe damage. 

NOTE: If 3D/4D probes are operated in continuous 4D mode for an 
unusually extended period of time, the surface temperature of 
the handle might get warm and exceed the limit specified in 
IEC60601-1. The temperature of the applied part will stay within 
the limits according to IEC60601-2-37.

WARNING Failure to follow the precautions listed in the Probe Care 
Recommendations table can result in serious injury and/or 
equipment damage. 

WARNING 3D/4D probes should not be used for continuous scanning for 
more than 25 minutes. Continuous scanning is defined as 
scanning without freezing the image. 3D/4D probes can be 
used for more than 25 minutes during an exam in cases where 
imaging is periodically frozen.

Table 11-3:  Probe Care Recommendations

Do: Don’t Do:

Handle all probes with extreme care. DO NOT drop or knock the probe or probe lens. 
Impacting the probe lens face can cause fractures of 
the crystal elements leading to failure. 

Ensure that connected probes are placed in the 
probe holder yoke when not in use. Be sure to utilize 
the endocavitary probe holder and the probe inserts 
for the 3D and small aperture probes that were 
provided at delivery.

DO NOT leave probes in places where they may be 
knocked over or dropped.  

Use wall-mounted probe holders with lens facing 
upward. 

Ultrasonic cleaning IS NOT approved for GE 
HealthCare probes. 
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Handling precautions 

Visually inspect probes and cables for damage prior 
to connecting them to the LOGIQ Totus. If a probe 
appears to be damaged, discontinue use and notify 
your GE HealthCare Customer Service 
Representative. Possible damage may include, but 
is not limited to: 
• Bent or broken probe pins
• Cable cuts or splitting
• Surface cracks
• Exposed wires or shielding
• Fluid leaks

DO NOT drop probes into holders or into 
disinfectant containers with the probe’s lens face 
down. Even a short drop can damage a probe. 

Disconnect probes from the system prior to cleaning 
or disinfecting the probe. 

DO NOT let probe cables dangle loosely from the 
LOGIQ Totus where they might be caught in the 
wheels/casters while moving. 

Ensure you follow the chemical manufacturer 
recommendations regarding the use and handling of 
the chemical. 

DO NOT immerse probes deeper than permissible 
levels. NEVER immerse the connector or adapter 
into any liquid. 

Clean and disinfect all probes following the 
procedures contained in this manual. 

DO NOT kink, tightly coil, or apply excessive force 
on the probe cable or TEE shaft. Insulation failure 
may result. 

Table 11-3:  Probe Care Recommendations (Continued)

Do: Don’t Do:

DANGER Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling. Use care 
when handling and protect from damage when not in use. DO 
NOT use a damaged or defective probe. Failure to follow these 
precautions can result in an increase probability of disease 
progression, injury and equipment damage.

CAUTION
Endocavity probes require a special handling. Refer to the user 
documentation enclosed with these probes.
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Electrical shock hazard 

Electrical
Hazard

The probe is driven with electrical energy that can injure the 
patient or user if live internal parts are contacted by conductive 
solution:

• DO NOT immerse the probe into any liquid beyond the 
level indicated by the immersion level diagram. Refer to the 
immersion illustration in the Probe Cleaning Process 
section. Never immerse the probe connector or probe 
adaptors into any liquid.

• DO NOT drop the probes or subject them to other types of 
mechanical shock or impact. Degraded performance or 
damage such as cracks or chips in the housing may result.

• Prior to each use, visually inspect the probe lens and case 
area for cracks, cuts, tears, and other signs of physical 
damage. DO NOT use a probe which appears to be 
damaged until you verify functional and safe performance. 
You must perform a more thorough inspection, including 
the cable, strain relief, and connector, each time you clean 
the probe. 

• Before inserting the connector into the probe port, inspect 
the probe connector pins. If a pin is bent, do not use the 
probe until it has been inspected and repaired/replaced by 
a GE HealthCare Service Representative.

• DO NOT kink, tightly coil, or apply excessive force on the 
probe cable. Insulation failure may result.

• Electrical leakage checks should be performed on a routine 
basis by GE HealthCare Service or qualified hospital 
personnel. Refer to the service manual for leakage check 
procedures.
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Special handling instructions

Using protective sheaths

Instructions.  Custom made sheaths are available for each 
probe.  Each probe sheath kit consists of a flexible sheath used 
to cover the probe and cable and elastic bands used to secure 
the sheath.

Sterile probe sheaths are supplied as part of biopsy kits for 
those probes intended for use in biopsy procedures.  In addition 
to the sheath and elastic bands, there are associated 
accessories for performing a biopsy procedure which are 
included in the kit.  Refer to the biopsy instructions for the 
specific probes in the Discussion section of this chapter for 
further information.

Reordering.  To reorder sheaths, please contact your local 
distributor or the appropriate support resource. 

WARNING Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is mandatory for intra-cavitary 
and intra-operative procedures. Failure to follow these 
instructions could lead to exposure to infectious agents. 

WARNING Devices containing latex may cause severe allergic reactions in 
latex sensitive individuals. Refer to FDA's March 29, 1991 
Medical Alert on latex products.

WARNING DO NOT use an expired probe sheath. Before using probe 
sheaths, verify whether the term of validity has expired. Failure 
to follow these instructions could lead to exposure to infectious 
agents.

CAUTION
Do not use pre-lubricated condoms as a sheath. In some 
cases, they may damage the probe. Lubricants in these 
condoms may not be compatible with probe construction.
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Endocavitary Probe Handling Precautions

If the disinfectant solution comes out of the endocavitary probe, 
please follow the cautions below.

NOTE: Sporadically, silicone grease can leak in small amounts from the 
probes’ cable bushing. This leakage is not a failure and is not 
harmful to the human body. Silicone grease does not contain 
any hazardous substances and is only use to seal the cable 
bushing. In the case of a leakage, wipe the grease with a cloth.

WARNING Sterile/sanitary sheaths are to be used on the probe during its 
actual use with patients. Wearing gloves protects the patient 
and operator. Failure to follow these instructions could lead to 
exposure to infectious agents.

WARNING Disinfectant Exposure to Patient (e.g., Cidex)—Contact with 
a disinfectant to the patient’s skin or mucous membrane may 
cause an inflammation. If this happens, refer to the 
disinfectant’s instruction manual.

Disinfectant Exposure from Probe Handle to Patient (e.g., 
Cidex)—DO NOT allow the disinfectant to contact the patient. 
Only immerse the probe to its specified level. Ensure that no 
solution has entered the probe’s handle before scanning the 
patient. If disinfectant comes into contact with the patient, refer 
to the disinfectant’s instruction manual.

Disinfectant Exposure from Probe Connector to Patient 
(e.g., Cidex)—DO NOT allow the disinfectant to contact the 
patient. Only immerse the probe to its specified level. Ensure 
that no solution has entered the probe’s connector before 
scanning the patient. If disinfectant comes into contact with the 
patient, refer to the disinfectant’s instruction manual.

Endocavitary Probe Point of Contact—Refer to the 
disinfectant’s instruction manual.

Failure to follow these instructions could lead to inflammation of 
skin or mucous membrane. 
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Probe handling and infection control

This information is intended to increase user awareness of the 
risks of disease transmission associated with using this 
equipment and provide guidance in making decisions directly 
affecting the safety of the patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that 
must be coupled to the patient by direct physical contact.  
Depending on the type of examination, this contact occurs with a 
variety of tissues ranging from intact skin in a routine exam to 
recirculating blood in a surgical procedure. The level of risk of 
infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between 
patients is with single use or disposable devices. However, 
ultrasound transducers are complex and expensive devices that 
must be reused between patients. It is very important, therefore, 
to minimize the risk of disease transmission by using barriers 
and through proper processing between patients. 

WARNING ALWAYS clean and disinfect the probe according to the probe 
specific instructions, including probe compatible chemicals 
between patients to the level appropriate for the type of 
examination and use FDA-cleared probe sheaths where 
appropriate. Failure to follow these instructions could lead to 
exposure to infectious agents.  

WARNING Adequate cleaning and disinfection are necessary to prevent 
disease transmission. It is the responsibility of the equipment 
user to verify and maintain the effectiveness of the infection 
control procedures in use. Always use sterile, legally marketed 
probe sheaths for intra-cavitary and intra-operative procedures.

WARNING To minimize the risk of infection from blood-borne pathogens, 
you must handle the probe and all disposables which have 
contacted blood, other potentially infectious materials, mucous 
membranes, and non-intact skin in accordance with infection 
control procedures. You must wear protective gloves when 
handling potentially infectious material. Use a face shield and 
gown if there is a risk of splashing or splatter.
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Care and Maintenance

Before first use

• Inspect the probe

• Clean the probe

• Disinfect the probe

Inspecting probes

Figure 11-3. Probe parts

WARNING If any damage is found, do not use the probe until it has been 
inspected and repaired/replaced by a GE HealthCare Service 
Representative. Failure to follow these precautions can result 
in injury and equipment damage.

1. Casing
2. Strain relief

3. Seal
4. Lens
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Visual Inspection

Housing, connection, operating elements, display facilities, 
labels, accessories, user manual.

Perform After Each Use

Inspect the probe's lens, cable, casing, and connector. Look for 
any damage that would allow liquid to enter the probe.  

NOTE: Keep a log of all probe maintenance, along with a picture of any 
probe malfunction.
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Probe Reprocessing

Probe Care Cards

The Probe Care Card contains a list of chemicals that have been 
tested for compatibility with GE HealthCare Ultrasound probes. 
The reprocessing instructions provided in this document have 
been validated with the chemicals specified in Table 11-6 on 
page 11-36.

Additional requirement to the already available reprocessing 
Instruction (5661328): Each probe shall be cleaned and 
disinfected before initial use.

The Probe Care Card is supplied with every probe and may also 
be downloaded from: 

Adequate cleaning and disinfection between patient cases are 
necessary to prevent transmission of disease. All probes must 
be thoroughly cleaned prior to disinfection. The level of 
disinfection required is based on patient contact. 

• To verify probe chemical compatibility, a full list of chemicals 
tested is available at the GE HealthCare Probe website 
Table 11-5 on page 11-19.

• Probes that contact mucosal or non-intact skin require 
cleaning followed by High-Level Disinfection either soaking 
or use of a trophon® EPR or trophon2. 

• Probes that contact intact skin require cleaning followed by 
Intermediate-Level Disinfection (wipe or spray). 

Table 11-4:  Documentation Web Site

Support Documentation Web Site

https://www.gehealthcare.com/documentation

Table 11-5:  Probe Web Site

Ultrasound Probe Web Site

https://www.gehealthcare.com/transducers
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Probe Pre-Treatment at the Point of Use (Required for All Probes)

The pre-treatment step is for removal of gel and gross 
contamination. 

1. After each use, remove protective sheath from the probe 
and remove the coupling gel by wiping from the strain relief 
to the lens with a soft, low-lint cloth.

2. Wipe the cable with one of the wipes listed in probe 
compatibility website from the strain relief to the connector. 
Wipe the cable with a low-lint cloth dampened with potable 
water to remove chemical residue. Dispose of the cloth, 
wipe and gloves in the clinical trash.

Figure 11-4. Cleaning the Probe Cable

NOTE: Use of wipes listed in the Ultrasound Probe website may 
result in discoloration of the cable.

CAUTION
DO NOT use abrasive products or brushes when cleaning or 
wiping a GE HealthCare Ultrasound probe. The use of abrasive 
wipes can damage the soft lens (acoustic window). To extend 
the life of the probe lens, pat dry only.
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Probe Pre-Treatment at the Point of Use (Required for All Probes)  

(continued)

3. After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter 
the probe.

 Figure 11-5. Inspect the Lens, Cable, and Probe House After Each Use

CAUTION
Use caution when cleaning the connector. This cable 
connector should only be cleaned with a slightly dampened 
cloth or wipe. Exposure to excessive moisture will result in 
damage to the probe and possibly the ultrasound console. 
DO NOT wet the connector/console interface surface or 
labels.

DANGER If the probe is damaged, do not place it into any liquid (e.g. 
for disinfection) and do not use it until it has been inspected 
and repaired/replaced by a GE HealthCare Service 
Representative.

1. Cleaning only portion
2. Cleaning only or cleaning and disinfection portion
3. Cleaning followed by appropriate level of disinfection
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Probe Manual Cleaning Instructions

Thorough cleaning is a mandatory first step to allow adequate 
subsequent disinfection or sterilization. Choose the most 
convenient method, either the wipe or enzymatic soak.

Use necessary precautions (e.g., gloves, face screen and 
gown), as directed by your facility.

Cleaning with Wipes

1. Hold the probe by the handle near the cable strain relief. DO
NOT suspend or hold the probe by the cable as this may 
damage the probe.

2. Dispense a cleaning wipe from the wipe canister. 

3. Gently wipe the probe with a cleaning wipe from the cable 
strain relief to the acoustic lens (i.e. from cleanest to dirtiest 
area). Gently wipe the probe’s acoustic lens. 

NOTE: Pay special attention to acoustic lens, edges, and 
crevices, removing all gel, product, and body fluids.

4. Turn the probe and continue wiping until the entire surface 
of the probe has been wiped. As the wipe becomes visibly 
soiled, discard the wipe into clinical trash and dispense 
fresh wipes as needed.

5. As needed for additional focused cleaning to crevices, wrap 
a clean wipe around a soft nylon bristle brush or other 
suitable instrument to access crevices, such as biopsy 
notches.

6. Visually inspect the probe for any remaining soil and, if 
necessary, repeat steps 3 through 5 until the probe is visibly 
clean.

7. Thorough dry the probe using a clean, low-/non-linting, soft 
cloth or wipe. Pat dry acoustic lens.

NOTE: Clean the probe holder of the ultrasound system before 
returning the probe back to the system. (Refer to the probe 
holder cleaning instruction in ultrasound system user 
manual for details).

WARNING DO NOT clean the probe in an automated washer-disinfector, 
due to the possible damage of the connector/console interface.
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Cleaning with Enzymatic Detergent 

1. Ensure the probe has been disconnected from the console. 
Replace gloves and fill a sink or basin with warm potable 
water (30 - 40°C) to a level allowing immersion of the probe 
up to the immersion line shown in the user manual.

2. Prepare the cleaning solution in accordance with the 
detergent manufacturer’s instructions.

3. Immerse the probe in the prepared cleaning solution up to 
the immersion line and ensure no air bubbles are trapped on 
the surface. 

NOTE: For IC5-9-D, E8C and E8C-RS, see Figure 11-12 on 
page 11-32 for special immersion instructions.

NOTE: Over-exposing ultrasound probes to cleaning solution may 
damage the ultrasound probe.

4. Brushing with a clean, soft, nylon bristle brush from the base 
of the cable strain relief to the distal tip is critical to ensure 
cleaning and disinfection efficacy.   

Figure 11-6. Cleaning the probe using a brush

CAUTION
DO NOT submerge probe beyond the immersion line 
shown in the Ultrasound console’s user manual.

CAUTION
Do not use the brush on the probe lens. 
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Cleaning with Enzymatic Detergent  (continued)

Figure 11-7. Probe Lens Examples

5. Continue brushing the probe for not less than the minimum 
contact time listed on the detergent manufacturer’s label. 

6. Visually inspect the probe for soil. Repeat Steps 3 through 5 
until all visible soil has been removed from the surface of the 
probe.

7. Rinse the probe under running warm potable water (30 - 
40°C) for not less than 2 minutes. Scrub the surface of the 
probe with a clean, soft, nylon bristle brush from the base of 
the cable strain relief to the distal tip. 

NOTE: Discard solutions and rinse waters in accordance with local 
regulations.

8. Visually inspect the device in a well-lit area to ensure all 
surfaces are free from residual cleaning solution. Repeat 
Step 7 if visible cleaning solution is observed.

9. Thoroughly dry the probe using a clean, low-lint, soft cloth or 
wipe. Pat dry lens.

NOTE: Clean the probe holder of the ultrasound system before 
returning the probe back to the system. (Refer to the probe 
holder cleaning instruction in ultrasound system user 
manual for details).

CAUTION
DO NOT use the brush on the probe lens. 

CAUTION
DO NOT use a twisting motion or abrasive paper products 
when wiping the probe as this may damage the soft lens. To 
extend the life of the probe lens, pat dry only.



Care and Maintenance

LOGIQ Totus – User Manual 11-25
5929163-1EN Rev. 3

Cable and Connector Manual Cleaning

The connector can be cleaned with a wipe dampened with 
alcohol. Use caution when cleaning the connector, wring wipe to 
remove excess of liquid before wiping the connector. Prevent 
introduction of foreign objects in the system connector 
assembly. Do not apply excessive force on any component of 
the system connector

Figure 11-8. Connector/console interface surface and label

The cable should be processed using cleaning/disinfectant 
wipes. If the cable has been in contact with risk factors, such as 
blood and/or mucous, cleaning should be followed by 
disinfection.

1. Dispense a cleaning/disinfectant wipe from the wipe 
canister

WARNING Exposure to excessive moisture will result in damage to the 
probe and possibly the ultrasound console. DO NOT wet the 
connector/console interface surface or labels (Refer to red 
circles in picture below). DO NOT clean the probe in an 
automated washer-disinfector.
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2. Wipe the cable with a cleaning/disinfectant wipe from the 
handle strain relief to the connector strain relief. As the wipe 
becomes visibly soiled, discard the wipe into clinical trash 
and dispense fresh wipes as needed

Figure 11-9. Cleaning the Probe Cable

NOTE: Some detergents and disinfectants might cause 
discoloration to the probe’s cable.

3. Visually inspect the cable for any remaining soil and, if 
necessary, repeat cleaning until the cable is visibly clean

If disinfection is needed, dispense a new cleaning/
disinfectant wipe and continue wiping the cable. Use as 
many wipes as needed, to ensure all surfaces remain wet 
for the minimum required contact time mentioned in 
Table 11-6 on page 11-36. Discard the wipes into clinical 
trash.

4. Saturate a soft, low-/non-linting cloth with Critical Water 
(remove excess water, wipe should be damp but not 
dripping) and thoroughly wipe all surfaces of the cable to 
remove chemical residues. Discard the cloth into clinical 
trash.

NOTE: Critical Water is water that is treated (usually by a multistep 
treatment process that could include a carbon bed, 
softening, DI, and RO or distillation) to ensure that the 
microorganisms and the inorganic and organic material are 
removed from the water to an appropriate level (Refer to 
AAMI TIR34/ST108). Use of this type of water will reduce 
the recontamination of probes during processing.

5. Let the cable air dry until visibly dry



Care and Maintenance

LOGIQ Totus – User Manual 11-27
5929163-1EN Rev. 3

Probe Intermediate-Level Disinfection (ILD)

For Intermediate-Level Disinfection of intact skin contacting 
probes, choose either the spray or wipe method.

NOTE: Probes that contact only intact skin may be disinfected in this 
manner. All probes that contact non-intact skin or mucous 
membranes (e.g., endocavitary, Transesophageal) require 
High-Level Disinfection.

Probe ILD - Disinfectant Spray or Wipe

NOTE: Disinfectant exists either in pre-impregnated wipe or in spray. 
The spray should be sprayed onto a low-/non-linting cloth and 
then used in same way as a pre-impregnated wipe. In steps 1 to 
4 of this section, “wipe” will then stand for a pre-impregnated 
wipe as well as for a low-/non-linting cloth saturated with 
disinfectant. 

Do not spray disinfectant onto the probe directly.

Use necessary precautions (e.g. gloves, face screen and gown), 
as directed by your facility.

1. Dispense a new wipe. 

2. Holding the probe near the strain relief, wipe the acoustic 
lens and handle areas. Slightly rotate the probe after each 
wiping pass and continue wiping until all areas of the probe 
and handle have been wetted. Wring the wipe above 
recessed areas and ridges for dripping liquid directly onto 
the less accessible surfaces.

3. Using fresh wipes, repeat step 2 as many times as needed 
to ensure all surfaces remain wet for the minimum required 
contact time listed in Table 11-6 on page 11-36

CAUTION
After each use, inspect the lens, cable, and housing of the 
probe. Look for any damage that would allow liquid to enter the 
probe.

DANGER If the probe is damaged, DO NOT place it into any liquid (e.g. 
for disinfection) and DO NOT USE until the probe has been 
inspected and repaired/replaced by a GE HealthCare Service 
Representative.
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Probe ILD - Disinfectant Spray or Wipe  (continued)

Figure 11-10. Disinfecting the Probe with slight rotation

4. Saturate a soft, low-/non-linting wipe with Critical Water 
(remove excess water, wipe should be damp but not 
dripping) and thoroughly wipe all surfaces of the probe to 
remove chemical residue. Discard the wipe into clinical 
trash.

NOTE: Critical Water is water that is treated (usually by a multistep 
treatment process that could include a carbon bed, 
softening, DI, and RO or distillation) to ensure that the 
microorganisms and the inorganic and organic material are 
removed from the water to an appropriate level (Refer to 
AAMI TIR34/ST108). Use of this type of water will reduce 
the recontamination of probes during processing.

5. Thoroughly dry all surfaces of the probe using a soft, low-lint 
wipe or cloth, changing wipes/cloths when necessary to 
ensure the probe is completely dry. Pat dry acoustic lens. 
Visually inspect the probe to ensure all surfaces are dry. 
Repeat drying steps if any moisture is visible. 

6. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. Refer to the Probe Transportation and 
Storage section for additional information.

NOTE: Ensure that probe holder of the ultrasound system has been 
disinfected before returning the probe back to the system 
(refer to the probe holder disinfection instruction in 
ultrasound system user manual for details).
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Probe High-Level Disinfection (HLD)

High-Level Disinfection is required for devices that contact 
intact mucous membranes or non-intact skin. High Level 
Disinfection can be performed using either disinfectant 
wipes (only for some probes),  a disinfectant soaking 
method or an automated system such as trophon EPR and 
trophon2. 

NOTE: Handles of semi-critical probes that are not submerged during 
High-Level Disinfection require at minimum Intermediate-Level 
Disinfection to avoid cross contamination.

NOTE: All probes must be thoroughly cleaned and dried prior to 
High-Level Disinfection.

WARNING DO NOT disinfect the probe in an automated 
washer-disinfector, due to the possible damage of the 
connector/console interface.

DANGER If the probe is damaged, remove it from patient use. Clean and 
disinfect the probe before contacting your GE HealthCare 
Service Representative for inspection and repair/replacement.

CAUTION
After each use, inspect the acoustic lens, cable, and housing of 
the probe. Look for any damage that would allow liquid to enter 
the probe.
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Probe HLD - Soak

1. Ensure the probe has been disconnected from the console. 
Replace gloves and fill a sink or basin with High-Level 
Disinfectant diluted in accordance with the disinfectant 
manufacturers instructions to a level allowing immersion of 
the probe up to immersion line shown in Figure 11-11 on
page 11-31.

2. Immerse probe in the disinfectant up to the immersion line 
and ensure no air bubbles are trapped. Ensure the probe 
remains in the disinfectant for at least the minimum contact 
time listed in the disinfectant manufacturer’s instructions for 
use. 

CAUTION
Ensure no liquid comes into contact with the probe connector 
pins or labels.
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Probe HLD - Soak  (continued)

 Figure 11-11. Probe Immersion Levels, 1 = Fluid Level

For IC5-9-D probe with serial numbers listed below or 
greater, refer to Figure 11-12 on page 11-32 for the soaking 
level: 

• IC5-9-D: 780333WX1 or greater (example 780334WX1, 
780335WX1)

The prefix number, i.e. 780333 for 780333WX1, 
indicates serial number sequence.
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Probe HLD - Soak  (continued)

Figure 11-12. Probe Immersion Level for IC5-9-D

NOTE: Over-exposing ultrasound probes to high-level disinfectants 
may damage the ultrasound probe. NEVER exceed the 
disinfectant manufacturer’s maximum exposure time. 

Figure 11-13. Probe suspended in disinfectant basin

3. Thoroughly rinse the probe by immersing it in a large 
volume of critical (purified) water for a minimum of 1 (one) 
minute. Remove the probe and discard the rinse water.

Do not reuse the water. Always use fresh volumes of water 
for each rinse. Repeat Step 3 two additional times, for a total 
of 3 (three) rinses.

NOTE: Critical Water is water that is treated (usually by a multistep 
treatment process that could include a carbon bed, 
softening, DI, and RO or distillation) to ensure that the 
microorganisms and the inorganic and organic material are 
removed from the water to an appropriate level (Refer to 
AAMI TIR34/ST108). Use of this type of water will reduce 
the recontamination of probes during processing.

1. Serial number location

CAUTION
Ensure that the probe is suspended. The probe face should not 
be resting against the tank/basin surface and should be in full 
contact with the liquid. Carefully place the probe in the basin, 
taking care not to damage the transducer lens. 
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Probe HLD - Soak  (continued)

4. Thoroughly dry all surfaces of the probe using a soft, low-lint 
wipe or cloth, changing wipes’ cloths when necessary to 
ensure the probe is completely dry. Pat dry lens. Visually 
inspect the probe to ensure all surfaces are clean and dry. 
Repeat drying steps if any moisture is visible.

5. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. This may be accomplished by placing the 
probe in a storage cabinet with filtered air flow and/or by 
using a disposable storage cover placed over the probe. 

The instructions provided above have been validated to properly 
prepare GE HealthCare Ultrasound probes for re-use. It remains 
the responsibility of the processor to ensure that the processing 
is performed as specified in this document. This may require 
verification and routine monitoring of the process. 

CAUTION
Failure to properly rinse probes with water following 
disinfection may cause skin irritation. Failure to follow these 
instructions could lead to inflammation to skin or mucosal 
membrane. 
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Probe HLD - trophon® EPR or trophon2

When performing High-Level Disinfection of GE HealthCare 
ultrasound probes with the trophon EPR and trophon2, it is not 
necessary to disconnect the probe from the ultrasound system. 
The probe must be inactive (not selected) during the disinfection 
cycle.

1. This automated disinfection replaces the manual HLD, but 
manual cleaning still needs to be performed prior to 
automated HLD. Refer to manual cleaning instructions 
mentioned in this document.

2. Follow the trophon instructions for probe placement and 
operation of the trophon system. Incorrect positioning of the 
probe may lead to probe/cable damage and High-Level 
Disinfection not being achieved. 

3. Once the trophon High-Level Disinfection cycle is complete, 
use necessary precautions (e.g. gloves), as directed by your 
facility and promptly remove the probe from the trophon 
machine. DO NOT store the probe in the trophon chamber.

4. Hold the probe’s handle near the strain relief cable. DO NOT 
suspend or hold the probe by the cable, as this may damage 
the probe.

CAUTION
Damage to the cable may occur if improperly hung. Damage to 
the probe may occur if the probe is placed in contact with the 
trophon chamber wall. Curved probes must be correctly 
positioned in the chamber using the Curved Probe Positioner 
(CPP) supplied with the trophon EPR system, or with the 
Integrated Probe Positioner (IPP) of trophon2 system.
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Probe HLD - trophon® EPR or trophon2  (continued)

5. Wipe the probe from the acoustic lens to strain relief with a 
clean, low-/non-linting, soft cloth or wipe to remove any 
possible residual hydrogen peroxide from the probe surface.

6. If the probe is not immediately reused, store the probe in a 
manner that will protect and keep the probe from being 
recontaminated. Refer to the Probe Transportation and 
Storage section for additional information.

CAUTION
USE non-abrasive cloth or wipe, such as KimwipesTM‚ Delicate 
Task Wipers or equivalent. DO NOT use a twisting motion 
when wiping the probe. To extend the life of the probe acoustic 
lens, pat dry only. 
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Chemicals Used for Efficacy Validation

The table below lists the products and intended use (clean, 
Intermediate-Level Disinfection, High-Level Disinfection) that 
were validated. 

A full list of chemicals tested for compatibility is available at the 
GE HealthCare Probe Web Site: 

NOTE: The tables in this manual indicate the status when this manual 
was published. Please visit the website for the latest 
information.

Table 11-6:  Chemicals used for Efficacy Validation

Product Type Trade Name Manufacturer

Minimum
Contact 

Time Active Ingredient

Cleaning (Wipe) Oxivir® Tb Diversey N/A Hydrogen Peroxide

Enzymatic Detergent 
(Soak)

Enzol®
 (Cidezyme®)

Advanced 
Sterilization 
Products® (J&J)

1-Minute
Soak

Proteolytic Enzymes

MetriZyme™ Metrex™

Prolystica® 2X
Concentrate 
Presoak & Cleaner

Steris

Intermediate-level 
Disinfectant (wipe)

Oxivir® Tb Diversey 10-Minute
Exposure

Hydrogen Peroxide

High-level 
Disinfectant (Soak)

Cidex® OPA Advanced 
Sterilization 
Products (J&J)

10-Minute
Soak

Ortho-phthalaldehyde

McKessen OPA/28 McKesson

Table 11-7:  Probe Web Site

Ultrasound Probe Web Site

http://www.gehealthcare.com/transducers
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Covering the Transducer using a Sterile, Protective Sheath

1. Place an appropriate amount of gel inside the protective 
sheath and/or on the transducer face.

NOTE: Failure to use imaging gel may result in poor image quality.

2. Insert transducer into sheath, making sure to use proper 
sterile technique. Pull cover tightly over transducer face to 
remove wrinkles and air bubbles, taking care to avoid 
puncturing the sheath.

Figure 11-14. Applying the Sheath

NOTE: No gel was applied to the probe in this photo. 

3. Secure the sheath in place.

NOTE: Failure to use a sheath that fully covers the transducer to 
the cable strain relief may lead to cross-contamination of the 
transducer.

4. Inspect the sheath to ensure there are no holes or tears. If 
the sheath becomes compromised, stop the procedure and 
replace immediately. 

5. After usage, discard the sheath into clinical trash.  

CAUTION
Probe sheaths are disposable and must not be reused.

CAUTION
Protective barriers may be required to minimize disease 
transmission, but their use does not replace cleaning and 
disinfection. Probe sheaths are available for use with all clinical 
situations where infection is a concern. Use of legally 
marketed, sterile probe sheaths is recommended for 
intra-cavitary, intra-operative, and biopsy procedures. 

1. Secure the Sheath with a rubber 
band.

2. The probe sheath should extend 
past the end of the probe to the 
probe’s cable. 
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Probe Cleaning and Disinfecting Notes

CAUTION
Each probe shall be cleaned and disinfected before initial use.

DANGER Ultrasound transducers can easily be damaged by improper 
handling and by contact with certain chemicals.  Failure to 
follow these precautions can result in serious injury and 
equipment damage.

• Do not immerse the probe into any liquid beyond the level 
specified for that probe.  Never immerse the transducer 
connector or probe adapters into any liquid. 

• Avoid mechanical shock or impact to the transducer and do 
not apply excessive bending or pulling force to the cable.

• Transducer damage can result from contact with 
inappropriate coupling or cleaning agents:

• Do not soak or saturate transducers with solutions 
containing alcohol, bleach, ammonium chloride 
compounds or hydrogen peroxide (except in the case 
of using trophon’s hydrogen peroxide).

• Avoid contact with solutions or coupling gels containing 
mineral oil or lanolin

• Avoid temperatures above 60 C (except with trophon 
for approved probes).

• Inspect the probe prior to use for damage or degeneration 
to the housing, strain relief, lens and seal.  Do not use a 
damaged or defective probe.

• Use only the products that are listed on the Transducer 
website or on the Probe Care Card enclosed with the 
probe. In addition, refer to the local/national regulations.

WARNING Do not steam, heat autoclave on general surface probes.
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Probe Cleaning and Disinfecting Notes  (continued)

CAUTION
CREUTZFELDT-JAKOB DISEASE

Neurological use on patients with this disease must be 
avoided.  If a probe becomes contaminated, there is no 
adequate disinfecting means.

CAUTION
DO NOT expose the system/probe connector to any moisture 
or liquids. 

CAUTION
Take extra care when handling the lens face of the Ultrasound 
transducer. The lens face is especially sensitive and can easily 
be damaged by rough handling. NEVER use excessive force 
when cleaning the lens face.

CAUTION
In order for liquid chemical disinfectants to be effective, all 
visible residue must be removed during the cleaning process. 
Thoroughly clean the probe, as described earlier before 
attempting disinfection.

You MUST disconnect the probe from the LOGIQ Totus prior to 
cleaning/disinfecting the probe. Failure to do so could damage 
the system.  

DO NOT soak probes in liquid chemical disinfectant for longer 
than is stated by the disinfectant instructions for use. Extended 
soaking may cause probe damage and early failure of the 
enclosure, resulting in possible electric shock hazard. 
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Probe Cleaning and Disinfecting Notes  (continued)

NOTE: Cleaning products should be as close to neutral PH as possible. 
Any gel, cleaning, or disinfectant products containing 
concentrations, surfactants, methanol, ethanol, benzyl or methyl 
alcohol, mineral oil, lubricant oil, oil-based lotions, acetone, 
ammonia, anhydrous ammonia, iodine, iodine compounds, 
acids with 5PH or greater may damage or discolor your probe. 
Ultrasounic cleaning is not approved for GE HealthCare probes. 

NOTE: DO NOT re-use cloths or wipes. Soap, detergents, or enzymatic 
cleaners should be used in accordance with the manufacturer’s 
instructions. GE HealthCare is not responsible for damage 
incurred during the cleaning process for products which no 
material compatibility evaluation has been conducted.

CAUTION
Avoid cross-contamination, follow all infection control policies 
established by your office, department or hospital as they apply 
to personnel and equipment.

CAUTION
• Do not use paper products or products that are abrasive 

when cleaning the probe. They damage the soft lens of the 
probe.

• Before storing the probes, ensure that they are thoroughly 
dry. If it is necessary to dry the probe after cleaning, blot 
the probe with a soft cloth.

CAUTION
Probes must be cleaned and disinfected before they are 
replaced or disposed of.
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Probe Disinfectants 

Choosing a Disinfectant

NOTE: For latest chemicals tested for compatibility, check the GE 
HealthCare Probe Website at the link listed in Table 11-8.  

When choosing a disinfectant, determine the required level of 
disinfection. If the possibility of cross-contamination or exposure 
to unhealthy or non-intact skin exists, then high level disinfection 
should be performed. Good hand hygiene practice is highly 
recommended to help further reduce the risk of 
cross-contamination. 

NOTE: For additional information about cleaning and disinfection, refer 
to the recommendations of the Association for Professionals in 
Infection Control (APIC), the U.S. Food and Drug Administration 
(FDA), and the U.S. Centers for Disease Control (CDC). For 
country-specific disinfection regulations, check with your local 
regulatory infection control authorities. 

NOTE: GE HealthCare publishes a list of material-compatible 
disinfectants (see below and also refer to the GE HealthCare 
website at http://www3.gehealthcare.com/en/Products/
Categories/Ultrasound/Ultrasound_Probes. DO NOT use 
non-GE HealthCare-approved disinfectants or products that 
have not been evaluated by GE HealthCare for material 
compatibility. Damages linked to the use of disapproved 

Table 11-8:  Probe Web Link

Ultrasound Probe Web Site

http://www.gehealthcare.com/transducers

CAUTION
Disinfectant wipes and topical spray products are not FDA 
cleared high level disinfectants and do not provide adequate 
protection should the probe become cross contaminated or in 
contact with unhealthy or non-intact skin. Failure to 
appropriately disinfectant could lead to exposure to infectious 
agent(s). 

CAUTION
Review the probe care card that is packed with each probe.
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chemicals are not covered under product warranty or service 
contract. 
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trophon EPR Probe High-Level Disinfection

 Figure 11-15. trophon EPR

1. Screen Display
2. Start Button
3. Soft key buttons

4. Chamber door handle
5. Probe cable clamp
6. Cartridge door

CAUTION
Only those individuals previously trained on the trophon EPR or 
trophon2 unit may use the device. Refer to the trophon EPR or 
trophon2 user documentation for more information on 
disinfecting approved probes.
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trophon EPR Instructions for Use

Installing the 
disinfectant 
cartridge

1. The cartridge door automatically opens when a cartridge 
needs replacing.

2. Screen message: “Load Cartridge” or “Cartridge Empty, 
Replace Cartridge Now” displays.

3. Wear disposable gloves and chemical resistant goggles.  
These should be worn at all times while using the trophon 
EPR.

4. Press the soft key button under “Yes” to open the cartridge 
replacement door.

5. Remove the cartridge lid and insert the bottle on the side of 
the unit.

6. Rotate the cartridge until it drops into place and cannot 
rotate any further.

7. Close the cartridge door. Do not use excessive force to 
accomplish this. The door clicks into place and locks.

Disinfecting probe 
in trophon EPR

8. When the screen message reads “Load Probe”, open the 
chamber door.

9. Clean and rinse the probe. Dry the probe.

NOTE: The probe must be cleaned, per the manufacturer’s 
guidelines, and dried before disinfection. 

10. Place Chemical Indicator on the bottom of the device 
chamber.

11. While holding the probe handle, press the top of the probe 
into the chamber’s seal. Ensure the probe is straight and not 
touching either the walls or bottom of the chamber. Strain 
relief (interface between cable and probe body) must be 
positioned at the top of the chamber. The tip of the probe 
must be above the horizontal line marked in the chamber.

CAUTION
Do NOT allow the probe surface or lens to touch the 
chamber’s wall during the disinfection process. This could 
cause permanent damage to the probe.
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trophon EPR Instructions for Use  (continued)

12. Press the probe’s electrical cable into the cable clamp, 
found at the top of the chamber.

13. Close the chamber door. It will automatically lock.

14. The screen message “Is the probe clean and dry?” appears, 
select Yes. 

15. Press “Start” to begin the disinfecting process.

16. Discard disposable gloves.

Removing the 
Probe after 
7-minute cycle 
time

1. Wear a new pair of disposable gloves.

2. When “Cycle complete” displays on the screen, open the 
chamber door.

3. Check the Chemical Indicator color change and refer to the 
Chemical Indicator on the box.

4. Remove the Chemical Indicator from device and discard.

5. Remove the probe from the trophon EPR.

6. Wipe the probe prior to use with an absorbent, single-use, 
dry, low-lint cloth.

7. Remove and discard the disposable gloves.
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Coupling Gels

CAUTION
Do not use unrecommended gels (lubricants).  They may 
damage the probe and void the warranty.

Table 11-9:  Probe Gels

Gel
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Aquasonic 100 X X X X X X X X X X X X X X X X

Clear Image X X X X X X X X X X

EcoGel 200 Ultrasound Gel X X X X X X X X X X X X

EcoVue Ultrasound Gel X X X X X X X X X X X

Haiyin X X X X X X X X

Kendall Life Trace Ultrasound 
Gel

X X X X X X X X X X X X

Konix Ultrasound Gel X X X X X X X X X X X X

MediChoice Standard 
Ultrasound Gel

X X X X X X X X X X X X

Medline Ultrasound Gel/
Ultrasound Transmission Gel

X X X X X X X X X X X X

Natural Image X X

Scan X X X X X X X X X X X X

Sonogel X X X X X X X X X X X X

Wavelength Multi-Purpose 
Ultrasound Gel

X X X X X X X X X X X X
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Coupling Gels  (continued)

Applying In order to assure optimal transmission of energy between the 
patient and probe, a conductive gel or couplant must be applied 
liberally to the patient where scanning will be performed.

Precautions Coupling gels should not contain the following ingredients as 
they are known to cause probe damage:

• Methanol, ethanol, isopropanol, or any other alcohol-based 
product

• Mineral oil

• Iodine

• Lotions

• Lanolin

• Aloe Vera

• Olive Oil

• Methyl or Ethyl Parabens (para hydroxybenzoic acid)

• Dimethylsilicone

• Polyether glycol based

• Petroleum

Sterile Ultrasound Procedures

ONLY ultrasound gel that is labeled as sterile, is sterile. 

Ensure you always use sterile ultrasound gel for those 
procedures that require sterile ultrasound gel.

Once a container of sterile ultrasound gel is opened, it is no 
longer sterile and contamination during subsequent use is 
possible.

CAUTION
Do not allow gel contact with eyes. If there is gel contact with 
the eye, flush eye thoroughly with water.
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V Nav Cleaning Requirements

Cleaning and Disinfecting V Nav Probe Brackets

The probe bracket SHOULD NOT be autoclaved or gas 
sterilized. The bracket can be sterilized with Cidex. Details are in 
the CIVCO reference guide that is included with the bracket kit. 

Cleaning and Disinfecting Cables, and Transmitter

Periodically clean the equipment (transmitter, sensor, and 
cables) by wiping them down with a cloth dampened in a 
cleaning solution such as mild soap and water, isopropyl 
alcohol, or a similar acceptable cleaning solution. If the tracker’s 
components come in contact with biological fluid or tissue, be 
sure to follow your organization’s procedures for proper cleaning 
and disinfection. The transmitters and sensors are not designed 
to withstand autoclaving or gamma radiation. Sensors are 
ETO-compatible. DO NOT immerse the transmitter, sensor, or 
cables in liquids. Components are not waterproof.

Disinfecting and Sterilizing General Purpose Sensor  

High-level disinfect general purpose sensor using CIDEX OPA® 
ortho-Phthalaldehyde Solution (Johnson & Johnson) or 
equivalent .55% ortho-phthalaldehyde-based solution. Follow 
manufacturer’s instructions and recommendations for 
concentration, time of contact and postprocess procedure.

High-level disinfect or sterilize general purpose sensor using 
CIDEX® Activated Dialdehyde Solution (Johnson & Johnson) or 
equivalent 2% glutaraldehyde-based solution, CIDEX Plus® 
(Johnson & Johnson) or equivalent 3.4% glutaraldehyde-based 
solution, or a hydrogen peroxide-based solution. Follow 
manufacturer’s instructions and recommendations for 
concentration, time of contact and post-process procedure.

DO NOT gas sterilize or autoclave general purpose sensor.

Covers

Covers can be used to go over the probe, bracket, sensors, and 
transmitter. 



Care and Maintenance

LOGIQ Totus – User Manual 11-49
5929163-1EN Rev. 3

Planned Maintenance

The following maintenance schedule is suggested for the 
system and probes to ensure optimum operation and safety.

DANGER Improper handling can lead to early probe failure and electric 
shock hazards.

Failure to do so will void probe warranty.

DO follow the specific cleaning and disinfection procedures 
provided in this chapter and the disinfectant manufacturer’s 
instructions.

Table 11-10:  Planned Maintenance Program

Do the Following Daily After Each Use As Necessary

Inspect the Probes - X X

Clean the Probes X X X

Disinfect Probes - X X

Disinfect all other probe 
types

- X X
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Automatic Probe Diagnostics

Automatic Probe Diagnostics uses automated lens echo 
acquisition and advanced processing to provide real-time probe 
health information.

Enable Automatic Probe Diagnostics by selecting "Enable 
Automatic Probe Diagnostics" on the Utility>Admin page.

Figure 11-16. Enable Automatic Probe Diagnostics

Automatic Probe Diagnostics will execute once at each system 
startup (on only the first supported probe connected from the left 
to right) and generate a dump file in the “D:\log\diags\VITA” 
directory. The dump file will be transferred to the Back Office 
together with other files under D:\log directory every day.

NOTE: Pencil Probe does not support Probe check. 

NOTE: M5Sc-D Probe check only supports inner row 80 elements.
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Probe Check (not available in all countries)

The Probe Check utility appears on the B-Mode Touch Panel 
Page 2. (The Probe Check utility does not appear while Scan 
Assistant is running.) A manual probe check can be run with this 
utility.

Figure 11-17. Probe Check

NOTE: Pencil Probe does not support Probe check. 

NOTE: M5Sc-D Probe check only supports inner row 80 elements.

Run Probe Check

Ensure the probe lens surface is clean and free of dirt, water or 
coupling gel before beginning probe check.

1. Select the Probe Check button on the Touch Panel (see 
Figure 11-17). 

2. A pop-up appears specifying to ensure the probe lens 
surface is clean. If the lens is clean, select Yes on the 
pop-up (see Figure 11-18). The probe check takes 
approximately 2 to 10 seconds.

Figure 11-18. Probe Check Pop-up
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Run Probe Check  (continued)

3. When the probe check is complete, a pop-up displays 
specifying if the probe “Passed” or “Failed” the test (see 
Figure 11-19). If the probe passed the test, continue using 
the probe. If the probe failed the test, follow the instructions 
on the pop-up.

Figure 11-19. Probe Check Pass or Fail Pop-ups

NOTE: While Probe Check can correctly identify most damaged 
probes, there are some less common types of probe defects 
that Probe Check is not able to detect. If a probe passes the 
probe check but the image quality of the probe is 
unacceptable, please contact your service partner.
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Automatic Probe Check

Automatic Probe Check runs during probe selection at a time 
interval specified at Utility >Admin page > Enable Automatic 
Probe Diagnostics (see Figure 11-20). The time interval options 
are: Every Time, Once a day, Once a week, Once a month and 
Never.

Automatic Probe Check runs for all supported probes with 
NOTE. Automatic Probe Check increases the probe selection 
time by about five seconds. If the probe fails the probe check, a 
pop-up displays (see Figure 11-19). If the probe fails the check, 
follow the instructions on the pop-up.

Figure 11-20. Automatic Probe Check

NOTE: Pencil Probe does not support Probe check. 

NOTE: M5Sc-D Probe check only supports inner row 80 elements.
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Probe Care Cards

Perform After 
Each Use

Ultrasound probes can be disinfected using liquid chemical 
disinfectants. The level of disinfection is directly related to the 
duration of contact with the disinfectant. Increased contact time 
produces a higher level of disinfection. Refer to the Probe Care 
Card that was shipped with each LOGIQ Totus probe.

Table 11-11:  Description of Pictogram on Probe Care Cards

Pictogram Description

“ATTENTION” - Consult accompanying documents” is intended to alert the 
user to refer to the operator manual or other instructions when complete 
information cannot be provided on the label.

“CAUTION” - Dangerous voltage (the lightning flash with arrowhead) is used to 
indicate electric shock hazards.

Biohazard - Patient/user infection due to contaminated equipment.
Usage
• Cleaning and care instructions
• Sheath and glove guidelines

Ultrasound probes are highly sensitive medical instruments that can easily be 
damaged by improper handling. Use care when handling and protect from 
damage when not in use. 

Do not immerse the probe into any liquid beyond the level specified for that 
probe. Refer to the user manual of the ultrasound system.

Since there is a possibility of having negative effects on the probe, observe the 
specified immersing time by the disinfectant manufacturer strictly. Do not 
immerse the probe in liquid chemical disinfectants more than the time 
prescribed in the care card.

“Consult accompany document” - Refer to the ultrasound system user manual 
for important probe care and cleaning instruction.
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Symbol indicates useful information

This is to illustrate compatible ultrasound coupling gels

This is to illustrate compatible cleaners or disinfectants available in spray 
format (to be used according to instruction from the manufacturers of these 
products). 

This is to illustrate compatible cleaners or disinfectants available in wipes 
format (to be used according to instruction from the manufacturers of these 
products)

This is to illustrate compatible cleaners or disinfectants available in powder (to 
be used according to instruction from the manufacturers of these products). 

This is to illustrate compatible cleaners or disinfectants available in liquid 
format (to be used according to instruction from the manufacturers of these 
products). 

This is to illustrate compatible automated reprocessors (to be used according 
to instruction from the manufacturers of these products).

Table 11-11:  Description of Pictogram on Probe Care Cards (Continued)

Pictogram Description
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Returning/Shipping Probes and Repair Parts

US Department of Transportation and GE HealthCare policy 
requires that equipment returned for service MUST be clean and 
free of blood and other infectious substances.

When you return a probe or part for service (Field Engineer or 
customer), you need to clean and disinfect the probe or part 
prior to packing and shipping the equipment.

Ensure that you follow probe cleaning and disinfection 
instructions provided in the Basic User Manual.

This ensures that employees in the transportation industry as 
well as the people who receive the package are protected from 
any risk.
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Biopsy Special Concerns

Precautions Concerning the Use of Biopsy Procedures

WARNING Do not freeze the image during a biopsy procedure.  The image 
must be live to avoid a positioning error.

Biopsy guide zones are intended to assist the user in 
determining optimal probe placement and approximate the 
needle path.  However, actual needle movement is likely to 
deviate from the guideline. Always monitor the relative 
positions of the biopsy needle and the target mass during the 
procedure, otherwise it could result in repeated biopsies or 
patient injury.

WARNING NEVER reuse the TR5° disposable biopsy guide attachment, 
disposable sterile Ultra-Pro II needle guide kits or Verza Needle 
guide kits. Failure to follow the manufacturer’s instructions 
could lead to potential exposure to infectious disease.

WARNING The use of biopsy devices with accessories that have not been 
evaluated for use with this equipment may not be compatible 
and could result in injury. Failure to follow these instruction 
could result in repeated biopsies or patient injury.



Probes and Biopsy

11-58 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Precautions Concerning the Use of Biopsy Procedures  (continued)

WARNING The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission.  Equipment must be cleaned as appropriate for 
the procedure prior to use.

• Follow the probe cleaning and disinfection procedures and 
precautions to properly prepare the probe.

• Follow the manufacturer's instructions for the cleaning of 
biopsy devices and accessories.

• Use protective barriers such as gloves and probe sheaths.

• After use, follow proper procedures for decontamination, 
cleaning, and waste disposal.

Failure to follow these instructions could lead to exposure 
to infectious agents.

CAUTION
Improper cleaning methods and the use of certain cleaning and 
disinfecting agents can cause damage to the plastic 
components that will degrade imaging performance or increase 
the risk of electric shock. 

See ‘Probe Safety’ on page 11-11 for more information.

WARNING Consult the biopsy needle manufacturer’s instructions for 
acceptable reprocessing of biopsy needles. Failure to follow 
the manufacturer's instructions could lead to exposure to 
infectious agents. 

CAUTION
The biopsy needle and the biopsy needle guide (and the bore 
inside) must be sterile. 

CAUTION
Before starting a biopsy procedure with a 3D/4D probe always 
perform a volume scan first. This is important to ensure proper 
mechanical alignment and centering of the transducer element 
before the biopsy is performed. 
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Freehand Biopsy

NOTE: A water bath alignment verification is also necessary before 
performing freehand biopsy procedures

CAUTION
When performing a freehand biopsy, i.e. without a biopsy 
guide, it is the user’s responsibility to use appropriate 
equipment.

CAUTION
Always only use basic modes when performing a freehand 
biopsy
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Biopsy Guide Sterilization

Sterilization with autoclave is possible for the reusable stainless 
steel Biopsy Guides for the following probes:

• IC5-9-D

• RIC5-9-D

• RAB6-D

See ‘Probe Biopsy Reprocessing’ on page 11-89 for more 
information.
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Performing a Biopsy

Displaying the Guidezone

Activate the Biopsy Kit by selecting it from the B-Mode Touch 
Panel.

Figure 11-21. B-Mode Touch Panel Menu

The available biopsy options appear when Biopsy Kit is 
selected. There are fixed and adjustable angle biopsy kits and 
plastic/disposable and reusable biopsy guides available with the 
LOGIQ Totus depending on the probe. Select the desired biopsy 
kit. 

NOTE: You can display the biopsy guideline on the CFM image in 
simultaneous mode. Enabling Color Flow allows for visualization 
of the vascular structure around the area to be biopsied. Select 
the Show Biopsy Mark on CFM simultaneous Mode preset in the 
Utility -> System -> System Image -> Biopsy Guide screen.

CAUTION
Some angles (for example, if outside of the Field of View) may 
not be supported on all probes.
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Displaying the Guidezone  (continued)

NOTE: Be sure to match the angle setting on the bracket to the Biopsy 
Kit setting on the system.

Figure 11-22. Biopsy Guidezones for the M5Sc Probe

The biopsy guidezone represents the path of the needle. The 
dots which make up the guidezone represent the depth readout, 
where: 

• Yellow represents 1 cm increments. 

• Red represents 5 cm increments.

The display should be carefully monitored during a biopsy for 
any needle deviation from the center line or guidezone. 

Before scanning, verify the needle can be visualized within the 
imaging plane. Use appropriate needle length to reach target 
area. Adjust the guide settings on the system and confirm they 
pass through the target, then match the setting on the system to 
the pin settings on the guide. 

1. Biopsy Kit Name and Biopsy Needle Angle
2. 1 cm increments
3. 5 cm increments
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Displaying the Guidezone  (continued)

NOTE: Biopsy Needle Angle is defined with respect to the horizontal 
axis. This is equivalent to (90 deg) – (angle specified by 
CIVCO). Displayed angle may be slightly different from CIVCO’s 
specifications due to part variability. 

The Biopsy Guidezone adjusts along with image adjustments, 
such as image inversion/rotations, zoom and depth changes.

The needle may vary from the center line or guidezone for 
various reasons:

• Needle barrel to needle clearance or strength.

• Bracket manufacturing tolerance.

• Needle deflection due to tissue resistance.

• Needle size chosen. Thinner needles may deflect more.

WARNING Failure to match the guidezone displayed to the guide may 
cause the needle to track a path outside the zone.

It is extremely important that when using the adjustable angle 
biopsy guides, the angle displayed on the screen matches the 
angle set on the guide, otherwise the needle will not follow the 
displayed guidezone which could result in repeated biopsies or 
patient injury.

CAUTION
The default biopsy lines provided with the system software, 
must be verified at least once by the user. The procedure must 
be repeated if probes and/or biopsy guides are exchanged. 

CAUTION
Depending on the needle stiffness/thickness and the elasticity 
and composition of the different tissue-types in the path of the 
biopsy needle, the actual needle track can deviate from the 
predicted biopsy line. The biopsy needle might bend and not 
follow a straight line. 



Probes and Biopsy

11-64 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Guide circle on the biopsy line

You can use a guide circle on the biopsy line.

Mode: B/CF/PDI/Elastography/Contrast/Volume Navigation

Display format: Single/Dual

Figure 11-23. Guide circle

• Guide circle

• Biopsy line

• The system displays current size of Target diameter (inside 
circle) and margin distance in the status area.
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Preset for guide circle

Check “Show Biopsy Circle” in Utility ->  System -> System 
Imaging to display a guide circle control on the monitor display 
and the trackball key.

Biopsy circle control

Figure 11-24. Biopsy circle control

1. Target diameter

2. Margin distance

3. Guide circle display On/Off

4. Circle position (move Trackball Up/Down)
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Preparing the Biopsy Guide Attachment

Convex, Sector and Linear probes have optional biopsy guide 
attachments for each probe.  The guide consists of a 
non-disposable bracket to attach to the probe, disposable 
needle clip to attach to the bracket, sheath, gel (sterile gel if 
necessary) and disposable needle barrels.

The disposable needle barrels are available for a variety of 
needle sizes.

The bracket is packaged non-sterile and is reusable. To avoid 
possible patient contamination, ensure bracket is properly 
cleaned, sterilized or disinfected before each use.

Disposable components are packaged sterile and are single-use 
only. Do not use if integrity of packing is violated or if expiration 
date has passed.

CAUTION
DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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Fixed Needle Biopsy Guide Assembly

1. Identify the appropriate biopsy guide bracket by matching 
the label on the bracket with the probe to be used.

2. Orient the bracket so that the needle clip attachment will be 
on the same side as the probe orientation mark (ridge).

Figure 11-25. Probe/Bracket Alignment

a. Probe Orientation Mark

b. Bracket

3. Attach the biopsy bracket to the probe by sliding the bracket 
over the end of the probe until it clicks or locks in place.

4. Place an adequate amount of coupling gel on the face of the 
probe.

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood. Failure to follow these instructions 
could result in repeated biopsies or patient injury.

a

b
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Fixed Needle Biopsy Guide Assembly  (continued)

5. Using a sterile technique, place the proper sanitary sheath 
over the probe and biopsy bracket. Use the rubber bands 
supplied to hold the sheath in place.

Figure 11-26. Applying Sanitary Sheath

6. Snap the fixed or adjustable needle clip onto the biopsy 
guide bracket.

Figure 11-27. Fixed Needle Clip Attachment

a. Sheath

a
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Fixed Needle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure 
the lock. Make sure the needle guide is firmly attached to 
the bracket.

Figure 11-28. Locking the Needle Clip

NOTE: If using an in-plane needle guide, the needle clip appears as 
shown here. Be sure to choose an in-plane guide that 
matches the gauge of the needle being used. The in-plane 
guide does not support any on-screen graphics. This is 
because the guide allows variable angles. For in-plane 
needle guides, steps 8 and 9 are not applicable. 

Figure 11-29. Example of In-Plane Needle Guide



Probes and Biopsy

11-70 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Fixed Needle Biopsy Guide Assembly  (continued)

8. Choose the desired gauge (size) needle barrel. Twist it back 
and forth to remove it from the plastic tree.

Figure 11-30. Needle Barrel Selection

9. Place the needle barrel into the needle clip with the desired 
gauge facing the needle clip and snap into place.

Figure 11-31. Needle Barrel Installation

WARNING Ensure that all guide parts are seated properly prior to 
performing a biopsy. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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Multi Angle Biopsy Guide Assembly

1. Scan the patient and identify the target for biopsy. Move the 
probe to locate the target to the center of the image. Enable 
the system biopsy guidezone and try guidezone angles 
MBX1 to MBX3 to decide the best angle setting for needle 
path.

Figure 11-32. Example

2. Pull up on the pin (Figure 11-33 a) to freely move the needle 
guide attachment. Align the pin with the selected position of 
the needle guide attachment.

Push the pin down (Figure 11-33 b) into the desired slot to 
secure the angle position of the needle guide attachment.

Figure 11-33. Pull up and push down the pin

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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Multi Angle Biopsy Guide Assembly  (continued)

3. Fit a convex piece of the biopsy bracket (a) into the concave 
position of the probe (b).

Figure 11-34. Probe/Bracket Alignment

Hold the side (a) and tuck down the needle guide side (b) 
until it clicks or locks in place. 

Figure 11-35. Probe/Multi-angle Bracket Alignment 2

4. Place an adequate amount of coupling gel on the face of the 
probe.
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Multi Angle Biopsy Guide Assembly  (continued)

5. Place the proper sanitary sheath tightly over the probe and 
biopsy bracket. Use the rubber bands supplied to hold the 
sheath in place.

Figure 11-36. Applying Sanitary Sheath

6. Snap the needle guide onto the biopsy guide bracket.

Figure 11-37. Snap the needle guide
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Multi Angle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure 
the lock (a). Make sure the needle guide is firmly attached to 
the bracket.

Figure 11-38. Lock the Needle guide

8. Choose the desired gauge (size) needle barrel. Twist it back 
and forth to remove it from the plastic tree.

Figure 11-39. Needle Barrel

9. Place the needle barrel into the needle clip with the desired 
gauge facing the needle clip and snap into place.

Figure 11-40. Needle Barrel Installation



Performing a Biopsy

LOGIQ Totus – User Manual 11-75
5929163-1EN Rev. 3

Multi Angle Biopsy Guide Assembly  (continued)

Remove the biopsy guide

1. Hold the other side and push out the needle clip attachment 
side. See Figure 11-41.

Figure 11-41. Remove the biopsy guide

CAUTION
Prevent damage to the probe lens with finger nails. 
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Releasing the needle

According to the following procedure, you remove the needle  
from a probe and an assembly without moving the needle.

Figure 11-42. Release the needle from assembly

a. Push the knob portion of a sleeve in the direction of the 
arrow.

b. The needle is released from the assembly.

c. Push the probe and the assembly in the direction of the 
larger arrow to remove the needle.
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Endocavitary Probe Biopsy Guide Assembly - Representative Example

Preparation

To prepare the endocavitary probe for use:

1. Remove the probe from the box and carefully examine it for 
any damage.

2. If the biopsy guide is to be attached, use the filling removal 
tool to clean out the attachment area on the probe head.

Figure 11-43. Attachment Filling Removal

a. Probe Head

b. Attachment

c. Filling Removal Tool

3. Clean, then disinfect the probe.

NOTE: Ensure that protective gloves are worn.

WARNING DO NOT use the needle with the catheter (soft tube). There is a 
possibility of breaking the catheter in the body.

WARNING Before inserting the needle, scan the patient to determine the 
correct puncture depth and site. Only the sterile/sanitary 
sheath and rubber band are on the probe during the pre-needle 
placement scanning. Failure to follow these instructions could 
result in repeated biopsies or patient injury.
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Installing the sheath

To install the sheath:

1. Remove the sheath from its package. Do not unroll the 
sheath.

NOTE: Remember to rinse all sanitary probe sheaths of powder 
before placing on the probe. Powder can degrade the 
displayed image.

2. Place an adequate amount of ultrasound gel inside the 
sheath tip (the gel is between the sheath inner surface and 
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this 
purpose.

3. Place the sheath tip over the probe aperture and then pull 
the sheath end toward the probe handle.

4. Inspect the sheath for nicks, cuts or tears.

Figure 11-44. Endocavitary Probe with Sheath

5. Rub a finger over the tip of the probe to ensure all air 
bubbles have been removed.

1. Secure the Sheath with a rubber 
band.

2. The probe sheath should extend 
past the end of the probe to the 
probe’s cable. 
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Endocavitary Probe Biopsy Guide Preparation

1. If a biopsy is to be performed, snap the metal or plastic 
biopsy guide on to the probe over the sheath.

2. Fix with a screw

NOTE: For the RIC5-9-D and IC5-9-D probes, use the TR5 
guidelines for the plastic (disposable-only) biopsy guides; 
use the RU guidelines with the stainless steel reusable 
biopsy guides.

3. Place an adequate amount of ultrasound gel on the gel-filled 
sheath tip’s outer surface.

4. Ensure the guide is properly seated and secure by pushing 
forward on the needle insertion end of the guide until the 
attachment node is firmly in place in it’s hole.

WARNING Ensure that all guide parts are seated properly prior to 
performing a biopsy. Failure to follow these instructions 
could result in repeated biopsies or patient injury.
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4D Biopsy Guide Assembly - Representative Example

4D Probe

1. Place the needle guide onto the probe.

2. Push the needle forward until the bracket catches in the 
support on the housing of the probe (a).

Figure 11-45. Support on the housing

Figure 11-46. Biopsy Needle Guide

3. Fix the biopsy guide by locking the frame on the opposite 
side (b).

Figure 11-47. Mounting the Biopsy Needle Guide to the 4D 
Probe

NOTE: Needle guide sterilization with autoclave possible.
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4D Endocavitary Probe

1. Place an adequate amount of ultrasound gel inside the 
sheath tip (the gel is between the sheath inner surface and 
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this 
purpose.

2. Place the sheath tip over the probe aperture and then pull 
the sheath end toward the probe handle.

3. Inspect the sheath for nicks, cuts or tears.

4. Rub a finger over the tip of the probe to ensure all air 
bubbles have been removed.

5. Position the small swelling of the needle guide on the notch 
at the probe tip. Snap the needle guide.

Figure 11-48. Installation (without probe sheath)

NOTE: Material: Stainless Steel

NOTE: Needle guide sterilization with autoclave possible.
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Verza Biopsy Needle Guide

The Versa Biopsy Needle Guide is available for the C1-6-D and 
C1-6VN-D probes.

Activate the Biopsy Kit by selecting it from the B-Mode Touch 
Panel.

Figure 11-49. B-Mode Touch Panel Menu

The available biopsy options appear when Biopsy Kit is 
selected. Select the desired biopsy kit. 

CAUTION
Be sure to match the ‘pin’ setting on the bracket to the pin 
setting on the system.
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Verza Needle Guide Attachment Procedure

NOTE: The following procedure is shown with a C1-6-D probe. 

Table 11-12:  Verza Biopsy Guide Attachment Procedure

Step Instructions Illustration

1.  Attach the Biopsy Guide Bracket to the probe. 
a. Match the indentations on the Biopsy 

Guide Bracket and the probe. 

2. Tightly secure the Biopsy Guide Bracket to the 
probe.
NOTE: Be sure you are using the correct 
bracket for the probe.  The bracket and probe 
are clearly marked. 

3. Attach the probe sheath. 
a. Apply gel. 
b. Cover the probe. 
c. Attach the rubber band. 
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4. Tightly secure the Needle Guide to the Biopsy 
Guide Bracket through the sheath. 

5. Unlock angle lock to adjust the needle guide 
angle; then re-lock. 

Locked  Unlocked

Adjust Needle Guide Angle Re-lock

Table 11-12:  Verza Biopsy Guide Attachment Procedure (Continued)

Step Instructions Illustration
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6. Insert correct Needle Gauge Holder.   

7. Push the Quick Tab Release, insert the biopsy 
needle into the needle guide. Close the Quick 
Tab Release.

Table 11-12:  Verza Biopsy Guide Attachment Procedure (Continued)

Step Instructions Illustration
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4D Probe Biopsy Needle Path Selection

To select the needle path and verify that the path of the needle is 
accurately indicated within the guidezone on the system 
monitor, perform the following before use:

1. Properly install the bracket and biopsy guide.

2. Scan in a container filler with water (47° C). 

3. Select Biopsy kit. The available biopsy options from the 
Touch Panel.

Select the biopsy guidezone where the needle echo passes 
through the center of the guidezone. Use the selected 
biopsy guidezone when performing the biopsy.

Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within 
the guidezone on the system monitor, perform the following:

• Properly install the bracket and biopsy guide.

• Scan in a container filled with water (47° C).

• Display the biopsy guidezone on the monitor.

• Ensure that the needle echo falls within the guidezone 
markers.

CAUTION
The needle used for water bath alignment must not be used for 
a biopsy performed on a patient.



Performing a Biopsy

LOGIQ Totus – User Manual 11-87
5929163-1EN Rev. 3

The Biopsy Procedure

1. Place coupling gel on the scanning surface of the probe/
sheath/biopsy guide assembly.

2. Activate the biopsy guidezone on the system through the 
B-Mode Touch Panel.  When using multi-angle guides, 
ensure that the proper guidezone angle is displayed.

3. Scan to locate the target.  Center the target in the electronic 
guidezone path.

NOTE: Enabling color flow would allow for visualization of the 
vascular structure around the area to be biopsied.

4. Place the needle in the guide between the needle barrel and 
needle clip.  Direct it into the area of interest for specimen 
retrieval.

WARNING Biopsy procedures must only be performed on live images. 
Failure to follow these instructions could result in repeated 
biopsies or patient injury.

WARNING Ensure that all guide parts are seated properly prior to 
performing a biopsy. Failure to follow these instructions could 
result in repeated biopsies or patient injury.
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Post Biopsy

When the biopsy is complete, remove the needle barrel, needle 
clip and probe sheath.  Properly dispose of these items in 
accordance with current facility guidelines.

Clean and disinfect the probe. See ‘Probe Reprocessing’ on 
page 11-19 for more information.

The biopsy bracket can be cleaned and disinfected in a 
recommended disinfecting agent and reused.

WARNING When the biopsy needle guide kit is opened, all parts must be 
discarded after the procedure whether they have been used or 
not. Failure to follow these instructions could result in repeated 
biopsies or patient injury.
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Probe Biopsy Reprocessing

Manual Cleaning

NOTE: Efficacy of this manual cleaning process has been shown using 
ENZOL Enzymatic Detergent.

1. Remove the biopsy guide and protective sheath(s) from the 
probe.

2. Whenever possible the biopsy guide should be rinsed 
immediately after use. If the biopsy guide cannot be cleaned 
immediately after use, maintain moisture by placing them in 
a clean container. Cover the container with a towel 
dampened with purified water. Devices may remain in this 
condition for a maximum of 4 hours.

3. Remove all visible soil. Flush the biopsy guide using potable 
water (30 - 40°C) for not less than 2 minutes.

4. Prepare an enzymatic detergent safe for use with metal 
instruments according to the manufacturer’s 
recommendations, using potable water.

5. Submerge the biopsy guide in the prepared solution and 
soak for no less than 2 minutes.

6. After the 2-minute soak, while the biopsy guide is 
submerged in the detergent water, vigorously scrub the 
device with a soft nylon bristle brush.

7. Use a round nylon cleaning brush to clean the biopsy lumen. 
Use a syringe to flush detergent water through the lumen. 
Scrub the device for a minimum of 2 minutes.

8. Remove the device from the detergent water and rinse 
thoroughly in running potable water (30 - 40°C) taking care 
to remove any visible detergent. Rinse the device for a 
minimum of 1 minute. 

9. Visually inspect the device for any residual soil or detergent. 
Repeat steps 6 through 8 until the device is visibly clean.

NOTE: Discard solutions and rinse waters in accordance with local 
regulations

CAUTION
Do not clean any portion of the attachment with methanol, 
ethanol, isopropanol, or any other alcohol base detergent. 
Such substances can cause irreparable damage to the 
attachment.
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High-Level Disinfection

NOTE: High-Level disinfection efficacy of this manual process has been 
shown using Cidex OPA.

1. Fill a sink or basin with high-level disinfectant prepared in 
accordance with the disinfectant manufacturer’s instructions 
to a level allowing immersion of the biopsy guide.

2. Immerse the devices in the disinfectant solution and agitate 
to ensure all air bubbles are removed from the surface of the 
device.

3. Allow the devices to soak in the disinfectant solutions for 
least the minimum contact time listed in the disinfectant 
manufacturer’s instructions for use.

4. Thoroughly rinse the device by immersing in a large volume 
of critical (purified) water for a minimum of 1 minute. 

NOTE: Critical Water is water that is treated (usually by a multistep 
treatment process that could include a carbon bed, 
softening, DI, and RO or distillation) to ensure that the 
microorganisms and the inorganic and organic material are 
removed from the water to an appropriate level. (Refer to 
AAMI TIR34/ST108). 

5. Repeat Step 4 two additional times, for a total of 3 (three) 
rinses using fresh volumes of water for each rinse.

NOTE: Discard solutions and rinse waters in accordance with local 
regulations

6. Thoroughly dry the biopsy guide using a sterile, lint-free 
wipe. Visually inspect the biopsy guide to ensure all 
surfaces are clean and dry. Visually inspect the biopsy to 
ensure all surfaces are dry. Repeat drying steps if any 
moisture is visible.
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Autoclave Sterilization

NOTE: Sterilization efficacy testing was performed using worst-case 
parameters for time, temperature and load density. Parameters 
listed in the tables are the minimum required to ensure a Sterility 
Assurance Level (SAL) of 10-6 or better.

1. Place the cleaned and disinfected biopsy guide in an 
approved autoclave pouch.

2. Autoclave using the following parameters: 

Table 11-13:  Autoclave parameters

Parameter Cycle Type 1 Cycle Type 2

Sterilizer Pre-vacuum Pre-vacuum

Preconditioning Pulses 3 3

Temperature (Minimum) 132 degrees C 134 degrees C

Exposure Time (Minimum) 4 Minutes 3 Minutes

Drying Time (Minimum) 15 Minutes 15 Minutes

Package Configuration Tyvek Pouch (14 x 25 cm) Tyvek Pouch (14 x 25 cm)
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Chapter 12

User Maintenance

This chapter supplies system data, assistance 
information, and system care and maintenance 
instructions. 
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System Data

Features/Specifications
Table 12-1:  Physical Attributes

Dimensions and Weight (for Transport)
• Height

Transport position : 1285mm, 50.6 in
Normal use position (LCD monitor) : 1425mm - 
1825mm, 56.1 in - 71.9 in
Normal use position (HDU monitor) : 1465mm - 
1865mm, 57.7 in - 73.4 in

• Width
Base width : 490mm , 19.3 in 
Monitor width (LCD monitor) : 545mm, 21.5 in
Monitor width (HDU monitor) : 565mm, 22.2 in 

• Depth: 835mm, 32.9 in
• Weight: 73kg, 160.9 lb.

User interface
• Operating keyboard adjustable in height and 

rotation 
• Ergonomic hard key layout
• Interactive Back-Lighting
• Integrated recording keys for remote control of up 

to 4 peripheral or DICOM devices
• Integrated Gel Warmer (Option) 

Electrical Power
• Voltage:100 - 240 Vac
• Frequency: 50/60 Hz
• Power consumption maximum of 0.65 KVA with 

peripherals.

Touch Screen
• 14 inch Capacitive Touch Panel
• FHD 1920 x 1080(16:9) pixel Resolution.
• Brightness adjustment
• User-configurable layout

Console Design
• 4 Active Probe Ports
• Integrated SSD (1TB)
• On-board storage for peripherals: Thermal printer. 
• Integrated speakers
• Integrated locking mechanism that provides rolling 

lock and caster swivel lock 
• Integrated cable management
• Front and Rear handles
• Easily-removable air filters

HDU Display
• 23.8” Wide screen High-Resolution HDU Display
• Monitor translation: 350mm, 13.7 in. horizontal; 

120mm, 4.7 in. vertical; 90 degree swivel 
• Fold-down and Lock Mechanism for transport
• Brightness & contrast adjustment
• Resolution 1920 x 1080
• Anti Glare
• Viewing Angle 89/89/89/89 degrees

LCD Display
• 23.8” Wide screen High-Resolution LCD Display
• Monitor translation: 350mm, 13.7 in. horizontal; 

120mm, 4.7 in. vertical; 90 degree swivel 
• Fold-down and Lock Mechanism for transport
• Brightness & contrast adjustment
• Resolution 1920 x 1080
• Anti Glare
• Viewing Angle 89/89/89/89 degrees
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Table 12-2:  System Overview

Applications
• Abdominal
• Obstetrical
• Gynecological
• Breast
• Small parts
• Peripheral Vascular
• Transcranial (Adult and neonatal)
• Pediatric and neonatal
• Musculoskeletal (general and superficial)
• Urological
• Cardiac (adult and pediatric)

Operating modes
• B-Mode
• M-Mode
• Color Flow Mode (CFM)
• B-FLow (Option)
• Extended field of view (LOGIQView)
• Power Doppler Imaging (PDI)
• PW Doppler
• CW Doppler (Option)
• Volume Mode (3D/4D) (Option)

• 3D Static
• 4D Real Time

• Anatomical M-Mode
• Coded Contrast Imaging (Option)
• Strain Elastography
• Shear Wave Elastography (Option)
• UGAP (Option)

Scanning methods
• Electric sector
• Electric convex
• Electric linear
• mechanical volume sweep

Transducer Types
• Sector Phased Array
• Convex Array
• Micro convex Array
• Linear Array
• Matrix Array
• Volume probe (4D)
• Split Crystal

Standard Features
• Automatic Optimization 
• CrossXBeam
• Advanced Speckle Reduction Imaging 
• Fine Angle Steer 
• Coded Harmonic Imaging
• Virtual Convex
• Patient information database
• Advanced 3D
• Raw Data Analysis
• Real-time Automatic Doppler Calculations
• OB Measurements/Calculations
• Fetal Trending
• Multigestational Calculations
• Hip Dysplasia Calculations
• Gynecological Calculations
• Vascular Calculations
• Urological Calculations
• Renal Calculations
• Cardiac Calculations
• InSite Capability
• On-board electronic documentation
• Auto Doppler Assist
• Privacy and Security, including user and rights 

management
• LOGIQView
• External USB Printer connection 
• Network Printer Support 
• HDMI output available for compatible devices
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Options
• DICOM
• Adv. Security
• Coded Contrast
• Cardiac AFI
• Report Writer
• Stress Echo
• Tricefy
• LOGIQ Apps
• Scan Assistant
• Advanced Probes
• AUTO IMT 
• B Steer+
• B-flow
• flow QA 
• Measure Assist Breast
• Measure Assist OB
• Elastography
• Elasto QA
• Shear Wave Elastgraphy
• UGAP
• Hepatic Assistant - SWE-UGAP
• Software DVR
• Omni View
• STIC
• TUI
• VCI-Static
• VOCAL_II
• SonoNT SonoIT
• Compare Assistant
• Thyroid Productivity
• Breast Productivity
• VITA on Demand (option for regions except for 

USA)
• Auto Real-time Preset Selection
• Voice Control
• KOIOS INSTALL
• KOIOS Thyroid
• KOIOS Breast
• CW Doppler
• Realtime 4D
• Power Assistant and Scan on battery
• Small battery (3 packs)
• Big battery (6 packs)
• Pencil CW
• ECG Option
• ECG CABLE - AHA STYLE
• ECG CABLE - IEC STYLE

• TVTR Probe Holder 
• PROBE CABLE HANGER
• Control panel REAR TRAY
• REAR BASKET
• REAR HANDLE CABLE HOOK
• Ultrasound Probe Rack (USA only)
• Ethernet Protection Cable
• Vscan Air CL
• Voice Control
• Auto Preset Assistant

Peripheral Options
• Sony BW Printer
• Sony Color Printer
• USB FOOTSWITCH 3 BUTTON
• Barcode Reader USBee1000A (Japan only)
• Magnetic Card Reader (Japan and AKA Only)
• Powervar144k120v MG UPS (US and LATAM 

only)
• Powervar144k 230V MG UPS (EU only)
• EMI Filter
• Wireless LAN
• S-Video output available for compatible device
• Digital Expert Cables and Video Grabber
• Digital Expert with tablet
• Microsoft Surface Tablet with Case

Display Modes
• Live and Stored Display Format: Full and Split 

Screen -- both with thumbnails for Still and CINE
• Review Image Format: 4x4 and Thumbnails for 

Still and CINE
• Time line Display [Independent Dual B or 

CrossXBeam/PW Display; CW; Display Formats; 
Top/Bottom or Side/Side selectable Format; 2 
Timeline Methods: Scrolling or Moving Bar

• Virtual Convex
• Simultaneous Capability [B or CrossXBeam/PW, B 

or CrossXBeam/CW (Option), B or CrossXBeam/
CFM or PDI, B/M, B/CrossXBeam, Realtime 
Triplex Mode [B/CrossXBeam + CFM/PDI + PW]

• Selectable alternating Modes [B or CrossXBeam/
PW; B or CrossXBeam + CFM (PDI)/PW; B/CW 
(option)]

• Multi Image Split/Quad Screen [Live and/or 
Frozen, B or CrossXBeam+B or CrossXBeam/
CFM or PDI, PW/M, Independent Cine playback] 

Table 12-2:  System Overview (Continued)
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Table 12-3:  System Parameters

Controls Available on Freeze or Recall
• Automatic Optimization
• Advanced SRI Type 1
• CrossXBeam (display non-compounded and 

compounded image simultaneously in split screen)
• 3D Reconstruction from a stored CINE loop
• B/M/CrossXBeam Mode (Gray Map Optimization; 

TGC, Colorized B and M; Frame Average [Loops 
only]; Dynamic Range)

• Anatomical M-Mode
• Magnification Zoom
• Pan Zoom
• Baseline Shift
• Sweep speed
• PW-Mode (Gray Map; Post Gain; Baseline Shift; 

Sweep Speed; Invert Spectral Waveform; 
Compression; Rejection, Colorized Spectrum; 
Display Format; Angle Correct; Quick Angle 
Correct, Auto Angle Correct, Doppler Audio)

• Color Flow (Overall Gain [Loops and Stills]; Color 
Map; Transparency Map; Frame Averaging [Loops 
only]; Flash Suppression, CFM Display Threshold; 
Spectral Invert for Color/Doppler)

• Anatomical M-Mode on CINE Loop
• 4D (Gray Map, Colorize; Post Gain; Change 

display between single or rendered)

Controls Available While “Live”
• Magnification Zoom: Magnifies the entire image on 

the screen without zoom ROI
• Pan Zoom: Magnifies the display of the data within 

the ROI
• HD Zoom: Magnifies the image within the zoom 

ROI, with higher spatial resolution than original 
images

• B/M/CrossXBeam-Mode (Gain; TGC; Dynamic 
Range; Acoustic Output; Frame Rate Control, 
Sweep Speed for M-Mode; # of Angles for 
CrossXBeam)

• PW-Mode (Gain; Dynamic Range; Acoustic 
Output; Transmission Frequency; PRF; Wall Filter; 
Spectral Averaging; Sample Volume Gate for 
PW-Mode Length and Depth; Velocity Scale)

• Color Flow (CFM Gain; CFM Velocity Range; 
Acoustic Output; Wall Echo Filter; Frame Rate 
Control; CFM Spatial Filter; CFM Frame 
Averaging; CFM Line Resolution; Frequency/
Velocity Baseline Shift) 

Connectivity
• Ethernet network connection
• Wireless LAN 802.11ac/a/b/g/n (option)
• DICOM 3.0 (option) with Verify, Print, Store, 

Modality Worklist, Storage Commitment, Modality 
Performed Procedure Step [MPPS], Media 
Exchange, Off network/mobile storage queue, 
Query/Retrieve)

• Public SR Template
• Structured Reporting - compatible with Vascular, 

OB, Cardiac, and Breast standard
• InSite capability
• Advanced privacy and security (Option)

Scanning Parameters
• Displayed Imaging Depth: 0-50cm [Minimum: 0-2 

cm (Zoom); Maximum: 0-50 cm] (Probe 
dependent)

• Continuous Dynamic Receive Focus/Continuous 
Dynamic Receive Aperture

• Adjustable Dynamic Range
• Adjustable Field of View (FOV)
• Image Reverse: Right/ Left
• Image Rotation: 0, 90, 180, 270 degrees

Image Storage 
• On-board database of patient information from 

past exams
• Storage Format: DICOM (compressed/

uncompressed, single/multiframe, enhanced [3D/
4D], with/without Raw Data), Export JPEG, and 
WMV.

• Storage Devices: USB Memory Stick (64MB to 
64GB, for exporting individual images/clips); Hard 
Drive Image Storage (~730GB)

• Compare previous exam images with current 
exam

• Reload of archived data sets

CINE Memory/Image Memory 
• 1 GB of CINE Memory
• Selectable CINE Sequence for CINE Review
• Prospective CINE Mark
• Measurements/Calculations & Annotations on 

CINE Playback 
• Scrolling timeline memory
• Dual Image CINE Display
• Quad Image CINE Display
• CINE Gauge and CINE Image Number Display
• CINE Review Loop
• CINE Review Speed
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Table 12-4:  Measurements and Calculations

B-Mode
• Depth and Distance
• Circumference and Area (Ellipse/Trace)
• Volume (Ellipsoid)
• Angle between 2 Lines
• % Stenosis (Area or Diameter)
• Dual B-Mode capability

M-Mode
• M Depth and Distance
• Time 
• Slope
• Heart Rate

Doppler Measurements/Calculations
• Velocity
• Time
• Peak Systole
• End Diastole
• Acceleration
• Acceleration Time
• Ratios

• A/B Ratio (Velocities/Frequency Ratio)
• Peak Systole/End Diastole (PS/ED Ratio)
• End Diastole/Peak Systole (ED/PS Ratio)

• Heart Rate
• TAMAX (Time Averaged Maximum Velocity) 
• Volume Flow [TAMEAN and Vessel Area]
• PI (Pulsatility Index)
• RI (Resistivity Index)

Shear Wave Measurements/Calculations
• Stiffness
• Velocity

Vascular Measurements/Calculations
• Carotid, Vertebral, Subclavian Measurements, 

Auto IMT
• Summary Worksheet
• Summary Report

Small Part Measurement Analysis
• Koios DS Breast Lesion Decision Support
• Koios DS Thyroid Lesion Decision Support

Obstetrics Measurements/Calculations
• Gestational Age Calculation
• Calculations and Ratios
• EFW Calculation
• Growth Percentiles
• Multi-Gestational Calculation
• Fetal Qualitative Description (Anatomical Survey)
• Fetal Environmental Description (Biophysical 

profile)
• Programmable OB Tables
• Fetal Graphical Trending
• Measurements / Calculations by: ASUM, ASUM 

2001, Alexander, Bahlmann, Baschat, Berkowitz, 
Bertagnoli, Brenner, Campbell, CFEF, Chervenak, 
Chitty, Doubilet, Ebbing, Eik-Nes, Ericksen, 
Goldstein, Hadlock, Hansmann, Hellman, Hill, 
Hohler, Jeanty, JSUM, Kurmanavicius, Kurtz, Mari, 
Mayden, Mercer, Merz, Moore, Nelson, Osaka 
University, Paris, Pexsters, Rempen, Robinson, 
Shepard, Shepard/Warsoff, Sonek, Tokyo 
University, Tokyo/Shinozuka, WHO, Yarkoni

• Over 20 selectable OB Calcs
• Summary Worksheet
• Summary Report

Gynecology Measurements/Calculations
• Ovarian, Uterine, Pelvic Floor, Endometrium, 

Follicular Measurements, Cervix
• Summary Worksheet
• Summary Report
• Qualitative Description (Anatomical Survey)

Urology Measurements/Calculation
• Bladder, Prostate, Renal, Generic, Post-Void 

Bladder Volume Measurements
• Summary Worksheet
• Summary Report

Cardiology Measurements/Calculations
• Cardiology Measurements and Calculations
• Summary Worksheet
• Summary Report

Table 12-5:  Biopsy Guides

• Single-Angle, disposable with a reusable bracket
• Multi-Angle, disposable with a reusable bracket

• Single-Angle, disposable with a disposable bracket

Table 12-6:  Inputs and Outputs Signal

• HDMI (with stereo audio)
• S-Video 

• Ethernet
• Multiple USB 3.0 ports
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Clinical Measurement Accuracy

Basic Measurements

The following information is intended to provide guidance to the 
user in determining the amount of variation or measurement 
error that should be considered when performing clinical 
measurements with this equipment.  Error can be contributed by 
equipment limitations and improper user technique.  Be sure to 
follow all measurement instructions and develop uniform 
measurement techniques among all users to minimize the 
potential operator error.  Also, in order to detect possible 
equipment malfunctions that could affect measurement 
accuracy, a quality assurance (QA) plan should be established 
for the equipment that includes routine accuracy checks with 
tissue mimicking phantoms.

Please be advised that all distance and Doppler related 
measurements through tissue are dependent upon the 
propagation velocity of sound within the tissue.  The propagation 
velocity usually varies with the type of tissue, but an average 
velocity for soft tissue is assumed.  This equipment is designed 
for, and the accuracy statements listed on are based on, an 
assumed average velocity of 1540 m/s.  The percent accuracy 
when stated applies to the measurement obtained (not the full 
scale range).  Where the accuracy is stated as a percent with a 
fixed value, the expected inaccuracy is the greater of the two.
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Basic Measurements  (continued)

Table 12-7:  System Measurements and Accuracies

Measurement Units Useful Range Accuracy
Limitations or 

Conditions

Depth mm Full Screen 20%

Distance:

Axial (Equal to 
1540m/s)

mm Full Screen 3% or 1mm,
whichever is greater

Lateral (Equal to 
1540m/s)

mm Full Screen 5% or 1mm,
whichever is greater

Linear Probes

Lateral (Equal to 
1540m/s)

mm Full Screen 6.5% or 3.5mm, 
whichever is greater

Convex Probes

Lateral (Equal to 
1540m/s)

mm Full Screen 5% or 1mm,
whichever is greater

Sector Probes

Axial/Lateral  (Not 
Equal to 1540m/s)

mm Full Screen 7.5% or 5.0mm, 
whichever is greater 

All probes Not 
Equal To 1540m/s

Circumference:

Trace (Equal to 
1540m/s)

mm Full Screen 5% or 1mm,
whichever is greater

Ellipse (Equal to 
1540m/s)

mm Full Screen 5% or 1mm,
whichever is greater

Trace  (Not Equal 
to 1540m/s)

mm Full Screen 7.5% or 5mm,
whichever is greater

All probes Not 
Equal To 1540m/s

Ellipse  (Not Equal 
to 1540m/s)

mm Full Screen 7.5% or 5mm,
whichever is greater

All probes Not 
Equal To 1540m/s

Area:

Trace (Equal to 
1540m/s)

mm2 Full Screen 10% or 5mm2,
whichever is greater

Ellipse (Equal to 
1540m/s)

mm2 Full Screen 10%, or 5mm2,
whichever is greater

Trace (Not Equal 
to 1540m/s)

mm2 Full Screen 20% or 20mm2,
whichever is greater

All probes Not 
Equal To 1540m/s

Ellipse (Not Equal 
to 1540m/s)

mm2 Full Screen 20% or 20mm2,
whichever is greater

All probes Not 
Equal To 1540m/s

Time s Timeline Display 5%, not to exceed 
10ms

M or Doppler 
Mode

Slope mm/s Timeline Display 5%, not to exceed 
1mm/s

M-Mode Only
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Doppler Sample 
Volume Depth (SVD)

mm Full Screen 2mm (0.2cm) in any 
direction

When SVD is at 
least half the 
depth of the image

Velocity cm/s Full Range 10% PW and CW 
Doppler Mode

Doppler Angle 
Correction

degrees From 0-59
From 60-90

1%
2%

Shear Wave Speed Variation and Precision with Depth

Velocity m/s Shear wave ROI Absolute range <= 0.5 
m/s or relative range 
<= 15%, whichever is 
greater, for C1-6-D 
and C1-6VN-D. 
Absolute range <= 0.5 
m/s or relative range 
<= 10%, whichever is 
greater, for all other 
probes with shear 
wave elastography. 

Normalized SD 
less than or equal 
to 5% for multiple 
repeated 
measurements 
over the range of 
depths for which 
measurements 
can be made, 
limited by shear 
wave penetration. 

The formula for Stiffness: E = 3 * rho * c2

Where E = Young’s modulus of tissue
rho = density of tissue (assumed to be 1 g/cc)
c = shear wave speed in m/s
Note: The conversion from shear wave speed (m/s) to Young’s modulus is done under the assumption that 
the underlying material in which the shear wave propagates is linear, isotropic, incompressible, and 
homogenous.
Note: Relative Range = (Absolute Range / Actual Velocity).
Note: Normalized SD = (SD) / Average Velocity.

Table 12-7:  System Measurements and Accuracies (Continued)

Measurement Units Useful Range Accuracy
Limitations or 

Conditions
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Clinical Calculation Accuracy

Estimate the overall inaccuracy of a combined measurement 
and calculation by including the stated inaccuracy from the basic 
measurement accuracy statements.

Calculation formulas and databases are provided as a tool to 
assist the user, but should not be considered an undisputed 
database, in making a clinical diagnosis.  The user is 
encouraged to research the literature and judge the equipment 
capabilities on an ongoing basis in order to assess its utility as a 
clinical tool.
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V Nav Magnetic Field Data

For the Patient

Electromagnetic Field Strength is measured in units called 
Tesla, or for smaller fields, milliTesla (mT). According to this 
article from the World Health Organization (WHO), https://
www.who.int/peh-emf/publications/facts/fs299/en/, people with 
pacemakers should avoid fields that exceed 0.5 mT. 

The electromagnetic field created by the transmitter in our 
Volume Navigation offering is 0.5 mT once you are 7.5cm away 
from the transmitter face and goes down quickly after that (0.1 
mT at 18cm away, e.g.). Nevertheless, we recommend not using 
V Nav on patients relying on a pacemaker or defibrillator. 

DANGER DO NOT use the Volume Navigation feature on any patient 
relying on life-sustaining electronic equipment, such as a 
pacemaker or defibrillator. Failure to follow this instruction 
could lead to interference with patient electronic device(s).

WARNING The Tracker’s magnetic fields may possibly interfere with 
nearby electrical systems, e.g., an EKG. It is the users’s 
responsibility to identify nearby devices to ensure their 
performance is not degraded when you are simultaneously 
using Volume Navigation. 
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V Nav Magnetic Field Data  (continued)

For the Operator

The World Health Organization website addresses many items 
regarding exposure to electro-magnetic (EM) fields at http://
www.who.int/peh-emf/about/WhatisEMF/en/index.html (see 
extract below). 

Extracted from 
World Health 
Organization:

“Many people are surprised when they become aware of the 
variety of magnetic field levels found near various appliances. 
The field strength does not depend on how large, complex, 
powerful or noisy the device is. Furthermore, even between 
apparently similar devices, the strength of the magnetic field 
may vary a lot. For example, while some hair dryers are 
surrounded by a very strong field, others hardly produce any 
magnetic field at all. These differences in magnetic field strength 
are related to product design. The following table shows typical 
values for a number of electrical devices commonly found in 
homes and workplaces. The measurements were taken in 
Germany and all of the appliances operate on electricity at a 
frequency of 50 Hz. It should be noted that the actual exposure 
levels vary considerably depending on the model of appliance 
and distance from it.”   

In the context of this, the VNav transmitter has the following EM 
field strengths at various distances from the transmitter face: 

• 928µT at 5.1cm (2 inches) distance

• 287µT at 10.2cm (4 inches) distance

• 64µT at 20.3cm (8 inches) distance

• 11µT at 40.6cm (16 inches) distance

• 2.4µT at 71cm (28 inches) distance

NOTE: Note that the field is only active when the green light on the 
position sensing electronics unit is on. This is the same unit that 
the transmitter plugs into.
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V Nav Magnetic Field Data  (continued)

Typical Magnetic Field Strength Data

Typical magnetic field strength commonly found in your home 
are shown below:  

Table 12-8:  Typical magnetic field strength of household appliances at various 
distances

Electric Appliance
3 cm   Distance

( µT )
30 cm Distance

( µT )
1 m Distance

( µT )

Hair Dryer 6 – 2000 0.01 – 7 0.01 – 0.03

Vacuum Cleaner 200 – 800 2 – 20 0.13 – 2

Portable Radio 16 - 56 1 < 0.01

Microwave Oven 73 - 200 4 - 8 0.25 - 0.6

Fluorescent Light 40 – 400 0.5 - 2 0.02 - 0.25

Electric Oven 1 - 50 0.15 - 0.5 0.01 - 0.04
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Privacy and Security

Introduction

Privacy & Security considerations, capabilities and configuration 
of the LOGIQ Totus Ultrasound System are described in the 
LOGIQ Totus Privacy and Security Manual, available in the GE 
HealthCare Product Security Portal at the GE HealthCare 
Documentation Library website at: 

https://www.gehealthcare.com/support/documentation

Privacy & Security Environment

The GE HealthCare LOGIQ Totus Ultrasound System has been 
designed for an intended use with the following expectations of 
Privacy & Security protections included in the environment 
where this product will be used:

• The system should be connected to a secured LAN or 
VLAN, configured and segmented according to appropriate 
networking best practices, not open to unintended users or 
generally connected to a WAN.

• The LOGIQ Totus Ultrasound System should be physically 
secured in such a way that it is not accessible to unintended 
users.

• Default application users and passwords should be replaced 
with customized users and passwords.

• External media containing images, patient data, reports and 
logs should be secured. When no longer used, the data 
should be securely erased and/or the media should be 
securely deleted.

• The monitors of the LOGIQ Totus Ultrasound System should 
be placed in a way limiting the visibility of the screen content 
to the user only.

How to contact GE HealthCare

For privacy and security concerns regarding GE HealthCare 
products, visit to : https://www.gehealthcare.com/security
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Identity Provisioning

The provisioning of user accounts includes the steps of account 
creation, maintenance, and suspension of the account when it is 
no longer needed. A user account is created for the use by a 
specific individual. It is associated with access rights.

Management of user accounts

User accounts are created, maintained and suspended by users 
with administrator privileges. When received from factory the 
system has three predefined user accounts:

• “ADM”: an administrative user account 

• “USR”: a normal user account template without 
administrative privileges

• “EUSR” : an emergency user account template with limited 
privileges

When receiving the LOGIQ Totus Ultrasound System, it is 
recommended to do the following steps to ensure control of the 
user accounts on the system:

• Change the password of the “ADM” account.

• Change the password of the “USR” user account.

• Create groups for local or LDAP users and set their rights/
privileges appropriately for your workflows and operating 
environment.

• Create user accounts for each individual user of the system:

• Give each user the needed group memberships / 
privileges.

• Make sure to give administrative privileges only to users 
intended to perform administrative tasks on the system, 
like configuring dataflows, managing users on the 
system, inspecting audit logs etc. As administrative 
privileges may give the user access to privacy and 
security related configurations on the system, there 
should be a limited number of users with these 
privileges.

• It is recommended to create individual users for each 
user of the system. This is particularly relevant for the 
audit logging, to associate actions performed on the 
system with individual persons. 
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Identity Provisioning  (continued)

Maintenance of user accounts

It is recommended to establish administrative routines for 
removing user accounts no longer being used.

User information stored on the system

The following information can be entered for a user defined on 
the system:

• User ID / User name (Required)

• Display ID (Optional)

• Last name (Required)

• First name (Optional)

• Title (Optional)

• Phone number (Optional)

• E-mail address (Optional)

• Address (Optional)

The user password is encrypted and not accessible in the 
system.

User name and password restrictions

The restrictions for usernames and passwords are:

• User names can be 1 - 32 characters long.

• Password can be 0 - 256 characters long.

It is recommended to enable and configure username and 
password policies as described below.

Identity provisioning by use of Backup/Restore

Users defined on a system can be copied from one system to 
another by use of the system’s built-in Backup/Restore 
functionality.

Network Infrastructure

The infrastructure of the network where the LOGIQ Totus 
Ultrasound System is connected must be configured to allow 
traffic. For information on inbound and outbound firewall 
configuration, refer to the LOGIQ Privacy and Security Manual,  
available in the GE HealthCare Product Security Portal at: 

https://www.gehealthcare.com/en-US/security
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Anti-Virus Software Note

LOGIQ Totus Security

Since the LOGIQ systems are integrated into your IT-network, 
GE HealthCare wants to make sure that you are aware of the 
proactive measures we are taking to secure the system. Below 
are measures we have implemented to secure the LOGIQ 
systems. 

• Use of Windows* Embedded Standard 10, a componentized 
version of Windows 10 specifically made for embedded 
systems. Only the components required are used for the 
LOGIQ scanners, thereby reducing the OS attack surface. 
Please note that Windows 10 ioT Enterprise is NOT the 
same operating system as Windows 10.

• Disabled the user’s ability to access the internet and 
Windows desktop.

• Disabled, or made inaccessible, functionality that is typically 
used as malware vectors for spreading viruses (e.g. email 
services, web browsers).

• Disabled AutoRun functionality on removable media.

• Closed network entry points that are not in use by the 
LOGIQ scanner software by strict firewall configuration and 
by disabling Services. The only Internet connection needed 
is on outbound port to GE HealthCare’s remote service 
platform (Insite™  ExC), which is only opened on request by 
the user and through a secure HTTPS connection (port 
443), and inbound and outbound connections through port 
104 for DICOM connectivity.
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LOGIQ Totus Security  (continued)

• System provides user access controls under customer 
management to control scanner access.

• Uses secure integration and communication between 
systems (Scanners, Workstations and Servers).

• Monitor public security bulletins from software vendors and 
news services, analyze for applicability to the LOGIQ 
scanner, and include third party software security patches 
as necessary within GE HealthCare software.

• Release GEHC Ultrasound validated software or use other 
measures as necessary to resolve or mitigate product 
vulnerabilities.

• Assess potential vulnerabilities of our systems using 
up-to-date commercially available vulnerability scanning 
tools. Identified vulnerabilities are mitigated as appropriate 
based on risk assessment of the product.

GE HealthCare believes that this Defense in Depth strategy 
using the combination of the security measures above and the 
security standards of Microsoft Windows 10 ioT Enterprise will 
provide security against malware, especially for a system used 
in a professional hospital grade networking environment that 
itself should provide a high level of security measures.

Finally, a few points as to why GE HealthCare (as well as all 
other manufacturers of PC-based medical Ultrasound devices) 
do not use Anti-Virus software: Commercial Anti-Virus software 
is commonly used on general-purpose computers to detect the 
presence of malicious software (e.g. virus, Trojan horse, worm). 
Anti-Virus software is useful on general-purpose computers as 
they typically cannot be sufficiently hardened against the attack 
vectors used by malicious software.
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LOGIQ Totus Security  (continued)

The LOGIQ ultrasound systems however are single purpose 
(dedicated) devices that have controlled intended use, and thus 
are well hardened. For the LOGIQ ultrasound systems, the 
potential patient safety and security risks introduced by using 
commercial Anti-virus software would outweigh the security 
benefits.  Such risks include:

• Real-time anti-virus scanning can affect ultrasound system 
performance.

• The effectiveness of Anti-Virus software depends on regular 
updates of the virus definitions files. This would typically 
require internet connectivity for the ultrasound system. 

• The Anti-Virus software itself is a popular attack vector.

• Disruptive nature of the support of the Anti-Virus software 
throughout the life cycle of the medical device. The 
operating system of a medical ultrasound system is part of a 
medical device that requires a special and controlled 
release process. Any update of the Anti-Virus software 
would require a change of the system software.

Due to the cited risks, the use of commercial anti-virus software 
is not part of the LOGIQ systems product security strategy.

*Microsoft and Windows are trademarks of Microsoft Corporation.



User Maintenance

12-20 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Loading Windows Patches

Loading a Windows Patch

As part the product lifecycle management, GE HealthCare 
regularly analyzes and integrates software updates from our 
third party vendors into our products. These are typically 
released as part of regular updates or software releases.

To load a Windows patch onto the LOGIQ Totus:

1. Power down the LOGIQ Totus and insert the Windows 
Patch USB Flash Drive into a rear USB port.

NOTE: Ensure that the system is USB Device Enabled (check 
setting on System Admin Utility page).

2. Power on the LOGIQ Totus. Windows Patch files will be 
loaded onto the LOGIQ Totus automatically, following 
several screen prompts:

a. Select Install SW... on the Start Application screen.

b. Select OK on the first StartLoader screen.

c. Select the package and then select Install on the 
second StartLoader screen; software patch installation 
will begin.

NOTE: The Patch package is installed at the root folder or 
under the SWLoad directory in the root folder of the 
USB.

Multiple screens appear during the software re-imaging 
installation process. DO NOT interrupt this process 
AND follow instructions as they appear on the display.

d. Once the installation is complete, a message displays 
saying that the “Software Installation completed 
successfully. System will reboot soon.” The LOGIQ 
Totus restarts.

3. When the system starts up after the software installation has 
finished, the following dialog displays: the “New Software 
Verification” Checklist.



Loading Windows Patches

LOGIQ Totus – User Manual 12-21
5929163-1EN Rev. 3

Performing Software Patch Verification

The Software Patch Verification dialog is critical. You MUST
perform software verification after downloading and installing a 
software update. 

a. If you are able to successfully perform each function, 
then Pass all of the items and type your name into the 
Signature box and press OK. Press the Question Mark if 
you have questions about how to perform this task.  

b. As you verify that each feature works correctly, select 
“Passed.” If all features work correctly and “Passed” is 
filled in for all features, then the signature field is 
enabled at the bottom of the New Software Verification 
Checklist. 

Type your signature (minimum of three characters) and 
press OK. The system is now ready for use.

CAUTION
Perform a check for all the features listed. You MUST
ensure that the entire system functions normally, as 
expected, in each of the categories listed on the New 
Software Verification checklist. 

These verification results are tracked for regulatory 
purposes, sent back to GE HealthCare for tracking, and 
approved with your signature. 
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Performing Software Patch Verification  (continued)

The version of the installed Patch appears on the 
Utility--> System--> About page. 

CAUTION
If any of the features DID NOT function as expected, you 
need to select “Failed” next to the feature that failed. Type 
your signature (minimum of three characters) and press 
Reload.
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Performing Software Patch Verification  (continued)

c. If one of the steps fails, then Fail the item(s).  

d. Type your Signature, then press Reload. The previous 
version of software will be reloaded onto the system 
automatically.

e. Load the latest system patch which should be stored 
with the software located under the LOGIQ Totus 
covers.
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Patch Installation Notes

If by accident you try to load a patch that is not compatible with 
the software on the LOGIQ Totus, an error message will notify 
you of this incompatibility. 

If there is any issue with the media, an error message will 
indicate “The package cannot be installed. The package is not 
compatible or has been tampered. Please contact GE 
HealthCare Service.” 

The system may reboot multiple times during patch/software 
update. 

If the software reload fails, an error message will indicate 
“Software Reload operation failed. Please contact GE 
HealthCare Service.” 

Reloading Software

When reloading software, you will need to reload the latest 
system patches which should be stored with the software 
located under the LOGIQ Totus covers. 
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Software Download

Overview

The LOGIQ Totus is designed to download software updates 
when they are available. Software Download monitors, notifies, 
delivers and installs available system software updates. This 
feature requires active InSite ExC connectivity. 

When system software is available for download, a Software 
Download icon appears in the system status bar at the bottom of 
the monitor screen.

Table 12-9:  Software Download Icons

Software Download Available Icon

Software Download In Progress Icon

Software Download Paused Icon

Software Download Complete/Ready to Install Icon

Software Download Information Icon
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Software Download Available

When the “Software Download Available” icon appears in the 
status bar, select the icon to bring up the following Software 
Download and Install menu. Choose the desired option.

Figure 12-1. Software Download and Install Menu

Start Software Download and Install

1. Select Start to begin the software download. The software 
download status displays in the menu and the Software 
Download in Progress icon appears in the system status bar 
at the bottom of the monitor.

Figure 12-2. Software Download in Progress

While the software is downloading, you can choose to 
pause the download, hide the Software Download and 
Install menu or stop the download. 

• Select Pause to temporarily pause the download. The 
Software Download Paused icon appears in the system 
status bar. Select the icon again to bring up the 
Software Download menu and press Resume to 
resume the download from the previous download point.
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Start Software Download and Install  (continued)

• Select Hide to hide the Software Download menu (the 
download continues in the background). The Software 
Download in Progress icon appears in the system status 
bar. Select the icon again to bring up the Software 
Download menu.

• Select Stop Download to discontinue the download 
process. The download progress is not saved, and the 
Software Download Available icon must be selected 
again to bring up the Software Download menu to 
restart the software download process.

2. When the download is complete the Software Download and 
Install menu informs you the software is ready to install.

Figure 12-3. Software Ready to Install Menu

Select Start to begin the installation. The installation begins 
and the software Installation in Progress status is displayed.     
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Start Software Download and Install  (continued)

3. New Software Verification - When the software package 
installation is complete, the system shuts down and restarts. 
When the system restarts, the New Software Verification 
checklist dialog displays. You MUST perform the new 
software verification.

Figure 12-4. New Software Verification Dialog

As you verify that each feature works correctly, select 
“Passed.” If all features work correctly and “Passed” is filled 
in for all features, then the signature field is enabled at the 
bottom of the New Software Verification Checklist. Type 
your signature (minimum of three characters) and press OK. 
The system is now ready for use.

If any of the features DID NOT function as expected, you 
need to select “Failed” next to the feature that failed. Type 
your signature (minimum of three characters) and press 
Reload.

Contact your GE HealthCare Service Representative for 
assistance. 

CAUTION
Perform a check for all the features listed. You MUST 
ensure that the entire system functions normally, as 
expected, in each of the categories listed on the New 
Software Verification checklist. 
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More Info

Select More Info from the Software Download and Install menu 
to see details about the available software download.

Figure 12-5. More Info

Remind Me Later

Select Remind Me Later to close the Software Download and 
Install Menu and download the software at a later time. The 
Software Download Available icon remains in the system status 
bar at the bottom of the monitor screen.

Decline

Select Decline to decline the software download package. A 
popup displays.    

Figure 12-6. Decline Software Download Package Popup

You can then select OK or Cancel.

• Select OK to decline the package. You must then enter a 
signature consisting of three or more characters.

OR

• Select Cancel to go back to the Software Download and 
Install menu.
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Base Image and Software Load

Base Image and Software Load Procedure

For the Base Image and Software Load procedure, refer to the 
LOGIQ Totus Basic Service Manual.
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Copyrighted Material

Viewing Copyrighted Third Party Software License Information

The LOGIQ Totus contains copyrighted material. For more 
information, you can view Copyrighted Third Party Open Source 
Software Licenses via the Utility-> System-> Licenses page. 

• Select Utility-> System-> Licenses

• Scroll to select the license you wish to view in the License 
Title section. Press Set. 

Figure 12-7. Third Party Software License Information

• The selected software license appears in the License 
window. Use the Set+Trackball to scroll through the license. 
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System Care and Maintenance

Overview

Refer to Section 10 of the LOGIQ Totus Service Manual for any 
additional maintenance guidance.

The user must ensure that safety inspections are performed at 
least every 12 months according to the requirements of the 
patient safety standard IEC 60601-1. Refer to the Service 
manual, Chapter 10.

Only trained persons are allowed to perform the safety 
inspections mentioned above.

Technical descriptions are available on request.

To ensure that the unit constantly operates at maximum 
efficiency we recommend that the following procedures be 
observed as part of the customer’s internal routine maintenance 
program.

Contact the local Service Representative for parts or periodic 
maintenance inspections.

Expected Service Life Description

The expected service life for the LOGIQ Totus system and 
probes is identified in this table: 

Table 12-10:  Expected Service Life

Equipment / Accessory Expected Service Life

LOGIQ Totus system The expected service life for the LOGIQ Totus is at least seven (7) 
years from the manufacturing date under the provision of regular 
maintenance by authorized service personnel.

LOGIQ Totus Probes The expected service life for the LOGIQ Totus probes meets or 
exceeds five (5) years from the date the probe is placed in service, 
under the provision that the customer follows the care instructions 
provided on the Probe Care Card / Accompanying LOGIQ Totus 
Instructions for Use.
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Maintenance Schedule

Follow this Maintenance Schedule to maintain optimum system 
function and patient care: 

Table 12-11:  LOGIQ Totus Maintenance Schedule

Monthly Weekly Daily After Each Patient

Inspect the following on 
a monthly basis: 
• Connectors on cables 

for any mechanical 
defects.

• Entire length of 
electrical and power 
cables for cuts or 
abrasions.

• Equipment for loose or 
missing hardware.

• Control panel and 
keyboard for defects.

• Casters for proper 
movement and locking 
operation. 

Clean the following on a 
weekly basis: 
• Console

• System Cabinet
• Removable 

Trackball/Trackball
• Air Filters (weekly, 

or as needed)
• Footswitch
• B/W Printer

• Monitor and Monitor 
Frame

• Operator Controls and 
Touch Panel

Clean and Disinfect the 
following areas where 
Cross Contamination 
can occur: 
• Operator  Panel and 

Touch Panel
• Monitor Frame
• Front and Rear 

Handles

Clean and Disinfect the 
following after each 
patient: 
• Probe
• Biopsy Bracket, as 

applicable
Additionally, Clean and 
Disinfect any area on 
the system that has 
visible contamination 
from the previous exam. 
Note: Biopsy 
Accessories must be 
cleaned and disinfected 
or disposed of after 
each patient. Refer to 
the Probes Chapter, for 
probe cleaning and 
disinfecting instructions.

DANGER To avoid electrical shock hazard, do not remove panels or 
covers from console.  This servicing must be performed by 
qualified service personnel.  Failure to do so could cause 
serious injury.

If any defects are observed or malfunctions occur, do not 
operate the equipment but inform a qualified service person.  
Contact a Service Representative for information.
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Cleaning and Disinfecting the System

These cleaners/disinfectants can be used anywhere on the 
console (Operator Panel, Monitor, Probe Holders, etc.), except 
for the probes. Refer to ‘Probe Disinfectants’ on page 11-41  for 
probe disinfectant information and web links.  

Always consult the cleaner or disinfectant manufacturer’s 
instructions for proper use of their product. Wear appropriate 
PPE as indicated by the manufacturer. 

WARNING All cleaners and disinfectants NOT on this list are unapproved
by GE HealthCare. Failure to follow guidelines could result in 
damage to the device.  

CAUTION
When reprocessing the operator control panel, make sure not 
to spill or spray any liquid on the controls, into the system 
cabinet, or in the probe connection receptacle.

CAUTION
To avoid liquids entering the product, DO NOT spray any liquid 
directly onto the surfaces. ALWAYS use a cloth or wipe. 

CAUTION
Avoid using ALCOHOL (ISOPROPANOL) 70% inside the 
trackball. ALCOHOL (ISOPROPANOL) 70% may also 
compromise the durability of the paint used on the console 
controls.

CAUTION
Oxivir TB Wipes may compromise the durability of the paint 
used on the console handles and controls. Avoid the use of any 
Hydrogen Peroxide (H2O2) based disinfectants on the HDU 
monitor, as it may result in damage to screen.
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Cleaning and Disinfecting the System  (continued)

Appropriate cleaners/disinfectants for the console that have 
been validated for compatibility are shown below: 

Table 12-12:  Appropriate Cleaners/Disinfectants

Product Manufacturer Notes Chemistry Locale
Cleaner/

Disinfectant

Acryl-Des 
Wipes

Schülke & Mayr 
GmbH

Same as 
Mikrozid 
Sensitive Wipes 
also by Schulke 

Quat Europe Cleaner/
Disinfectant

Alcohol 
(Isopropanol) 
70%

Generic Alcohol Global Disinfectant

Cleanisept 
Wipes

Dr. Schumacher 
GMBH

Same as GE 
HealthCare 
branded 
Septiwipes

Quat Europe Cleaner/
Disinfectant

Clinell Clorox 
Wipes

GAMA 
HealthCare

Same formula as 
Clorox
Healthcare
Bleach 
Germicidal 
Wipes sold in 
USA

Bleach Europe Cleaner/
Disinfectant

Clinell 
Universal
Sanitizing
Wipes

GAMA 
HealthCare

Quat+
Polyhexanide 
(PHMB)

Europe Cleaner/
Disinfectant

Clorox
HealthCare 
Bleach 
Germicidal 
Wipes

Clorox
Professional

Same formula as 
Clinell Clorox 
Wipes

Bleach US 
Canada 
Europe

Cleaner/
Disinfectant

Easy Screen 
Cleaning
Wipes

Professional
Disposables Inc. 
(PDI)

This product is 
70% IPA

Alcohol US Disinfectant

Mikrobac 
Tissues

BODE Chemie 
GmbH

Quat Europe Cleaner/
Disinfectant

Mikrozid 
Sensitive
Wipes

Schülke & Mayr 
GmbH

Same formula as 
Acryl-Des wipes

Quat Europe Cleaner/
Disinfectant

Oxivir TB 
Wipes

Sealed Air H2O2 US 
Canada

Cleaner/
Disinfectant

Protex Ultra 
Wipes

Parker
Laboratories

Same formula as 
SONO Wipes 

Quat US Cleaner/
Disinfectant
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Sani-Cloth HB 
Germicidal 
Disposable 
Wipe

Professional
Disposables Inc. 
(PDI)

Quat US Cleaner/
Disinfectant

Sani-Cloth Plus 
Germicidal 
Disposable 
Cloth

Professional
Disposables Inc. 
(PDI)

Same Formula 
as Asepti Wipes 
II

Quat + Alcohol US Cleaner/
Disinfectant

Sani-Cloth
Prime
Germicidal 
Disposable 
Cloth

Professional
Disposables Inc. 
(PDI)

Quat + Alcohol US Cleaner/
Disinfectant

Septiwipes EDM Medical 
Imaging

Same formula as 
Cleanisept Wipes 

Quat Europe Cleaner/
Disinfectant

Sodium
Hypochlorite 
5.25% (Bleach) 
diluted 10:1

Generic Same formula as 
Clorox
Healthcare
Bleach 
Germicidal 
Wipes sold in 
USA

Bleach Worldwide Cleaner/
Disinfectant

SONO
ULTRASOUND 
WIPES

Advanced 
Ultrasound
Solutions, Inc.

Quat US Cleaner/
Disinfectant

Super 
Sani-Cloth
Germicidal 
Disposable 
Wipes

Professional
Disposables Inc. 
(PDI)

Quat + Alcohol US Cleaner/
Disinfectant

Tristel Distel Tristel Quat+PHMB Europe Cleaner/
Disinfectant

Trophon 
Companion 
Cleaning
Wipes

Nanosonics Same formula as 
SONO Wipes 

Quat US Cleaner/
Disinfectant

Virox Accel TB 
wipes

Virox 
Technologies 
Inc. (owned by 
Sealed Air)

Same formula as 
Oxivir TB 

H202 CAN Cleaner/
Disinfectant

Table 12-12:  Appropriate Cleaners/Disinfectants (Continued)

Product Manufacturer Notes Chemistry Locale
Cleaner/

Disinfectant
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Console

Cleaning the LOGIQ Totus Console 

The LOGIQ Totus Console includes the System enclosure, 
Monitor, Monitor Frame, Operator Panel, Touch Panel, and 
Probe Holders. For Probes Reprocessing, see ‘Probe 
Reprocessing’ on page 11-19.

Always clean visible soil from surfaces first before disinfecting 
the Console. 

Follow the cleaning/disinfecting frequency suggested in  
‘Maintenance Schedule’ on page 12-33.

To clean the system, 

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution or 
approved cleaning/disinfecting agent.

NOTE: The cloth/wipe should be damp, not dripping wet and 
running. Moisture should not drip into the crevices anywhere 
on the console. 

NOTE: Refer to Table 12-12 on page 12-35 for a list of acceptable 
solutions to be used on the Console. 

2. Use a gentle wiping action to clean any surface on the 
console. 

3. Wipe off excess cleaning agents. 

NOTE: Do not spray any liquid directly into the unit.

NOTE: DO NOT scratch or press on the panel with any sharp objects, 
such as pencils or pens, as this may result in damage to the 
panel. 

HINTS A scrubbing action with the wipe may be necessary to help 
remove stubborn soil from the surfaces.  However be 
careful with this action over cervices and gaps in the 
surface to prevent liquid from being scraped off the wipe 
and entering the product. 



User Maintenance

12-38 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Disinfecting the LOGIQ Totus Console

For disinfectants to be effective, the surface must first be clean. 
Refer to ‘Cleaning the LOGIQ Totus Console’ on page 12-37.

ALWAYS follow the manufacturer’s instructions concerning the 
use of the disinfectant and follow the contact time to be sure the 
disinfectant’s kill claims are accomplished. 

Follow the cleaning/disinfecting frequency suggested in  
‘Maintenance Schedule’ on page 12-33.

Disinfect the desired surfaces of the console. To prevent cross 
contamination, surfaces that are often touched during exams 
should be disinfected after every patient. To disinfect the 
system, 

1. Moisten a sterile cloth with a liquid disinfectant or remove 
pre-moistened disinfectant wipe from the container. 

2. Wet the surfaces by gently applying the cloth or wipe. Avoid 
high pressure or squeezing the wipe to avoid having the 
liquid enter the gaps and cervices of the Console. Scrubbing 
is not necessary in the disinfecting step; evenly applying the 
liquid is the goal.

3. Let the surface remain wet for the appropriate contact time. 

4. If the surface does not remain wet for the full contact time, 
apply an additional application of the disinfectant, as 
necessary, to extend the time. 

5. After the contact time has expired, remove excess liquid 
with a dry sterile cloth. 

6. To avoid disinfectant buildup, or to remove disinfectant 
residue which may cause skin irritation, perform a rinse step 
with a sterile damp cloth.

CAUTION
If a cleaner/disinfectant wipe was used to clean off visible 
soil per the above section, a second, fresh cleaner/
disinfectant product should be used for the disinfectant 
step. 
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Probe Cleaning Notes

When cleaning/disinfecting probes, take care NOT to damage 
the Console with a solution that is approved for the probe but 
that IS NOT APPROVED for the Console. Refer to ‘Probe 
Disinfectants’ on page 11-41 for a list of acceptable solutions to 
be used on the Console. Refer to the Probes Chapter, for probe 
cleaning and disinfecting instructions. 

When cleaning/disinfecting probes using a spray cleaner/
disinfectant, DO NOT spray the probe while the probe is set in 
its probe holder on the Ultrasound system.

 Figure 12-8. DO NOT Spray a Probe While in its Holder

CAUTION
NEVER use any cleaner or disinfectant containing alcohol.

1. Spraying the probe while the probe is set in its probe holder can damage the Control 

panel.
2. If you are cleaning/disinfecting probes while they are on the ultrasound system, use 

a wipe cleaner/disinfectant.
3. Keep away from the ultrasound system while using a spray cleaner.
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Monitor and Monitor Frame

Monitor

To clean the Monitor:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

2. Wipe down the top, front, back, and both sides of the 
monitor. 

3. Wipe off excess cleaning agents. 

NOTE: Never use thinner, benzene, alcohol (ethanol, methanol, or 
isopropyl alcohol), abrasive cleaners, or other strong solvents, 
as these may cause damage to the monitor.

Monitor Frame

To clean the monitor frame:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

2. Wipe down the top, front, back, and both sides of the 
monitor frame. 

3. Wipe off excess cleaning agents. 

Other acceptable cleaning agents are: 

• Ammonia

• Bleach (10 to 1 ratio of water to 5% home bleach)

• Hydrogen Peroxide / Hydrogen Peroxide Wipes

NOTE: DO NOT scratch or press on the panel with any sharp objects, 
such as pencils or pens, as this may result in damage to the 
panel.
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Operator Controls and Touch Panel 

ONLY USE the following cleaners on the LOGIQ Totus Operator 
Panel:

• Palmolive Dishwashing Liquid (manufactured by 
Colgate-Palmolive, www.colgatepalmolive.com)

• Sani-Cloth® HB, green cap (manufactured by Professional 
Disposables International, www.wearepdi.com). NOTE: May 
cause yellowing to the operator panel and probe cabling.

• Super Sani-Cloth®, purple cap (manufactured by 
Professional Disposables International, www.wearepdi.com)

• Sani-Cloth® Prime, plum cap (manufactured by 
Professional Disposables International, www.wearepdi.com)

• Sono® Ultrasound Wipes (manufactured by Advanced 
Ultrasound Solutions, Inc, www.UltrasoundWipes.com)

• Bleach (10 to 1 ratio of water to 5% home bleach)

• Hydrogen Peroxide / Hydrogen Peroxide Wipes

DO NOT USE:

• Cleaners or Disinfectants NOT listed above
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Cleaning the Trackball

To clean the Trackball,

1. Twist and remove the trackball prior to cleaning both the trackball and trackball housing. (1-3)
2. Clean the trackball and trackball housing with dry, soft cloth. (4-6)
3. After cleaning the trackball, replace and twist the trackball into the trackball housing. (7-8)
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Other Maintenance

Cleaning the air filter

Clean the system's air filters to ensure that a clogged filter does 
not cause the system to overheat and reduce system 
performance and reliability. It is recommended the filters be 
cleaned every two weeks, but the requirements will vary due to 
your system use.

Cleaning rear cover air filter

1. Pull the rear cover.

Figure 12-9. Remove the rear cover

CAUTION
Be sure to lock the wheels before cleaning the air filters to 
avoid injury by any unexpected movement of the system.

DO NOT operate the unit without the air filters in place.

Allow the air filters to dry thoroughly before re-installing them 
on the unit.
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Cleaning rear cover air filter  (continued)

2. Unlock the air filter and pull out from the rear cover.

 Figure 12-10. Remove the air filter

3. Dust the filter with a vacuum cleaner and/or wash it with a 
mild soapy solution.

If washed, rinse and dry the filter before re-installation.

4. Put back the air filter into rear cover and assemble the rear 
cover.

Cleaning side cover left/right air filter

1. Pull out the side cover left or right.

Figure 12-11. Remove the side cover left or right
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Cleaning rear cover air filter  (continued)

2. Unhook the air filter and pull out from the frame.

 Figure 12-12. Remove the air filter

3. Dust the filter with a vacuum cleaner and/or wash it with a 
mild soapy solution.

If washed, rinse and dry the filter before re-installation.

4. Put back the air filter into side cover left or right and 
assemble the rear cover.
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Cleaning Straoge Tray and TVTR probe holder

Cleaning Base Tray

1. Push up the base tray from the bottom and disassemble 
from the system.

2. Wash the tray with mild detergent.

3. Thoroughly dry the tray using a clean, low-lint, soft cloth or 
wipe.

4. Attach the tray to the system.

Figure 12-13. Disassemble the base tray
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Cleaning the Control panel rear tray (Option)

1. Unhook 3 hooks on the bottom of the tray.

2. Pull the tray with the arrow direction.

3. Wash the tray with mild detergent.

4. Thoroughly dry the tray using a clean, low-lint, soft cloth or 
wipe.

5. Attach the tray to the system.

Figure 12-14. Disassemble the Control panel rear tray
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Cleaning the Control panel rear tray (Option)

1. Grab the rear basket with 2 hands and pull up to 
disassemble.

2. Wash the tray with mild detergent.

3. Thoroughly dry the tray using a clean, low-lint, soft cloth or 
wipe.

4. Attach the tray to the system until the clicking sound heard.

Figure 12-15. Disassemble the rear basket
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Cleaning Straoge Tray and TVTR probe holder  (continued)

Cleaning TVTR Probe Holder

1. Pull the hook to disassemble the probe holder from the 
system.

2. Wash the probe holder with mild detergent.

3. Thoroughly dry the probe holder using a clean, low-lint, soft 
cloth or wipe.

4. Put the probe holder to the original position.

Figure 12-16. Pull the hook to disassemble the probe holder
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Replacing key caps

Contact a local Service Representative when a key cap needs to 
be replaced.

For Feature Keys, the user can rearrange these keys if desired. 
Please see ‘System/User Configurable Key’ on page 10-26 for 
more information on how to remove and replace these Feature 
keycaps. 

Footswitch

To clean the footswitch:

1. Disconnect the footswitch from the LOGIQ Totus.

2. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet. 

3. Wipe the external surfaces of the unit then dry with a soft, 
clean, cloth.
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Quality Assurance

Introduction

A good Quality Assurance Evaluation program consists of 
periodic systematic actions that provide the user with adequate 
confidence that their diagnostic ultrasound system will produce 
consistently high quality images and quantitative information.

Therefore, it is in the best interests of every ultrasound user to 
routinely monitor equipment performance.

The frequency of Quality Assurance evaluations should be 
based on user's specific needs and clinical practice.

Periodic monitoring is essential in order to detect the 
performance changes that occur through normal aging of 
system components. Routine equipment evaluations may also 
reduce the duration of exams, number of repeat exams, and 
maintenance time required.

NOTE: For information on setting up the Image Quality Check, refer to 
Image Quality Check .  

For details on system and peripheral routine preventive 
maintenance instructions, See ‘System Care and Maintenance’ 
on page 12-32 for more information.
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Typical Tests to Perform

Quality assurance measurements provide results relating to 
system performance. Typically these are:

• Axial Measurement Accuracy

• Lateral Measurement Accuracy

• Axial and Lateral Resolution

• Penetration

• Functional & Contrast Resolution

• Gray Scale Photography.

With these tests, a performance baseline can be set at 
installation with the phantom in your department. Future test 
results can be compared to the baseline in order to maintain a 
record of system performance trends. 

The phantom shown is shown as a representative example of a 
phantom. You can select from any number of phantoms 
available on the market. 

Frequency of tests

Quality assurance tests are used to determine whether a 
scanner is providing the same level of performance from day to 
day.

The frequency of testing varies with the amount of system usage 
and modes to be tested. It is recommended that the user 
perform quality assurance tests at least every three months or 
every 400 patient studies. Tests should also be performed when 
a question about system performance exists.

A mobile system may require more frequent tests.

Image quality should also be tested immediately after the 
following events:

• Service calls

• System upgrades/modifications

• Dropped probe, power surge, etc. 
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Phantoms

Quality Assurance Evaluations may be done with phantoms and 
test objects that are applicable to the parameters being 
evaluated or to the user's clinical practice.

Typical phantoms are composed of material that acoustically 
mimic human tissue. Pins, anechoic and echogenic targets are 
physically positioned to provide information for a variety of tests.

The RMI 403GS phantom is shown in the illustration below as a 
representative example of a phantom. 

 Figure 12-17. Representative Phantom Example

1. Penetration

2. Axial Distance Measurement

3. Functional Resolution

4. Lateral Resolution

5. Lateral Distance Measurement

6. Axial Resolution

7. Contrast Resolution and Gray Scale Photography

8. Gray Scale Plane Targets
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Baselines

An absolute necessity for a quality assurance program is 
establishing baselines for each test or check. Baselines are 
established after the system has been verified to be working 
properly at installation or after a repair. If a probe or major 
assembly is replaced, new baselines should be generated.

Baselines can be made by adjusting system parameters to 
prescribed levels or to the best possible image. The key factor to 
remember is reproducibility. The same conditions must be 
reproduced for each periodic check.

All system parameters not displayed on the monitor should be 
recorded for the permanent record.

Periodic Checks

Periodic checks should be performed in accordance with your 
facility’s quality assurance requirements. For the data to be 
valid, periodic checks should mimic the baseline setup 
parameters.

The resulting image, when scanning the phantom exactly as 
before, should be recorded and compared to the baseline. 
When a matching image is obtained, it can be assumed that the 
system performance has not degraded from the baseline.

If a significant difference between the baseline and periodic 
check is noted, double check the system setup and repeat the 
test. If the difference between the baseline and periodic check 
persists, contact a local Service Representative.

Failing to reproduce the control settings as in the baselines will 
introduce errors in the data and potentially invalidate the results.
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Results

Lack of standardization among test instruments, the wide range 
of acceptance criteria, and incomplete knowledge regarding the 
significance of certain performance parameters prohibit the 
establishment of absolute performance criteria for these tests.

Quality Assurance Evaluation results should be compared to 
previously-recorded results. 

Performance trends can then be detected. Unacceptable 
performance or diminishing trends should be identified for 
maintenance or repair before a malfunction or inappropriate 
diagnosis occurs. 

The user should determine the best method for recording and 
archiving the baseline and periodic checks. In most cases the 
choice is hard copy.

It is important to maintain good consistent records for 
inspections that may arise, as well as to detect system 
performance trends.

System Setup

The user should tailor the tests to their particular needs. It is 
certainly not necessary to make all checks with all probes. A 
representative example, with the probes used most often by the 
customer, should be adequate in judging system performance 
trends.

Use a gray scale phantom as the scan object for the tests. 
Commercial phantoms are supplied with its own operator 
manual. Be familiar with proper phantom operating procedures 
prior to use for quality assurance evaluations.

1. Adjust image monitor. Brightness and contrast should be set 
to the normal viewing of a good gray scale image.

2. Check all recording devices for proper duplication of image 
monitor. Ensure that what is seen is what is recorded. 

3. Annotate non-displayed image processing controls. 

4. Set TGC slide pots to center (detent) position. 

5. Place focal zone marker(s) in area of interest for an 
optimum image.
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Test Procedures

The following are recommended Quality Assurance tests. A brief 
description of the test, the benefit it provides and steps to 
accomplish the test are supplied.

The importance of recording scan parameters and consistent 
record keeping cannot be stressed enough. Reproducibility to 
monitor system trends is the key to quality assurance 
evaluations.

Using the system's dual image display format is often very 
convenient and saves recording media.
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Axial distance measurements

Description

Axial measurements are the distance measurements obtained 
along the sound beam. See Figure 12-17 for more information.

Benefit

The accurate measurement of the size, depth and volume of a 
structure is a critical factor in determining a proper diagnosis. 
Most imaging systems use depth markers and/or electronic 
calipers for this purpose.

Method

Axial distance should be measured in the near, mid and far fields 
as well as in zoom. If necessary, different depths or fields of 
view can be tested.

Procedure

To measure axial distance:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets to typical depths for the probe being 
used.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the vertical pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if vertical measurements differ by 
more than 1.50% of the actual distance.
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Lateral distance measurements

Description

Lateral measurements are distance measurements obtained 
perpendicular to the axis of the sound beam. See Figure 12-17 
for more information.

Benefit

The purpose is the same as vertical measurements. 
Precisely-spaced horizontal pin targets are scanned and results 
compared to the known distance in the phantom.

Method

Lateral distance should be measured in the near, mid and far 
fields as well as in zoom. If necessary, different depths of fields 
of view can be tested.

Procedure

To measure lateral distance:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets from side to side.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the horizontal pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if horizontal measurements differ by 
more than 3mm or 3% of that distance, whichever is greater.
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Axial resolution

Description

Axial resolution is the minimum reflector separation between two 
closely-spaced objects to produce discrete reflections along the 
axis of the sound beam. It can also be monitored by checking 
the vertical size of known pin targets. See Figure 12-17 for more 
information.

Axial resolution is affected by the transmitting section of the 
system and the probe.

Benefit

In clinical imaging, poor axial resolution displays small 
structures lying close together as a single dot. This may lead to 
improper interpretation of the ultrasound image.

Procedure

To measure Axial resolution:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. 

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets to typical depths for the probe being used.

3. Press Freeze to stop image acquisition.

4. Perform a standard distance measurement of the pin 
vertical thickness at different points in the image. Record all 
images for archiving.

5. Scan the vertical pins in zoom or at different depth/scale 
factors.

6. Press Freeze to stop image acquisition; repeat the vertical 
thickness measurements of the pins and record the images 
for archiving.

7. Document the measurements for reference and future 
comparison.

Axial resolution should remain stable over time. Contact a 
Service Engineer if any changes are observed.
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Lateral resolution

Description

Lateral resolution is the minimum reflector separation between 
two closely spaced objects to produce discrete reflections 
perpendicular to the axis of the sound beam. It can also be 
monitored by checking the horizontal size of known pin targets. 
See Figure 12-17 for more information.

Lateral resolution is dependent upon the beam width produced 
by the probe. The narrower the beam, the better the lateral 
resolution.

The beam width is affected by the frequency, degree of focusing, 
and distance of the object from the face of the probe.

Benefit

Clinically, poor lateral resolution will display small structures 
lying close together as a single dot. This may lead to improper 
interpretation of the ultrasound image.

Procedure

To measure lateral resolution:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets.

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets from side to side.

3. Press Freeze to stop image acquisition and perform a 
standard distance measurement of the horizontal thickness 
of a pin at different points in the image. Record all images 
for archiving.

4. Scan the horizontal pins in zoom or at different depth/scale 
factors.

5. Press Freeze to stop image acquisition; repeat the 
horizontal thickness measurements of the pins and record 
the images for archiving.

6. Document the measurements for reference and future 
comparison. 

Pin width should remain relatively constant over time ("1mm). 
Dramatic changes in pin width may indicate beamforming 
problems. Contact a Service Engineer if beam width changes 
consistently over 2 to 3 periodic tests. 
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Penetration

Description

Penetration is the ability of an imaging system to detect and 
display weak echoes from small objects at large depths. See 
Figure 12-17 for more information.

Penetration can be affected by the system's: 

• Transmitter/receiver

• Degree of probe focusing

• Attenuation of the medium

• Depth and shape of reflecting object

• Electromagnetic interference from local surroundings. 

Benefit

Weak reflecting echoes are commonly produced from the 
internal structure of organs. Definition of this tissue texture is 
important in the interpretation of the ultrasound findings.

Method

Scan a phantom to see how echoes begin to fade as depth is 
increased. The maximum depth of penetration is the point at 
which homogeneous material in the phantom begins to lose 
brightness.

Procedure

To measure penetration:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom along the vertical pin targets to typical 
depths for the probe being used.

4. Perform a standard distance measurement from the top of 
the image displayed to the point at which homogeneous 
material in the phantom begins to lose brightness.

5. Document the depth measurement for reference and future 
comparison. 

Contact a Service Engineer if the depth of penetration shifts 
more than one centimeter (1cm) when using the same probe 
and same system settings.
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Functional resolution

Description

Functional resolution is an imaging system's ability to detect and 
display the size, shape, and depth of an anechoic structure, as 
opposed to a pin target. See Figure 12-17 for more information.

The very best possible image is somewhat less important than 
reproducibility and stability over time. Routine tests at the same 
settings should produce the same results.

Benefit

The data obtained will give a relative indication of the smallest 
structure the system is capable of resolving at a given depth.

Procedure

To measure functional resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with a vertical row of anechoic cyst 
targets to typical depths for the probe being used.

4. Evaluate the cysts at various depths for a good (round) 
shape, well-defined borders and no fill in. Remember, TGC 
slide pots are centered and should remain fixed. This may 
NOT provide optimal cystic clearing.

5. Document all results for future reference and comparison.

Contact a Service Engineer if a greatly distorted image is 
obtained.
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Contrast resolution

Description

Contrast resolution is the ability of an imaging system to detect 
and display the shape and echogenic characteristics of a 
structure. See Figure 12-17 for more information.

Specific values measured are less important than stability over 
time. Routine tests at the same settings should produce the 
same results.

Benefit

A correct diagnosis is dependent upon an imaging system's 
ability to differentiate between a cystic or solid structure versus 
echo patterns from normal surrounding tissue.

Method

A phantom with echogenic targets of different sizes and depths 
should be used.

Procedure

To measure contrast resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position. Set dynamic range to 54 db.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with echogenic targets at the depths 
available.

4. Evaluate the echogenic targets for contrast between each 
other and between the surrounding phantom material. 
Remember, TGC slide pots are centered and should remain 
fixed. This may NOT provide an optimal scan image.

5. Document all results for future reference and comparison.

Contact a Service Engineer if the echogenic characteristics or 
shapes of the targets appear distorted.
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Gray Scale photography

Description

Poor photography will cause loss of low level echoes and the 
lack of contrast between large amplitude echoes. See 
Figure 12-17 for more information.

Benefit

When photographic controls and film processors are properly 
adjusted, weak echoes, as well as strong echoes, are accurately 
recorded on film.

Procedure

1. Adjust the camera according to the manufacturer's 
instructions until the hard copy and video display are equal.

2. Scan the phantom and it's echogenic contrast targets.

3. Make a hard copy photograph of the display and compare it 
to the image on the video monitor for contrast and weak 
echo display.

4. Document all results for future reference and comparison.

Contact a Service Engineer if camera cannot duplicate what is 
on the image monitor.

NOTE: Optimization of brightness/contrast controls on the display 
monitor is imperative in order to make sure that the hardcopy 
and monitor look alike.

The display monitor is adjusted first. The hardcopy camera or 
printer is adjusted to match the display monitor.
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Setting up a Record Keeping System

Preparation

The following is needed: 

• Quality Assurance binder.

• Hard copy or electronic file of images.

• Quality Assurance Checklists. 

• Display the following information while testing quality 
assurance: 

• Acoustic Output

• Gain

• Depth

• Probe

• Dynamic Range

• Set up new patient to be the name of the test.

• Annotate the following: 

• Any control where its value is NOT displayed. 

• Significant phantom information.

Record Keeping

Complete the following: 

1. Fill out the Ultrasound Quality Assurance Checklist for each 
probe, as scheduled. 

2. Make a hard copy or archive the image. 

3. Compare images to baseline images and acceptable 
values. 

4. Evaluate trends over previous test periods. 

5. File hard copy or electronic file of images and checklist in 
Quality Assurance binder. 
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Ultrasound Quality Assurance Checklist 

Table 12-13:  Ultrasound Quality Assurance Checklist (Part 1)

Performed By Date

System Serial Number

Probe Type Probe Model Serial Number

Phantom Model Serial Number Room Temperature

Acoustic Output Gain Focal Zone

Gray Map TGC Depth

Monitor Setting

Peripheral Settings

Other Image Processing Control Settings

Table 12-14:  Ultrasound Quality Assurance Checklist (Part 2)
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Image Quality Check

Image Quality Check (IQC)

Image Quality Check is intended to facilitate Image Quality 
checks during Quality Assurance Evaluations. Quality 
Assurance tests are used to determine whether a scanner is 
providing the same level of performance year after year. 

By using the same settings year after year, this ensures that the 
data collection is consistent, independently of who performs the 
test. 

This preset only includes fundamental settings for B-Mode. 
Processing modes like SRI, Harmonics, etc., are turned off. 

To do an Image Quality Check (IQC), 

1. Activate IQC via Utility--> Imaging Preset Manager--> 
Category (select the Category first). 

2. Click on the plus sign in front of IQC for Service and select 
IQC. 

3. Assign IQC to a Touch Panel key by using the right arrow 
key. 

4. Map the IQC to the location you want it to appear on the 
Touch Panel. 

5. Select Probe. Then select IQC. 
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Assistance

Supplies/Accessories

Not all features or products described in this document may be 
available or cleared for sale in all markets.

Contact the distributor, GE HealthCare affiliate or sales 
representative for approved peripherals. For HCATs, contact 
your sales person. For field service replacement part numbers 
(FRUs), these are service replacement part numbers that may 
be either new or refurbished, please consult the Basic Service 
Manual. To order these, contact CARES in the US, or call 
service in Europe and Asia. 

The following supplies/accessories have been verified to be 
compatible with the system:
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Peripherals

Table 12-15:  Peripherals and Accessories

Accessory Illustration/Photo

Onboard Printer installation kit (UP-D898DC)

Sony UP-D25M Color Printer

Footswitch, USB

Powervar144k120v MG UPS UPS N/A

Powervar144k 230V MG UPS N/A

Magstripe Card Reader

ASUS Z380M-A2-GR ZenPad 8 Tablet N/A

Digital Expert (Microsoft-Surface) N/A

Ethernet protection cable (GES.2203369.01) N/A
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Console

Table 12-16:  Console Accessories

Accessory Illustration/Photo

AN keyboard English

AN keyboard German

AN keyboard French

AN keyboard Greek

AN keyboard Norwegian

AN keyboard Russian

AN keyboard Swedish

Power Cord - North American 

Power Cord - Argentina

Power Cord - Europe

Power Cord - UK-Ireland

Power Cord - Switzerland

Power Cord - Denmark

Power Cord - Italy

Power Cord - Israel
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Power Cord - Japan

Power Cord - China

Power Cord - Australia/New Zealand

Power Cord - India

Power Cord - South Africa

Power Cord - Brazil

Power Cord - Taiwan

TVTR Probe Holder Assembly 

Probe Cable Hanger

Rear basket

Table 12-16:  Console Accessories (Continued)

Accessory Illustration/Photo



User Maintenance

12-72 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Drawer

Rear handle cable hook

Gel warmer

OPIO rear tray

Table 12-16:  Console Accessories (Continued)

Accessory Illustration/Photo
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Volume Navigation

V Nav Shelf Load Description

Shelf load for the V Nav wire shelf on the V Nav Stand is 10 lbs. 

Table 12-17:  Volume Navigation

Accessory

V Nav Active Tracker (Omni TRAX) Starter Kit

V Nav Needle Tracking Storage Insert

V Nav eTRAX 
• 18/20g Starter Kit
• 14g Starter Kit
• 12g Starter Kit

V Nav Probe Sensor

Probe Holder Insert

Volume Navigation Stand

V Nav Needle Tracker Starter Kit

V Nav Needle Virtual Tracker Starter Kit (VirtuTRAX)

Virtual Tracker Sensor

Volume Navigation Bracket Starter Kit

V Nav Upgrade to Needle Tracking Kit
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Hardware options

ECG Accessories

Table 12-18:  Hardware options

Accessory

CW Doppler Option

Realtime 4D

ECG Option

Battery Option

Volume Navigation

WLAN (AX210)

UVSC Option

Pencil CW Hardware Kit

EMI Filter (TNC, BF-10A)

Gel warmer

Vscan Air Charger

HDU monitor

Table 12-19:  ECG Accessories

Accessory

ECG Cables, IEC, AHA Style for Americas

ECG Cables, IEC Style

ECG Cable Kit
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Probes

Table 12-20:  Probes and Accessories

Probe Biopsy Guide V Nav Capable

C1-6-D
Convex

Verza starter Kit
Note: ONLY support Verza Starter Kit. 

No

Biopsy Starter Kit

C1-6VN-D
Convex

Verza starter Kit
Note: ONLY support Verza Starter Kit. 

Yes

C2-7-D
Convex

Multi-angle disposable with a reusable bracket

Multi-Angle Reusable Stainless Bracket

No

C2-7VN-D
Convex

Multi-angle disposable with a reusable bracket

Multi-Angle Reusable Stainless Bracket

Yes

Vscan Air CL N/A No

C3-10-D
Convex

N/A Yes

IC5-9-D
Micro Convex Intracavitary

Single Angle

Disposable with a Plastic Bracket or 

Reusable with a Stainless Steel Bracket

Yes

9L-D
Linear

Multi-angle Yes

L3-12-D Multi-angle No

L6-24-D
Linear Array

N/A No

M5Sc-D
XDclear Active Matrix Single 
Crystal Phased Array 
Transducer

Multi-angle disposable with a reusable bracket Yes

ML6-15-D
Matrix Array Linear

Multi-angle Yes

RIC5-9-D
4D Convex Volume 
Intracavitary

Single Angle, Reusable
Biopsy Kit for RAB Light or Disposable with a 
Plastic Bracket

N/A

RAB6-D
4D Volume

Starter Kit N/A

RAB Biopsy Starter Kit

6S-D N/A No
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12S-D N/A No

P2D
Pencil Probe

N/A N/A

P6D
Pencil Probe

N/A N/A

Table 12-20:  Probes and Accessories (Continued)

Probe Biopsy Guide V Nav Capable
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Options

NOTE: Not all options are available in all countries. 

Table 12-21:  Options

Option

Advanced Security

*Coded Contrast - AM

Cardiac Automated Functional Imaging (AFI)

Report Writer

Stress Echo

Tricefy

LOGIQ Apps

KOIOS SW

Thyroid Assistant, Powered by Koios DS

Scan Assistant

Advanced Probes

Auto IMT

B-Steer+

B-Flow

Compare Assistant

DICOM

Flow Quantification (Q-Analysis)

Breast Measure Assist

OB Measure Assistant

Elastography

Elastography QA

Shear Wave Elastography

Ultrasound Guided Attenuation Parametre (UGAP)

Hepatic Assistant 

SonoNT/SonoIT

DVR
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SRI HD Type2

OmniView

STIC

TUI

VCI Static

VOCAL II

Thyroid Productivity 

Breast Productivity

VITA on Demand

Vscan Air CL

Auto Preset Assistant

Voice Control

*The LOGIQ Totus is designed for compatibility with commercially available Ultrasound contrast agents. 
Because the availability of these agents is subject to government regulation and approval, product features 
intended for use with these agents may not be commercially marketed nor made available before the 
contrast agent is cleared for use. Contrast-related product features are enabled only on systems for delivery 
to an authorized country or region of use. 

Table 12-21:  Options (Continued)

Option
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Gel

Disinfectant

Ultrasound Probe and Cord Sheath Sets

Table 12-22:  Gel — Refer to Accessories Catalog

Accessory Units

Thermasonic Gel Warmer Holds three plastic bottles 
(250ml or 8 oz)

Aquasonic 100 Scan Gel 5 liter jug

250 ml plastic bottles (12/case)

Scan Ultrasound Gel 8 oz plastic bottles (12/case)

1 gallon plastic jug

Four 1-gallon plastic jugs

Table 12-23:  Disinfectant — Refer to Accessories Catalog

Accessory Units

Cidex Activated Dialdehyde 16/1 quart bottles

4/1 gallon bottles

2/2.5 gallon bottles

Table 12-24:  Probe and Cord Sheath Sets — Refer to Accessories Catalog

Accessory Units

Sterile Ultrasound Probe Sheath Set 20 Per Set

Sterile Ultrasound Cord Sheath Set 20 Per Set

Sanitary Rectal/Vaginal Probe Cover 20 Per Set

Sterile Combination Probe and Cord Cover Set 12 Per Set

Sterile Ultrasound Probe Sheath Set for Wide (2.5 and 3.5) Aperture 
Sector Probes

20 Per Set
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Chapter 13

Advanced Features

Describes Advanced system features and options.
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Using 4D

4D Introduction

4D provides continuous, high volume acquisition of 3D images. 
4D adds the dimension of “movement” to a 3D image by 
providing continuous, real-time displays. With 4D, you can apply 
rendering techniques to smooth out the appearance of an 
anatomical structure, for example, a baby’s spine.

You can perform the following types of volume acquisitions 
within the 4D feature:

Features supported with 4D

The following features are supported with 4D:

• Most B-Mode controls

• Annotations

• Measurements and Calculations

The following post-processing controls are available with 4D:

• CINE 

• Zoom

Table 13-1:  4D Package Options

4D Type Description
Acquisition 

Mode

4D Designed for continuous volume acquisition of a 3D image. B, 4D

Static 3D Designed for single volume acquisition of a 3D image. B, 3D
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4D Principles of Operation

The acquisition of volume starts with a 2D image using special 
probes designed for performing 3D sweeps and 4D scans. The 
volume box defines the region of interest to be used for the 
volume sweep.

Volume sweep refers to the range of the sweep of the 2D image 
to be transformed into a rendered, 3D or 4D image. Static 3D 
acquisition involves a single volume sweep. 4D involves 
multiple, continuous volume sweeps. 

Figure 13-1. Volume Sweep 

1. Central 2D scan

2. Start 2D scan

3. Range of VOI sweep

When you initiate a volume sweep, you can adjust the angle of 
the volume.

What is Interactive 3D Rendering? 

Interactive 3D rendering allows you to visualize certain 
structures and to view and analyze different sections of the 
volume.
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Region of Interest (ROI) / Render Box

The Region of Interest (ROI) - also referred to as the Render 
Box in rendering - contains the section of the volume you want 
to render. Therefore, objects that are not inside of the box are 
not included in the render process and are cut out (this is 
important in surface mode to allow a free line of sight). This may 
or might not be the entire Volume of Interest (VOI). 

You can adjust the view direction of the ROI.

Figure 13-2. Render View Directions

Render View 

In Render view, only the rendered image displays - no reference 
images. 

1. Up/Down
2. Left/Right
3. Front/Back

4. Down/Up
5. Right/Left
6. Back/Front



Using 4D

LOGIQ Totus – User Manual 13-7
5929163-1EN Rev. 3

Image Orientation

Orientation of Image in Sectional view

 Figure 13-3. Quad Render Visualization Mode

1. Longitudinal

2. Transverse

3. Coronal
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Principle of Sectional Planes

Sectional planes represent three different planes of the same 3D 
volume. There are three separate planes, A (Longitudinal), B, 
(Transverse) and C (Coronal). 

Figure 13-4. Illustration of Sectional Planes

The presentation of three orthogonal sectional planes is different 
from the conventional patient orientation in 2D sonography. 

NOTE: Whenever you select the usual, longitudinal section of the 
patient to display in field A, the conventional orientation for 
longitudinal and transverse sections is valid. 
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Reference Images

Reference images are the individual image displays within the 
corresponding sectional plane. Reference image A represents 
the longitudinal view; reference image B the transverse view, 
and reference image C represents the coronal view.

 Figure 13-5. Monitor Display of Reference Images in Sectional View

1. Reference Image A (Longitudinal)

2. Reference Image B (Transverse)

3. Reference Image C (Coronal)

Orientation Help. When you view a 4D image on the display, 
it’s sometimes difficult to recognize the orientation. To help, the 
system displays a three-dimensional drawing to illustrate the 
orientation. This drawing displays ONLY in sectional view. 
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Reference Images  (continued)

Figure 13-6. Reference Image A 

For Reference image A, the transducer plane migrates from the 
FRONT to the REAR through the volume body.

Figure 13-7. Reference Image B

For Reference image B, the transducer plane migrates from the 
LEFT to the RIGHT through the volume body.

Figure 13-8. Reference Image C

For Reference image C, the transducer plane migrates from the 
TOP to the BOTTOM through the volume body.
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-9. Abdominal Probe Orientation

1. Image Plane A

2. image Plane B

3. Image Plane C
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-10. Endocavity Probe Orientation

1. Image Plane A

2. Image Plane B

3. Image Plane C

4. Groove
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4D Operational Controls

Control Panel Overview

When you enter 3D/4D mode, the behavior of some of the 
Control Panel buttons changes. For example, in 3D/4D mode, 
you use the PW-Mode, CF-Mode, M-Mode buttons (along with 
Depth) to manipulate the Volume of Interest (VOI).

 Figure 13-11. Control Panel Buttons

1. User-configurable controls. 

2. M key, M-Mode key used to rotate about the X axis.

3. PW key, PW-Mode key used to rotate about the Y axis.

4. CF Key, CF-Mode key used to rotate about the Z axis.

5. Depth key, used as a transverse translation through the 
image.

6. Width key, used to adjust the size and position of the VOI.

7. Trackball, used to move the VOI. Also, the 4 keys 
surrounding the Trackball map to additional functionality, as 
shown on the monitor display. 

8. L (left) key, used to begin a 4D acquisition.

9. Freeze or R (right) key, used to freeze a 4D image.
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4D Monitor Display

Imaging parameters are displayed in the upper right-hand 
portion of the display. The 4D specific parameters are Quality 
(Q), Volume Angle (A) and Volume Rate (VR). The Status Bar 
contains instructions on the tasks you can perform at each stage 
of the 4D imaging process. Remember to take a look at the 
Status Bar as needed.
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4D Touch Panel Overview

The following is the first Touch Panel that appears when you 
press 3D/4D.

Common 4D Touch Panel Controls

Most 4D Touch Panel screens contain some similar controls. 
Refer to the table below for descriptions of these controls. 
Controls that are unique to or that contain slightly different 
functionality are described in their respective sections.

Table 13-2:  Common 4D Touch Panel Controls

Preset Parameter Description

Tile You can divide the display into 1, 2, or 4 windows for Render view (Render = 
On) and 1 or 4 windows for Sectional view (Render = Off). 

Reset Curve Resets the three-point curve to a straight line. 

Direction Adjusts the view direction of the ROI. 

Visualization Sectional, Render, VCI, or Tomographic Ultrasound Imaging (TUI). Render 
view displays one rendered image, or reference image(s) and rendered 
image. 

Focus Position Adjusts the focal position. 

Volume Angle Sets the range of the volume sweep. 

Quality Balances speed with line density. Max combines the highest density with the 
slowest speed; Low combines the lowest density with the highest speed. 
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4D Presets 

Real-Time 4D/Static 3D Presets

1. When you enter 3D/4D mode, press the Preset tab.

2. Select one of the preset settings for data acquisition and 
display. Presets are defined in the preset file and differ by 
application.

Static 3D Presets

1. When you enter 3D/4D mode, press Static 3D, then the 
Preset tab.

2. Select one of the preset settings for data acquisition and 
display. Presets are defined in the preset file and differ by 
application.

Table 13-3:  Common 4D Touch Panel Controls

Preset Parameter Description

Save Selections: Overwrite, Create New, Cancel. Overwrite. Overwrite the 
application preset file with the changes you just made. Create New. Create a 
new user application preset file based upon the current exam category and 
application. Cancel. Cancel without saving preset parameters.   

Pre-defined Preset Reloads the presets for the selected application. 

User1, User2, User3, 
User4

Used to define new user presets for a given application. 
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Performing a 4D Scan

Visualizations

4D provides two types of views for displaying and working with 
images: Sectional, Render, and Tomographic Ultrasound 
Imaging (TUI).

Sectional View

Sectional view contains one display for each sectional plane. 

 Figure 13-12. Monitor Display in Sectional View

1. Sectional Image A

2. Sectional Image B

3. Sectional Image C
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Visualizations  (continued)

Render View

The LOGIQ Totus continuously displays the 4D rendered image. 

NOTE: When the tile selection is single, only the rendered 4D image 
appears. When the tile selection is quad, the sectional images 
are located in 3 quadrants with the rendered 4D image in the 
fourth.

Figure 13-13. Quad Tile Render View
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Visualizations  (continued)

Orientation Help

When you view a 4D image on the display monitor, it’s 
sometimes difficult to recognize the orientation. To help, the 
system displays a three-dimensional drawing to illustrate the 
orientation. This drawing displays ONLY in sectional view.

Figure 13-14. Orientation Help Graphic
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Acquiring and Rendering a 4D VOI

Starting with a 2D Image

To create a 4D image, you start with an optimized 2D image. 
The 2D image serves as the mid-line for the resulting 4D image.

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

NOTE: If the appropriate 4D probe is not connected, the original 3D 
Touch Panel appears.

2. Obtain a 2D image. Optimize the image as usual. 

Entering 3D/4D Mode

In 3D/4D mode, you choose the type of scan you want to 
perform: 4D or Static 3D.

1. Press 3D/4D to enter 3D/4D mode. The first time you press 
3D/4D, the system is in B Pre mode.

NOTE: The location of the number of focal zones might change 
when you enter 3D/4D mode, since the number of zones is 
pre-determined by the default ROI.

The default acquisition mode varies by application. If you 
are in OB, the default acquisition mode is Real-Time 4D; for 
all other applications, Static 3D is the default acquisition 
mode. When you enter pre-mode, an ROI graphic may 
appear on the monitor display that defines the initial ROI 
(Region of Interest) of the volume.

Figure 13-15. ROI Graphic

2. Press the Preset tab. Select one of the preset settings for 
data acquisition and display. Presets are defined in the 
preset file and differ by application. 



Using 4D

LOGIQ Totus – User Manual 13-21
5929163-1EN Rev. 3

Quick Acquisition Steps

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

2. Select a 4D probe from the probe indicator.

3. Obtain a 2D image. Optimize the image as usual.

4. Press 3D/4D. An ROI graphic appears. 4D is selected.

5. Define the Volume of Interest (VOI) to be scanned. Use the 
Trackball to move the VOI and the Width button to re-size 
and re-position the VOI. Only the area defined within the 
VOI is rendered.

6. Adjust the volume angle and quality. This defines the range 
of the volume sweep. A small sweep angle results in a lower 
number of slices with a high volume rate.

7. To begin 4D acquisition, press the L key.

You DO NOT have to hold the probe steady during data 
acquisition.

During data acquisition, you can manipulate the VOI to see 
different views of the image. To rotate the VOI left or right, 
use the PW control. To rotate the VOI forward or backward, 
use the CF control. To rotate the VOI in a circular motion, 
use the M control.

To return to 3D/4D pre-mode, press L.

NOTE: If the volume size is too large, the message “Volume Size 
Too Big - Quality Degraded” displays in the status bar. The 
system changes the quality automatically to below the upper 
limit and displays the proper Quality value in the information 
window. 

8. Set Render to On.

9. To complete the acquisition, press Freeze or R.

10. Store the image.
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4D

4D provides continuous, high volume acquisition of 3D images. 
You can apply rendering techniques to smooth out the 
appearance of an anatomical structure, for example, a baby 
face.

4D imaging contains two main viewing modes: Sectional, 
Render, and Tomographic Ultrasound Imaging (TUI). Sectional 
mode displays three separate representations of the image: 
Longitudinal (original 2D image), Transverse (elevational), and 
Coronal (horizontal). Render mode displays one rendered 4D 
image.

Acquiring a 4D Volume of Interest (VOI)

Once you have acquired an optimized 2D image, you can 
perform a 4D scan to acquire the 4D image.

During 4D image acquisition:

• Frame Averaging is disabled.

• You cannot change the transmit frequency.

To acquire a 4D VOI:

1. Press 4D.

2. Make sure the VOI is defined appropriately. If necessary, 
adjust the volume angle. This defines the range of the 
volume sweep. A small sweep angle results in a lower 
number of slices with a higher volume rate.

See Manipulating the Volume of Interest (VOI) for more 
information.

3. To begin 4D acquisition, press the L key. The system will 
perform continuous sweeps across the VOI. You do not 
have to hold the probe steady during a 4D scan.

To return to 4D pre-mode, press L.

4. Set the Render to On.
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Sectional VOI Acquisition

Sectional view provides three separate views of the same 
image: Longitudinal (original image), Transverse (elevational), 
and Coronal (horizontal).

1. In the 4D tab, Render defaults to On (Render mode). 
Change Render to Off for Sectional view.

2. To select a reference image, use the Ref Image control on 
the Touch Panel. The reference image selected contains the 
focus for control panel keys, allowing you to manipulate or 
optimize that image.

Table 13-4:  4D Data Acquisition Parameters

4D Parameter Description

Restore View Resets all parameters back to the original values or chosen presets.

Tile Selections: Single, Quad. You can divide the display into 1 or 4 windows. 

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view 
displays one rendered image, or reference image(s) and rendered image. 

Ref Image Use to select the reference image that has focus for use with the control 
panel keys and Trackball.

Orientation Help Displays a three-dimensional drawing to illustrate the orientation. Only 
displays in sectional view. 

Volume Angle Sets the range of the volume sweep. 

B Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line 
density. Max combines the highest density with the slowest speed. Low 
combines the lowest density with the highest speed. BQ displays on the 
display. 
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Render VOI Acquisition

Rendering allows you to distinguish subtle anatomical detail. 
You can render all areas of an VOI, or just certain regions of the 
VOI. The region you define for rendering is referred to as the 
Render Box.

1. Define the area you want to render. For example, if you 
have an image of an entire fetus, you might only want the 
fetal face to be rendered. Therefore, you would define the 
fetal face as the VOI.

2. Set Render to On.

Table 13-5:  4D Data Acquisition Parameters - Render Mode 

4D Parameter Description

Restore View Select to reset all parameters back to the original values or chosen presets.

Tile Selections: Single, Dual, Quad. You can divide the display into 1, 2, or 4 
windows.

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view 
displays one rendered image, or reference image(s) and rendered image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 
Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 

Ref Image Use to select the reference image that has focus for use with the control 
panel keys and Trackball. This control is enabled only if Tile is set to Quad.

Volume Angle Sets the range of the volume sweep. 

Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line 
density. Max combines the highest density with the slowest speed. Low 
combines the lowest density with the highest speed. 

Activate Curve Define a three-point curved surface for the render window using the 
Trackball. 

Reset Curve Reset the three-point curve to a straight line. 

Mix Selections: 0-100% in increments of 2. Allows you to mix a Rend Mode 1 
mode with a Rend Mode 2 mode. Always select two modes. 

Lower Threshold Selections: 0-255. Sets a lower threshold below which weaker echoes are 
removed.
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Render VOI Acquisition  (continued)

1. Select the Render Setting tab.

The Render Setting tab allows you select and combine 
gray-scale and color rendering modes.

HINTS If you are using Surface modes, we recommend that you adjust 
the Lower Threshold to recognize border structures more 
clearly.

Table 13-6:  4D (Data Acquisition) Render Parameters

4D Parameter Description

Direction The ROI determines the region that is rendered during 4D acquisition. You 
can change the direction in which this ROI is viewed. Selections: Up/Down,
Down Up, Left/Right, Right/Left, Front/Back, Back/Front.

Gray Map Displays the gray map selections on the display monitor. Select maps using 
the Trackball.

Colorize Displays the tint map selections on the display monitor. Select maps using 
the Trackball.

Render Mode Select Gray or Inversion. If you select Inversion, inverts the gray values of the 
rendered image (e.g., image information that was black becomes white and 
vice versa). 

Render 1 Allows you to combine render mode values from render mode 1. Select the 
render map combination from the upper-left portion of the monitor display. 
Select map combinations using the Trackball.
Render Mode 1 Selections: Surface Smooth, Surface Texture, Transp Max, 
Transp X-ray, Transp Min, HDlive Texture. 
Surface Smooth - Surface displays in a smoothed texture mode, which 
means that the gray values of the surface are identical with the gray values of 
the original 2D scan. Surface Texture - Surface displays in texture mode, 
which means that the gray values of the surface are identical with the gray 
values of the original 2D scan. Transp Max. - Displays the maximum 
intensity of gray values in the ROI. This is helpful for viewing bony structures. 
Transp X-Ray - Displays the mean value of all gray values in the ROI. Trans 
Min. - Displays the minimum number of gray values in the ROI. This is helpful 
for viewing vessels and hollow structures. HDlive Texture - Uses an 
illumination source that can be positioned by the user around the rendered 
3D object on a spherical coordinate. By highlighting structures from the side, 
the three-dimensional impression can be improved considerably. 
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Render 2 Allows you to combine render mode values from render mode 2. 
Render Mode 2 Selections: Surface Smooth, Light, Gradient Light, Transp 
Max, Transp X-ray, Transp. Min., HDlive Smooth. 
Surface Smooth - Surface displays in a smoothed texture mode, which 
means that the gray values of the surface are identical with the gray values of 
the original 2D scan. Light - Surface displays in light mode. Structures in the 
near field are brighter; structures in the far field are darker. Gradient Light - 
Surface displays as if it is illuminated from a spot light source. This is helpful if 
the displayed surface is surrounded by hypoechoic structures (for example, 
liquids). Transp Max. - Displays the maximum intensity of gray values in the 
ROI. This is helpful for viewing bony structures. Transp X-ray - Displays the 
mean value of all gray values in the ROI. Transp Min. - Displays the 
minimum number of gray values in the ROI. This is helpful for viewing vessels 
and hollo4w structures. HDlive Smooth - Smoothed HDlive texture mode. 
When Render 1 value is set to HDlive Texture, the only available mode for 
Render 2 is HDlive Smooth.Note: HDlive rendering is not available if VCI is 
active.

Edit Light Activates the light editor for the virtual light source in HDlive render mode. 
User can position the light source by moving the Trackball, A light icon on the 
main display indicates the direction of the light. Note: The Edit Light
parameter is only available for the HDlive rendering modes. 

Transparency Selections: 20 to 250. Sets the transparency of the image. The higher the 
number, the more transparent the gray scale information.

Table 13-6:  4D (Data Acquisition) Render Parameters (Continued)

4D Parameter Description
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Manipulating the Volume of Interest (VOI)

Imagine you are able to manipulate the 4D volume of interest 
(VOI) in your hand. The 3D/4D ROI is a tangible anatomical 
object that you can see and manipulate easily using the 
Trackball and other control panel keys.

If the monitor display is in Sectional view, select the desired 
reference image before you manipulate the image.

NOTE: The manipulation examples are with A set as the reference 
image.

Rotating the 4D 
VOI Left/Right or 
Forward/Backward

You can rotate the VOI around the X, Y, and Z axes. To rotate 
the VOI around the Z axis, turn the CF control left/right. 

Figure 13-16. Rotate about Z Axis with CF Control
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Manipulating the Volume of Interest (VOI)  (continued)

To rotate the VOI around the Y axis, turn the PW left/right. 

Figure 13-17. Rotate about Y Axis with PW Control

Rotating the 4D 
Image in a Circular 
Motion

To rotate the VOI around the X axis, turn the M control left/right. 

Figure 13-18. Rotate about X Axis with M Control

NOTE: To speed up the rotation, press the PW, CF, or M controls before 
you turn them. To slow down the rotation, press PW or CF again. 
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Manipulating the Volume of Interest (VOI)  (continued)

Moving through 
the VOI

To move through the image to view a particular slice, press 
Depth.

This allows a displacement of the center of rotation along the 
intersection lines of the sectional planes A, B, and C. The 
displacement of the center of rotation leads to the display of 
parallel sectional images. See ‘Reference Images’ on page 13-9 
for more information.

Zooming the 
Image

Rotate Zoom to zoom on the image.

Moving the VOI 
Position

To move the position of the VOI, move the Trackball left, right, 
up and down, as needed.

Resizing the VOI To re-size the VOI, use the Width control panel button. See the 
Width section in this chapter.

Stopping 4D Image Acquisition

To stop acquiring a 4D image, press Freeze or R if you are in 
Render view or just Freeze if you are in Sectional view.

4D VOI Post-Processing

When you press Freeze or R, one of the following Touch Panel 
displays, depending on whether you are in Render view or 
Sectional view.



Advanced Features

13-30 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Volume CINE

The system constantly stores CINE images so you can play 
back and review those images. CINE is useful for focusing on 
images during the specific part of the heart cycle or to view short 
segments of a scan session.

To activate CINE in 4D:

1. Press Freeze.

2. Select the VolCine tab. 

3. If you were in Render visualization mode when you entered 
4D CINE mode; press L to return to Pre-Mode.

If you were in Sectional visualization mode when you 
entered 4D CINE mode; press L to return to Pre-Mode. 

4. To re-start real-time 4D acquisition, press Freeze.

Table 13-7:  4D Cine Parameters

Preset Parameter Description

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one 
loop sequence forward. BiDirectional - plays the sequence forward and 
backward.

First Displays the first volume in the CINE loop. 

Last Displays the last volume in the CINE loop. 

Run/Stop Starts and stops the CINE loop.

Loop Speed Adjusts the CINE loop speed. 

Volume by Volume Used to select an individual volume in the CINE loop. 
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Static 3D

You can create a single sweep, single volume static 3D image.

Performing a Static 3D Scan

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

2. Select a 4D probe from the probe indicator.

3. Obtain a 2D image. Optimize the image as usual.

4. Press 3D/4D.

5. Press Static 3D. Set Visualization to Render. 

6. Set the Volume of Interest (VOI) to be rendered. Use the 
Trackball to move the VOI and Width to re-size the ROI. 

7. Adjust the volume angle. This defines the range of the 
volume sweep. A small sweep angle results in a lower 
number of slices with a high volume rate.

8. Set the probe down on the patient, making sure the probe is 
held steady. Press the L key to start acquisition.

NOTE: During 3D acquisition, no control panel keys are not 
available, except for ‘R.’ 

NOTE: When the 3D acquisition begins, the Touch Panel appears 
blank for a brief moment.

9. Hold the probe steady until the system stops automatically. 
You will know the acquisition has stopped when the Touch 
Panel changes to display the Render Setting, 3D Rotational 
Cine, and Scalpel tabs.

To stop the acquisition manually, press the R key. 

10. Save the image.

11. To further manipulate the 3D image, press Static 3D.

The Touch Panel that displays depends on the visualization 
mode selected prior to freeze, Sectional, Render, TUI or 
VCI.

Static 3D Sectional View

Table 13-8:  3D After Acquisition Parameters - Sectional View

Preset Parameter Description

Orientation Help Displays a 3-dimensional drawing to illustrate the orientation. Only displays in 
sectional view.
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Static 3D Render View

VCI

Introduction

VCI (Volume Contrast Imaging) allows you to sweep smaller 
slices of data with a higher volume rate. The resulting image 
shows an average, integrated gray value of the tissue contained 
within the ROI. VCI improves the contrast resolution and signal/
noise ratio. It also reduces image speckle. This may facilitate 
finding diffuse lesions in organs. 

Touch Panel

The data is represented as in Static 3D - Sectional Planes. 
However, the three planes are VCI renderings (tissue 
information of a thick slice) computed from the 3D dataset. 

Table 13-9:  3D After Acquisition Parameters - Render View - Page 1

Preset Parameter Description

Edit/Accept ROI Selections include Edit, Accept. Edit - Select to adjust the size of the Region 
of Interest (ROI). Accept - accepts the active 3D image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 
Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 

Table 13-10:  VCI View

Preset Parameter Description

Slice Thickness Select the slice thickness
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Static 3D Color

To view Static 3D Color, 

1. Acquire the anatomy you want to view in B-Mode. 

2. Activate Color Flow or PDI. 

3. Activate 3D/4D. The Pre-3D displays. Select the desired 
Visualization. 

NOTE: 4D cannot be selected from Pre-Mode with Color active.

4. Press ‘L’ to render the image. 

The color is rendered. You can adjust the Render Mode (default 
is Glass Body): 

• Gray. Gray, no color. 

Figure 13-19. 3D Color - Gray

• Inversion. Inverts the grayscale. 



Advanced Features

13-34 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Static 3D Color  (continued)

• Color. Displays Color-Flow. 

Select the rendering method ([Rend Color1] (Surface only) 
or [Rend Color2]) and the mixing ratio.

Figure 13-20. 3D Color - Color

• Glass Body. Displays both Color-Flow and B-Mode. 

Select the rendering method ([Rend Gray] or [Rend Color]) 
and the mixing ratio.

Figure 13-21. 3D Color - Glass Body

To hide the color on the sectional planes, select Color Off from 
the Touch Panel. 

NOTE: If you scan in Render mode and select Tile as Quad, you can 
hide the color with the Color Off Touch Panel key.
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Volume Review

You can post process VOI (the entire volume of interest) and 
scroll through acquisition planes via Volume Review. This allows 
you to review all of the frames within this volume set. 

In Volume Review, start in Run/Stop so that every frame in the 
volume is displayed. 

NOTE: If you adjust the screen while in Volume Review, these changes 
ARE NOT reflected on the Static 3D volume. 

Scalpel

Scalpel allows you to edit/cut sections of a 3D image. Scalpel is 
available only on a rendered image.

1. Press Scalpel.

Table 13-11:  Scalpel Parameters

Preset Parameter Description

Cut Mode Selections: Inside Contour, Outside Contour, Inside Box, Outside Box, Eraser 
Big, Eraser Small. Inside Contour, Outside Contour - Allows you to trace 
the portion of the image you want to cut. Trace Outside removes all portions 
of the image that fall outside your traced region. Trace Inside removes all 
portions of the image that fall inside your traced region. Inside Box, Outside 
Box - Displays a box you can use to define the portion of the image you want 
to cut. Outside Box removes all portions of the image that fall outside the box. 
Inside Box removes all portions of the image that fall inside the box. Eraser
Big, Eraser Small - Provides a big and small eraser tool you can use to 
define the portion of the image to cut by hand. Available only if Depth is Full.

Cut Depth Selections: Full, Define. Full -The entire depth of the selected region will be 
cut.   Define - Allows you to define the depth to cut using the Depth control 
panel knob.

Undo Last Undoes the last cut only.

Redo Select to redo scalpel.

Undo All Undoes all cuts since you entered Scalpel mode.

Done Applies to User Defined Cut Depth when complete. 
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Scalpel  (continued)

2. Select the cut mode.

3. Use the Trackball and Set key to define the portion of the 
image to cut. Press Set to start, move the Trackball to 
define the region, then press Set again to cut the image. 
The portion is removed.

To undo the last cut, select Undo Last.

To undo all cuts in the current session, select Undo All.

NOTE: With the cut image displayed, if you attempt to switch to the 
Static 3D tab to edit the ROI, the following warning message 
appears: Scalpel changes will be lost. Do you want to continue? 
[Yes/No]. 
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3D Rotation CINE

3D Rotation CINE allows you to view the 3D image from various 
angles.

To activate rotation CINE in 3D:

1. Press Freeze.

2. Select the 3DRot Cine tab. 

Table 13-12:  3D Rotation Cine Parameters 

Preset Parameter Description

Rotational Angle Sets the rotational angle of the 3D image over which the CINE loop is played. 
Typical values are 30, 45, 60, 90, 180 and 360 degrees.

Step Angle Sets the step angle between individual frames in the CINE loop. 

Rotation Axis Sets the axis about which the CINE loop is calculated. Selections X and Y.

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one 
loop sequence forward. BiDirectional - plays the sequence forward and 
backward.

First Displays the first volume in the CINE. 

Last Displays the last volume in the CINE. 

Run/Stop Starts and stops the CINE sequence.

Start Angle Used to select the starting angle in the CINE loop range. The default Start 
Image is calculated from the rotational angle as:   -1 X Rotational angle / 2 If 
you adjust the Start Image, the Rotational Angle is re-set to be the value of 
the adjusted Start Image.

End Angle Used to select the ending angle in the CINE loop range. The default End 
Image is calculated from the rotational angle as:   Rotational angle / 2 If you 
adjust the End Image, the Rotational Angle is re-set to be the value of the 
adjusted End Image.

Image by Image Used to select an individual image in the CINE loop. 
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VOCAL

You use VOCAL (Virtual Organ Computer-aided Analysis) to 
visualize and calculate the volume of anatomical structures, 
such as a tumor lesion, cysts, and the prostate. VOCAL is 
available after a Static 3D or Real-Time 4D acquisition. 

1. Press Vocal. Specify the volume calculation method 
(Manual, Contour Detect, SemiAuto Detect, or Sphere).
Select the reference image you want to use to perform the 
trace by selecting Ref Image A, B, or C. Press Start.

2. Trace the anatomy using the Trackball. Press Set to start 
and end the trace. You must go across the dotted line for the 
trace to take effect (it turns yellow). The trace is performed 
on each image slice, separated by the rotational step angle. 
Rotate the Rot. Ref dial until you have completed the total 
of the required rotations (for example, if you’ve selected 30 
degrees, you need to complete six traces if you’ve selected 
Manual). After you’ve completed the trace target, the Calc
Volume button is active for you to press. The calculated 
VOCAL image appears in the lower, right-hand corner of the 
display. You are now in the edit state. 

NOTE: Trace not used for Sphere. For Sphere, set the Poles. 

3. Edit as necessary. You can apply a shell, adjust its 
thickness, navigate through the reference angles, or restart 
the VOCAL. 

VOCAL Touch Panel states are described in the following tables. 

Table 13-13:  VOCAL Parameters on Setup Touch Panel

Parameter Description

Manual When you select the Manual method, you need to perform a manual trace on 
each of the rotation angles. 

Contour Detect When you select the Contour Detect method, you need to perform a manual 
trace on each of the rotation angles. 

SemiAuto Detect When you select the Semi Automatic Detect method, you need to perform a 
trace on only two rotation angles. The system applies an algorithm to define 
the traces. 

Structure Structure is only available with the SemiAuto Detect method. Select Hypo, 
Cystic, or Hyper/Iso. 

Sphere Calculates the volume based on the pole settings. 

Pole 1 Adjust the upper contour point (green arrow) of the structure. 

Pole 2 Adjust the lower contour point (green arrow) of the structure.
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The Shell Modes allows you to construct a shell or contour 
“around” the structure of interest, which enables you to 
distinguish between the contour of the targeted structure and 
the contours the inside and outside of the structure.

Rotational Step Angle Specify the angular spacing between contour traces. Typical values are 6, 9, 
15, and 30 degrees. The number of planes varies by this formula: 180 
degrees / selected rotational step angle. 

Ref Image Use this to select the image you want to use to perform the trace. 

Start Press Start when you’re ready to perform the trace. 

Rot.Ref #/#    Back/Next Select Next/Back to move to the next image for contour definition in the 
rotation step. 

Table 13-14:  VOCAL Calculate Volume Touch Panel

Parameter Description

Calc Volume Press Calc Volume to initiate the VOCAL image calculation. 

Clear Press Clear to remove the trace from the image. 

Restart Vocal Press Restart Vocal to return to the initial VOCAL state. 

Table 13-13:  VOCAL Parameters on Setup Touch Panel (Continued)

Parameter Description

Table 13-15:  VOCAL Parameters on Edit Touch Panel

Parameter Description

Shell Off Select Shell Off if you do not want a shell around the VOCAL image. 

Inside Select Inside if you want a shell inside the volume. 

Outside Select Outside if you want a shell outside the volume. 

Symmetric Select Symmetric if you want half of the shell thickness inside and half 
outside the volume’s perimeter. 

Shell Thickness Adjust to vary the thickness of the shell. 
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Static 3D Render Setting

Static 3D Volume Review

You can post process VOI (the entire volume of interest) and 
scroll through acquisition planes via Volume Review. This allows 
you to review all of the frames within this volume set. 

In Volume Review, start in Run/Stop so that every frame in the 
volume is displayed. 

NOTE: If you adjust the screen while in Volume Review, these changes 
ARE NOT reflected on the Static 3D volume. 

Storing 4D Images

You store 4D images exactly as you would your 2D images. 
Because 4D images contain more data, they also require more 
space. Pay close attention to the size of the volumes.

• Still image: Store as Raw Data

• CINE: Store as Raw Data when “Enhanced DICOM” is 
selected for printing 4D. 

Table 13-16:  3D After Acquisition Parameters - Render View - Page 1

Preset Parameter Description

Edit/Accept ROI Selections include Edit, Accept. Edit - Select to adjust the size of the Region 
of Interest (ROI). Accept - accepts the active 3D image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 
Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 
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Tomographic Ultrasound Imaging (TUI) 

Tomographic Ultrasound Imaging (TUI) is a visualization mode 
which presents data as parallel slices (planes) through the 
dataset. This method of visualization is consistent with CT and 
MRI. The distance between the different planes can be adjusted.   

1. Select TUI as the Visualization mode. 

2. Press ‘L’ to start acquisition. 

3. If in 4D, press ‘R’ to end the acquisition. This step is not 
required in Static 3D.

The reference image + the number of specified slices 
appears. The reference image always displays and 
indicates which slices you are currently viewing as solid 
lines.
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Tomographic Ultrasound Imaging (TUI)  (continued)

Figure 13-22. TUI 3x3 Example

a. The TUI reference image that shows the slice position. 
This image is orthogonal to the reference image.

b. The number and green asterisk shows the position of 
each slice. A green asterisk indicates the center image 
(A, B or C-plane).

c. Slice distance displays when the slices are in certain 
intervals.

d. A solid line indicates the slice appears on the monitor.

A dotted line indicates the slice did not appear on the 
monitor.

NOTE: TUI with Color is only available with Static 3D, not with 4D. 
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Tomographic Ultrasound Imaging (TUI)  (continued)

4. Adjust the number of slices and slice distance.

You can adjust the number of slices by using the Slices
rotary. You can adjust the distance between the slices using 
the Slice Distance rotary. Max value is 40mm.

• Move forward/backward through the slices via Prev./
Next Slice.

• Change the center image via Ref. Image if needed 
(Reference image A, B or C).

• Select Display Format from 1X1, 1X2, 2X2 and 3X3.

• The following features are supported in TUI: Zoom, 
Rotation (X/Y/Z), Trackball (Move the position), 
Translation and Gain.

• To hide the color, select Color Off from the Touch 
Panel.
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Tomographic Ultrasound Imaging (TUI)  (continued)

You can adjust each slice position with Adjust Slices.

1. Press Adjust Slices on the Touch Panel.

2. The pointer displays. Select a slice by using the Trackball.

Figure 13-23. Adjust Slice screen (example)

a. Selected slice displays with yellow border

b. Distance from the center image

• Adjust the slice distance from the reference image by 
using Slice Position. Slice Position only affects the 
selected slice. 

NOTE: If you place the pointer on the reference image and 
rotate Slice Position, the position of the reference 
image and all slices are moved.

• Adjust the number of right and left slices off the center 
image by using Left Slices or Right Slices.

3. After the adjustment is finished, press Set. The slice is 
marked with an “X”. To print this slice, press a print key. 
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SonoRenderlive

SonoRenderlive helps to find the render start position to easily 
separate solid tissue in front of the render object.

The SonoRenderlive algorithm “looks” for the transition from 
solid to liquid tissue and positions the “Render Start” into the 
liquid area visualized by the green render start line. The render 
start line is not a straight line but a “free” trace for optimal 
adaptation to the render object.

 Figure 13-24. Screen Display Off
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SonoRenderlive  (continued)

 Figure 13-25. Screen Display On

Using SonoRenderlive

1. Start the Render Visualization Mode.

2. Press the SonoRenderlive Rotary control.

3. To adjust the distance between the render start position and 
the render object, rotate the Sensitivity control below the 
Touch Panel. A high value indicates a smaller distance.

NOTE: If SonoRenderlive is not used, the Render Start line can also be 
modified manually. Press the trackball button Curve to activate 
Curved Render Start and move the trackball to modify the line.
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OmniView

OmniView provides an arbitrary cross-sectional plane, as 
opposed to a strict coronal plane. In VCI OmniView, the 
rendering box is very thin so you can visualize the tissue 
information of a thick slice. The resulting image shows the 
average (integrated) gray value of the tissue contained within 
the narrow box. 

VCI OmniView improves the contrast resolution and the signal/
noise ratio and therefore facilitates the detection of diffuse 
lesions in organs. The result is an image with no speckle pattern 
and a highly improved tissue contrast.

• 4D Real Time

• 3D Static

• STIC
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OmniView Workflow

1. Press 3D/4D.

2. Select OmniView.

3. Adjust Volume Angle and B Quality as necessary.

4. Press the right Set key to start acquisition.

The volume acquisition starts and the acquired images are 
displayed.

5. The cross cursor displays on the reference image. 

6. Select the appropriate trace mode to display the sectional 
plane. 

• Line: Select the sectional image by using straight line. 

• Curve: Select the sectional image by using curved line. 

Move the cursor to the start point and press Set. Move 
the cursor to the end point and press Set. Use the 
Trackball to make a curved line and press Set.

• Trace: Select the sectional image by using any arbitrary 
curve.

• Polyline: Select the sectional image by using a 
continuous line composed of one or more line 
segments. You can create a polyline by specifying the 
endpoints of each segment by press Set.
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OmniView Main Menu

Table 13-17:  OmniView Parameters on Edit Touch Panel

Parameter Description

View Icon Show or hide the OmniView Icon.

View Line Show or hide the OmniView Line.

VCI OmniView Switch to VCI Omniview.

Trace Mode Four tracking line methods are available.

Tile Select a display format (Single, Dual, Quad)

Clear All All existing lines are deleted and a new line entry is started.

Ref. OmniV To activate OmniView Ref. Line view.

Ref. Image Select the Reference image.

OmniV. Rot Rotates the OmniView line.

Undo To re-adjust the traced line.

Mix Selections: 0-100% in increments of 2. Allows you to mix a Rend Mode 1 
mode with a Rend Mode 2 mode. Always select two modes. 

Slice Thickness Select the slice thickness
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OmniView Control

Figure 13-26. OmniView Control

Table 13-18:  OmniView Parameters on Line Edit Mode: New

Parameter Description

Img. Activate the image.

Redo Restart the line.

OmniView Activate OmniView Line

View# Select the next OmniView image and line as 1, 2, or 3. 

Next Select to activate the next OmniView Ref. Line view.
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STIC (Spatio-Temporal Image Correlation) 

Overview

With this acquisition method the fetal heart or vascularity can be 
visualized. It is not a Real Time 4D technique, but a post 
processed 3D acquisition.

STIC is designed for beating (fetal heart) as well as blood 
perfused organs. Only STIC can synchronize structures that 
have a pulsation in Doppler mode, but no visible pulsation in 
B-Mode.

Data is acquired for a predefined period of time. The acquired 
images are post processed to calculate a Volume Cine 
sequence representing one complete heart cycle.

In order to achieve a good result, try to adjust the size of the 
volume box and the sweep angle to be as small as possible. The 
longer the acquisition time, the better the spatial resolution will 
be. The user must be sure that there is minimal movement of the 
participating persons (e.g., mother and fetus), and that the probe 
is held absolutely still throughout the acquisition period. 
Movement will cause a failure of the acquisition. If the user 
(trained operator) clearly recognizes a disturbance during the 
acquisition period, the acquisition has to be canceled.

A good STIC data set shows a regular and synchronous beating 
of the fetal heart or of an artery. Please make sure that the 
borders of the fetal heart or the artery are smooth and there are 
no sudden discontinuities. Always adopt a critical attitude to 
images created in STIC mode.

If the expected frame rate is too low (10Hz) for a good STIC 
quality, a warning is displayed in STIC mode.

After the STIC acquisition is finished the calculation process 
starts to calculate the volume cine sequence. If a result is 
detected by the system, the Volume cine sequence is shown in 
run mode and the STIC accept menu appears. As soon as the 
result is accepted the system releases the volume cine mode. If 
the result is not accepted but canceled, the system switches 
back to STIC pre mode.
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Overview  (continued)

One or more of the following artefacts in the data set indicate a 
disturbance during acquisition:

• Sudden discontinuities in the reference image B: These are 
due to the motion of the mother, the fetus or fetal arrhythmia 
during acquisition.

• Sudden discontinuities in the color display: Motion of the 
mother, the fetus or fetal arrhythmia affects the color flow in 
the same way it affects the gray image.

• Fetal heart rate far too low or far too high: After acquisition 
the estimated fetal heart rate is displayed. If the value does 
not correspond to the estimations based on other diagnostic 
methods at all, the acquisition failed and has to be repeated.

• Asynchronous movement in different parts of the image: 
e.g., the left part of the image is contracting and the right 
part is expanding at the same time.

• The color does not fit the structures displayed in gray mode: 
The color is displayed above or below the actual vessel.

• Color “moves” through the image in a certain direction: This 
artefact is caused by a failure in detecting the heart rate due 
to low acquisition frame rate. Use higher acquisition frame 
rate for better result.

NOTE: In all of the above cases the data set has to be discarded and 
the acquisition has to be repeated.

When is it not allowed to perform the STIC fetal cardio 
acquisition?

• Severe fetal arrhythmia

Following STIC acquisition modes are available:

• STIC

• STIC CFM

• STIC PDI
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Performing STIC Scan

NOTE: STIC can only be used in OB applications.

1. Select a 4D probe from the probe indicator.

2. After obtaining a feasible 2D image of the fetal heart or an 
artery, press 3D/4D to activate the Volume mode.

3. Select STIC.

4. Set the Volume of Interest (VOI) to be rendered. Use the 
Trackball to move and resize the VOI.

NOTE: Press top Trackball key to switch Pos and Size.

5. Adjust the Acquisition Time.

6. Set the volume sweep angle by using Volume Angle.

NOTE: In order to acquire a good result, try to adjust the ROI and 
the sweep angle to be as small as possible. The longer the 
acquisition time, the better the spatial resolution will be.

7. Hold the probe still and ask the patient not to move.

8. Press the right Set key to start the acquisition.

NOTE: When the STIC acquisition begins, the Stop Acquisition 
button appears. If the user recognizes a movement of the 
probe, fetus or the patient during the scan, press Stop 
acquisition to cancel the acquisition.

9. Hold the probe steady until the system stops automatically. 
Estimated Fetal Heart Rate and Accept/Cancel buttons 
appears on the Touch Panel.

10. Press Accept if the fetal heart rate displayed on the Touch 
Panel is accepted. STIC image is displayed.

If the result is not accepted, select Cancel. The system 
switches back to STIC-pre mode.

NOTE: If the user (trained operator) clearly recognizes a 
disturbance during the acquisition period, the acquisition 
has to be canceled.
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Screen Layout

The yellow caution icon and the calculated heart rate are 
displayed as well.

NOTE: Displayed Heart Rate indicates the heart rate [B/min] calculated 
from the delta time length per beat. A yellow caution icon 
indicates that the displayed heart rate is only an estimation. Do 
not diagnose based on this value.

 Figure 13-27. Screen Layout

STIC Controls

Touch Panel/All hard key and trackball controls are the same as 
in 4D/Static 3D mode. Therefore only the STIC relevant controls 
are described here:

Table 13-19:  STIC Pre-mode Touch Panel

Relevant controls Description

Acq. Time Only available in STIC. Acquisition time can be set.

Volume Angle Adjusts the volume angle.
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Contrast Imaging

Overview

NOTE: The LOGIQ Totus is designed for compatibility with most 
commercially available Ultrasound contrast agents. Because the 
availability of these agents is subject to government regulation 
and approval, product features intended for use with these 
agents may not be commercially marketed nor made available 
before the contrast agent is cleared for use. Contrast-related 
product features are enabled only on systems for delivery to an 
authorized country or region of use. 

WARNING Misdiagnosis based on image artifacts

Misdiagnosis in ultrasound contrast images may be caused by 
several artifacts, most importantly:

Motion artifacts: Give rise to signals independent of contrast 
presence. This may be caused by patient movement (including 
respiration) or by probe movement influenced by the operator.

Regional drop outs: Caused by unintentional destruction of 
the contrast agent, too low concentration of contrast agent, 
poor acoustic penetration due to rib/lung shadows or the 
system failing to detect the contrast agent due to erroneous 
settings induced by the operator.

Tissue harmonics: Creates contrast-like signals 
independently of the presence of contrast agent.

CAUTION
Cardiac rhythm disturbances during cardiac perfusion studies 
using gas ultrasound contrast agents have been observed in 
the diagnostic range of Mechanical Index (MI) values. See the 
specific package insert for the contrast agent being used for 
details.
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CAUTION
Read and follow contrast agent instructions provided by the 
manufacturer.
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Contrast Imaging Overview

By adjusting the acoustic output, you can enhance either 
contrast harmonics or stimulated acoustic emission (SAE).   

See Chapter 11 for probe availability. 

Coded Contrast Imaging utilizes three technologies: Amplitude 
Modulation (AM), Phase Inversion (PI), and Coded Harmonic 
Angio (CHA). 

• Contrast: Amplitude Modulation and Phase Inversion (AM 
and PI) is included in the Contrast option. 

Benefits The contract imaging technique, facilitated by the use of a 
contrast agent, detects non-linear signals while suppressing 
linear signals from surround tissue. Blood containing the 
contrast agent stands out brightly against a dark background of 
normal tissue.

Clinical Use Possible clinical uses are to detect and characterize tumors of 
the liver, kidney, and pancreas and to enhance flow signals in 
the determination of stenosis or thrombus. 

Table 13-20:  Available Contrast Display Settings

 Label Description Clinical Use

Low MI B--Single Low MI B-Mode 
image display mode

Find the tumor before/after 
contrast agent injection

Tumor detection and 
characterization

Contrast Only—single contrast 
image display mode

Use contrast agent nonlinearity to 
detect contrast agent signal. 

Tumor detection and 
characterization

Single View--Single Contrast 
enhanced image display with low 
MI B-Mode image data 
acquisition mode

Use contrast agent nonlinearity to 
detect contrast agent signal. 

Tumor detection and 
characterization

Dual View—Real-time 
side-by-side dual image display 
with the right side contrast image 
and the left side B-Mode 
reference image

Use contrast agent nonlinearity to 
detect contrast agent signal. 

Tumor detection and 
characterization
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Contrast Imaging Overview  (continued)

Affect on other 
controls

The default acoustic output adjusts for contrast imaging and the 
Power Output key provides more subtle gradations for use while 
in contrast imaging. When you exit Contrast Imaging, the 
system returns the acoustic output to its original setting. When 
you reactivate Contrast Imaging, the system enters the default 
Contrast Mode. 

Most system controls are available (Depth, Zoom, Colorize, 
etc.). However, some controls are not available (Anatomical M 
Mode, Rejection, and Suppression). 

Controls adjusted while in Contrast Imaging retain these values 
when you exit Contrast Imaging (except for post-processing 
controls). 

Bioeffect Activating Contrast Imaging may change the TI and/or MI. 
Observe the output display for possible effects. 

The Power Output key has been enhanced to provide more 
subtle gradations for use while contrast imaging. The 
Mechanical Index displays values less than 0.1. These values 
are displayed on CINE Loops and on archived images. 

Feature 
Availability

3D and Volume Navigation are available; Multi Image and 
LOGIQView are not available. 

Technique 
Availability by 
Probe

Use the table in Chapter 11 to determine which contrast 
technique is available by probe. 
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Mode

Reference Mode

Reference (Ref) Mode is to image the anatomical reference, not 
the contrast enhancement.

Contrast Mode

There are several contrast imaging techniques. Note that the 
appropriate imaging technique may vary by agent and 
application. In other words, the imaging technique is not 
dedicated for the agent and vice versa.

Contrast MVI Mode

Contrast MVI uses MVI (Micro Vascular Imaging) in Contrast 
mode. The characteristics of MVI's higher sensitivity and higher 
spatial resolution can be used in Contrast Imaging.

In addition to the MVI features, Flash, Flash + Capture, Max 
Enhance, and Contrast Clock can be used.

The choice of AM, PI, CHA mode in Contrast is not in Contrast 
MVI.

Support probes: C1-6-D, C1-6VN-D, 9L-D, L3-12-D and 
ML6-15-D.
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Contrast Presets

You access the Contrast Imaging Presets via Utility -> 
Imaging -> Ref or Con tabs. 

Target MI

Description Target MI control provides automated adjustment of the acoustic 
output to keep a specified Target value to reduce an unexpected 
change in MI during a contrast exam.

Target MI control can be preset in the Utility -> Imaging -> CON 
and Ref.

NOTE: The value of Target MI for Reference Image is adjustable on Ref 
tab, only when Ref-Only mode.

Time Delay To set the Trigger time delay, press the down arrow next to Time 
Delay.

Dual View To set the default contrast mode, press the down arrow next to 
Default Mode on Con tab to select the mode.   

Additional Presets To adjust other Contrast Imaging presets (Map, Frame Average, 
etc.), press the down arrow to adjust the setting. 

Sonazoid™ Contrast Agent

Sonazoid™ is a contrast agent approved in some countries. 
Refer to local clearances and availability in your respective 
market(s).

Sonazoid is a different microbubble, compared to other agents. 
You can select the Sonazoid contrast agent via Utility--> 
Imaging--> CON. 
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Contrast Controls

Max (Maximum) Enhance

Description Sets the acoustic output to its maximum setting (100%)

Values On/Off. When you deactivate Max Enhance, the acoustic output 
is returned to its previous setting. Max Enhance is deactivated 
by the system when you turn it off, change probes, or change 
the contrast technique. 

Benefits This control provides quick transition to High MI imaging. This 
allows the user a quick one-button push to destroy the agent. 
Useful when the user is interested in the bubble wash-in 
characteristics of the anatomy being scanned. 
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Contrast Clock (Timer)

Description You can use the Contrast Clock by activating it at the time of 
injection and deactivating it at the end of the exam.

Two timers, Contrast Clock1 and Contrast Clock2 can be 
displayed on the bottom, left-hand corner in the image area and 
info area for several injections. 

NOTE: You can also configure the system to perform a countdown for 
the contrast injection with the Utility -> System -> System 
Imaging -> Countdown Time for Contrast preset.

Values On/Off. You deactivate the Contrast Clock via the Touch Panel 
control or by starting a new patient. 

Display There are two areas on the screen where the Contrast Clock 
displays: on the image and on the lower, left-hand portion of the 
display. The timer on the image freezes when you freeze the 
image (the timer updates when you unfreeze the image). 
However, the timer located on the lower, left-hand portion of the 
display continues to display over a freeze, probe change, mode 
change, multi image, and zoom. 

The timer also appears on CINE Loops and archived images. 

Benefits The Contrast Clock measures the time since injection. 

You can save the data of contrast clock to an external file by 
using Export Traces of TIC.

1. Press Freeze. Scroll with the Trackball to show Cine tab.

2. Press TIC Analysis on the Touch Panel to enter TIC 
application.

3. Put a ROI on the image.

4. Press Export Traces. Type the file name and store it to the 
storage device.
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Accumulation

Description Accumulation enhances the flow in an image. 

Values 8 settings: 0=Off, 0.2, 0.4, 0.6, 0.8, 1.6, 3.2, and Infinite. 

If Accumulation is turned off, then Frame Averaging is used; if 
Accumulation value is set, then Accumulation is used. 

Availability Available in Contrast, Color Flow, and PDI. 

Benefit Accumulation detects the maximum signal and holds it for the 
level specified (1-7). 

SRI Usage

Description You can use SRI-HD for the tissue image and the contrast 
image independently or together. 

Adjusting You can preset SRI Usage in Utility -> Imaging -> Ref tab. 

Visualization

Description Define the display technique. Only available for Single View or 
Dual View.

Values Contrast. Displays the contrast-enhanced image. 

Tissue. Displays the tissue image. 

Hybrid Contrast. Displays the contrast-enhanced image and 
the tissue image using Hybrid Map. 
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Hybrid Map

Description Select the hybrid map for the Hybrid Contrast visualization in the 
Dual/Hybrid Display.

Flash

Description This feature provides a way to expose the higher acoustic power 
for a specified time duration by pressing a control once. 

NOTE: Set the frame numbers to scanned with the higher acoustic 
power in Utility--> Imaging--> Con--> Flash Frames. The frame 
numbers defined by Flash Frames are applied to both the 
contrast imaging modes. 

• If you select Flash once in the Con menus, the system 
scans with 100% acoustic output burst pulses for the 
specified number of frames. The acoustic output then 
reverts to the original settings.

• When Max Enhance is ON for the contrast imaging modes, 
the system keeps Max Enhance = ON with no acoustic 
output change when Flash is selected in the Con menu.
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Relationship with other controls

• L + R Simultaneous Display (L: Tissue, R: Active 
Visualization)

• Accumulation/Cine Capture

- Applied on the right side image only.

- You cannot compare On and Off image using L + R.

• SRI-HD

- Applied on both side image.

• Frame Average

- Applied on both side image.

• TIC

• Measured on a recalled CINE, except “Hybrid Contrast”.

• “Hybrid Contrast” is disabled and measured on 
“Contrast” visualization.

• Easy 3D

• Build volume data from active visualization, except 
“Hybrid Contrast”.

• Hybrid map is disabled and forces “Contrast” 
visualization.

• Advanced 3D/Tru3D

• Build volume data from active visualization.

• For the Single/Dual View data set of contrast mode, 
both reference and contrast data are rendered in 
individual volume segments. Each volume data is 
manipulated using Active Data and Visual Data.

• 3D

• Hybrid Map is disabled and forces “Contrast” 
visualization.

• The Cine frames have “Contrast” data only.

• Archive

• The raw data size increases between two to three times 
the size compared to the previous raw data. It takes a 
longer period of time to save as Cine.
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Static 3D with Contrast 

Static 3D is available while in Contrast imaging mode while 
imaging with 4D probes. 

1. Activate Contrast imaging. 

2. Adjust the image, as necessary. 

3. Activate the Contrast Clock (if you want the acoustic output 
set at 100%). Or, you can activate these when you inject the 
contrast agent. 

NOTE: To restart the Contrast Clock, you need to turn it off, then 
back on. 

4. Activate 3D--> Static 3D. Specify the quality, angle, and 
render mode (Sectional, Render, and VCI Static are 
supported). 

Wait to inject the contrast agent until after you have set up 
your pre-mode data. Adjust the ROI and other parameters 
before injecting the agent. 

NOTE: Accumulation and Trigger turns off or resets to 0 when you 
activate Pre-mode.

5. Activate the Contrast Clock and inject the contrast agent, 
then press the Start Key to activate the Static 3D acquisition 
as soon as the contrast agent washes in. 

The system automatically ‘stores’ the sweep (to internal 
memory, not to the clipboard). 

NOTE: You may want to set up a Fast Key to automate these 
keystrokes. See Chapter 6 for more information. 
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Static 3D with Contrast  (continued)

6. To store this VOI, press a print key. All CINE and volume 
data loops are saved in 3D when you press P1. Store loops 
from Static 3D or from the Volume Review tab in order to 
store the complete volume. 

NOTE: You can also configure the system to perform a count down 
for the contrast injection via Utility-->System-->System 
Imaging. 

7. At the completion of the sweep, the Static 3D tab appears. 

NOTE: The Contrast Timer on the Volume Review images 
represents a timestamp of when the image was captured 
relative to when the timer was started. 

8. Press the Start key to acquire volume data. 
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Time Intensity Curve (TIC) Analysis

Overview

Time Intensity Curve (TIC) enables the user to perform the 
following analysis:

• Time-Intensity analysis allows instant time-intensity 
calculation from up to eight regions of interest.

• Curve fitting analysis for research studies of contrast agent 
concentration rates.

The basic TIC process works as follows:

1. Scan the patient after injecting the contrast agent.

2. Observe the agent flow through the anatomy of interest.

3. When the desired contrast effect has been visualized, 
freeze the image and select a range of images for analysis.

4. Position an ROI (region of interest) on one of those images 
where the contrast effect is visible.

5. The system then calculates the mean pixel intensity within 
that ROI for all frames in the user designated loop and plots 
the resulting data as a function of time.

You can also choose to fit this data to one of several 
mathematical functions. The fundamental idea is that the 
contrast effect flowing through the organ of interest can be 
modeled mathematically, and details of the wash in and washout 
of the agent can be gleaned by analyzing the numerical 
parameters of the mathematical model.
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Activating TIC

Starting TIC in cine loop

1. Open an examination and select a contrast cineloop.

2. Select TIC Analysis on the Touch Panel.

Starting TIC in live mode

1. Scan and freeze the patient in Contrast live mode.

2. Move the trackball to activate Cine.

3. Select TIC Analysis on the Touch Panel.

Exiting TIC Analysis

There are several methods to exit TIC Analysis.

• Select Exit TIC Analysis on the TIC Touch Panel.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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TIC Analysis Screen Description

 Figure 13-28. TIC Analysis Screen - Graph with dual image layout (example) 

1. Contrast cineloop window
2. B-Mode cineloop window
3. Analysis window
4. Sample area

5. Time and velocity at cursor position
6. Sample area tools
7. Layout icons
8. Frame marker

Table 13-21:  Cineloop windows 

 Graphic Description

Displays Contrast image data
Sample area:
Indicates sampling position of the intensity trace. The sample 
area is color-coded: the first sample area is yellow, the 
second blue...etc.
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Displays B-Mode data
Sample area:
Indicates sampling position of the intensity trace. The sample 
area is color-coded: the first sample area is yellow, the 
second blue...etc.
NOTE: B-Mode image is not displayed when cine clip stored 
in contrast only mode.

System menu on Sample Area
This menu is displayed by pressing the left Set key when the 
cursor is placed over a sample area in one of the Cineloop 
windows.
Note: The system menu is dependent on mode.
• Set As Default ROI Size: Displays on elliptical ROI.
• Label Sample Area: Sets a descriptive name to the sample 

area. The label is useful for identification of the sample area 
when exporting data.

• Delete Anchor (On ROI setting as anchor point only)
• Copy Sample Area
• Copy & Move
• Copy & Move (Same Depth)
• Move (Same Depth)
• Set Start Frame: Set start frame for current ROI to calculate 

the TIC parameters and fitting curves.
• Set End Frame: Set end frame for current ROI to calculate 

the TIC parameters and fitting curves.
• Cancel: exits the System menu.
System menu on Image when copy sample area is selected. 
• Paste Sample Area

Displays time-intensity curve.
• Y axis: Intensity scale (logarithmic) (db) or linear acoustic 

units (AU).
• X axis: Time(s) or Dt(s), elapsed time from previous frame. 
• ECG (where available -- not shown): displays ECG trace 

(where available).
• Frame Marker: the current frame marker and the start and 

stop markers for the cineloop.
• Time at cursor position and velocity at cursor position.
• Intensity (dB or AU) at cursor position.
• Intensity (dB or AU) at frame marker position (color coded)

Table 13-21:  Cineloop windows  (Continued)

 Graphic Description
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System menu of the analysis window
This menu is displayed by pressing left Set key when the 
cursor is in the Analysis window.
Note: The system menu is dependent on mode.
• Vertical Auto-Scaling: selects between full unit range or a 

range according to the maximum and minimum values of 
the displayed trace(s). Delayed, On, Off.

• Vertical Unit: toggles between logarithmic (dB) and linear 
acoustical units (AU). Vertical unit of previous analysis is 
retained. 

• Horizontal scale: Only on a loop including different frame 
rate.

• Line Style: selects between solid line only or solid line with 
square markers at each data point.

• TIC Parameters: The TIC parameters dialog appears.
• Curve Fitting Parameters: toggles between Wash-in, 

Wash-out, Gamma Variate and off.
• Gradient: On or Off.
• Gradient Plot: Gradient, Gradient Derivative, All or Off (On 

Graph with Dual Image Layout and Small Data Layout only).
• ECG Triggering: Only on a loop including the ECG cycle.
• Cancel: exits the System menu.

Table 13-22:  Analysis windows 

 Graphic Description

Displays time-intensity curve.
• Y axis: Intensity scale (logarithmic) (db) or linear acoustic 

units (AU).
• X axis: Time(s) or Dt(s) [Diastolic time in seconds], elapsed 

time from previous frame. 
• ECG (where available -- not shown): displays ECG trace 

(where available).
• Frame Marker: the current frame marker and the start and 

stop markers for the cineloop.
• Time at cursor position and velocity at cursor position.
• Intensity (dB or AU) at cursor position.
• Intensity (dB or AU) at frame marker position (color coded)

Table 13-21:  Cineloop windows  (Continued)

 Graphic Description
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System menu of the analysis window
This menu is displayed by pressing left Set key when the 
cursor is in the Analysis window.
Note: The system menu is dependent on mode.
• Vertical Auto-Scaling: selects between full unit range or a 

range according to the maximum and minimum values of 
the displayed trace(s). Delayed, On, Off.

• Vertical Unit: toggles between logarithmic (dB) and linear 
acoustical units (AU). Vertical unit of previous analysis is 
retained. 

• Horizontal scale: Only on a loop including different frame 
rate.

• Line Style: selects between solid line only or solid line with 
square markers at each data point.

• TIC Parameters: The TIC parameters dialog appears.
• Curve Fitting Parameters: toggles between Wash-in, 

Wash-out, Gamma Variate and off.
• Gradient: On or Off.
• Gradient Plot: Gradient, Gradient Derivative, All or Off (On 

Graph with Dual Image Layout and Small Data Layout only).
• ECG Triggering: Only on a loop including the ECG cycle.
• Cancel: exits the System menu.

Table 13-23:  Layout icon 

 Graphic Description

You can select layout from following.
• Graph with Dual Image Layout
• Small Data Layout
• Large Data Layout
• Everything Layout
• Single Image Layout
• Dual Image Layout

Indicates an analysis graph.

Indicates an image
One icon means Contrast image. Two icons mean Contrast 
and B-Mode.

Indicates parameters.
10 dots means that all parameters display. 4 dots means that 
only displays high level parameters.

Table 13-22:  Analysis windows  (Continued)

 Graphic Description
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Table 13-24:  Sample area drawing tool 

 Graphic Description

Creates a sample are based on freehand drawing.

Creates a sample area with a pre-defined circular/elliptic 
shape.

Table 13-25:  Trackball Assignment 

 Graphic Description

Press the top Trackball key to toggle the trackball assignment 
between QA and Scroll.

• QA
Pointing tool in TIC mode.

• Scroll
When the cineloop is stopped, enables scrolling through the 
cineloop.

• Menu
Press left Set key to display System Menu.

• Set
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TIC Touch Panel

Table 13-26:  TIC Touch Panel Description

Parameter Description

Exit TIC Analysis Exit TIC. 

Motion Tracking Users use TIC to analyze tumor characteristics precisely, without distortion 
due to patient movement. Motion Tracker enables the system to 
automatically adjust the ROI’s placement across multiple frames in order to 
accommodate patient breathing or body movements. 
To activate, press Motion Tracking on the Touch Panel. This starts the 
calculation to adjust the all ROI positions for every image frame. After 
completion, the ROI graphic on each frame is changed to the ROI with the 
anchor. 

Accumulation Enhances the flow in an image. 

Enable All Frames Re-enables disabled frames. 

Curve Fitting Toggles between Wash-In, Wash-Out, Gamma Variable and Off. 

Smoothing Smooths the trace displayed by applying a filter over a defined time window. 
Both the filter type and time window are user-selectable. The type of filter 
available depends on the analysis signal displayed. 

Delete Sample Area Removes selected sample area from the CINE Loop window and 
accompanying trace in the Analysis window. The Trackball marker must be 
pointed at an anchored sample area. 

Auto Calc Range Auto Calc Range enables system to automatically estimate the ROI's start 
frame and end frame to calculate TIC parameters and fitting curves. The start 
and end frames for each ROIs are displayed by small squares on the graph. 
Toggles between Current Sample, All Samples and Reset All.

First Move to the first frame of cineloop.

Last Move to the last frame of cineloop.

Run/Stop Start/Stop the cineloop review.

Loop Speed Adjust the cine loop playback speed.

ROI width/height Move the rotary left/right or up/down to adjust ROI width/height.

ROI tilt angle Rotate the rotary to adjust ROI tilt angle.
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Start Frame Rotate the rotary to select the start frame and push to set the frame.

End Frame Rotate the rotary to select the end frame and push to set the frame.

Frame by Frame Rotate the rotary to review the CINE image frame by frame manually.

Disable frame Push the rotary to disable the selected frame.

Graph # Select the clip for general TIC analysis. System can register up to 10 clips 
and the individual parameters for each TIC analysis are maintained in one 
TIC analysis session.

Remove Graph Remove the selected graph from the clip list in Graph # button.

Merge Graphs Referring to Contrast Clock1 in the stored clips, system merges the TIC 
graphs. Contrast Clock1 and at least 2 ROIs are required for Merge Graphs. 

Table 13-26:  TIC Touch Panel Description (Continued)

Parameter Description



Contrast Imaging

LOGIQ Totus – User Manual 13-77
5929163-1EN Rev. 3

Generating a Trace

Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) 
before anchoring.

NOTE: The free sample area disappears when the QA cursor is 
moved over a static anchored frame.

• Static sample area: the free sample area is anchored by 
pressing Set.

• Dynamic anchored sample area: the sample area is 
anchored in two or more frames (see Manual tracking 
below). In these particular frames, the sample area is 
displayed with an anchor. The sample area moves smoothly 
between the anchored positions when playing/scrolling the 
cineloop.

Trace from a pre-defined sample area (Ellipse ROI)

1. Press the top Trackball key until the QA trackball 
assignment is selected.

2. If necessary, select the sample area Ellipse ROI button 
(shape icon on the monitor display).

3. Move the cursor to one of the Cineloop windows using the 
Trackball.

The cursor is changed to a sample area (white circle). A 
preview of the trace is displayed in the Analysis window.

4. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If 
the cineloop has more than one heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle.

The trace is updated accordingly in the Analysis window.
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Generating a Trace  (continued)

Trace from freehand sample area

1. Select the Freehand ROI button (pencil icon on the monitor 
display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Trace the outline of the desired ROI by moving the caliper 
with the Trackball.

4. Press Set to anchor the sample area.

The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window.

Copy, move and paste a Sample Area

To copy and paste the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Copy sample area.

3. Move the cursor to the desired location for the copied ROI 
and press the left Set Key. The system menu displays. 

4. Select Paste sample area.

To copy and move the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Copy & move. Or if you want to move to the same 
depth as the original ROI, select Copy & move (same 
depth).

3. Move the copied ROI using the Trackball. Press Set to fix 
the position.

To move the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Move (same depth).

3. Move the ROI using the Trackball. Press Set to fix the 
position.
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Manual tracking of the sample area (dynamic anchored sample area)

The sample area can be moved within the loop to ensure that 
data in the trace is generated from the same anatomical location 
during the cyclic motion of the heart.

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

NOTE: In the original frame and this particular frame the sample 
area is marked with an anchor.

7. Press the top Trackball key until the scroll trackball 
assignment is selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.
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Moving a dynamic anchored sample area

1. Freeze the image.

2. Press top Trackball key until the scroll trackball assignment 
is selected.

3. Using the Trackball, browse through the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

4. Press top Trackball key until the QA trackball assignment is 
selected.

5. Move the cursor to the sample area using the Trackball.

6. Press Set. The sample area is unanchored.

7. Drag the sample area to a new location.

8. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 



Contrast Imaging

LOGIQ Totus – User Manual 13-81
5929163-1EN Rev. 3

Zooming in the Analysis window

To zoom:

1. In the Analysis window, press and hold down the Set key 
while dragging the cursor to define the zooming area.

2. Release the Set key.

To unzoom:

1. Press the left Set key in the Analysis window. The system 
menu displays.

2. Select Unzoom.

NOTE: Shown only in zoom mode.

Delete a trace

The user can delete all traces at once or one at a time.

1. If necessary, press the top Trackball key until the QA 
trackball assignment is selected.

2. Move the cursor over one of the sample area. Confirm that 
cursor is changed to hand icon.

3. Press the Delete Sample Area on the touch panel.

4. Select Current Sample or Delete all as necessary.

NOTE: The corresponding traces for the deleted ROIs are erased from 
the plot.
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Disabling/Enabling the frame

Frame disabling excludes the actual frame from the cineloop 
display. Frame disabling is available only with contrast data.

Disabling the frame from the frame marker

To disable One Frame:

1. Use the Trackball to move the cursor to the frame on the 
Frame Marker which you want disable.

2. Press Set to disable the frame.

3. The frame marker is changed from green to red to indicate 
the frame has been disabled. 

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory.

Disabling multi-frames from the frame marker 

1. Use the Trackball to move the cursor to the first frame on 
the Frame Marker.

2. Press and hold down Set

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.

Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in 
all heart cycles but a selected one. This function can be used for 
example to select a particular systolic frame for each heart 
cycle.

1. Scroll through the cineloop to identify the cardiac phase to 
analyze or identify the cardiac phase on the ECG trace 
(where available).

2. Position the cursor on the analysis window and press left 
Set key. The system menu displays.

3. Select ECG triggering (where available).

All frames in all heart cycles are disabled except for the 
selected and corresponding frames in the other heart 
cycles.
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Disabling/Enabling the frame  (continued)

To enable the frames

1. Select Enable all frames on the Touch Panel.

2. All disabled frames are re-enabled.

Figure 13-29. Frame markers

1. Analysis Window
2. Frame markers axis
3. Enabled frame (Green)
4. Disabled frame (Red)
5. ECG (where available)
6. Current frame
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Manipulating the Sample Area

Up to eight ROIs can be saved on the reference image, with the 
corresponding eight traces plotted simultaneously on the graph. 
Each ROI display has a different color, and its corresponding 
trace data is plotted using that same color.

Once eight ROIs have been saved, the system does not 
automatically generate an active ROI when the cursor is 
positioned over the displayed reference image.

The saved ROIs can be a mixture of elliptical and freehand 
ROIs.

When the user repositions an ROI, the old trace data is erased 
from the plot and the trace data for the new position replotted.

If the ROI position on the last frame of the selected image range 
is moved, the corresponding ROIs on all frames are 
repositioned to match the last frame.

The user shall also have the capability of setting separate ROI 
positions on different frames of the contrast images, and the 
system shall linearly interpolate the ROI positions for the frames 
in between the selected frames. 
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Manipulating the Sample Area  (continued)

Setting the default sample area shape

1. Place the cursor on the sample area.

2. Press left Set key. The system menu displays.

3. Select Set as Default ROI Size.

4. The current ROI size is set as the default for subsequent 
Ellipse ROIs.

Reshaping a Sample Area

To reshape the sample area:

Figure 13-30. ROI 

• Move the rotary up and down to change the height.

• Move the rotary left and right to change the width.

• Rotate the rotary to change the tilt angle.

Labeling a Sample Area

The sample area label is used to identify data associated with 
the sample area when exporting.

1. Position the cursor on the ROI to label and press the left Set
key.

2. The ROI system menu displays. Select Label sample area.
The Label Dialog box displays.

3. Enter a name for the sample area.

4. Select OK.
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TIC Plot Control

Vertical Unit

When analyzing the contrast data, the Y-axis can be set to 
display either logarithmic scale (dB) or linear, acoustic units (AU) 
for both tissue intensity (2D) or Angio intensity data.

To toggle between dB and acoustical display units for the Y-axis. 
The unit of previous analysis is retained. 

• dB—The traditional log compressed B-Mode data is used to 
calculate the time-intensity curve values.

• Acoustic—The system reverse the log compression 
function to provide un-log compressed data for the TIC 
analysis.

Vertical auto-scaling

The system can be configured to display the full unit range or a 
range according to the maximum and minimum values of the 
displayed trace(s) (auto-scaling function). In addition, the 
auto-scaling function can be set to be live update (updates while 
the sample area is moved) or delayed (updated when the 
sample area is anchored).

• Delayed—The system automatically rescale the vertical 
axis of the trace graph only when a new ROI is saved, to 
account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of 
the trace graph every time the currently selected (active) 
ROI is moved.

• Off—Disable any automatic scaling of the vertical axis. 
There is user-defined system defaults on the system preset 
page for the fixed vertical scale to be used for the plot.

Y-Scale

1. When you select “Off” for Vertical Auto-Scaling, Y-Scale 
dialog displays.

2. Enter maximum and minimum value for vertical scale on the 
graph.

3. Press OK. The vertical scale is updated. 
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TIC Plot Control  (continued)

Line Style

• Solid—Setting the results in a plotted trace that does not 
display small boxes at the data points

• Squares—Setting the results in a plot where small squares 
are displayed at each data point, and the squares are linked 
together by lines.

Horizontal Scale

Set the horizontal unit as time scaling (s) or time interval (dt) 
between frames.

NOTE: Only on a loop including different frame rate.

Smoothing

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing on the Touch Panel.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays. Select the appropriate 
parameter.

NOTE: When smoothing is turned on, it applies to all traces in the plot 
window.
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Trace Measurement

Gradient

Gradient is displayed on the screen instead of Intensity (db or 
AU). The gradient calculates from 7 points (includes previous 
and next frames). 

Figure 13-31. Gradient
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Trace Measurement  (continued)

TIC Parameters

Following parameters are automatically calculated and 
displayed with the graph. 

 Figure 13-32. TIC Parameters

Table 13-27:  TIC Parameters

MGrad Maximum Gradient

MGT Max Gradient Time

Grad. Mean Gradient for the peak intensity.

ArT Arrival Time

TtoP Time to Peak

PI Peak Intensity

TWH Time Width at Half maximum intensity

TWR Time Width Ratio for wash-in and wash-out

AUC Area Under the Curve

WiAUC Wash-in Area Under the Curve

WoAUC Wash-out Area Under the Curve

A, B, C, k and MSE The coefficients and the mean square error for fitting curve equation. These 
parameters are displayed only on Large Data Layout with curve fitting.
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Trace Measurement  (continued)

Show graph (Gradient plot)

1. Select Gradient Plot from the pull-down menu.

2. Select the parameter.

• Off: A graph plots TIC.

• Gradient: Two graphs plot TIC and TIC gradient.

- Unit of Y-axis is dB or AU in case of intensity.

- The unit is d(db)/dt or d(AU)/dt in case of the intensity 
gradient.

- Gradient values for the current frame are displayed in 
the upper right corner of the graph.

• Gradient Derivative: Two graphs plot TIC and TIC 
gradient derivative.

- The Y-axis units is d2(dB)/dt2 or d2(AU)/dts in case of 
the intensity gradient derivative.

- Gradient derivative values for the current frame are 
displayed in the upper right corner of the graph.

• All: Three graphs plot TIC, TIC gradient and TIC 
gradient derivative.
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Curve Fit

1. Select Curve Fitting on the Touch Panel.

2. The Curve Fit selection list displays.

Figure 13-33. Curve Fit Selection List

• Off—Remove the fitted curves from the plot and the fit 
parameters from the display.

• Wash-in—Used to find and estimate the local perfusion rate 
using the contrast agent. Exponential wash-in is described 
by the function:

Y(t) = A(1-exp(-kt))+B, where:

• A (dB or AU) is the intensity from the contrast agent.

• B (dB or AU) is the intensity at time t=0 (defined as the 
time of the left marker). This corresponds to the tissue 
(baseline) signal if no contrast is present at the selected 
starting point.

NOTE: A + B = contrast + tissue = plateau level.

• k (1/s) is a time constant.

• Wash-out—Used to find and estimate a local wash-out rate. 
Exponential wash-out is described by the function:

Y(t) = Aexp(-kt)+B, where:

• A (dB or AU) is the intensity from the contrast agent.

• B (dB or AU) is the intensity from the tissue = baseline 
signal.

NOTE: A + B is the initial intensity level.

• k (1/s) is a time constant.

• Gamma variate

Y(t) = Atcexp(-kt)+B



Advanced Features

13-92 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Parameters of Gamma curve fitting

Figure 13-34. Gamma Curve

• tc: Increasing function (C>0) for “Wash-in”. 

For larger C, the intensity increases quickly before the peak. 

• exp(-kt): Decreasing function (k>0) for “Wash-out”. 

For larger k, the intensity decreases quickly after the peak. 

• B: Intercept intensity at t=0. 

• The peak intensity of the curve is affected by all parameters. 

Larger A, larger B, larger C, and smaller k make larger peak. 
The peak time is calculated by C/k. 

• MSE: Mean Square Error

If the MSE is small, the difference of actual data and the 
fitted curve is small. 
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Set Start/End Frame for Curve Fit per ROI position

1. Generate TIC and perform a Curve Fit. In this state, the 
Curve Fit graph is drawn from Cine Start Frame to Cine End 
Frame for all the ROIs. 

2. Push Auto Calc Range on Touch Panel and select All 
Samples. Then the start and end frames for each ROI are 
automatically estimated.

If you need to optimize the start and/or end frames, 

1. Select the start frame as with Cine or move the cursor to the 
desired position on the graph and press the right Set key. 

2. Move the arrow pointer on the ROI (hand cursor appears) 
and press the left Set key. The system menu appears. 

3. Select Set Start Frame from the menu. 

4. Select the End Frame as with Cine or move the cursor to the 
desired position on the graph and select the right Set key. 

5. Move the arrow pointer on the ROI (hand cursor appears) 
and select the unmarked key (the left Set key). The system 
menu appears. 

6. Select Set End Frame from the menu. The ROI colored line 
displays. 

7. Repeat the above procedures as necessary. The system 
retains the start/end frame per ROI while TIC is active. Once 
the TIC menu is closed, the settings are lost.
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Display/Hide Calculation Values

You can select the TIC parameters for Small Data Layout and 
Everything Layout.

1. Place the cursor on the analysis graph and press left Set 
key. Select TIC Parameters from the pull-down menu. 

2. The TIC Parameters dialog appears. 

3. Select a maximum of 6 parameters to display for each TIC.

• Save As Default: saves as a system preset.

• Save: saves as temporary.

• Cancel

NOTE: If you select more than 6 parameters and select Save or 
Save as default, you will be prompted to select up to 6 
parameters.

4. The selected parameter displays for Small Data Layout and 
Everything Layout. Press the Large Data Layout button to 
display all parameters; or press the other Layout button to 
hide all parameters. 

Figure 13-35. Curve Fitting Parameters Dialog
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Raw Data store with TIC Setting

You can store the raw data with TIC setting.

1. Run TIC cineloop. 

2. During cine running mode, press appropriate print key.

When you recall the raw data clip with TIC data, you can add, 
delete or modify the analysis measurements on the recalled raw 
data in TIC mode.

Printing TIC Data

1. Press Run/Stop to freeze the image.

The still image can be get when cineloop is stopped by Run/
Stop button. 

2. The system captures a single still frame which consists of 
the plot, the reference image and user annotation.

Annotating the TIC Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.
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SaveAs (Save image file and export trace data)

You can save the image file and trace data.

1. Select SaveAs.

2. The following dialog displays.

• Location: Select Location which to save.

• Filename: Enter the file name. (Only Text)

• Export Trace: If you check this box, LOGIQ Totus 
exports trace data to .csv file. 

Note: Name of exported file has same name as the 
image file saved at the same time.

3. Select OK to save the image and data and return to the TIC 
Analysis screen.

• All displayed ROI traces are saved in the exported file.

• The fit parameters are included in the trace file if the 
user has done a curve fit.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: Data for disabled frames are not included in the exported trace 
file.

NOTE: No trace results are saved in the standard image database.

NOTE: Trace results are not shown on the Worksheet.
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TIC cineloop store

When you transfer TIC cineloop to the external server, check 
“Add Multiframe Data” in Utility -> Connectivity -> Button and 
then store the cineloop to the system. 

Figure 13-36. Button page

TIC Analysis for multiple Clips

When you load additional contrast data on the clipboard in TIC 
mode, the system registers the contrast clips to analysis list up 
to 10 data in one TIC analysis session. The system maintains 
individual TIC setting such as ROI shape, position, smoothing, 
motion tracking state etc. for each clip. You can recall the clip by 
eGraph #f button on touch panel. The eRemove Graph button 
can remove selected clip from the analysis list.

The registered clip list and TIC settings are reset by exiting the 
TIC mode.

Merge Graphs

You can merge the multiple graphs such as early phase and late 
phase for 2 TIC graph plots by eMerge Graphs button on touch 
panel. This function requires the stored clips which have the 
Contrast Clock1 information and at least 2 ROIs (yellow and 
light blue) for TIC analysis.
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The horizontal scale of merged graph is based on Contrast 
Clock1.

Merged graph Screen Description

 Figure 13-37. Merged Graph display

Table 13-28:  Merge Graphs Touch Panel Description

Parameter Description

Exit Exit to individual TIC analysis mode. 
All TIC parameters for registered clips are maintained.

1. Merged graph window
2. Parameter table

Table 13-29:  Merged graph window

Graphic Description

Displays the merged graph on the upper part of 
monitor. 
The horizontal scale is based on the Contrast 
Clock1.
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SaveAs (Save image file and export merged trace data)

You can save the graph image file and trace data.

1. Select SaveAs.

2. The following dialog displays.

• Location: Select Location which to save.

• Filename: Enter the file name. (Only Text)

• Export Trace: If you check this box, system exports 
trace data to csv file.

Note: Name of exported file has same name as the image 
file saved at the same time.

3. Select OK to save the image and data and return to the 
merged graph screen.

Displays the parameters on the lower part of 
monitor. 
The parameters are the intensity of ROI1 (Yellow), 
ROI2 (Light blue), Subtraction (ROI1-ROI2) and 
Standard deviation of ROI1 and ROI2..
These are calculated for peak and last 5sec. 
average of 1st clip, and average of other clips based 
on Contrast Clock1 value.

This menu is displayed by pressing the left Set key 
when the cursor is placed over the merged graph 
window. 
Connection : selects the graph connection method. 
Average, Direct and No Line.
Vertical Unit : toggles between logarithmic(dB) and 
linear acoustic units(AU). Vertical unit of previous 
analysis is retained.

Table 13-29:  Merged graph window

Graphic Description
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Strain Elastography

Description

Strain Elastography shows the spatial distribution of tissue 
elasticity properties in a region of interest by estimating the 
strain before and after tissue distortion caused by external or 
internal forces. The strain estimation is filtered and scaled to 
provide a smooth presentation when displayed. 

Below is an example of Strain Elastography. The image is 
displayed in dual mode with the color map/bar of the Strain 
Elastography on the left side and the imaging parameters on the 
right side of the display below E. 

You activate Elastography via the Elasto hard key on the Control 
Panel.

 Figure 13-38. Strain Elastography Example
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Using Strain Elastography

The Strain Elastography image is achieved by pulsating the 
probe while you are scanning the anatomy of interest. Here are 
some criteria to use: 

Handheld elasticity imaging can be very dynamic as the size of 
distortion depends on the movement of the hand-held probe. To 
maintain stable and consistent displayed strains, pay attention 
to the Quality graph. Two forms of feedback are provided. In 
either form, an ideal manual compression is indicated by a high 
value feedback. In addition, apply the following post-processing 
controls: Smoothing, Window, Scaling, and Frame Averaging. 

Strain Elastography displays firmer tissue in blue and softer 
tissue in red. To enhance Blue, increase Hard Compress; to 
enhance Red, increase Soft Compress on the Touch Panel. To 
enhance strain elastography contrast, reselect the Color Map. 

If you need more resolution, reduce Smoothing, increase 
Frequency, or reduce Window.

If you need a smoother image, increase Window or Smoothing. 

If the images seem too flashy, decrease Frame Reject to 1.0 and 
Noise Reject to have consistent imaging throughout. 
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Using Strain Elastography  (continued)

Table 13-30:  Strain Elastography 

 Using Strain Elastography

Manual Compression:
1. Press “Elasto” button at the console to 

activate.
2. Select Strain on Touch Panel.
3. Adjust the position of the ROI to place the 

suspicious area at the center.
4. Adjust the size to include surrounding tissue 

(sample area size = x3 dimension of the lesion 
per axis).

Manual compression depends on the type of 
probe.
1. Linear probes: Perform slight compressions 

keeping transducer perpendicular to the skin. 
Duration: 5 sec. or 10 compressions.

2. Convex probes: Turn the patient on his left side 
more than 90 deg. Pressing with the probe 
above the lesion, allowing the heart and lungs 
to create the compressions.

3. Endocavitary probes: Perform soft, angular 
movement in plane of the probe. Duration: 5 
sec. or 10 compressions.

Note 1: Any very soft (vessel, cyst, air) or very stiff 
(bone) tissue above the lesion or the reference 
area may cause interference with the 
compressions. You may want to attempt from a 
different view.

Note 2: Keep the lesion within the image and watch 
the quality graph for consistent high nearly flat 
(plateau-like) peaks.

Select the frame to analyze
1. Press “Freeze.”
2. Using the trackball or “frame by frame” knob, 

select a frame on a plateau of the quality graph 
(Image 1, A) or when consistent frames with 
green bars are visualized (Image 1, B).

Image 1: Elastography image with quality graph (A), 
quality bar (C) and elasto color bar (B).

The relation between elastography colors and area’s 
stiffness is given at the elastography color bar (Image 
1, B).

Less Stiff

Stiffer
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Clinical Applications

Strain Elastography Controls

Table 13-31:  Clinical Applications 

Application Compare the suspicious lesion with: Probe

Breast A fatty area in the breast or the average rounding
breast tissue.

• 9L-D
• ML6-15-D
• L3-12-D

Thyroid A normal area in the parenchyma of the gland. • 9L-D
• ML6-15-D
• L3-12-D

MSK A normal area in the same part of the body. • C1-6-D/C1-6VN-D
• 9L-D
• L3-12-D
• ML6-15-D

Liver A normal area in the parenchyma of the liver. • C1-6-D/C1-6VN-D
• 9L-D

Prostate A normal area in  the parenchyma of the prostate. • IC5-9-D

Uterus A normal area in  the parenchyma of the uterus. • IC5-9-D

Table 13-32:  Strain Elastography Touch Panel Description

Parameter Description

Axial Smoothing Controls the smoothness of the strain elastography image in the axial 
direction. A higher value means a smoother image.

Lateral Smoothing Controls the smoothness of the strain elastography image in the lateral 
direction. A higher value means a smoother image.

Window Controls the RF data segment size for the motion tracking. A higher Window 
value gives a better signal to noise ratio (SNR) at the cost of axial resolution.

Map Controls the strain elastography maps. Seven different maps are available 
with various contrast and color schemes, including a grayscale map. 
Selections: E0-7, E-Gray, and S Map.
The E Map calculates the mean strain for the whole ROI and assigns this 
mean value to a green (center) color. This is best suited for imaging a 
localized mass compared to the surrounding tissue with external forces (the 
movement of the hand-held probe). 
The S Map is useful for imaging diffusely-distributed diseases and local 
strain changes brought about by internal forces such as the movement of a 
beating heart and moving vessels. The default strain sensitivity is unique by 
probe/application. You can adjust the strain scale by adjusting the strain 
sensitivity tool. 

Frame Average Controls the persistence of the strain elastography images. 

Frequency Controls the transmit frequency.
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Strain Sensitivity If S0 Map (in live) is selected, the user can control Strain Sensitivity (SS). 

Soft Compress Individually controls the image enhancement for the softer than average 
tissues.

Hard Compress Individually controls the image enhancement for the harder than average 
tissues.

Scale Controls the time interval between consecutive firings. A lower value dictates 
a higher sensitivity to weak manual motion.

Transparency High values bring out the tissue behind the strain elastography data. You 
adjust via the Color Gain control; this imaging parameter appears as a “T” on 
the right-hand portion of the display. 

Biopsy Kit Biopsy Kit.

Frame Reject Controls how many frames get rejected due to low quality vertical motion. A 
higher value means more frames get rejected. A rejected frame has a 
completely transparent ROI with the B-Mode background showing through.

Noise Reject Controls how many frames get rejected due to lateral and elevational motion. 
A higher value means more frames get rejected. A rejected frame has a 
completely transparent ROI with the B-Mode background showing through.

Line Density Optimizes B-Mode frame rate or spatial resolution for the best possible 
image. 

Show Quality Graph 
(restart needed)

Select to display a Quality Graph for Elastography. The higher the level, the 
higher the data quality for the frames.

Table 13-32:  Strain Elastography Touch Panel Description (Continued)

Parameter Description
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Application Parameters

You can set the Quality Bar and Quality Graph on the Utility--> 
Application--> Settings --> Elasto page. 

For Quality Bar: 

• Check to display a Quality Bar for Elastography.

For Quality Graph: 

• Off (No elasto quality graph is displayed in the image)

• Small, Medium or Large for display size of Quality Graph.

General Imaging Parameters by Application/Probe/Feature

Select the Default Elasto Mode via Utility--> Imaging--> General. 

You can specify Strain to be the default setting by application 
and probe.

1. To specify a default probe per application, select Utility --> 
Imaging --> General.

2. Select the application. 

3. Select the default probe from the pull-down menu.

4. Specify the Default Elasto setting: 

• Strain

• Shear
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Elastography Analysis

Overview

The Elastography Mode detects strains by correlating the echo 
amplitudes of the tissue when compressed and uncompressed. 
Different displacement of echoes is an indicator for different 
stiffness (strain) of the tissue. High strain means that the tissue 
is softer, low strain means that it is stiffer. Zero is absolutely stiff 
without any elasticity. Elastography Analysis is a strain ratio 
comparative tool that enables users to compare the strain of one 
tissue to the surrounding tissue.

Using Elastography Analysis

1. If not yet in Elastography Mode press Elasto.

2. Perform the scan. Proper manual compression/
decompression is indicated by a fully green quality bar. 

3. Press Freeze and scroll the Trackball to bring up the CINE 
tab on the Touch Panel.

4. Press Analysis on the Touch Panel. The Elastography 
Analysis Touch Panel appears and the monitor screen 
shows the Elastography Analysis display. The valid 
Elastography frames are marked green. 

5. Adjust the start and end of the CINE Loop within the green 
frames using the rotary buttons below the Touch Panel 
(Start Frame/End Frame). Press Set to confirm..

6. Activate the cursor and move it over the Elastography image 
on the top left side of the screen. A white sample area 
appears. By default this sample area is a circle. It will be the 
reference sample area and should be placed in the normal 
breast tissue.

7. Position this reference sample area and press Set. A yellow 
plot curve displays the strains over time on the right side of 
the monitor screen.

8. Move the Trackball again. A new sample area appears 
(sample area 1) which should be placed in the lesion.

9. Position the sample area and press Set. A second plot 
curve is displayed (blue curve).
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Using Elastography Analysis  (continued)

In total you can create 7 sample areas and 1 sample area. Each 
sample area can be edited, moved, copied, or deleted. A sample 
area can also be drawn manually.

1. To edit an existing sample area, move the cursor over the 
sample area then press the left Trackball control (Menu) to 
bring up the menu. Select “Set Sample Area Shape” to enter 
a dialogue window where Height and Width can be 
adjusted. You can also label, delete, copy, move the sample 
area by selecting corresponding options in the menu. 

2. To draw a sample area manually, select the pencil icon. 
Then the cursor becomes a cross inside the strain image. 
Start to draw the sample area by pressing “Set.” Press “Set” 
again to stop drawing. 

3. Both Stiffness and Ratio plots can be displayed: Switch to 
Ratio plots by pressing the Ratio control on the Touch Panel. 

4. Press Exit Analysis to return to Elastography Mode.
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Using Elastography Analysis  (continued)

NOTE: The maximum strain value in human tissue can be up to 2%.

NOTE: The ratio value indicates how many times the tissue of a sample 
area is harder or softer than the tissue of the Reference sample 
area.

HINTS Use the trackball to scroll the Cine Loop quickly.
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Elastography Analysis Display Description

Figure 13-39. Elastography Analysis Example

1. Reference sample area

2. Lesion

3. Harder compression

4. Lower compression

5. Strain plot

6. Ratio plot

7. Frame indicator lines: green lines indicate frames with color 
in the Elastography image, red lines indicate invalid frames 
without color.

8. Reference sample area is set to 1

9. Lesion is 0.8 times as rigid as the Reference sample area
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Additional Notes for Elastography Analysis

HINTS Limitations: 

• This is a relative quantification tool based on freehand 
manual palpation technology. It cannot show the stiffness 
by the kPa (kilopascal).

• There is no compatibility among manufacturers regarding 
the value. It depends on their strain imaging technology 
and definition of the value.

• Colors indicate degree of stiffness and do not directly 
correlate to a specific tissue type. Interpretation of what the 
tissues are and how to apply these ratios clinically is at the 
discretion of the user.

• Elastography physics dictates that cystic structures will be 
displayed with a three-layer pattern. This three-layer 
pattern will start with blue on the factory default map (which 
corresponds to hard), then progresses to green and then to 
red (which corresponds to soft). The posterior 
displacement of elastography patterns also may cause the 
B-Mode cyst to consist primarily of blue with the green to 
red being posterior to the B-Mode cyst. You need to be 
aware of the three-layer pattern of a cyst in elastography. 
Utilizing Elastography Analysis and setting the sample 
area in the blue portion of the three-layer pattern on the 
cyst and then setting the sample area in the “normal” tissue 
may cause you to misinterpret the Elastography Analysis 
ratio as the cyst to be hard as compared to the “normal” 
tissue.
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Shear Wave Elastography

Overview

Shear wave elastography on the LOGIQ Totus is an ultrasound 
imaging mode in which shear waves are generated in-vivo 
acoustically via the imaging ultrasound transducer. The motion 
of the shear waves is then tracked using ultrasound to 
determine their velocity of propagation, which is a quantifiable 
indicator of the mechanical properties of the tissue through 
which it traveled. The steps associated with performing this 
analysis on the LOGIQ Totus include correctly placing a 
user-specific region of interest (ROI) over the anatomy of 
interest. Next, the user activates the shear wave analysis mode 
where the shear wave generation and tracking occurs. Up to 
four (4) sites may be analyzed. After acquiring the data, the user 
either stores the image or analyzes it via measurement tools 
which can produce shear wave velocity or stiffness statistics of 
areas within the ROI. 
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Overview  (continued)

Figure 13-40. Shear wave Probe Characteristics

1. Excitation and imaging transducer

2. Tissue

3. Propagating Wave

4. Focus



Shear Wave Elastography

LOGIQ Totus – User Manual 13-113
5929163-1EN Rev. 3

Intended Uses

Shear wave elastography Intended Uses are: 

• Abdomen

• Small Parts

• Musculoskeletal

• Gynecological

• Urological

Configuring Shear Wave

To configure Shear Wave parameters, you need to adjust the 
following Utility pages:

• ELASTO Imaging Parameters (Utility -> Imaging -> Elasto)

• General Imaging Parameters (Utility -> Imaging -> General)

• System Imaging Parameters (Utility -> System -> System 
Imaging)

• Measurement Parameters (Utility -> Measure -> 
Advanced -> for both Abdomen and Small Parts Breast)

CAUTION
Shear wave elastography IS NOT intended for use for 
Obstetrical exams. 
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ELASTO Imaging Parameters

To configure Shear Wave Elastography settings, select Utility--> 
Imaging--> ELASTO. 

• Push Output (%) — The acoustic output of the shear wave 
push

• Track Output (%) — The acoustic output of the shear wave 
tracking pulse

• Transparency — The transparency of the shear wave image 
overlay

• Gain — Gain, as can be manipulated by the CF knob

• Width — ROI Width (values vary by probe)

• Vertical Size (cm) — ROI Vertical Height (values vary by 
probe)

• Center Depth (cm) — ROI Center Depth (values vary by 
probe)

• Color Map — Select shear wave Map 0 or shear wave 
Map 1 (SW0 or SW1) plus other ELASTO Maps (E1, E2, E3, 
E4, E-GRAY)

• Enter ELASTO DualView by Default — Check to select 
entering shear wave in DualView. 
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ELASTO Imaging Parameters  (continued)

Shear wave Color Bars: 

Figure 13-41. Shear wave Maps

The illustration shows the color maps for kiloPascals and 
velocity (meters per second). The images look the same, 
regardless of the unit (m/s or kPa). You can preset which color 
on the map represents stiffness (Red as Hard or Blue as Hard). 

General Imaging Parameters by Application/Probe/Feature

Select the Default Elasto Mode via Utility--> Imaging--> General. 

You can specify shear wave to be the default setting by 
application by probe.

1. To specify a default probe per application, select Utility --> 
Imaging --> General.

2. Select the application. 

3. Select the default probe from the pull-down menu.

4. Specify the Default Elasto setting: 

• Shear

• Strain
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System Imaging Parameters

You can set the shear wave Display Units and specify which 
color on the shear wave map represents stiffness on the 
Utility--> System--> System Display--> Display page. 

Set the Shear Elasto Display Units to either of the following 
settings:

• m/s (meters per second)

• kPa (kiloPascals)

Specify which color on the shear wave map represents stiffness: 

• Red as Hard

• Blue as Hard

Measurement Parameters

On the Utility--> Measure--> Advanced--> Abdominal page, set 
the following: 

• Shear Measure Size — Sets the Default Diameter size of 
the shear wave measurement circle

• Shear Measure Fixed Size — Sets to ON to move the shear 
wave measurement circle with keeping the fixed size.

• Shear Calculation Method — Specify Mean (Mean averages 
of all of the shear wave points within the measurement 
circle) or Median (Median sorts, then selects the middle 
point of all points within the measurement circle) 

• Shear Units Determine Folder — When On is specified, the 
unit specified pre-selects the measurement folder. If m/s is 
specified as the unit, then the Velocity folder is used; if kPa 
is specified as the unit, then the Stiffness folder is used
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Measurement Parameters  (continued)

On the Utility--> Measure--> Advanced--> Small Parts page, 
specify the Calculation Method (Mean/Median). 

• Shear Measure Size - Sets the Default Diameter size of the 
shear wave measurement circle.

• Shear Measure Fixed Size - Sets to ON to move the shear 
wave measurement circle with keeping the fixed size.

• Shear Calculation Method — Specify Mean (Mean averages 
all of the shear wave points within the measurement circle) 
or Median (Median sorts, then selects the middle point of all 
points within the measurement circle)

Activating Shear Wave

To activate shear wave, press ELASTO and Touch Panel Shear
controls. (1) To position and size the shear wave ROI, or to Start 
or return to Pre-Mode shear wave, touch the right-most 
Trackball control. (2) To save the Shear Elasto image, activate 
the P1 control. 

Figure 13-42. Shear wave Operator Panel Controls

ELASTO -- When you activate ELASTO, the default Elasto 
Mode appears on the display and Touch Panel. If shear wave is 
preset as the default Elastography Mode, then Shear Wave 
Elastography mode appears; if Strain Elastography is set, then 
Strain Elastography mode appears. 



Advanced Features

13-118 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Shear Wave Display

Shear wave displays as follows while performing a 
measurement: 

 Figure 13-43. Shear wave Display with Measurement

1. Measurement Window
2. Shear wave Map
3. Measurement(s)
4. Shear wave ROI
5. Trackball Controls

6. Imaging Parameters
• E = Elastography, Shear Wave
• Gn = Gain
• T = Transparency
• SVD = Sample Volume Depth
• PO% = Push Output Percentage
• TO% = Track Output Percentage
• f50-200Hz = Shear Wave Frequency range  
• Gen/Pen = General/Penetration.   

“Gen” appears when viewing an image where general 
settings were applied.
“Pen” appears when viewing an image optimized for 
penetration.  
“Clock” displays in Low Frame Rate Use cases. 

Note: The measurements’ Median and Inter-Quartile Range (IQR) are displayed by default in the 
Measurement Window and Worksheet. The Caliper Area, Depth of Caliper Center, and average Quality  
within the measurement area can also be displayed on the Worksheet, along with how many measurements 
used for the median calculation. 
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Selecting Measurements to Display

The following measurements are displayed by default, except 
those marked with an asterisk (*): 

• Shear Stiffness (kPa)

• Standard Deviation within the Shear Stiffness Measurement 
Area*

• Shear Velocity (m/s)

• Standard Deviation within the Shear Velocity Measurement 
Area*

• Measurement Area (cm2)*

• Depth of Caliper Center (cm)*

• Average Quality within the measurement area (%)*

*Items not displayed by default can be added via Utility--> 
Measure. See below. 

 Figure 13-44. Configure Shear Wave Measurements
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Selecting Measurements to Display  (continued)

Checkmark the Shear Wave measurements to be displayed on 
the monitor and on the Extended Worksheet.  

Figure 13-45. Selecting Default Shear Wave Measurements

Figure 13-46. Shear Wave Measurement Results Window

Figure 13-47. Shear Wave Extended Worksheet



Shear Wave Elastography

LOGIQ Totus – User Manual 13-121
5929163-1EN Rev. 3

Shear Wave Quality Indicator

The Shear Wave Quality Indicator displays the reliability of the 
Shear Wave image. A Quality value is computed for every pixel 
of the Shear Wave image and displayed as an image in a 
color-coded ROI. Locations with higher quality values have 
more reliable Shear Wave data. 

To View the Shear Wave Quality Image

The Quality Image can only be displayed in Dual Mode. It can be 
turned on and off using the Quality button on the Shear Elasto 
page on the Touch Panel.

Figure 13-48. Quality Image Button

NOTE: You must be in Elasto Dual Mode to select the Quality button.
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To View the Shear Wave Quality Image  (continued)

When the Quality Image display is turned on, the Quality Image 
is displayed on the left and the Shear Elasto image on the right.

Figure 13-49. Shear Wave Display with Quality Image Enabled

The Color Bar on the left of the Quality Image shows the quality 
value corresponding to the colors in the Quality Image. Low 
quality is indicated by the colors at the bottom of the bar, and 
high quality by colors at the top.

Quality Map

There are two Quality Maps available to choose from on the 
Shear Elasto screen (under Quality Map), each with a specific 
color range:

• SWQ0 - Black/red/orange/yellow/white (low to high quality)

• SWQ1 - Red/orange/yellow/green (low to high quality)

1. Color Bar for Quality Image
2. Quality Image
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Elements of a good Shear Wave image

Elements of a good shear wave image contain the following: 

• Good contact

• ROI placed in the middle of image

• Gain at or near factory default

• Uniform color fill-in

• Homogeneous color pattern
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Shear Wave Touch Panel

Table 13-33:  Shear wave elastography Touch Panel Parameters

Preset Parameter Description

Strain or Shear Elasto Toggle touch key between Strain and shear wave elastography. 

Measurement Bias 
Information

Press to bring up measurement bias information. 

Quality Press the Quality button to open the Quality Indicator screen (while in Dual 
Mode). 

Phantom Press the phantom button to get good performance when measuring stiff, 
motion-free phantoms. The 049A phantom is recommended. For more 
information, refer to the CIRS website at http://www.cirsinc.com/products/all/
74/elasticity-qa-phantoms/?details=specs .

Penetration Press Penetration for instances measuring especially hard tissue (fibrotic or 
cirrhotic livers or technically difficult tissue in general).

Map Shear wave Color Map. 

Push Output The acoustic output of the shear wave push. 

Track Output The acoustic output of the shear wave tracking pulse. 

Range Min/Max Velocity, or Stiffness displayed. 

Transparency The transparency of the shear wave image overlay. 
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Measurement Bias Information Tables

The Measurement Bias Information tables display the bias and 
precision percentage at different spatial resolutions (Bias/
Precision vs Object Size, in millimeters) and at incremental 
depths (Bias/Precision vs Depth, in centimeters) for each shear 
wave probe. 

 Figure 13-50. C1-6-D/C1-6VN-D Measurement Bias Information (Velocity on the left 
and Stiffness on the right)
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Measurement Bias Information Tables  (continued)

 Figure 13-51. IC5-9-D Measurement Bias Information (Velocity on the left and Stiffness 
on the right)
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Measurement Bias Information Tables  (continued)

 Figure 13-52. ML6-15-D Measurement Bias Information (Velocity on the left and 
Stiffness on the right)

 Figure 13-53. L3-12-D Measurement Bias Information (Velocity on the left and 
Stiffness on the right)
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Measurement Bias Information Tables  (continued)

 Figure 13-54. 9L-D Measurement Bias Information (Velocity on the left and Stiffness on 
the right)

Speed Ranges and Accuracy are shown at the top of the Bias/
Precision vs Object Size tables. 
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Using Shear Wave (SW)

There are three shear wave states: 

• Pre-shear wave acquisition

Pre-shear wave acquisition is an intermediate mode 
between B-Mode and shear wave acquisition. During 
Pre-mode, the previous B-Mode imaging mode is still active. 

NOTE: You cannot store images in Pre-Mode. 

• Shear wave acquisition

Pressing the “Start" set key initiates SW acquisition.

• Post-shear wave acquisition (Freeze)

The system displays the acquired SW image and 
background B-Mode image. The User can cycle through the 
acquired frames, perform measurements, and annotate the 
image. 

SW images can be stored in both raw data and DICOM format. 

Table 13-34:  Using Shear wave

     Pre-Shear wave Mode Shear wave Acquisition Post-Shear wave Acquisition
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Typical Exam Protocol (Liver)

A recommended shear wave elastography protocol to scan the 
liver is, 

1. Image the right lobe of the liver intercostally in Pre-shear 
wave Mode. 

2. Position and size the ROI. 

3. Instruct the patient that during the exam they can mostly  
breathe normally. However, advise the patient that they will 
need to suspend their breathing mid breath so that you can 
obtain an optimum image while performing the scan. 

4. Adjust ROI as needed, avoiding vessels and fluid-filled 
structures. It is advisable to avoid rib shadows whenever 
possible. 

5. Start the shear wave acquisition. 

6. Freeze the image when desired frame is obtained. 

7. Perform the measurement. The system prompts you 
through the measurement.  

8. The system will auto sequence the measurements and walk 
you through all of the measurements (Abdominal 
Application Preset), if preset. 

NOTE: For Breast measurements, users typically take single 
measurements to measure the lesion once. Or, users can 
perform a ratio of two different tissues (one of the lesion and 
non-lesion tissue). 

9. Repeat steps 3 through 9 for the remaining samples. 

10. Typically, users obtain ten (10) samples. 

HINTS The smaller the ROI, the faster the Frame Rate. 
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Typical Exam Protocol (Liver)  (continued)

11. Once measurements are complete, you can elect to add 
another site to the exam. To add another site, press Add
Site on the Touch Panel.  Select Enter Site Name to add 
the name for the new site.   

Figure 13-55. Add Additional Shear Wave Site and Enter Site 
Name

NOTE: If you no longer need the added site, you can select to 
delete the site via Delete Site on the Touch Panel. 

12. Once measurements for all sites are complete, select 
Summary on the Touch Panel to view saved measurements. 

CAUTION
Excessive manual compression of the underlying tissue with 
the probe can lead to biased shear wave measurements. 
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Shear Wave Measurements

The higher the velocity, the stiffer the tissue. 

Types of Shear Wave Meeasurements

There are two types of measurement units for quantifying 
stiffness: 

• Velocity (meters per second)

• Stiffness (kiloPascals)

Measurement used to quantify stiffness: Shear wave imaging 
measures the velocity of shear waves generated by acoustic 
radiation force impulse in tissue. The velocity, in units of meters 
per second (m/s), can be converted to Young’s Modulus 
(stiffness), in units of kiloPascals (kPa), under simplifying 
assumptions. Velocity or stiffness can be used to quantify the 
local tissue elasticity.  

NOTE: Acoustic radiation force is generated by a transfer of momentum 
from an acoustic wave to the medium through which it is 
propagating, caused by absorption and scattering in soft tissue. 
Impulsive application of focused acoustic beams in tissue can 
generate shear waves which propagate away from the focal 
region of the beam.  

Measurement Analysis

To take shear wave measurements, typically users get ten (10) 
samples.

1. After you have acquired the desired image, avoiding vessels 
and fluid-filled structures, press Freeze. 

2. Press Measure. Select the measurement (Stiffness or  
Velocity) unless preset to “Shear Units Determine Folder” is 
turned on.  

NOTE: This step only needs to be done in the Breast Small Parts 
Application Preset and is not needed in Abdomen. 

CAUTION
Tissue inhomogeneities and other factors may bias shear wave 
measurements. 
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Measurement Analysis  (continued)

3. Perform the measurement. The system prompts you 
through the measurement.  

a. Position the first caliper at the desired location on the 
ROI. Place the first control point and press Set on the 
Trackball control. 

An ROI ellipse appears and a second caliper. 

b. Adjust the size of the ROI. Adjust ellipse and place the 
last control point. 

NOTE: This step only needs to be done in the Breast Small Parts 
Application Preset and is not needed in Abdomen. 

4. Repeat the scan and measurement. The system will auto 
sequence the measurements and walk you through all of the 
measurements, if preset. 

5. Measurements are transferred to the Worksheet. 

NOTE: The measurements’ Median and Inter-Quartile Range (IQR) 
are displayed by default in the Measurement Window and 
Worksheet. The Caliper Area, Depth of Caliper Center, and 
average Quality Percent within the caliper, and Standard 
Deviation within the caliper can also be displayed by going 
to Utility--> Measure, as shown in Figure 13-44 on 
page 13-119. 
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Shear Wave Worksheets

There are two types of Worksheets (Overall and Extended). 

Figure 13-56. Shear Wave Overall Worksheet

Figure 13-57. Shear Wave Extended Worksheet
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Deleting or Excluding Measurements from the Worksheet

Measurements can be deleted from the Extended 
Worksheet.Once a measurement has been deleted, it cannot be 
re-added. Deleted measurements show as a blank. 

NOTE: You can also choose to delete all Shear Wave measurements, 
without deleting non-Shear Wave measurements from the 
worksheet. 

Measurements can also be excluded from the Extended 
Worksheet -- and added back in at a later time. Excluded 
measurements show as a blank. 

To delete/exclude a measurement, 

1. Highlight the measurement you want to delete/exclude. 

2. Right click on the Extended Worksheet to bring up the 
Delete/Excluded pop-up menu. 

3. Select the appropriate action. 
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Deleting or Excluding Measurements from the Worksheet  (continued)

In the example below, measurements from line 4  with the blue 
rectangle have been excluded (and can be added back in); and 
measurements from line 2 have been deleted (and cannot be 
added back in). 

Figure 13-58. Example showing both deleted and excluded 
measurements
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Shear Wave Graph

The Shear Wave Graph displays an average of Shear Wave 
stiffness and velocity measurements for a patient over a period 
of time.  To see the Shear Wave Graph, select Worksheet and 
then Graph on the touch panel.

Figure 13-59. Shear Wave Graph
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Measurement Information 

The formula for Stiffness: E = 3 * rho * c2

Where E = Young’s modulus of tissue

rho = density of tissue (assumed to be 1 g/cc)

c = shear wave speed in m/s

NOTE: The conversion from shear wave speed (m/s) to Young’s 
modulus is done under the assumption that the underlying 
material in which the shear wave propagates is linear, isotropic, 
incompressible, and homogenous. 

NOTE: Relative Range = (Absolute Range / Actual Velocity)

NOTE: Normalized SD = (SD) / Average Velocity

Table 13-35:  Shear Wave Speed Variation and Precision with Depth

Measurement Units Useful Range Accuracy
Limitations or 

Conditions

Velocity m/s Shear wave ROI Absolute range <= 0.5 
m/s or relative range 
<= 15%, whichever is 
greater, for C1-6-D 
and C1-6VN-D. 
Absolute range <= 0.5 
m/s or relative range 
<= 10%, whichever is 
greater, for all other 
probes with shear 
wave elastography. 

Normalized SD 
less than or equal 
to 5% for multiple 
repeated 
measurements 
over the range of 
depths for which 
measurements 
can be made, 
limited by shear 
wave penetration. 

CAUTION
The values for shear wave speed and tissue modulus are 
relative indices intended only for the purpose of comparison 
with other measurements performed using the system. 
Absolute values for these measurements may vary among 
different measurement devices. Use Shear Wave Elastography 
as a complement to other techniques when making a 
diagnostic decision.
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Shear Wave Elastography Calculation

An Interquartile Range/Median (IQR/Median) Shear Wave 
Elastography ratio has been added. You can use this ratio to 
evaluate the reliability of Shear Wave measurements in the liver. 
This ratio is displayed as a percentage (%) on the worksheet 
(Display Accuracy to 1 decimal place). Values <30% are 
recommended for a reliable Shear Wave Liver exam. 

NOTE: The IQR/Median ratio is calculated automatically for both 
Velocity and Stiffness and displayed by default to the user. 
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Scanning Hints

HINTS You may find the following recommendations helpful when 
performing a Liver shear wave scan:  

• Locate right lobe of liver intercostally. 

• Place the ROI away from the capsule in an area free of 
vessels and fluid-filled structures.

• Suspend Patient breathing in mid-breath during the scan

• Position the ROI between 2-5 cm deep for an optimal shear 
wave scan

You may find the following recommendations helpful when 
performing a Breast shear wave scan: 

• Locate lesion

• Place lesion in center of ROI, including a sufficient amount 
of the surrounding tissue

• Only compress slightly, if necessary (compression changes 
the elastic tissue properties). 

To increase frame rate: 

• Reduce ROI Width

• Turn off Penetration Mode

• Reduce Push Output

To increase penetration: 

• Turn on Penetration Mode

• Keep Push and Track Output at 100%

• Place ROI away from edges of image

To reduce artifacts: 

• Minimize motion during acquisition

• Ensure there are no vessels within the ROI or near the left 
or right edge of the ROI. It is advisable to avoid rib 
shadows whenever possible.  

• Keep ROI at least 1cm away from the liver capsule. 
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Ultrasound-Guided Attenuation

Parameter (UGAP) Option

Overview

Ultrasound-Guided Attenuation Parameter (UGAP) measures 
the attenuation value (i.e. attenuation coefficient [dB/cm/MHz] or 
attenuation rate [dB/m]) in the liver to evaluate diffuse liver 
disease. There are four visualizations: B Ref, Color Ref, B/Color 
Dual, and Qual./Att. Dual. All visualizations measure a 
representative attenuation value. Color Ref, B/Color Ref, and 
Qual./Att. Dual measure a representative attenuation value in 
2D color map and dual display of B-Mode and 2D color map, 
respectively. 

UGAP Availability

UGAP is available on the C1-6-D and C1-6VN-D probes in the 
Abdomen (ABD) application.
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Activation

To activate UGAP, select the appropriate probe Abdominal 
application, then press BT1 (configured as UGAP). UGAP 
parameters are displayed as “U” (Frequency and Acoustic 
Output Percent) in Simple Mode. Unit of attenuation coefficient 
values are displayed as dB/cm/MHz. 

 Figure 13-60. UGAP Display
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Measurement and Worksheet

Measure the Coefficient Value

1. Scan to get the appropriate view to measure. 

2. Press Start (right Set key).  

NOTE: The Measurement ROI can be moved using the Trackball; 
more than one ROI can be placed in one frame. Avoid 
structures such as vessels to obtain UGAP measurement. 

Figure 13-61. UGAP Study

Measurements can be performed afterwards using CINE or 
recalled data where multiple frames can be selected to measure 
attenuation coefficients. 
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Add a New Site

Once measurements are complete, you can elect to add another 
site to the exam. To add another site:   

1. Press the Measurement button on the console. 

2. Select Add Site on the Touch Panel.  

3. Select Enter Site Name to add the name for the new site.

Figure 13-62. Add Additional Shear Wave Site and Enter Site 
Name

NOTE: If you no longer need the added site, you can select to delete 
the site via Delete Site on the Touch Panel. 
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Summary and Overall Worksheets

Measurements are transferred to the Summary and Overall 
Worksheets. 

Figure 13-63. UGAP Summary Worksheet

Figure 13-64. UGAP Overall Worksheet

Attenuation Coefficients are displayed (A1, A2, A3), Median, 
IQR, IQR/Median, and number of measurements (N). 
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2D Color Map

2D color map is available on Color Ref, B/Color Dual and Qual./
Att. Dual. There are two 2D color maps: Attenuation Map and 
Quality Map. Attenuation Map provides the distribution of 
attenuation values. Quality Map provides the distribution of the 
signal quality to support ROI placement.

 Figure 13-65. Attenuation Map

 Figure 13-66. Quality Map
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Continuous Wave Doppler (CWD)

Overview

There are two CW Doppler operating modes: Steerable and 
Non-Imaging.

Allows examination of blood flow data all along the Doppler 
Mode cursor rather than from any specific depth. Gather 
samples along the entire Doppler beam for rapid scanning of the 
heart. Range gated CW allows information to be gathered at 
higher velocities.

Steerable

Allows viewing of the B-Mode image to position the Doppler 
cursor to the area of interest while viewing the Doppler spectrum  
and listening to the Doppler Audio signal.

Non-Imaging

Provides only Doppler Spectrum and Audio for ascending/
descending aortic arch, other hard-to-get-to spaces or higher 
velocities.
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Activating CW Doppler

To activate CW Doppler Mode, press CW.

The Steerable CW Doppler spectrum displays along with the 
B-Mode image. The cursor changes to a Doppler cursor. 

You can now position and size the sample volume gate to get a 
velocity. Use Doppler Audio to listen for when the sample 
volume gate is positioned over an area of flow. 

Update toggles between real time B-Mode with Doppler Mode 
and real time spectral display. 

Exiting CW Doppler

To exit CW Doppler Mode, press CW.
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Tissue Velocity Imaging (TVI)

Intended Use

Tissue Velocity Imaging (TVI) calculates and color-codes the 
velocities in tissue. The tissue velocity information is acquired by 
sampling of tissue Doppler velocity values at discrete points.The 
information is stored in a combined format with gray scale 
imaging during one or several cardiac cycles with high temporal 
resolution.

Activating TVI

1. Select the desired probe.

2. While in B-Mode, press the TVI key located above the PDI 
control on the Touch Panel. The TVI image and Touch Panel 
display.

NOTE: To set up TVI on the Imaging Preset page, go to Utility--> 
Imaging--> TVI. 

CAUTION
TVI can be activated on Cardiac Sector and TEE probes only.
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Optimizing TVI

The use of preset gives optimum performance with minimum 
adjustment. If necessary, the following controls can be adjusted 
to further optimize the TVI display:

• To reduce quantification noise (variance), the Nyquist limit 
should be as low as possible, without creating aliasing. To 
reduce the Nyquist limit: Reduce the Scale value.

NOTE: The Scale value also affects the frame rate. There is a trade 
off between the frame rate and quantification noise.

• TVI provides velocity information only in the beam direction. 
The apical view typically provides the best window since the 
beams are then approximately aligned to the longitudinal 
direction of the myocardium (except near the apex). To 
obtain radial or circumferential tissue velocities, a 
parasternal view must be used. However, from this window 
the beam cannot be aligned to the muscle for all the parts of 
the ventricle.
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TVI and TVD

TVI

You can preset all parameters in Utility -> Imaging ->TVI.

The TVI parameters function the same as those described in the 
Color Flow specific section. The only differences would be that it 
pertains to tissue velocity rather than the color flow image. In the 
table below any TVI parameter or parameter specifics are noted.

TVD

While in TVI, press PW to activate Tissue Velocity Doppler.

You can preset all parameters in Utility -> Imaging ->TVD.

Table 13-36:  TVI Parameters

Control Details

Visible
Description
Adjusting
Values

In LIVE/Freeze/Archive, you can display TVI Color with TVI.
Select Visible on the Touch Panel.
On or Off.

Invert Color Invert

Baseline Adjusts the Baseline. 

Angle Steer Steers the angle

Line Density Optimizes B-Mode frame rate or spatial resolution for the best possible 
image.

Map Values: TV1 and TV2. 

Frame Average Averages color frames. 

Threshold High values display more color. Low values limit the color to lower tissue echo 
(Opposite of Threshold in Color Flow Mode). 

Transparency Map Values 0-5. 

Spatial Filter Values 0 and 1. 

Duplex Allows two modes to be active at the same time.

TVI Gain Control color transparency. High values display more color; low values 
display more tissue. This parameter is assigned to the Color Gain control.
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Quantitative Analysis (QAnalysis)

Overview

Quantitative Analysis is available for the following CINE loops 
obtained in the following modes: Tissue Velocity Imaging, Color 
Flow Mode, and Power Doppler Mode. All of the Quantitative 
Analysis modes operate similarly, with some variation.

The Touch Panel may be slightly different, for example; and the 
type of information you quantify varies by mode as well. Please 
see a summary of each mode below; followed by general 
instructions on how to perform Quantitative Analysis. 

Quantitative Flow Analysis

Provide tools for semi-quantitative assessment of inflammation 
in joints and vascularization in tumors.

NOTE: There is frame number limitation for color quantification as 400 
frames.
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Statistics

The LOGIQ Totus extracts various statistics from the image data 
within each sample area. The statistics depends on the imaging 
mode in use.

Press Statistics to enable/disable display of statistics of the 
frame or loop. The statistics are shown only when the loop is 
stopped.

• Ratio: Ratio of Color (Power) Doppler pixels over total 
sample area area.

• Area (mm2): The size of sample area

• Max Ratio/Time of Max Ratio: Maximum Ratio of Color 
(Power) Doppler pixels in each sample area, and which 
frame that occurs in.

• Min Ratio/Time of Min Ratio: Minimum Ratio of Color 
(Power) Doppler pixels in each sample area, and which 
frame that occurs in.

Quantification supports two different statistical display formats: 
Short Form and Long Form.
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Statistics  (continued)

• Short Form: Ratio and Area. 

 Figure 13-67. Color Flow Mode Short Form - Example

• Long Form: Ratio, Area, Max Ratio/Time of Max Ratio, Min 
Ratio/Time of Min Ratio 

 Figure 13-68. Color Flow Mode Long Form - Example
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QAnalysis - Tissue Velocity Imaging 

Multiple Time -Motion trace display from selected points in the 
myocardium.

QAnalysis Screen Description

 Figure 13-69. Q-Analysis Screen

Table 13-37:  QAnalysis Screen Description

1. TVI Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 
sample area is yellow, the second green, etc.

2. B Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 
sample area is yellow, the second green, etc.

3. Analysis Window.
• Y axis: Velocity scale (cm/s)
• X axis: Time(s) 
• ECG
• Time at cursor position.
• Velocity at Cursor position.
• Velocity at frame marker position (Color coded)

4. Sample Area

5. Time at cursor position and velocity at cursor position. Position the pointer cursor over the analysis 
window. 

6. Sample Area Tools.
• Pencil Icon: Creates a sample area based on freehand drawing.
• Shape Icon: Creates a sample area with a pre-defined circular/ellipse shape.
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QAnalysis Plot Control

The following controls are user configurable presets which are 
configurable through the pull-down menu in QAnalysis mode. 
When using the pull-down menu:

1. Place the cursor over the analysis window and press the left 
Set key. The system menu displays at the cursor position.

2. Select the appropriate parameter.

To switch trace 
(Analysis signal)

Analysis Signal toggles the trace display between velocity, 
displacement or gray scale intensity curves.

1. Position the cursor over the plot window and select Analysis 
Signal from the pull-down menu.

2. Select Velocity, Displacement or Grayscale Intensity as 
necessary. 

Vertical Unit

NOTE: Vertical Unit is only available when Grayscale intensity is 
selected in Analysis Signal.

When analyzing the data, the Y-axis can be set to display either 
logarithmic scale (dB) or linear, acoustic units (AU).

To toggle between dB and acoustical display units for the Y-axis.

• dB—The traditional log compressed B-Mode data is used to 
calculate the time-intensity curve values.

• Acoustic—The system reverse the log compression 
function to provide un-log compressed data for the 
Qanalysis.

Drift Compensation

Drift Compensation compensates drifting of Tissue Tracking 
curves by either resetting the curve to zero at the tracking start 
point (cycle resetting) or by linear compensation throughout the 
cycle (linear compensation).

NOTE: When Displacement is chosen by AnalysisSignal, Drift 
Compensation is active.

NOTE: Drift Compensation is inactive if ECG data cannot be acquired.
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Trace Measurements

Gradient Select Gradient entry on the pull-down menu that is obtained 
when the cursor is placed over the plot.

Gradient is displayed on the screen instead of velocity. The 
gradient calculates from 7 points (includes previous and next 
frames).

Max Gradient Displays the time and gradient that becomes the maximum 
gradient between the CINE start and end frame. 

Figure 13-70. Max Gradient
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Selecting QAnalysis Image Range

A range of frames is selected for the QAnalysis in Cine mode 
(before accessing QAnalysis). Only the frames in this range are 
used for the QAnalysis.

If a range is not selected prior to accessing the QAnalysis, the 
system uses the default Cine start and end frames as the default  
start and stop frames.

1. The first frame in the analysis series is selected by adjusting 
the Start Frame control to the desired frame

OR

using the Trackball or the Frame by Frame control to 
select the desired first frame and then selecting the Start 
Frame control.

2. The last frame in the analysis series is selected by adjusting 
the CINE End Frame control to the desired frame

OR

using the Trackball or the Frame by Frame control to 
select the desired end frame and then selecting the End
Frame control.

Activating QAnalysis

1. Scan and Freeze the patient in the desired live mode or 
recall a desired cine loop from the stored images.

NOTE: QAnalysis is only available when the system is in CINE 
mode.

NOTE: Images from the current scan session acquired in the 
desired analysis mode (already in CINE) or from a saved 
image loop can be used for QAnalysis.

2. QAnalysis displays on the Cine Touch Panel.

3. Select QAnalysis. The QAnalysis screen and Touch Panel 
displays. To toggle the trackball function between QA and 
Scroll, press the top Trackball key.
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Common QAnalysis Function

Display the System Menu

Place the cursor to the desired position and press the left Set
key. The system menu displays at the cursor position.

The system menu is dependent on the area which you place the 
cursor.

Generating a Trace

Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) 
before anchoring.

NOTE: The free sample area disappears when the QA cursor is 
moved over a static anchored frame.

• Static sample area: the free sample area is anchored by 
pressing Set.

• Dynamic anchored sample area: the sample area is 
anchored in two or more frames (see Manual tracking 
below). In these particular frames, the sample area is 
displayed with an anchor. The sample area moves smoothly 
between the anchored positions when playing/scrolling the 
cineloop.

Trace from a pre-defined sample area

1. If the trackball assignment is not on QA, press the top 
Trackball key until QA highlights.

2. If necessary, select the sample area Ellipse sample area 
button (shape icon on the monitor display).

3. Move the cursor to one of the Cineloop windows using the 
Trackball.

4. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If 
the cineloop has more than one heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle.

The trace is updated accordingly in the Analysis window.
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Generating a Trace  (continued)

Trace from freehand sample area

1. Select the Freehand sample area button (pencil icon on the 
monitor display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Press and hold down the Set key while drawing a sample 
area using the Trackball.

4. Release the Set key.

The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window.

Manual tracking of the sample area (dynamic anchored sample area)

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

7. Press the top Trackball key until the scroll trackball 
assignment is selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.
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Generating a Trace  (continued)

Moving a dynamic anchored sample area

1. Press the top Trackball key until the scroll trackball 
assignment is selected.

2. Using the Trackball, browse through the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to a new location.

7. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 

Manipulating the Sample Area

Up to eight sample areas can be saved on the reference image, 
with the corresponding eight traces plotted simultaneously on 
the graph. Each sample area display has a different color, and 
its corresponding trace data is plotted using that same color.

Once eight sample areas have been saved, the system does not 
automatically generate an active sample area when the cursor is 
positioned over the displayed reference image.

The saved sample areas can be a mixture of elliptical and 
freehand sample areas.

When the user repositions a sample area, the old trace data is 
erased from the plot and the trace data for the new position 
replotted.

If the sample area position on the last frame of the selected 
image range is moved, the corresponding sample areas on all 
frames are repositioned to match the last frame.

The user shall also have the capability of setting separate 
sample area positions on different frames of the contrast 
images, and the system shall linearly interpolate the sample 
area positions for the frames in between the selected frames. 
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Setting the default sample area shape

1. Select Set sample area shape. The Information Box 
displays.

Figure 13-71. Sample Area Information Box

2. Select Height, Width and Tilt angle.

3. Select Set as default. The current sample area size is set 
as the default for subsequent Ellipse sample areas.
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Sample Area Shapes

There are two different methods for determining the shapes of 
the sample area.

Ellipse sample area

1. Select the ellipse icon (shape icon on the monitor display).

2. When the trackball positions the image display cursor over 
the reference image(s), an elliptical sample area is 
automatically generated and displays on the reference 
image(s). 

3. The average velocity value inside the ellipse is calculated 
for every image in the image analysis range and plotted in 
the image display area.

4. The last generated or selected ellipse is considered the 
active sample area, and its trace plot automatically updates 
as the user repositions it on the reference image. Old traces 
are erased.

5. When scanning with an elliptical sample area, press Set to 
fix the sample area position and freeze its corresponding 
trace on the plot. A new active sample area is generated 
whose position is manipulated by the trackball and whose 
velocity curve traces will be plotted as before, while the 
previous sample area and trace remain fixed at the points 
they were saved at.

NOTE: Elliptical sample areas can be positioned in any manner that 
keeps their center within the image boundaries. In the case that 
part of the sample area is outside the image boundary, only data 
from within the image boundary is used for calculating the mean 
velocity value.

NOTE: You can change the size of the Ellipse sample area by adjusting 
the Ellipse control. 

Freehand sample area

1. Select Freehand icon (pencil icon on the monitor display).

Use the Trackball to position the caliper on the reference 
image at the start point. Press Set to fix the start point.

2. While holding down the Set key, trace the outline of the 
desired sample area by moving the caliper with the 
Trackball.
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Reshaping a Sample Area

To reshape the sample area:

1. Position the cursor on the sample area to reshape and 
press the left Set key.

2. The sample area system menu displays. Select Set sample 
area shape.

Figure 13-72. Sample Area Information Box

3. Adjust Height, Width and Tilt angle.

4. Press OK. The selected sample area size changes.

Labeling a Sample Area

The sample area label is used to identify data associated with 
the sample area when exporting.

1. Position the cursor on the sample area to label and press 
the left Set key.

2. The sample area system menu displays. Select Label 
sample area. The Label Dialog box displays.

Figure 13-73. Label Dialog Box

3. Enter a name for the sample area.

4. Select OK.
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Copy, move, and paste a Sample Area

To copy and paste the sample area, 

1. Move the cursor over the sample area and press the left Set 
key. The system menu displays. 

2. Select Copy sample area.

3. Move the cursor to the desired location for the copied 
sample area and press the left Set Key. The system menu 
displays. 

4. Select Paste sample area.

To copy and move the sample area, 

1. Move the cursor over the sample area and press the left Set 
key. The system menu displays. 

2. Select Copy & move. Or if you want to move to the same 
depth as the original sample area, select Copy & move 
(same depth).

3. Move the copied sample area using the Trackball. Press 
Set to fix the position.

Deleting a Sample Area

Sample sample areas and their corresponding traces can be 
deleted using Delete Sample Area.

1. Select Delete Sample Area; a pull-down menu displays.

Figure 13-74. Delete Sample Area pull-down menu

2. Select Current sample to delete the currently active sample 
area.

Select Delete all to delete all currently set sample areas 
and all of their traces.

NOTE: The corresponding traces for the deleted sample areas are 
erased from the plot.

NOTE: Deleting a sample area causes the sample areas to be deleted 
from all frames in the analysis loop.
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QAnalysis Plot Control

NOTE: Plot Control is available only with TVI and Elastography modes.

The following controls are user configurable presets which are 
configurable through the pull-down menu in QAnalysis mode. 
When using the pull-down menu:

1. Place the cursor over the analysis window and press the left 
Set key. The system menu displays at the cursor position.

2. Select the appropriate parameter.

Vertical auto-scaling

The system can be configured to display the full unit range or a 
range according to the maximum and minimum values of the 
displayed trace(s) (auto-scaling function). In addition, the 
auto-scaling function can be set to be live update (updates while 
the sample area is moved) or delayed (updated when the 
sample area is anchored).

• Delayed—The system automatically rescale the vertical 
axis of the trace graph only when a new sample area is 
saved, to account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of 
the trace graph every time the currently selected (active) 
sample area is moved.

• Off—Disable any automatic scaling of the vertical axis. 
There is user-defined system defaults on the system preset 
page for the fixed vertical scale to be used for the plot.

Figure 13-75. Vertical Autoscale Pop-up menu
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Line Style

• Solid—Setting the results in a plotted trace that does not 
display small boxes at the data points

• Squares—Setting the results in a plot where small squares 
are displayed at each data point, and the squares are linked 
together by lines.

Figure 13-76. Line style Pop-up menu

Smoothing

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing.

OR

Position the cursor over the analysis window and press the 
left Set key. The System menu is displayed at the cursor 
position. Select Smoothing.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays.  Select the appropriate 
parameter.

Horizontal Sweep

Horizontal Sweep allows you to increase or decrease the time 
interval over which to plot the analysis curve. 

The default is the user selected image range. If the user has not 
yet selected a first and last frame, the first and last default 
frames from the displayed CINE loop are used.
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Zooming in the Analysis window

To zoom:

1. In the Analysis window, press and hold down the Set key 
while dragging the cursor to define the zooming area.

2. Release the Set key.

To unzoom:

1. Press the left Set key in the Analysis window. The system 
menu displays.

2. Select Unzoom.

Disabling/Enabling the frame

NOTE: Frame disable/enable is available only with Elastography, CF, 
and PDI modes.

Frame disabling excludes the actual frame from the cineloop 
display.

Disabling the frame from the frame marker

To disable One Frame:

1. Use the Trackball to move the cursor to the frame marker to 
disable.

2. Press Set to disable the frame.

3. The frame marker is changed from green to red to indicate 
the frame has been disabled. 

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory.

Disabling multi-frames from the frame marker 

1. Use the trackball to move the cursor to the first frame 
marker to disable.

2. Press and hold down Set

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.
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Disabling a frame from the cineloop window

1. Use the trackball to move the cursor to the cineloop window.

2. Press the left Set key. The system menu displays.

3. Select Disable frame.

The current frame is disabled and the corresponding frame 
marker displays red.

Disabling Frames - Auto

When the user enters Elasto Quantification, the useless frames 
are disabled automatically. The LOGIQ Totus uses Elastography 
Index value to find useless frame (low quality frames).

Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in 
all heart cycles but a selected one. This function can be used for 
example to select a particular systolic frame for each heart 
cycle.

1. Scroll through the cineloop to identify the cardiac phase to 
analyze or identify the cardiac phase on the ECG trace 
(where available).

2. Position the cursor on the ECG trace (where available) and 
press left Set key. The system menu displays.

3. Select ECG triggering (where available).

All frames in all heart cycles are disabled except for the 
selected and corresponding frames in the other heart 
cycles.
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Disabling/Enabling the frame  (continued)

To enable the frames

To re-enable all deleted frames:

1. Position the cursor on the Frame Marker line and press the 
left Set key. The system menu is displayed at the cursor 
position.

2. Select Enable all frames.

3. All disabled frames are re-enabled.

Figure 13-77. Frame Markers

1. Analysis Window
2. Frame markers axis
3. Enabled frame (Green)
4. Disabled frame (Red)
5. ECG (where available)
6. Current frame
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Exporting Traces (Saving the Trace Data)

You can save the trace data to an external file in ASCII format, 
readable in spreadsheet programs.

1. Select Export Traces to save the trace data.

2. Specify the following: 

• Location : Select Location which to save.

• Filename : Enter the filename. (Only Text)

3. Select OK to save the data and return to the QAnalysis 
screen.

• All displayed sample area traces are saved in the 
exported file.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: No trace results are saved in the standard image database.

Annotating the QAnalysis Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.

Printing QAnalysis Data

Press the appropriate print key in the desired analysis mode 
mode. 

The system captures a single still frame which consists of the 
plot, the reference image, and user annotation.

Exiting QAnalysis

There are several methods to exit QAnalysis.

• Toggling Exit QAnalysis on the QATouch Panel.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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Stress Echo

Introduction

The LOGIQ Totus Ultrasound system provides an integrated 
stress echo package, with the ability to perform image 
acquisition, review, image optimization, and wall segment 
scoring and reporting for a complete, efficient stress echo 
examination.

The stress package provides a protocol template for the two 
types of stress exams (exercise and pharmacological stress). 

In addition to preset factory protocol templates, templates can 
be created or modified to suit your needs.

You can define various quad screen review groups, in any order 
and combination, that will suit your normal review protocol.

When reviewing stress examination images, the images are 
viewed at their original image quality, and different 
post-processing and zoom factors may be applied to the images 
under review for effective image optimization.

The protocol template may be configured for Continuous 
Capture.

A stress echo examination consists of three steps:

• Selection of a stress test protocol template

• Image acquisition

• Stress Analysis

NOTE: If WallMotion Segment Score is not displayed on the screen, 
select the “WallMotion” preset in the Utility -> Measure ->  M&A 
-> Plot -> Available Folders and Measurements. 
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Getting started with a stress study

1. After selecting the appropriate application and probe, press 
the Protocol tab on the Touch Panel. The protocol screen 
displays the layout of the default stress protocol for the 
current probe. This layout is also known as a template.

Table 13-38:  Protocol Tab

Parameter Description

Analyze Display the Analysis screen

Template Editor Display the template editor screen

Add Level Add Level to the template

Delete Images Delete the selected image

Move Image Move the selected image to the another cell

Sync. Select Synchronize the selected images.

End CC End Continuous Capture

Begin/Cont. Begin or continue the acquisition

Template Display the template list

T1 Display/Hide the timer T1

T2 Display/Hide the timer T2

Cancel Cancel Stress Echo
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Getting started with a stress study  (continued)

2. To use the current template, press Begin/Cont. to initiate 
scanning. 

To use another template, press Template. The template list 
displays.

Figure 13-78. Template List

3. Trackball to the desired template and press Set.
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Getting started with a stress study  (continued)

4. The selected template displays.

Figure 13-79. Template (Example)

a. Level

b. Projection

c. Current Acquisition (green)

5. Press Begin/Cont. to initiate scanning using the new 
template.
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Image acquisition

Images are acquired in a pre-defined order, according to the 
selected template. The highlighted (green) cell of the template 
matrix, displayed in the Clipboard window, indicates which view 
is currently being acquired.

The names of the view and levels for the current cell are 
displayed on the top left corner of the image area and under the 
template matrix.

Acquisition Screen

1. Current View Level

2. Timer

3. Template Matrix

4. Current View (Green cell)
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Starting acquisition

1. Select the template.

2. Press Begin/Cont.

3. Perform a scan that conforms with the view that is 
highlighted in the template matrix on the Clipboard window.

4. Press the P1 (Image Store) key.

• If the actual stress level is configured to preview the 
cine loop before storing, use the cine loop controls to 
select the most appropriate heart cycle and if desired 
adjust the loop markers. Press P1 again to save the 
selected cine loop.

or

If you do not want to store the cine loop, press Freeze to 
cancel. Return to the scan screen.

• If the actual stress level is not configured to preview the 
cine loop before storing, the system automatically 
stores the last heart cycle.

Stress levels can be configured for side-by-side display/
comparison of the reference loop from baseline or previous level 
and the loop to acquire.

5. After storing the cine loop, the system automatically 
highlights the next view in the matrix to be acquired.

6. Repeat previous steps until all required views are 
completed.

7. If you select Auto Start Analysis on the Template Editor for 
this template, a dialogue asking “Do you want to start 
protocol analysis now?” displays when the last acquisition is 
complete. If you select Yes, the Stress Echo Analysis screen 
is displayed.

The template used can be configured so that analysis 
automatically starts by displaying the first protocol group. The 
wall segment scoring diagrams for each view is displayed in the 
Parameter window on the left side of the screen.
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Starting acquisition  (continued)

If the Protocol tab is selected during acquisition, the following 
Touch Panel displays.

Table 13-39:  Protocol Tab during acquisition

Parameter Description

Stop Stop Stress Echo.

Pause Pause Stress Echo. The template matrix continues in display. Even if you 
press P1, the cine loop does not store to the matrix.

Select Cycles The Continuous Capture Selection screen is displayed (only available in 
Continuous Capture mode).

Analyze Enter Analysis screen.

Template Enter Template screen.

Add Level Add level to the template.

T2 Display (Start)/Hide Timer T2.
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Selecting a view during acquisition

A fixed protocol is provided for scanning, based on the selected 
template. The system automatically highlights the next view to 
be acquired in the template matrix, as images are stored. 
However, the order of scanning may be changed manually as 
follows:

Manual selection of a view during acquisition

1. Use the Trackball or the arrow keys on the alphanumeric 
keyboard to move the cursor to the cell that represents the 
view to be acquired.

The selected cell in the template matrix, highlighted in red, 
indicates the non-default position. When blinking, it contains 
a previously-stored acquisition.

2. Press Begin/Cont. to initiate scanning.

3. Scan and save the selected loop as explained in the 
previous section.

After storage, the system automatically highlights the next 
available view to be acquired.
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Moving an acquired image

An image can be moved from one cell to another during 
acquisition.

Procedure 1

1. When in the Protocol screen, press Move Image.

2. Use the Trackball to move the cursor to the desired image.

3. Press Set.

4. Use the Trackball to move the cursor to the destination cell.

5. Press Set. The image is moved from the source cell to the 
destination cell.

Procedure 2

1. In the Protocol screen, use the Trackball to move the cursor 
to the cell containing the image to move (source cell).

2. Press and hold down Set.

3. With the Set key still depressed, move the Trackball to the 
desired cell.

4. Release the Set key. The image is moved from the source 
cell to the destination cell.

If the destination cell contains an image, the images from the 
source and destination cells is exchanged when moving an 
acquired image.
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Timers

Two timers can be displayed in the Stress mode acquisition 
screen, beside the template matrix.

Timers

• T1 displays the elapsed time from the start of stress 
examination.

• T2 starts when entering live scanning on the second stress 
level.

Both T1 and T2 timers can be manually stopped and restarted 
during the acquisition.

The display of T1 and T2 is user-configurable.

NOTE: If you activate the Timer in Stress Echo, the T1 timer is 
displayed in the lower left-hand corner of the image area after 
exiting Stress Echo. 
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Continuous Capture mode

Continuous Capture mode enables the user to perform 
acquisition continuously for all views at any level depending on 
the selected template configuration. Continuous Capture 
consists of temporary images and loops acquired during the 
session in a storage buffer in system memory. To enable best 
possible use of the limited storage buffer capacity, a Pause/
Capture mode is provided, as opposed to the normal Freeze/
Scan mode. The Pause mode enables scanning and live display 
on the screen, without any capture, thereby leaving the buffer 
available.

To run Continuous Capture, the user has to select a template 
where this feature is activated.

WARNING Leaving a Stress Echo exam PRIOR TO saving portions of the 
Continuous Capture through “select cycle” or triggering a 
“Store All” could result in the loss of Continuous Capture data. 

The continuous capture acquisition obtained using the P1 print 
key while in protocol is stored in temporary memory. Loss of 
power before properly ending the patient or before selecting 
cycles will result in the loss of this information in certain 
configurations. 

Upon completion of cycle selection or when ending current 
patient, the user will be prompted as to what they would like to 
do with this temporary buffer.  If they choose "store all," the 
information will then be placed in permanent memory on the 
system’s hard drive. 

WARNING DO NOT change modes or power off the system while in 
Continuous Capture Mode. Doing so causes images and data 
acquired during the session to be lost.   
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The buffer bar

When entering a level with Continuous Capture enabled, a 
buffer bar displays in the window.

The Buffer bar displays the following information:

• The scanning state

• Pause (live scanning without storing)

• Capture (live scanning with storing temporary images 
and loops to system memory buffer)

• The percentage of the buffer that is filled

• The buffer filling progression showed by a filling gage

• The capturing sessions, reflected by the red lines along the 
buffer bar

Figure 13-80. Buffer Bar



Advanced Features

13-184 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Controlling the capture process

When entering a stress level with Continuous Capture enabled, 
the system is automatically set in Pause mode.

1. Press P1 to start image capture.

“Capture” is displayed in the buffer bar, the gage starts filling 
and the percentage of filled memory buffer increases.

2. Press P1 again to stop capture.

“Pause” is displayed in the buffer bar.

When 90% of the memory buffer is filled up, the text display in 
the buffer bar turns red.

The system enters Freeze mode automatically once the buffer is 
full and the captured loops display in the Continuous Capture 
selection screen.

Activating Continuous Capture

1. Do all your pre-stress acquisitions in the Cardiac 
application.

2. Press the Protocol tab to enter the Stress Echo mode. The 
Protocol screen displays.

3. Press Template. The template list displays.

4. Select the template Exercise 2x4 from the list.

5. Press Begin/Cont..

6. Acquire the resting loops in all four views.

NOTE: Use the P1 key to store the images.

7. Once the fourth loop is acquired, the system enters into a 
waiting mode where Continuous Capture is in a pause state 
awaiting the patient to exercise.

8. When the patient is back on the bed, press P1. The 
Continuous Capture acquisition starts.

9. Acquire all your views.

The memory buffer gage increases. When memory exceeds 
90%, the percent number turns red.

10. Press Freeze to finish.
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Activating Continuous Capture  (continued)

11. Press Select Cycle.

The Continuous Capture selection screen displays.

Refer to the next section if additional image acquisitions are 
necessary after the buffer is full.

 Figure 13-81. Continuous Capture Selection Screen
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Activating Continuous Capture  (continued)

12. Assign the cine loops to the four views. 

 Figure 13-82. Drop-down Menu

1. Trackball to the desired loop.
2. Press Set. A drop-down menu appears with the available choices.
3. Trackball to the appropriate view.
4. Press Set.
5. Continue these steps until all views are selected.

NOTE’ To access additional cycles, use the arrow keys on the lower left 
portion of the select cycle screen.

6. Select Done when complete. A dialogue window displays, asking 
whether the entire Continuous Capture acquisition should be saved.
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Activating Continuous Capture  (continued)

Figure 13-83. Dialogue Window

13. Press Delete to discard the loop or press Store to keep the 
entire loop.

14. Perform Analysis and scoring.
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Continuous Capture with additional image acquisition

If the buffer is filled up before all the image acquisitions are 
done, additional loops can be stored in the clipboard before 
doing image assignment to the views.

1. Perform the Continuous Capture. See ‘Activating 
Continuous Capture’ on page 13-184 for more information.
(Steps 1 to 11).

2. In the Continuous Capture selection screen, press Select 
Later.

The Continuous Capture screen displays.

3. Perform the additional acquisition.

4. In order to resume the stress echo exam and assign loops 
for the views from the Continuous Capture buffer, press 
Protocol. If not displayed, select the template Exercise 2x4
from the template list.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view. See ‘Activating 
Continuous Capture’ on page 13-184 for more information.
(Step 12 a - f).

7. Press Delete to discard the loop or press Store all to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.

8. Perform Analysis and Scoring.
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Postponed image assignment

The assignment of the cine loops to the view can be done on a 
later stage on a stored Continuous Capture acquisition.

1. Perform the Continuous Capture.  See ‘Activating 
Continuous Capture’ on page 13-184 for more information.
(Steps 1 to 11).

2. Press Store all.

The entire Continuous Capture acquisition is stored. The 
examination can be ended and the image assignment, 
analysis and scoring can be done later.

3. Re-open the examination, if necessary.

4. Press Protocol. The Protocol screen displays.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view.  See ‘Activating 
Continuous Capture’ on page 13-184 for more information.
(Step 12 a - f).

7. Select Done.

8. Perform analysis and scoring.

Restart capture from the Continuous Capture Selection

• Press Restart Capture.

The recording in memory is deleted and the Continuous 
Capture starts again.

Resume Continuous Capture

• Press Continue Capture.

Resumes Continuous Capture recording (only if the 
Continuous Capture buffer is not full).
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Assigning and storing the cine loop

The cine loops captured in the buffer are assigned to the stress 
protocol views and stored from the Continuous Capture 
selection screen.

 Figure 13-84. Continuous Capture Selection Screen

1. Highlighted loop
2. Cycle number and total number of cycles
3. Blue Gauge: Position of the highlighted loop within buffer area. 
4. Red bar: Pause session. 
5. Navigation Controls: << < > >> (back to first selection, back to previous selection, forward to next 

selection, and forward to final selection). 
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Assigning a cine loop to a view

1. Use the Trackball to move the cursor to the desired cine 
loop in order to assign it to a particular view of the stress 
template.

The frame of the loop is highlighted.

2. Press Set.

A pop-up menu displays with the view names of the 
template.

 Figure 13-85. Loop Assignment

1. Already assigned view
2. Views pop-up menu

NOTE: A checkmark appears on the Views pop-up after you have assigned a view to an image.
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Assigning a cine loop to a view  (continued)

3. Use the Trackball to select the required view name.

4. Press Set.

The name of the view displays above the timers in the 
window.

5. Repeat steps 1 through 4 to assign loops to the other views 
of the level.

6. Press Done when complete.

A dialogue window displays asking whether the entire 
Continuous Capture acquisition should be saved.

7. Press Delete to discard the loop or press Store all  to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.
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Post Acquisition Features

Post acquisition, you can utilize Raw Data to adjust the following 
in B-Mode: 

• Zoom

• SRI-HD

• Rejection

• Frame Average

• TGC

• Maps

• Dynamic Range

• Gain

• Rotation

You can also take measurements post Stress Echo acquisition. 
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Analysis

Analysis consists of viewing previously saved loops and 
assigning scores to each cardiac segment, in order to quantify 
the function of the muscle or wall segment.

Depending on the protocol configuration, the analysis stage can 
start manually or automatically after completion of the stress 
test. In this case, the usual procedure consists of sequentially 
opening all image groups (if defined) and performing scoring 
from image to image.

The quad screen is the standard display for comparing heart 
cycles. The heart cycle loops in the display are synchronized to 
enable comparison. Each loop in the quad screen can be 
magnified, using the zoom control.

Image Selection for Analysis

Images can be selected manually or from a pre-defined group in 
the Protocol screen.

Selection of Images from a group

If groups of images have been defined in the protocol template, 
you can select a group of images for analysis and sequentially 
analyze all images from all groups from within the Analysis 
screen.

1. In a stress examination, press Protocol. A preview of the 
acquisition displays.

2. Press Analysis. A pre-defined group appears in the display 
with a Wall Segment window on the left. 

3. To advance to other groups, use the Trackball to move the 
cursor to the arrows at the bottom of the Wall Segment 
window. Select an arrow to advance to another group. For 
further clarification, see callout E in Figure 13-86. 
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Manual selection of images from Analysis screen

1. When currently in the protocol analysis screen in the Stress 
analysis quad screen, hold down the SHIFT key while 
performing Steps 2 through 4.

2. Use the Trackball to move the cursor to the first image to 
select in the template matrix.

3. Press Set. The frame of the selected loop is in the Stress 
analysis screen and the next window in the quad screen is 
automatically selected.

4. Repeat step 2 and 3 to select other images.

5. Depress SHIFT .

Manual selection of images in the Protocol screen

1. In a stress examination, press Protocol. A preview of the 
acquisition displays.

2. Use the Trackball to move the cursor to the first image to 
select.

3. Press Set. The frame of the selected loop highlights.

4. Repeat Steps 2 and 3 to select other images.

5. Press Analyze to open images in the Analysis screen.
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Scoring acquired loops

1. After image selection, press Analyze.

The Stress Echo analyze screen displays.

 Figure 13-86. Analysis Screen

a. Wall segment diagram
b. Selected loop (Highlighted frame)
c. Displayed loops (Highlighted frames)
d. Exit Wall motion scoring
e. Change page or enter next image group
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Scoring acquired loops  (continued)

2. Use the Trackball to move the cursor to a score.

3. Press Set.

The score displays in the relevant segment area in the 
diagram.

NOTE: To edit a score, select it and choose a new score.

4. Repeat step 1 through 3 to score relevant segments.

5. Press the Change Page arrow to display the next group of 
images.

6. Repeat step 1 through 3 to score relevant segments on the 
new loops.

Figure 13-87. Segment Scoring

NOTE: Since Cine changes into sync mode, subsequent scans are also 
synchronized. Exit sync mode from the Cine menu.
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Editing/Creating template

The stress package provides protocol templates for exercise as 
well as pharmacological stress examinations.

The user can create new templates or modify existing templates 
to suit the individual needs. Up to ten projections and fourteen 
stress levels can be created in a template.

Templates created may be temporary, used only during the 
current examination, or saved as new templates, for future use 
and reference.

The editions that may be performed include:

• Adding/Deleting levels and projections.

• Assigning new labels to levels and projections.

• Defining level options.

• Defining new groups.

Templates are edited/created from the Template editor screen.

Entering the Template editor screen

1. Press Protocol to enter the stress echo mode.

2. Press Template.The template list displays.

3. Use the Trackball to select the Template Editor.

4. Press Set. The Template Editor screen displays.

OR

1. Press Protocol to enter the stress echo mode.

2. Press Template Editor on the Touch Panel. The Template 
Editor screen displays.
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Template Editor screen overview

 Figure 13-88. Template Editor Screen

Table 13-40:  Template

Parameter Description

Template Select a pre-defined template from the pull-down menu. The protocol 
template preview updates accordingly.

Table 13-41:  Protocol Template Preview

Parameter Description

Protocol Template Preview • Displays an updated preview of the template accordingly to the settings 
applied.

• To change Projection and Stress level labels, select a pre-defined label from 
the pull-down menu or press Set in the actual label field and type a new 
name.
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Table 13-42:  Template Settings

Parameter Description

Template Settings • Cycles: select the number of cine loop heart cycles to store for each level 
from the pull-down menu or enter the desired value manually.

• Continuous Capture: Checking this parameter enables continuous image 
acquisition throughout the level. The images acquired are temporarily 
stored in the system’s storage buffer.

• Preview of store: Checking this parameter enables review and 
adjustment of cine loops before store.

• Show reference: Checking this parameter displays a dual screen with the 
reference level (first or previous level) on the left and the live image on 
the right.

Table 13-43:  Scan Mode

Parameter Description

Scan Modes • 2D, Color, PW (Pulsed Wave Doppler), CW (Continuous Wave Doppler), 
MM (M-Mode), Color MM, Color PW, Color CW

Table 13-44:  Other options

Parameter Description

Other Options • Grid Size: Enter the number of levels and projections for the selected 
template.

• Timers: If you check this parameter, starts T1 and T2 timers 
automatically.

• Auto-start analysis: If you check this parameter, displays the Stress Echo 
Analysis when the last acquisition is performed.

• Show Systole in Analysis: When selected, the systolic part of the cardiac 
or ECG cycle is only displayed. The whole cycle is not displayed. 

• Smart Stress: Check Smart Stress to store and automatically reuse a 
subset of the image acquisition settings from a previous level in the 
corresponding views in the next level.  When smart stress is used  with 
"preview to store" function the timeline modes (PW, CW, M Mode, TDI) 
will only transfer image acquisition settings from baseline. 

• Reference image: When Show Reference is selected, selects either 
corresponding baseline loop or corresponding loop from the previous 
level to be displayed as reference image during acquisition.

Table 13-45:  Pre-defined groups

Parameter Description

Pre-defined groups • Shows the image groups created.
• New group: Creates a new image group. Select the desired images on 

the template preview.
• Update group: Edits a selected group after new loop selection on the 

template preview.
• Delete group: Deletes a selected group.
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Editing/Creating a template

Selecting a base template to edit

1. Select the base template from the template pull-down menu 
on the upper left corner.

2. Press Set.

The selected template displays in the protocol template 
preview field, showing the levels, projections and their 
labels.

Adding/Deleting levels and projections 

1. Enter the number of levels and projections in the Grid size 
field.

The new grid size displays in the protocol template preview 
field.

2. Press New Template to create a new template.

or

Press Save Template to update the base template.

Display timers

1. Check the box(es) to display timer(s) as specified.

NOTE: The timers can also be started or stopped at any time during 
stress examination by using the T1 and T2 Touch Panel key.

Start analysis automatically

1. Check Auto Start Analysis to display the Stress Echo 
Analysis screen when the last acquisition is performed.

Smart Stress

1. Check Smart Stress to store and automatically reuse a 
subset of the image acquisition settings from a previous 
level in the corresponding views in the next level.  When 
smart stress is used  with "preview to store" function the 
timeline modes (PW, CW, M Mode, TDI) will only transfer 
image acquisition settings from baseline.
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Editing/Creating a template  (continued)

Configuring levels

The following options can be set up for each level:

Number of cycles to be stored in the cine loop:

1. Enter the desired number (1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 15, 20) 
in the Cycles field.

Continuous Capture

1. Check Continuous Capture if continuous image acquisition 
throughout the level is desired.

When Continuous Capture is selected, preview of the cine 
loop and reference display during acquisition are not 
possible.

Preview of store

1. Check Preview of store if review and adjustment of cine 
loops before storage is desired.

Show reference

1. Check Show reference if the display of the corresponding 
reference loop is desired during acquisition (Dual screen 
mode).
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Editing/Creating a template  (continued)

Adding a group

1. In the Protocol template preview field, select the cells to be 
part of the group.

2. In the Pre-defined group field, press New group.

A dialogue box displays to ask the user to enter a name for 
the new group.

3. Enter the group name.

4. Press OK. The new group displays in the pre-defined group 
field.

Updating an existing group

1. In the Pre-defined group field, select the group to edit.

The selected cells are highlighted in the Protocol template 
preview field.

NOTE: A selected group is highlighted by a blue frame.

2. Either select a new cell(s) to add to the group or deselect an 
existing cell(s) to remove from the group.

3. Press Update group.

The display in the Protocol template preview field is updated 
accordingly.

Deleting a group

1. In the Pre-defined group field, select the group to delete. 

NOTE: The selected group is highlighted by a blue frame.

2. Press Delete group.

The group is removed from the list in the pre-defined group 
field.

Specifying Scan Mode for each Projection

1. Specify the Scan Mode for each Projection: 2D (B-Mode), 
Color Flow Mode, M-Mode, Color M-Mode, PW Mode, Color 
PW Mode, CW Mode, or Color CW Mode. 
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Editing/Creating a template  (continued)

Saving the Template

You can save the template using controls at the bottom of the 
Template Editor page, or use the controls on the Touch Panel. 

Table 13-46:  Template Editor Saving Options

Parameter Value

New Template Select this option to create an entirely new template. 

Save As Template If you would like to create a new template based on the existing template with 
your modifications, select to Save this Template As, and give it a name. 

Save Template Select this option to save the default template with your modifications. 

Delete Template Select this option to delete a template. 
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Wall Motion Segment Setup 

You can set up the following parameters for Wall Motion 
Segment in the Utility screen (Utility--> Measure--> Advanced--> 
Cardiac).

Utility Application Settings for Protocol

Table 13-47:  Wall Motion Segment Parameters

Parameter Value

WMS freeze loop at ES Specify to freeze the Loop at End Systole

WMS Segment Model Select 16 or 18 segments

WMS initial scoring Undefined or Normal

WMS scoring legend ASE, ASIA or European

Table 13-48:  Protocol Parameters

Parameter Description

Show Protocol Tab Show/Hide the Protocol tab for that preset (Bicycle Normal, Bicycle Sporty, 
Contrast Pharmacological, Pharmacological 4x4, Pharmacological 8x5, 
Exercise 2x4, Exercise 2x4 B, Pharmacological US 4x4, or User-configured).

Template Select the default template.
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Report

If you set up the Wall Motion Analysis field on the Report, you 
can insert the results. 

Select Report to view either the Bull’s Eye or Cut Plane Report. 

 Figure 13-89. Bull’s Eye Report Sample
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Report  (continued)

 Figure 13-90. Cut Planes Report Example

HINTS Select either Bull’s Eye or Cut Plane on the Reports--> Adult 
Template. 
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Cardiac Automated Functional

Imaging (Cardiac Strain)

Cardiac Strain

Cardiac Automated Function Imaging (Cardiac Strain) is a 
decision support tool for global and regional assessment of the 
LV systolic function. Cardiac Strain calculates the myocardial 
tissue deformation based on feature tracking on B-Mode grey 
scale loops.

Cardiac Strain is performed on the standard apical views, apical 
long-axis (APLAX), 4-chamber (A4CH) and 2-chamber (A2CH), 
following an on screen guided workflow. The apical views may 
be acquired sequentially in B-mode.

Cardiac Strain is also available for standard apical views 
acquired with a TEE probe.

Cardiac Strain may be launched from the Cardiac application 
using Transthoracic echocardiogram (TTE) images from the 
M5Sc-D probe, or from the Pediatric application using either the 
6S-D probe.

If a complete analysis of all three views is performed, the result 
is presented as a Bull's eye display showing color coded and 
numerical values for peak systolic full wall longitudinal strain, 
PSS (Peak Systolic Strain), TTP (Time To Peak global 
longitudinal strain) and traces. 

If the user approves the results, all values are stored to the 
worksheet. In addition, Global Strain for each view, Average 
Global Strain for the whole LV, standard deviation of the 
segmental Time To Peak Strain and the Aortic Valve Closure 
time used in the analysis are stored to the worksheet.
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Texture is an imaging technique that enhances structural 
information and attenuates reverberations and other signals that 
do not represent the location displayed. Unlike B-mode, the 
brightness of the Texture image is not directly related to echo 
amplitude. Texture is useful for an enhanced view of layers, 
borders and structures. Pixels in a normal image that would be 
dominated by energy not coming from the target location will 
appear darkened. Speckle from blood signals will appear 
enhanced.

Images acquired with Texture have different speckle 
characteristics and might therefore influence the results of 
speckle tracking. For this reason, it will not be possible to 
perform Cardiac Strain analysis of images were Texture was 
enabled



Advanced Features

13-210 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

 Figure 13-91. AFI Workflow



Cardiac Automated Functional Imaging (Cardiac Strain)

LOGIQ Totus – User Manual 13-211
5929163-1EN Rev. 3

Acquisition

Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

Sequential acquisition

Acquire 2D grey scale cineloops of an APLAX, A4CH and A2CH 
view.

NOTE: It is recommended to acquire all three apical views sequentially 
to get similar heart rate in all views.

Acquisition requirements

• The frame rate should be between 37 and 80 frames per 
second. A higher frame rate is recommended for high heart 
rate.

• Heart rate variability between the recordings should not be 
greater than 30%.

• The system should be configured to store 100 ms before 
and after each heart cycle.

• If the acquisition has more than one heart cycle, the 
analysis will by default be done on the second to last heart 
cycle. 

• The entire myocardium should be visible.

• A depth range that includes the entire left ventricle should 
be used.

CAUTION
Cardiac Strain is only recommended for adult cardiac images 
acquired with the M5Sc-D probe. Cardiac Strain is only 
recommended for pediatric cardiac images acquired with the 
6S-D probe. The measurement accuracies of the longitudinal 
strain values reported in the Reference manual are verified with 
these probes.
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Starting Cardiac Strain from sequential acquisition

1. Open the exam for which you want to perform Cardiac 
Strain analysis and select one of the apical images you 
would like to use for the analysis.

2. Press Measure on the Control panel and select the Cardiac 
Strain study. If the images are acquired with a transthoracic 
probe, the system will try to identify a suitable triplet of 
apical views suitable for the analysis. If this succeeded, the 
tool will launch and start up in the Define ROI stage with the 
selected view. The tool will launch and start up in the Select 
View stage.

 Figure 13-92. Define ROI Stage
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 Figure 13-93. Select View stage

Cardiac Strain Stage Menu

The workflow in Cardiac Strain is controlled by the stage menu 
to the right in the tool window. It is possible to navigate between 
the stages by clicking on the stage buttons. Stages that are not 
accessible from the given tool state are greyed out. 

 Figure 13-94. AFI stage menu
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The stage menu buttons also contain information about 
completeness state and a reset button. 

Beneath the stage menu button, a help string for the current 
active state is shown.

Cardiac Strain on the APLAX view

1. The first stage when launching the tool, will be the Select 
View stage. The user should then:

• Perform any Left-Right flip corrections.

• Select Cycle and adjust Cine markers as appropriate.

• Annotate the view by clicking one of the view labeling 
buttons (A4CH, A2CH, APLAX). 

2. An automatic ROI is generated when entering the Define 
ROI stage. The ROI may be edited by clicking and dragging 
on the endocardial and epicardial contours. See ‘ROI 
adjustment’ on page 13-216 for more information.

NOTE: If Cardiac Strain is performed on pediatric exams, the 
automatic ROI is disabled. See section about 3-click ROI in 
‘To create a new ROI’ on page 13-218.

3. When satisfied with the ROI, either stop moving the cursor 
and wait for automatic processing to start or click on the 
Process button, Results for A4CH/A2CH, or Set AVC for 
APLAX. Now the system performs feature tracking to get a 
temporal ROI trace. On completion, it proceeds to the next 
stage. 

4. (APLAX only) After the ROI edit stage, the system enters 
the Set AVC stage. Select one of the AVC setting strategies 
to verify AVC time. See ‘Timing Validation’ on page 13-222 
for more information. On completion, the Cardiac Strain tool 
now proceeds to the Results stage.

5. The Cardiac Strain tool is now displaying the Results stage 
in a Quad layout. Now the tracking quality must be 
inspected and verified. The tracked ROI is divided into 
segments. The tracking quality for each segment is 
automatically evaluated and applied to reject segments for 
which the tracking is assumed to be not reliable. Segments 

By clicking the Reset button, the stage is reset and all user 
entered information in that stage is cleared. Any automatic 
procedures are re-run. 

If a stage is labeled, it means the stage is complete and 
nothing more needs to be done in that tool stage. 
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that have been rejected do not have values in the segmental 
result ROI to the lower left in the Quad view, but instead 
shows an X. The strain trace (upper right), Curved Anatomic 
M-mode section (lower right) and parametric overlay on the 
dynamic ROI (upper left) are disabled for rejected 
segments. By clicking on a segment in the segmental result 
ROI it is possible to override the automatic quality 
assessment to either show or hide segmental values. The 
tracking for each segment must be visually controlled and 
validated as described below.

 Figure 13-95. Results stage in Quad layout

Once the tracking quality has been controlled for all 
segments, you may choose to click:

• Reprocess – To completely reprocess the view currently 
being reviewed. This will take the user back to “Define 
ROI” stage of the workflow.

• Approve and Select Next - Proceed to the Select View 
stage, and the operator has to manually select the next 
view to process from the clipboard.

• Approve and Exit – To exit the tool and store performed 
measurements. No segmental strain results are stored 
in this case. 

In case of a multi-cycle recording, the system automatically 
launches the second to last cycle for analysis. If during 
analysis, the operator wants to switch to another cycle, that 
is possible by entering the Select View stage and change 
cycle using the Cycle button.
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Tracking validation

Poor tracking quality could result from a variety of causes. 
Inspect each segment and make sure that the center line is 
moving together with the underlying 2D image. Use the various 
results layouts to examine the tracking quality (e.g. Quad 
layout).

The following can help examining the tracking quality:

• Turn off the color overlay by clicking Color button. 

• Reduce playback speed by using the Speed slider (or the 
rotary on the touch panel). 

• Use the Single layout to get a larger view of the dynamic 
mesh (especially in difficult cases).

If the tracking needs to be improved for some segments, the 
user can modify the ROI or create a new ROI.

ROI adjustment

If the automatic ROI is not optimal (resulting in poor tracking), 
the user can either adjust the ROI or create a new ROI as 
described below.

General ROI remarks

The calculations performed on the tracked ROI aim to find the 
longitudinal deformation along the cardiac muscle from the base 
to apex. These calculations assume the ventricle to have a 
horse-shoe shape. 

CAUTION
Poor tracking quality may lead to incorrect measurement 
results. The tracking for each segment must be visually 
controlled and validated.

CAUTION
If the ROI does not have a horse shoe shape, the calculated 
measurements may not be accurate. 
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To adjust the ROI

Enter the Define ROI stage. The following adjustments can be 
done to the existing ROI:

• Adjust ROI width by clicking the ROI Width Control.

• Click and drag on the endocardial part of the ROI. 
Endocardial editing edits the whole ROI 

• Click and drag anchor points on the epicardial ROI 
(highlighted in red on mouse hovering). Epicardial editing 
edits the epicardial part only

In the upper right of the screen there is a pictogram indicating 
the core features of a good APLAX ROI. 

 Figure 13-96. ROI Editing Options
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To create a new ROI

The system automatically displays a frame where the 
endocardial border is usually clearly visible. To use another 
frame, while in Define ROI stage, pause the playback by 
pressing Stop. Then, use the Frame slider (or rotary) to select a 
different frame for ROI definition. 

Creating a new automatic ROI

To create a new automatic ROI, click the Reset stage button. 
This relaunches the automatic segmentation. 

Creating a new manual ROI

Sometimes the automatic ROI may fail to capture the correct 
ROI. In this case, a 3-Point ROI alternative is provided. 

NOTE: The 3-Point ROI is the standard ROI method for TEE data and 
Pediatric exams. 

To generate a ROI by this method, when in Define ROI stage, 
click on the button 3-Click. The AFI tool will now prompt to click 
3 landmarks. Take care to select proper landmarks, as displayed 
close to the pointer 

When the third landmark is selected, a ROI is generated and 
can optionally be edited as for the automatic ROI. 

NOTE: If the ROI needs to be adjusted, make sure to make the changes 
immediately after the ROI is displayed, before the auto 
processing of the ROI begins.

NOTE: The timing when auto processing of the ROI will start is 
configurable (from Config).

NOTE: The Yo-yo function is turned on to help find correct location for 
the points.

CAUTION
Faulty landmark selection may cause segment values to be 
swapped in the final results. 
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 Figure 13-97. AFI Auto processing configuration

 Figure 13-98. Defining a ROI

After placing the three points the ROI is displayed.

Guidelines when re-creating the ROI

Correct ROI definition is crucial to get good tracking. See use 
cases below for common pitfalls.

Tip: Make sure to follow the recommendations when placing the 
three points.
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Table 13-49:  Tips for re-creating the ROI

Tips Correct Incorrect

Base
1. Correct position of the base 

points.
2. The ROI extends into the 

aortic tract.

Apex
1. Correct position of the Apex 

points.
2. The apex point is placed too 

high. The ROI is extending 
beyond the epicardium.

Apex
1. Correct position of the Apex 

points.
2. The apex point is too high; 

the ROI is extending beyond 
the epicardium. 



Cardiac Automated Functional Imaging (Cardiac Strain)

LOGIQ Totus – User Manual 13-221
5929163-1EN Rev. 3

Bulges
1. Correct ROI.
2. ROI should not be bulging or 

follow the papillary muscle. 
To edit the ROI, see ‘ROI 
adjustment’ on page 13-216.

General
The left ventricle must be visible 
through the entire cycle.
1. End systole frame: the entire 

left ventricle is displayed.
2. End diastole frame: the 

annulus is not displayed.

Table 13-49:  Tips for re-creating the ROI (Continued)

Tips Correct Incorrect
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Timing Validation

Timing information may be crucial to accurate diagnosis. The 
most important event timing is the aortic valve closure (AVC), 
since it is part of the definition of the end systolic strain 
parameter.

Determination of the AVC timing by the system is as follows, 
depending on the situation:

• An automatic AVC estimate determined by the temporal 
contraction of all LV segments (Strain curves) is used.

• From the APLAX view, the user can adjust the estimated 
AVC timing. The adjusted AVC timing will then be used in 
the other apical views when running Cardiac Strain on these 
views.

This option is only available from the APLAX view.

AVC Timing Adjustment (APLAX only)

After tracking is performed, the system enters the Set AVC 
stage. The following options for AVC settings are provided:

• Automatic: AVC is set automatically based on the ROI 
tracking using the time of peak negative strain. 

• Manual: Set the AVC time manually. The frame can be 
selected by the track ball. 

 Figure 13-99. Parametric Systolic Strain APLAX View



Cardiac Automated Functional Imaging (Cardiac Strain)

LOGIQ Totus – User Manual 13-223
5929163-1EN Rev. 3

Inspecting results

After completed tracking, and for APLAX completed AVC timing 
adjustment, the system displays the Quad screen layout for 
tracking validation (see page 8-26) and inspection of results for 
this view. 

The screen contains the following result displays:

• Tracked ROI: A dynamic display of the tracked ROI to be 
used for tracking validation. The tracked ROI has a texture 
overlay indicating strain values according to the colormap. 
The overlay may be turned off/on by clicking the Color 
button.

NOTE: Rejected segments will not have texture overlay. 

• Segmental result ROI: A static display indicating the peak 
strain value per segment. Rejected segments are displayed 
with an X instead of a value. Clicking a segment changes its 
rejection status (See ‘Tracking validation’ on page 13-216 
for more information.)

• Strain traces: A static display indicating the segmental and 
global strain traces with time. The peak values are 
indicated. 

NOTE: The peak values can be adjusted by clicking and dragging 
the peak markers with the mouse.

• Curved anatomic M-mode: A static display indicating a 
curved anatomic M-mode along the center of the ROI. The 
M-mode has a parametric overlay indicating peak strain 
values. 

NOTE: Rejected segments will not have texture overlay.

NOTE: The Segmental result ROI, Strain traces and Curved anatomic 
M-mode are using color codes to link the different segments. 

CAUTION
Segments and peak detection should be checked to make 
sure that non-physiological traces are excluded in the 
calculation of indices.
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Cardiac Strain on A4-Ch and A2-Ch views

The procedure for Cardiac Strain on Apical 4-chamber and 
2-chamber views is similar to the one used in the APLAX view.

Perform the steps 1,2,3 and 5 from the APLAX procedure.

Perform the tracking validation (‘Tracking validation’ on 
page 13-216) and, optionally, ROI adjustment (‘ROI adjustment’ 
on page 13-216) procedures.

AutoEF Layout

The results screen for A4CH and A2CH views also has an 
AutoEF layout. In this layout, the system presents automatically 
generated end systolic and end diastolic traces used to 
calculate ejection fraction (EF), stroke volume (SV), cardiac 
output (CO), as well as volumes. See ‘Auto EF Measurements’ 
on page 13-231 for more information.

NOTE: If both A4CH and A2CH have been analyzed, the system also 
calculates biplane Simpson EF, SV, CO and volumes. 

NOTE: The EF values (including volume values) provided by running 
the AFI tool will appear in the Worksheet, Report and in DICOM 
SR in exactly the same way as EF values provided by running 
the dedicated AutoEF tool. If first AutoEF is performed and then 
AFI, there will be two instances of the EF values in the 
Worksheet.

CAUTION
If the APLAX view was not analyzed first, the strain values 
displayed in the Quad screen for the A4CH/A2CH are labeled 
temporary and may be different after APLAX have been 
analyzed. The reason for this is that for the A4CH and A2CH 
views, the AVC time is automatically set based on strain curve 
peaks (Auto mode). If, during APLAX analysis, the AVC time is 
manually set, the globally applied AVC time becomes different, 
causing segmental results to change.

CAUTION
If AVC mode is set to Auto, the final value of AVC time is not 
available before all three views have been analyzed. Thus, 
strain values displayed in Quad screen of the two views 
analyzed first are labeled temporary. The reason for this is that 
the Auto-AVC calculation derived from all three views is most 
accurate and may be different from the intermediate AVC 
calculations used for each view.
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Completed analysis results

When all three apical views have been analyzed, the result 
screen provides three new Layouts to inspect global function.

• BE: Bull’s eye presentation with segmental full wall Peak 
systolic strain color coding and segmental Peak systolic 
strain values.

• Traces: In addition to the Bull’s eye, also displays the strain 
traces for all three views. In this view, it is possible to correct 
trace peaks by clicking and dragging peak markers or 
clicking the corresponding segment in the Bull’s eye (Figure 
8-20).

• Tracking: In addition to the Bull’s eye, also displays the 
cineloops for all three views. 

• EF: Displays EF result.

Bull’s eye standards

The Bull’s eye can be configured to display either 18 or 17 
segments using either the AFI or the ASE standard (from 
Config). Consult the Advanced Reference Manual for more 
information regarding Bull’s Eye segmentation formats.

Bull’s eye colormaps

The tool provides a set of different colormaps for the Bull’s Eye. 
The different colormaps are available from the Colormap 
dropdown menu in the Result stage menu. 

The system can be configured to display other color maps 
(Config). The following colormaps are available: 

• PSS Red-Blue: Peak systolic strain in a red-blue color 
coding. 

• PSS-Green-Yellow-Red: Peak systolic strain in a 
green-yellow-red color coding. 

• PSI: Post Systolic Index (PSI) color coding and segmental 
PSI values in the Bull's eye

• TTP: Time-to-peak strain (TTP) color coding and segmental 
TTP values in the Bull's eye

NOTE: PSI and TTP color maps are based on the global peaks (as 
supposed to systolic peaks).

CAUTION
If reprocessing a file with a different Bull’s Eye standard, the 
segmental values will change. The system will warn the 
operator if attempting to reanalyze a stored loop with a different 
Bull eye’s standard
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Rejected segments in the Bull’s Eye are identified by the peak 
values being replaced by a X, and that the segment is greyed 
out in the colorimetric display. 

 Figure 13-100. Colorimetric display

1. Segment with tracking quality scored as Not acceptable (x).

Measurements available after complete analysis

The following parameters are also available after completed 
analysis

• Global Strain (GS) values for all three apical views. In a 
given view the Global Strain (GS), also called Global 
Longitudinal Peak Strain (GLPS), is defined as the 
percentage of maximal contraction over the whole cardiac 
cycle of the entire myocardial wall relative to its end diastolic 
length.

• Averaged Global Strain value from all three apical views.

• AVC measurement (either automatic, event timing 
measurement or manual, see ‘Timing Validation’ on 
page 13-222)

• PSD: Peak Strain Dispersion is an index that displays 
variability in time-to-peak (TTP) longitudinal strain. The 
index is the standard deviation of the TTP strain (of all 
segments) over the whole cycle. The TTP bulls-eye is useful 
in association with PSD as the color scheme uses green 
color to indicate normal contraction with a peak around 
AVC, blue color to indicate early contraction, and yellow to 
red color to indicate late contraction.
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Exiting AFI

 Figure 13-101. Bull’s Eye and Trace screen

At any time, the tool can be cancelled by pushing the Cancel 
button. The plugin will close and any unsaved data will be lost. 

When in the Results stage the operator may click the Approve 
and Exit button. The behavior depends on the number of views 
analyzed:

• If all three views have been analyzed, the tool will go to the 
Bull’s eye only layout and prompt the operator whether the 
results should be stored. If Yes is selected, measurements 
are transferred to the worksheet, and a result file with a 
screenshot of the Bull’s Eye will be generated. See also 
‘Reprocessing data’ on page 13-229.

• If only one or two views have been analyzed, the tool will 
enter the Quad layout of the most recently processed view 

CAUTION
Rejection of non-physiological traces and correct peak 
detection (see also ‘‘Inspecting results’ on page 13-223) is 
particularly important when using the TTP color map, as wrong 
peaks will influence the PSD index significantly. Peaks 
detected in very early systole and late diastole should be 
checked, and traces rejected if they are considered 
non-physiological. 
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and prompt the operator whether the results should be 
stored. If Yes is selected, measurements are transferred to 
the worksheet and a result file with a screenshot of the 
Quad screen is generated. See also ‘Reprocessing data’ on 
page 13-229.

Peak detection

The peak systolic strain detection for each segment can be 
verified and manually adjusted as required. To adjust the peak 
detection:

1. Press Traces. The Bull's Eye and Traces screen is 
displayed

2. To change the peak marker position on a curve:

• Click on the peak marker (square point) on one of the 
curves, move the peak marker to a new position and 
click again to fix the point.

• Place the cursor on a segment in the Bull's Eye. The 
corresponding curve is highlighted. Click on the 
segment to select the corresponding peak marker and 
move it to a new position.

The peak type is determined by the selected color map (systolic 
for PSS, global for PSI and TTP). The position of the AVC 
marker can also be checked in the Bull's Eye and Traces 
screen. If needed, the APLAX view should be reprocessed to 
change the AVC time.

About the results

Be aware of the following:

• Clinical assessments should be made based on both color 
and segmental full wall Peak systolic strain values.

• The export function is intended for research purposes and 
should not be used to archive diagnostic data.

• No values shown in any Result screen will be transferred to 
the Worksheet unless either Approve and Exit or Approve 
and select next is pressed. 

• All results shown (curves, colors and values) are based on 
drift compensated values. Any strain drifting is linearly 
compensated throughout the cycle. If the drift compensation 
in a given segment is too high, the segment is automatically 
rejected.

• If more than one segment is rejected, the Global Strain 
value is not calculated.
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Reprocessing data

The data from one or several views from a saved AFI analysis 
may be reprocessed. 

NOTE: When doing reprocessing, if the operator chooses to store the 
results, the results will be treated as new analysis with new 
measurements in the worksheet and a new thumbnail in the 
clipboard. 

Reference layer for strain

The tool supports calculation of strain parameters based on 
either endocardial deformation or myocardial/full wall 
deformation. 

• Endocardial deformation is assessed by performing analysis 
of the endocardial part of the ROI trace. Measurements 
derived from endocardial deformation are suffixed Endo, 
such as for instance GPeakSysSL(Avg)_Endo

• Myocardial/full wall deformation is assessed by performing 
analysis of the whole ROI trace. Measurements derived 
from myocardial deformation are suffixed Full, such as for 
instance GPeakSysSL(Avg)_Full

It is possible to change the reference layer preference using the 
Config screen. 

NOTE: If attempting to reprocess an analysis using a different reference 
layer a warning will be shown informing that the values in the 
analysis will change. 

AFI configuration

It is possible to configure some of the AFI controls to modify the 
workflow slightly.

1. Press Utility > Scanner Apps. Select the AFI tab. The 
following parameters may be adjusted:

• Autoprocessing timeout - The time the operator has to 
keep trackball still before automatic start of tracking.

• BE Mode - Colormaps that shall be available for the 
Bulls Eye.

• BE Segment model - Select the preferred Bulls Eye 
standard (ASE/AFI, 17/18 segment models).

CAUTION
Measurements based on endocardial and myocardial analysis 
are not comparable.
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• ROI Method - Select whether fully automatic or 3-Click 
ROI shall be the tool default.

• YoYo - When adjusting the ROI, select whether a limited 
number of frames around the selected ROI frame 
should be looped back and forth to ease ROI 
adjustment. 

• Strain reference layer - Select whether the strain values 
shall be calculated based on endocardial or full wall 
tracking. 

• AVC Stage mode - Select whether to always open the 
AVC Selection stage. If “Auto” is selected, upon analysis 
of the APLAX view, the user will be taken to Results 
stage after the ROI stage. “Auto” AVC or Event timing 
will be used by default. It will still be possible for the user 
to re-visit the AVC Selection stage to edit the chosen 
AVC.

• Prioritize event timing - Select “yes” to use “event 
timing” values for AVC if there are some in the current 
exam and AVC Stage mode is on “Auto”.

• Positive Peak Rule - If On, then a positive strain value 
will be shown if the maximum positive peak exceeds 
30% of the maximum negative peak, resulting in a blue 
segment in the Bull’s Eye. If Off, then the negative strain 
value will be shown regardless of the size of the positive 
peak.

 Figure 13-102. AFI Configuration
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Auto EF

Auto EF Measurements 

Automated Ejection Fraction (AutoEF) is a semi-automatic 
measurement tool used for measurement of the global EF 
(Ejection fraction). The AutoEF tool is used as an optional 
decision support tool.

The AutoEF tool is derived from a 2D speckle tracking algorithm 
which tracks and calculates the myocardial tissue deformation 
based on feature tracking on 2D grey scale loops.

AutoEF is performed on either one or both apical 4-chamber or 
2-chamber views, in any order.

The result is presented as Ejection Fraction value, calculated by 
Simpson MOD for each view and MOD Bi-plane Ejection 
Fraction for the whole LV. All values are stored to the worksheet 
when approved.

Acquisition

NOTE: AutoEF is only available on the M5Sc-D probe.

1. Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

2. Acquire B-Mode cineloops of an Apical 4 chamber view 
(4-ch) and an Apical 2 chamber view (2-ch).

Acquisition requirements

• The frame rate should be between 37 and 80 frames per 
second. A higher frame rate is recommended for high heart 
rate.

• LOGIQ Totus should be configured to store at least 100 ms 
before and after each heart cycle.

• If the acquisition has more than one heart cycle, the 
analysis will be done on the second last heart cycle.

• The entire myocardium should be visible.

• A depth range that includes the entire left ventricle should 
be used
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Starting AutoEF

1. Recall any one of the stored views and press Measure.

2. Select AutoEF either in Measure menu or on touch panel.

The tool will launch and start up in the Select View stage.

Figure 13-103. Select View Stage

AutoEF on the A4CH view

1. When in Define ROI stage: Verify that the view annotation 
shown to the upper left of the screen is correct. If it is not, 
either:

• Click the Select View stage button to reannotate to the 
correct view and proceed analyzing that image. 

• Click on an A4CH image in the clipboard. This will 
discard analysis of the current loop and replace it with 
the one selected from clipboard. The tool will start in the 
Select view stage where it should be annotated as 
A4CH.

Pay attention to the left/right orientation of the image by 
comparing the LV wall names with a visual inspection of the 
image. If the image orientation is wrong:

• Go back to the Select view stage.

• Press Left-Right Flip.

• Verify the view by annotating it as A4CH again

NOTE: You may alternatively exit AutoEF, invert the image and start 
AutoEF again.

2. An automatic endocardial ROI is generated when entering 
the Define ROI stage. The ROI may be edited by clicking 
and dragging on the endocardial and epicardial contours. 
See ‘ROI adjustment’ on page 13-216 for more information..

CAUTION
AutoEF is only recommended for adult cardiac images 
acquired with the M5Sc-D probe. The measurement accuracies 
of the 2D Auto EF measurement values reported in the 
Reference manual are verified with M5Sc-D probe.
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3. When satisfied with the ROI, either stop moving the cursor 
and wait for automatic processing or click on the Process 
button. Now the system tracks the ROI with time. On 
completion, it proceeds to show the results in the EF result 
screen. The tracking must be visually controlled and 
validated as described below.

EF results

The Results stage opens with a multi frame EF result layout. 

• The running loop is shown on the left. A green dotted line 
marks the inner border of the chamber. In case of poor 
tracking, the system automatically displays parts of the 
border in red.

• The frames with the maximal volume (ED) and minimal 
volume (ES) are displayed on the right side.

• Press EF Dual to only display the ED and ES frames.

• The End Diastolic volume (EDV), the End Systolic Volume 
(ESV) and the resulting Ejection Fraction (EF) are 
displayed. Results for each view are summarized in a table 
on the right side.

Tracking Validation

• Inspect the ROI traces for the end systole and end diastole. 

• If the tracking results are visually correct, you may press 
Approve and Exit to exit the tool and store the values to the 
worksheet, so they can be used in a report. 

Possible causes of poor tracking

Poor tracking quality could result from a variety of causes. The 
common causes for bad tracking are:

• Erroneous placement of the basal points when defining the 
border. If the basal points are placed too far from the 
annular region, the border segments at the annular base will 
not move together with the underlying 2D image throughout 
the entire heart beat.

• Erroneous placement of the apex point when defining the 
border. The point should be placed so that the resulting 
border trace covers mainly the endocardium. If the apex 
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point is placed too high, the border trace will mainly cover 
the epicardium resulting in poor tracking.

• Too much clutter. Images with too much static clutter will 
result in poor tracking.

Tracking correction

The following can be done if tracking needs correction:

• Press EF dual to display ES and ED frames side-by-side.

• Adjust ES frame and ED frame controls if different frames 
need to be selected for ES and ED.

• Edit misaligned points on the endocardial border trace as 
described on ‘Editing the endocardial border trace’ on page 
8-47.

• Create a new endocardial border trace (See ‘To create a 
new ROI’ on page 13-218 for more information.)

Possible causes of poor tracking

• Erroneous placement of the basal points when defining the 
border. If the basal points are placed too far from the 
annular region, the border segments at the annular base will 
not move together with the underlying 2D image throughout 
the entire heartbeat.

• Erroneous placement of the apex point when defining the 
border. The point should be placed so that the resulting 
border trace covers mainly the endocardium. If the apex 
point is placed too high, the border trace will mainly cover 
the epicardium resulting in poor tracking.

• Too much clutter. Images with too much static clutter will 
result in poor tracking.

Trace adjustment of the endocardial border

If the automatic endocardial border detection is not optimal the 
user can either adjust the trace or create a new trace as 
described below.

CAUTION
Poor tracking quality may lead to incorrect measurement 
results. The tracking must be visually controlled and validated.
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Editing the endocardial border trace

• Enter the Define ROI stage.

• Adjust the trace by moving the cursor over the endocardial 
border trace, select an anchor point and drag it to a new 
location. The shape of the endocardial border trace is 
updated accordingly.

In the upper right of the screen there is a pictogram indicating 
the core features of a good APLAX AutoEF ROI. 

Figure 13-104. Moving an anchor on the trace

To create a new ROI trace

The system automatically displays a frame where the 
endocardial border is usually clearly visible. To use another 
frame, while in Define ROI stage, pause the playback by 
pressing Stop. Then, use the Frame slider (or rotary) to select a 
different frame for ROI definition. 

To create a new automatic ROI, click the Reset stage button. 
This relaunches the automatic segmentation. 

Sometimes the automatic ROI may fail to capture the correct 
ROI. In this case, a 3-Point ROI alternative is provided. 

To generate a ROI by this method, when in Define ROI stage, 
click on the button 3-Click. The AutoEF tool will now prompt to 
click 3 landmarks. Follow the indications displayed on the 
screen when placing the three points.

When the third landmark is selected, a ROI is generated and 
can optionally be edited as for the automatic ROI. 

NOTE: If the ROI needs to be adjusted make sure to make the changes 
immediately after the ROI is displayed, before the auto 
processing of the ROI begins.

NOTE: The timing when auto processing of the ROI will start is 
configurable (from Config).
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NOTE: The Yo-yo function is turned on to help find correct location for 
the points.

Figure 13-105. Tracing the Endocardial border

Exiting AutoEF

At any time, the tool can be cancelled by pushing the Cancel 
button. The plugin will close and any unsaved data will be lost. 

When in the Results stage the operator may click the Approve 
and Exit button. The tool will enter the dual layout of the most 
recently processed view and prompt the operator whether the 
results should be stored. If yes, measurements are transferred 
to the worksheet and a result file with a screenshot of the dual 
screen will be generated. See ‘Reprocessing data’ on 
page 13-229 for more information.

Reprocessing data

The data from a saved AutoEF analysis may be reprocessed. 

NOTE: When doing reprocessing, if the operator chooses to store the 
results, the results will be treated as new analysis with new 
measurements in the worksheet and a new thumbnail in the 
clipboard. 

1. Single view analysis stored

• Double-click on the thumbnail showing the AutoEF dual 
screen result layout. A dual screen is displayed, 
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showing the dual view result screen and the cineloop 
processed in that analysis. 

• Launch AutoEF. The tool will proceed to the Results 
stage. You may choose to reprocess the view already 
analyzed or to complete the analysis adding the missing 
view to the analysis.

2. Both views analysis stored

• Double-click on the thumbnail showing the AutoEF dual 
screen result layout. A quad screen is displayed, 
showing the dual view result screen of the last 
processed view and the cineloops processed in the 
analysis.

• Launch AutoEF. The tool will automatically proceed to 
the Results stage of the last processed view. You may 
choose to reprocess the views already analyzed or even 
replace the cineloops used in earlier processed views.
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ECG

Overview

A physiological input panel is available for the LOGIQ Totus.  
This panel has inputs for ECG signals.

The physiological module consists of this channel:  

1. ECG

The scanned image that is displayed is synchronized with the 
ECG traces. In Doppler or M-Mode, the traces are synchronized 
to that particular mode’s sweep.

Approved accessory cables provide the proper signals to the 
Physiological Panel.

To display the ECG Signal on the monitor, go to Utility--> 
Imaging--> General--> ECG Display. 

CAUTION
There will be a slight time gap between the ECG signal and the 
Doppler waveform when the selected  PRF is low (less than 1.0 
kHz).

CAUTION
To avoid skin burns in surgical use, do not place ECG 
electrodes in current path between Electrosurgical Unit (ESU) 
active and dispersive electrodes. Keep ESU cables away from 
ECG leads.
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Overview  (continued)

Figure 13-106. Optional Physiological Input Panel

WARNING • Do not use with a defibrillator except with 
DEFIBRILLATION PROOF APPLIED PARTS.

Only the ECG connection port is a defibrillator proof 
applied part.

• DO NOT USE the physiological traces of the LOGIQ Totus 
Ultrasound system for diagnosis and monitoring in lieu of 
ECG.

• Only approved and recommended peripherals and 
accessories should be used.

• After the defibrillator stimulates the patient, the ECG 
requires 4 to 5 seconds recovery time.
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ECG Cable

The ECG Cable is a modular cable consisting of two different 
cable parts:

• Single cable with a system connection at one end and a 
cable splitter at the other.

• A triple color-coded electrode cable to be inserted into the 
splitter device. Each electrode cable hooks up to the 
appropriate stick-on electrode by a color-coded clip type 
connector.

The color-coding of the electrodes follows one of two standards 
that are common in different parts of the world. The cable splitter 
device has a drawing defining the color codes, names and body 
location for the two standard color codes. 

Table 13-50:  ECG Color Code Cable

IEC
(Europe, Asia, ROW)

AHA 
(USA)

Position of the 
human body surfaceElectrode Mark Color Code Electrode Mark Color Code

R Red RA White Right Arm

L Yellow LA Black Left Arm

F Green LL Red Left Leg
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Physiological Trace Monitor Display

The scanned image is synchronized with the ECG trace. In 
Doppler or M-Mode, the traces are synchronized with that 
particular mode’s sweep.

The user can control the gain, position and sweep speed of the 
traces using the Touch Panel controls.

Figure 13-107. Physiological Trace Monitor Display

1. ECG

2. Auto Heart Rate Display
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ECG Touch Panel

The ECG Touch Panel provides for control of the physiological 
input signals.

Without the ECG option, the ECG Touch Panel is not displayed.

Table 13-51:  ECG parameters

Parameter Description

Sweep Speed Change the speed of the trace. The sweep speed of the physio signal on the 
B-Mode image can be set independent of the timeline (Doppler and 
M-Mode) sweep speed.
Value: 1 - 16.

ECG Lead ECG Lead Pattern: 1, 2, 3
1: RA (-) to LA (+) (Right, Left, or Lateral)
2: RA (-) to LF (+) (Superior Inferior)
3: LA (-) to LF (+) (Superior Inferior)
NOTE: RA=Right Arm; LA=Left Arm; LF=Left Foot

Timer Trigger Enables intermittent imaging based on a timer.
NOTE: If Timer Trigger is turned on, the ECG Trigger is set to None.
Value: On or Off.

ECG Trigger Enables intermittent imaging based on the ECG. The trigger location(s) 
relative to the R trigger are set with the Delay Time key.
Adjusting: Press ECG Trigger and select one of the options and adjust the 
delay time using the Delay Time key.
• ECG Trig 1 specifies the delay (ms) from R-wave to triggered frame.
• ECG Trig 2 specifies the delay from R-wave to second frame.
• Both activates ECG Trig 1 and ECG Trig 2 simultaneously. Trig 2 must be 

greater than Trig 1 for dual triggering (Both) to be active.
NOTE: If other than None is selected, Timer Trigger is turned off.
Value: None, Trig1, Trig2, and Both.

ECG Display Provides the ability to turn on the ECG trace and Auto Heart Rate for display 
on the monitor.
Adjusting: When the key is selected, the ECG trace and Auto Heart Rate 
toggles between on and off.
Value: On or Off
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ECG Trigger Period The control specifies the number of heart cycles (R-waves) that are skipped 
between ECG triggers. 
The default is 1 or no skipping; 2= skip 1 cycle. 
Adjusting: Adjust the corresponding control.
Value: 1 - 30

Delay Time In ECG Trigger Mode: If only ECG Trig1 or ECG Trig2 is selected via the 
ECG Trigger key, the Delay Time key controls the R-Delay time of the active 
trigger. If both triggers are selected (Both), press this key to toggle ECG 
Trig1 and ECG Trig2 and rotate the key to change the delay time. Once the 
trigger is set, the snap shot image is displayed each time the update line 
passes the active trigger(s).
In Timer Trigger Mode: Rotating the knob changes the delay time between 
images.
NOTE: Delay time may be different for Trig1/2 (0-2 seconds) and Timer 
Trigger. 
Adjusting: Adjust the corresponding control.
Value: 0.10 - 10.00

ECG Gain/Position Allows for the amplitude control of the ECG trace or allows for the vertical 
positioning of the ECG trace on the image display.
Adjusting: Press the knob to toggle between Gain and Position. The default 
is Gain.

Table 13-51:  ECG parameters (Continued)

Parameter Description
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Volume Navigation

Introduction

Using a position sensor attached to the probe, or using a probe 
with V Nav Inside, Volume Navigation Fusion (V Nav) lets you 
import a pre-acquired DICOM volume dataset, register the 
location of the live Ultrasound image with the 3D volume image, 
and then use the position sensing system to simultaneously 
show the live Ultrasound image side-by-side with the 
corresponding multi-planar reformatted (MPR) slice from the 
pre-acquired dataset. 

NOTE: DICOM datasets must have positional data to allow for V Nav to 
treat the datasets as a volume. Most CT, MR, and PET datasets 
have this information as do some X-Ray Angiography datasets. 

In addition, you can use V Nav as a type of “GPS” positioning 
marker to track an anatomy of interest. 

The V Nav Trackers allow you to use a V Nav sensor to track 
where the needle/needle tip is inside the body. 

V Nav is available in B-Mode, Color Flow, Elastography, PDI, 
and Contrast Modes; it is not available while in 3D/4D or when 
timeline modes are active. Biopsy capability is available while in 
V Nav. Dual Caliper is available while in V Nav.

You can load Auto Sweep data for V-Nav, after the data stored 
as volume data in Easy 3D/Advanced 3D.

DANGER DO NOT use the Volume Navigation feature on any patient 
relying on life-sustaining electronic equipment, such as a 
pacemaker or defibrillator. Failure to follow this instruction 
could lead to interference with patient electronic device(s).

CAUTION
When performing interventional procedures, remember that the 
pre-acquired dataset is not live and should not be used as sole 
guidance for interventional procedures. 
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Introduction  (continued)

V Nav displays in Split Screen, with the Ultrasound Image on the 
left side of the display and the 3D Dataset on the right side of the 
display. 

Figure 13-108. V Nav Example

V Nav-Specific Definitions

3D Datasets. Computed Tomography (CT)-, or Magnetic 
Resonance Imaging (MR), Positron Emission Tomography 
(PET), XA (X-Ray Angiography), hand held SPECT datasets 
(NM) and Invenia (US) series stored in DICOM format. 
Ultrasound datasets acquired using Tru3D and AutoSweep.  

Registration. Linking the 2D Ultrasound image to the 3D 
dataset. You can register the 3D dataset to the Ultrasound 
image via two techniques, Parallel Plane Registration or Point 
Registration.  

Auto Registration. Auto-registration is available when fusing to 
a Tru3D dataset. When entering V Nav directly from a Tru3D 
acquisition, the Tru3D volume is automatically loaded into V Nav 
and automatically registered. 

Parallel Plane Registration. This registration technique 
requires that the user mark a plane parallel to the 3D dataset 
slices and one common anatomical point, referred to as a 
Translation Point since it performs an x, y, and z correction at 
the point.  
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V Nav-Specific Definitions  (continued)

Point Registration. This registration technique requires that the 
user mark three or more anatomical point pairs. Performing a 
Plane Registration first may make the process of matching the 
anatomical point pairs easier. 

Anatomical Point Pair. Marking the same anatomical location 
in the 2D Ultrasound and the 3D dataset creates an anatomical 
point pair. 

Lock. After you have set the registrations between the 2D 
image and 3D dataset by either plane or point registration, you 
lock this registration in place. This means that the image content 
of the B-Mode image and the corresponding cut plane through 
the 3D dataset remains the same when you move the probe. 

Magnetic Distortion. A magnetic field is generated by the 
position sensing system. It can become distorted in the 
presence of ferrous or highly conductive metal.  

Environmental Quality. On-screen visual quality map that 
indicates distortion and proximity to the transmitter. Monitoring 
and controlling these two variables contribute to the highest 
quality environment. 

RMSD, Root Mean Square Deviation. Root Mean Square 
Deviation, which equals the 'goodness' of fit. After the user has 
completed a Point Registration, there's a numeric indicator to 
describe the goodness of fit. The lower the number, the better 
the fit. <1 to 10 would be good, 30-40 not so good.  

Window Levelling. Balances the brightness/contrast in the 3D 
Dataset. 

Position Sensing System. Consists of four components: 
Transmitter, Receiver (2), Probe Bracket, Probe/Receiver Cable 
Clips. 

GPS Marker. Used in GPS to track the position of an anatomical 
structure while scanning or while performing a biopsy. 

Virtual Tracker . The V Nav Virtual Tracker allows you to attach 
a sensor to the shaft of the needle (away from the tip). The 
position of the needle tip and the projected needle path are 
projected onto the 2D Ultrasound image. 
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V Nav-Specific Definitions  (continued)

Active Tracker. The Active Tracker is a device that consists of 
at least four markers that show up in a volume imaging dataset 
such as CT or MR. The markers are in known positions relative 
to each other such that the orientation of the Active Tracker can 
be uniquely determined based on the marker positions in the 
image. The device also holds a position sensor in a known 
position relative to the markers. Holes are provided in the Active 
Tracker so that its location can be marked on the body.

Needle Tip Tracker. The V Nav Needle Tip Tracker allows you 
to insert a V Nav tracker inside the Needle to  track the projected 
path and needle tip location inside the body. 

Clinical vs. Research. You can specify which V Nav controls 
you want to appear on the Touch Panel. You can set these via 
Utility -> Application -> Imaging Controls -> Clinical Controls V 
Nav. 

Environment Quality

In order to obtain best results when registering, setting GPS 
markers, it is important to have the highest quality environment 
(minimal distortion and proximity to the transmitter).

Figure 13-109. Environmental Indicator

An Environmental Quality reading for each sensor is provided 
via the Environmental Quality indicator (located in the upper, 
left-hand corner of the display).
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Environment Quality  (continued)

Each sensor has a quality reading from 1 (low quality) to 7 (high 
quality. In addition, the distance between the two probe sensors 
is used to adjust the environmental quality reading presented to 
the user.

If needle tracking is being used, an overall environmental quality 
reading is provided.

The Overall Environmental Quality reading is based on the 
environmental quality readings of the probe sensors and the 
needle sensor as well as the distance between the needle tip 
and the transducer face.

The environmental quality readings update in real time and are 
retained so that they can be displayed during cine scrolling.

Moving the cursor over the Environmental Quality indicator for 
each sensor provides the following information:

Sensor 1 displays a quality reading.

Sensor 2 displays a quality reading and a Distortion reading 
between the 2 probe sensors in [mm]. The magnetic distortion is 
represented as a measured distance between the two sensors 
relative to the expected distance between the two sensors. 

The Needle Sensor displays a quality reading.

The Overall indicator displays an overall Quality reading, and a 
Probe to Tip distance in cm.

Calibration

To calibrate V Nav, contact GE HealthCare Service. 

Configuration

You can specify the maximum retrospective loop length to store 
via Utility -> Application -> Print controls -> Time span. 

Accuracy

Accuracy depends on precise registration, minimal distortion, 
and controlling the patient’s breathing during a scan. 
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Load the Volume Dataset

If you are using media to load the 3D dataset, you may want to 
store the CT,  MR, PET,  XA, DX, NM or Invenia Dataset on a 
USB flash drive, USB HDD so that you can clearly label the 
media in a way that identifies the patient information stored on 
the disk. 

We recommend that you load the 3D Dataset onto the 
Ultrasound system prior to starting the V Nav exam to ensure 
that it loads properly and to ensure that the quality is acceptable.  

Ultrasound volume datasets need to have been acquired using 
Tru3D, i.e., a volume dataset that was previously acquired using 
a position sensor. 
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Query/Retrieve

NOTE: For Query/Retrieve to find a patient, the patient MUST have a 
Patient ID. 

Query

Figure 13-110. VNav Query

1. Press Patient and select Data Transfer. The Data Transfer 
screen displays.

2. Select Q/R.

3. Select the Query/Retrieve server from the Transfer From 
pull-down menu.

4. Type Patient name in the name field.

5. Press Query in the Transfer From section.

6. All studies for that patient and that modality will list.
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Retrieve

Figure 13-111. VNav Retrieve

7. Select the specific series or study which use in V-Nav exam.

8. Press Transfer.

NOTE: Transfer time will vary based on network and file size.
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Load DICOM  Volume Dataset

Load a pre-acquired 3D DICOM volume dataset, 

• Exit and re-enter V Nav and retain the 3D Dataset by 
pressing the V Nav control. 

OR, 

Discard the pre-acquired 3D Dataset, 

• Press Exit and Clear on the Touch Panel. 

From USB 

 Figure 13-112. Loading Dataset From USB

1. If applicable, insert the media containing the pre-acquired 
3D dataset. Volume  datasets  that  can  be  loaded  from  
disk  may  include  CT, MR, PET, XA, DX, CBCT, and GE 
HealthCare ABUS (US).

2. Select VNav. Press Load and select From USB.

3. Double click on the DICOMDIR or database file (or single 
click and select the Open button). 
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From USB  (continued)

4. Navigate to the location of the 3D dataset. A list of patients 
and a list of image series for each patient displays. Highlight 
the Series you want to import and select Import Series.

5. The Check Patient Data screen appears. Confirm that the 
patient information matches the patient associated with the 
current exam. After verifying patient information, press 
Accept (or Reject). You can also specify to display Patient 
Data by checking the Display Patient Data box. 

If you turn on “Display Patient Data”, Patient name, ID and 
birth date are displayed on the Volume data. These remain 
on the live scanning image. 

NOTE: If Hide Patient Data preset or Hide Date Time preset 
(Utility->System->General) is set to "On Store", then the 
patient data is removed from the volume dataset prior to 
image storage and then redisplayed after image storage.

6. B-Mode image displays on the left side and the loaded 
volume data displays on the right side.
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From Database

NOTE: Volume datasets that can be loaded from the database: CT,  
MR, PET, XA, DX, CBCT, and GE HealthCare ABUS (US).

1. Press Load and select from Database.

2. Select the desired volume from the Image History screen 
and press Load.

3. The Check Patient Data screen appears. Confirm that the 
patient information matches the patient associated with the 
current exam. After verifying patient information, press 
Accept (or Reject). You can also specify to display Patient 
Data by checking the Display Patient Data box. 

If you turn on “Display Patient Data”, Patient name, ID and 
birth date are displayed on the Volume data. These are 
remained on the live scanning image. 

Figure 13-113.  Check Patient Data Dialog

NOTE: If Hide Patient Data preset or Hide Date Time preset 
(Utility->System->General) is set   to  "On Store", then the 
patient data is removed from the volume dataset prior to 
image storage and then redisplayed after image storage.

NOTE: If you load a Tru3D volume data, Check Patient Data is not 
displayed. 

NOTE: If you Load From Database and want to cancel out, use the 
Exit button on the Image History screen.

4. B-Mode image displays on the left side and the loaded 
volume data displays on the right side.
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Load Multi Volume Datasets

You can load multiple datasets (up to 10 datasets) of same study 
at the same time: 

When loading multiple volume data at the same time, they must 
all be configured in the same direction (eg, Axial plane).

Sometimes there are multiple acquisitions stored within a single 
series. When you select Load All, these are loaded as one 
dataset (if they are not overlapping) or as two datasets (if two or 
more datasets are overlapping). 

1. Load dataset From USB, check data of the Select Series 
pop-up. 

Figure 13-114. Select Series pop-up

Load dataset from database, select one image from each 
exam and press Load in the Image History screen.

Figure 13-115. Image History screen
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Load Multi Volume Datasets  (continued)

2. V Nav screen and multiple dataset menu are displayed.

Table 13-52:  Multiple dataset menu

Item Description

1-5 Dataset List (CT and PT in this example)

1 Display Color

2 Active Dataset Indicator

3 Active Dataset

4 Name of dataset

5 Display Weighting

6-12 Control Area

6 Single Display

7 Multiple Overlapping Display

8 Volume-to-Volume Registration

9 Compare Volume

10 Color Control

11 Delete

12 Expand/Collapse Dataset list
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Load Multi Volume Datasets  (continued)

Using the Touch Panel control, you can adjust: 

NOTE: When you select Save Volume on the Touch Panel, all 
volumes are saved to a single file on the Clipboard, 
including GPS Markers. 

Load additional volume datasets

Whenever a dataset is loaded and you want to load another 
dataset From USB, from clipboard or from a database or if you 
generate a Tru3D dataset and then switch then back to VNav, 
the system asks you if you want to add the dataset as an 
additional dataset or to replace the existing dataset(s).

If you choose to add the dataset, the necessary adaption of the 
datasets with regard to size and resolution will be performed 
automatically at the end of the load.

Easy Access to PACS

The LOGIQ Totus is set up to easily receive exams from PACS. 

The system displays DICOM image transmission status at the 
bottom of the screen as:

• Incoming DICOM Images: In Progress.

• Incoming DICOM Images: Completed.

• Incoming DICOM Images: Failed - check spooler.

Refer to the Spooler to identify specific failed operations. 

User operation takes precedence and will cancel any ongoing 
image receive operation.  

Table 13-53:  Touch Panel Controls

Item Description

1 Dataset number and its Weight (%)

2 Toggle Up/Down: Select the dataset.

3 Push: Fix the selected dataset.

4 Rotate: Weight Dataset. You can weight the overlay 
amount of the volume dataset. 
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Setting Up V Nav sensors

Positioning Rules

The transmitter needs to be placed such that the face of the 
transmitter opposite of the cable (the field side) faces the 
working area

To avoid magnetic distortion, the following is recommended: 

• Remove all ferrous or highly conductive metal from the 
vicinity of the transmitter and the working area. 

• If the patient’s bed contains ferrous or highly conductive 
metal, place the transmitter 20cm or more above the bed so 
that the central portion of the magnetic field sits well above 
the bed. 

• To check for magnetic distortion, place a phantom that can 
be scanned from multiple directions in the planned working 
space. Using the 2D Marker on the GPS control on the 
Touch Panel, select Point. Scanning the phantom, place the 
Windows Pointer on a specific point in the phantom and 
then scan the same point from different directions. The 
distance between the graphical point (green cross) and 
actual structure is an indication of the amount of error. 
Larger than expected discrepancies could be the result of 
metal distortion or the transmitter field could be facing the 
wrong direction or be too far away from the working area. 

CAUTION
When using fusion or GPS Markers, it is important to place the 
transmitter so that its location does not move relative to the 
working space. If you rearrange the working space (patient or 
transmitter location), you need to redo the registration or 
replace the GPS marker.  

CAUTION
Place the transmitter such that the entire area of interest is in 
the front hemisphere of the transmitter. The front hemisphere 
generates the magnetic field used by the system. 
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Setting up the Position Sensing Apparatus

To set up the position sensing apparatus, 

1. Attach the receiver probe bracket to the probe. Ensure that it 
is attached securely. 

2. Fix the position sensor to the bracket. 

 Figure 13-116. Set up the position sensor

CAUTION
For accurate image registration, ensure that you connect the 
two probe position sensors to the probe as described in the 
instructions below. Match the numbers when you attach the 
sensors connectors to the sensor unit.  

1. Position the sensor’s nub to the bracket’s indentation. 
2. Push the sensor into the bracket. 
3. Tilt the sensor to position it in the bracket. 
4. Tilt the sensor until positioned firmly in the bracket.
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Setting up the Position Sensing Apparatus  (continued)

3. Connect the receiver cable from the Position Sensor to the 
front of the Ultrasound system.  

Figure 13-117. Volume Navigation Connections

4. Trace back each cable physically to insure the cable in 
position 1 on the probe is connected to position 1 on the 
console and that the cable in position 2 on the probe is 
connected to position 2 on the console. 

5. Use the probe/receiver cable clips to hold the receiver 
cables to the probe cable. 

6. Attach the transmitter cable to the front of the Ultrasound 
system where the transmitter label is shown. 

1. V Nav Receiver Connector (2 cables)
2. V Nav Needle Tip Tracker/Virtual Tracker Sensor Connector
3. V Nav Active Tracker Connector
4. V Nav Transmitter Indicator
5. V Nav Transmitter Connector 

CAUTION
Place the transmitter such that the entire area of interest is 
in the front hemisphere of the transmitter (indicated by the 
‘1’ in the illustration above). The front hemisphere 
generates the magnetic field used by the system. 
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Setting up the Position Sensing Apparatus  (continued)

7. Now that all the cables are connected, press the V-Nav key. 
The light above the transmitter cable blinks until the position 
sensing system has been initialized by the system. Once 
initialization is complete, the light remains green.  

NOTE: Error message displays if the connection is incorrect.

8. Place electromagnetic transmitter next to patient with front 
toward scanning area of interest.

NOTE: Be sure patient and sensors are on the best position to start 
the exam.

NOTE: Patient must be in the same position as in the previous 
acquired exam.

V-Nav Inside Probe

V Nav Inside is a feature where the V Nav sensor is not external 
to the probe but is part of the probe. 

Probes with V Nav Inside transmit/receive automatically after 
you activate V Nav. 

CAUTION
If you need to connect/disconnect sensors, first use the V Nav 
key to exit V Nav. If you need to connect/disconnect the 
transmitter, make sure the light on the V Nav position sensing 
system is off. If it is on, enter V Nav and use the Exit & Clear 
Touch Panel control to leave V Nav.  
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Activate V-Nav

1. Begin an exam and optimize the image.

2. Press V Nav to activate Volume Navigation.

3. Perform Volume Navigation.

4. Press V Nav to exit V Nav. The following actions also exits V 
Nav: switching probes, recalling an image from the 
clipboard, starting a new patient, ending an exam, or 
selecting Exit and Clear from the Touch Panel. 

V Nav Controls

 Figure 13-118. V Nav Controls

1. V Nav On/Off
2. Touch Panel and Joystick Rotary Controls
3. 3D Dataset X Axis Rotation Control
4. 3D Dataset Y Axis Rotation Control
5. 3D Dataset Z Axis Rotation Control
6. Windows Pointer
7. Comment
8. Measure

9. Zoom and Depth
10. P1
11. Left Set
12. Right Set
13. Trackball
14. Bottom Trackball key locks the V Nav Plane
15. Left/Right Key: Switches Display Mode
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V Nav Touch Panel

V Nav Setup Touch Panel Menu

Prior to using V Nav, set up the following parameters:  

Table 13-54:  V Nav Volume Touch Panel descriptions 

VNav Parameter Description

Load Loads the 3D Dataset From USB (USB storage device) or From Database. 

Save Volume Saves current volume, including any GPS markers shown in the volume. 

Patient Data Check Confirms patient’s data

Reference Sensor Specify which sensor you are using. 

Orientation Select Axial, Sagittal, or Coronal

Orientation Markers Places orientation markers on the image. 

Display Mode Select Ultrasound only, 3D only, or Split Screen (both)

Clear/Reset Allows you to clear plane registration(s), point registration(s) or reset all, 
which clears all registrations and resets the 3D Dataset to its initial position. 

Exit and Clear Clears the current 3D Dataset and exits V Nav; the 3D dataset is no longer 
available.

Virtual Tracker Setup and select the Virtual Tracker. [Appears when the Virtual Tracker is 
present.]

Active Tracker Select the Active Tracker sensor. 

Window/Level (or Center/
Width) Rotary

Set the brightness/contrast for the 3D Dataset. To set the brightness, adjust 
the Level; to set the contrast, adjust the Window. 
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V Nav Touch Panel Menus

Table 13-55:  V Nav Touch Panel 1 Descriptions

V Nav Parameter Description

Scan Specifies which image is moving with probe motion:  Ultrasound (US), 3D, or 
Both

Registration Select the type of Registration, Plane, Point/All, Point/Best 3, or None. Auto 
Registration is an additional choice if a Tru3D Ultrasound dataset is loaded 
using auto registration.  

Save Current Registration Select to save the current registration

Control Priority Specifies the priority of shared image controls: Ultrasound image or 3D 
Dataset. 

Restore Registration Select to restore a stored registration. 

Display Mode Select Ultrasound only, 3D only, or Split Screen (both)

Clear/Reset Allows you to clear plane registration(s), point registration(s) or reset all, 
which clears all registrations and resets the 3D Dataset to its initial position. 

Overlay Displays the 3D dataset superimposed on top of the Ultrasound image. 

Overlay Brightness Adjusts the intensity level of the 3D Dataset.

Overlay Weight Adjusts the intensity level of the 3D Dataset.

Show Needle Tip Shows or hides the needle graphics. [Appears when the Needle Tracker is 
present.]
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V Nav Touch Panel Menus  (continued)

Table 13-56:  V Nav Touch Panel 2 Descriptions

V Nav Parameter Description

Save Volume Saves current volume, including any GPS markers shown in the volume. 

Measure Accuracy Press Measure Accuracy, then select a point on both the 2D Ultrasound 
image and on the 3D Dataset to tell you the distance as an indication of 
accuracy. 

Calibration Delete Used for calibration purposes, which is only available with a service key and 
performed by GE HealthCare Service.

Store Registration to File Press to save the current registration to a file. This is useful when you want 
to load another dataset with the same geometry. For example, both a T1 and 
T2 weighted MR series may be available. 

Read Registration from File Press to read a stored registration from a file. 

Read Markers from File Press to recall saved GPS markers from a file.   

Show Scan Area Shows or hides the Ultrasound scan area on the 3D Dataset.  

Cut Mode Select the cut mode: Cubic Plane, the 3D dataset slice in reference to the 
whole volume of data; Overview, fixed orientation slice; or Detailed, a slice in 
the same orientation as the current Ultrasound image. 

Exit and Clear Clears the current 3D Dataset and exits V Nav; the 3D dataset is no longer 
available.
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DICOM and Image Storage

Still Images

To store a still image, press Freeze, and then press P1. If you 
want to CINE back to find an image, you may need to set the 
Priority on the Touch Panel to Ultrasound. 

Loops

To store a loop after you have frozen the image, CINE back, 
change the Priority to Ultrasound (if necessary), indicate the 
start and end points, Run the CINE Loop, Press P1. 

Image-by-Image

To store individual images to a USB memory stick or external 
hard drive via the USB port, recall the image from the Clipboard, 
select Menu -> SaveAs. Type in the file name. We recommend 
that you select Image Only, Jpeg compression, Quality level 99. 
For CINE Loops, save as WMV. For stills, save as type Jpeg. 
Then press Save. Repeat for as many images as desired. When 
you take the USB device to another computer, the images are 
stored in the Export directory. 
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Save Volume

The system can save the volume and associated GPS markers 
as an image file in the exam.

The Save Volume key on the Touch Panel stores using the 
settings of whichever print key has Copy to Dataflow associated 
with it.

A saved volume can be loaded from the database and used as 
the pre-acquired volume.

Measurements and Comments

You can measure distance, angle, circumference, or area on the 
3D Dataset. You can annotate and perform any system 
measurement on the Ultrasound image. 

HINTS The Volume is stored in Raw Data format. If you send the 
volume to PACS without the raw data, the volume will not be 
available if you later Query/Retrieve it from PACS. 
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Using V-Nav

Magnetic field range of V-Nav Transmitter

The position of the V-Nav sensor can be detected correctly 
within the range shown below. Make sure that the V-Nav sensor 
is within this range.

Check the Environmental Quality indicator on the monitor for the 
detection accuracy while scanning.

NOTE: Remove the metal product from the region of the magnetic field 
to increase accuracy of position detection.

Figure 13-119. Magnetic Field Range from the Transmitter

From the center of the transmitter,
1. 30cm above and below
2. 28cm left and right
3. 20 - 66cm forward
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Perform V-Nav Exam

In order to perform a V-Nav exam, you need to have acquired 
the 3D Dataset and set up the position sensing apparatus. 

The workflow for V-Nav is to: 

1. Import the dataset if using Query/Retrieve. 

See ‘Query/Retrieve’ on page 13-250 for more information.

2. Perform the Setup (attach the sensors) as needed. 

See ‘Setting Up V Nav sensors’ on page 13-258 for more 
information.

NOTE: Probes with V-Nav Inside transmit/receive automatically 
after you activate V-Nav. 

3. Begin an exam; optimize the image. 

4. Enter V-Nav. 

5. Load the dataset. 

6. Perform the registration.

NOTE: Confirm that the plane orientation of the ultrasound image is 
the same as that of the loaded volume data before starting 
registration.

7. Perform the exam.

8. Take measurements and store images via the Print key. 

Ending an Exam

Press V-Nav, select End Exam, select End Current Patient,
then select Store all. The system is ready for the next patient.

HINTS Since Volume Navigation uses magnetic field to acquire probe 
position information, it may be affected by surrounding metal 
products.

If the image is flicked or misaligned, check the surroundings, 
such as the bed, the IV stand or the accessory, and move away 
those metal products from the magnetic field. If you use the 
bed with metal frame, it is desirable to be able to secure the 
distance from the metal frame using a thick mattress. 
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Perform the registration

Orient the Dataset and Pick a Slice

You can manipulate the 3D Dataset the same way you adjust 
any 3D volume. 

Manipulate the dataset to pick a slice that most closely matches 
the area where you will hold the probe initially.  

1. After the dataset has loaded, use the Zoom rotary to see the 
dataset in a larger size. 

2. Use the Orientation key to select Axial, Sagittal, or Coronal 
to easily view the Dataset from different orientations. 

You want the orientation that best matches the orientation of 
the patient. 

NOTE: If the data appears unacceptably blurred or smeared in one 
of these views, the dataset was not acquired with the 
appropriate settings for viewing the data in 3D. 

3. Pushing the X rotary rotates the dataset 90 degrees about 
the X-axis. Dialing the X rotary rotates the dataset about the 
X-axis in smaller increments. Same for Y and Z. 

Note which points are identifiable in both the live Ultrasound 
image and in the 3D dataset. Remember that a point needs to 
be identifiable in all three dimensions. A point along a surface is 
often difficult to identify in three dimensions; but intersections of 
vessels, calcifications, or centers of structures can often be 
identified clearly in three dimensions. 
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Registering, Locking, and Translating the Image with the 3D Dataset

After you’ve loaded the 3D Dataset, you need to link the 2D 
Ultrasound image to the 3D dataset via Registration. You can 
register the 3D dataset to the Ultrasound image by Parallel 
Plane Registration or Point Registration. 

Lock Plane: Align the section of displayed volume data with the 
vertical and horizontal orientations of the ultrasound scan plane. 
Match the state of inspiration and expiration with the loaded 
volume data and setting the probe orientation correctly to reduce 
the misalignment during the examination.

Lock Point: The position in the depth direction is adjusted at 
Lock Point. Synchronous display starts after setting Lock Plane. 
Set the reference point (Landmark) on the ultrasound and 
volume data. It can be set repeatedly.

NOTE: Confirm that the plane orientation of the ultrasound image is the 
same as that of the loaded volume data before starting 
registration.

NOTE: DO NOT move the patient once you have registered the image; 
if you move the patient, you lose registration. 

Select the type of registration on the Touch Panel. 

NOTE: When switching probes in V Nav, the registration is maintained. 
You can register with one probe, then scan with any probe. 
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Parallel Plane Registration

A plane registration constitutes a plane lock and a translation 
point.

To perform a Parallel Plane Registration, 

1. Select Registration -> Plane from the Touch Panel. 

2. Hold the probe parallel to the acquired (imported) 3D 
dataset, being careful not to tilt, twist, or rotate the probe. 

3. Press the Lock Plane (bottom Trackball key) to lock the 
plane as parallel. 

4. Define a translation point, by marking a common point in 
each image (Ultrasound and 3D Dataset) using the 
Windows Pointer and Trackball key labelled Lock Point.
This allows the system to do an x, y, and z correction at that 
point.

5. Move the probe and ensure that this registration is correct. 

6. Press Save Current Registration on the Touch Panel to 
save this registration. You can save up to five (5) 
registrations. 

Adjusting the Registration

To adjust the registration, you could try several things. 

1. Save the registration. It’s always a good idea to save the 
registration first. 

2. Update the translation point in the area of interest. 

3. Turn on Overlay and use the Z Rotary to adjust the 3D 
overlay relative to the Ultrasound image. 

4. Holding the probe still during the following steps: move the 
windows pointer over the overlay image, select the Overlay 
XY Trackball control, move the overlay relative to the 
Ultrasound image, press the Overlay XY key to lock in the 
adjustment. 

5. Manually adjust the parallel plane lock. Use the scan key on 
the Touch Panel to select only the 2D Ultrasound or the 3D 
dataset. Adjust the probe to make the scanned image match 
the locked image and then press Lock Plane.

6. Start over by using the Clear/Reset -> All control on the 
Touch Panel. 
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Point Registration

To perform a Point Registration, 

1. Select Registration -> Point from the Touch Panel. 

2. Find a common point on both the 3D Dataset and 
Ultrasound image. Use the Windows Pointer to select each 
point, then press Set Point each time. Do this 3 times. 

NOTE: You can select either a Point/Best 3 or Point/All. If you 
identify more than three point pairs, Point/Best 3 takes the 
best 3 point pairings. Point/All uses all point pairs that you 
identify when calculating the Point Registration. 

3. Move the probe and ensure that this registration is correct. 

4. Press Save Current Registration on the Touch Panel to 
save this registration. You can save up to five (5) 
registrations. 

NOTE: Point and Plane registrations are stored separately. 

To switch between Point and Plane Registration, change the 
registration via the Touch Panel. 

HINTS Performing a plane registration is not necessary to do a point 
registration, but is recommended because it simplifies the 
process as the probe can easily be used to search for the point 
pairs in both the Ultrasound image and in the 3D Dataset. 

HINTS When using a point pair to complete or update a registration, 
registration error is minimized at that point and will increase 
further away from that point. Therefore, registration accuracy 
near the anatomy of interest may be improved by marking the 
last point pair, or adding a point pair, in close proximity to the 
anatomy of interest.
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Auto Registration with Tru3D

Auto-registration is available when fusing to a Tru3D dataset.

When entering V Nav directly from a Tru3D acquisition, the 
Tru3D volume is automatically loaded into V Nav and 
automatically registered.

When a Tru3D data set from the current exam is loaded into V 
Nav from the clipboard or by loading from the database, the user 
shall be prompted to automatically register to the data set.

NOTE: Tru3D auto registration is possible if the magnet and patient 
have not been moved since the Tru3D data set was acquired. If 
the magnet or the patient have moved since the Tru3D dataset 
was acquired, you need to perform a parallel plane or point 
registration. 

Auto Registration appears as a choice on the Registration 
control only if auto registration was initially used. You can 
manually select a different registration method even if Auto 
registration was initially selected when the volume was loaded.
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Overlay

Use the Overlay control on the Touch Panel to overlay the 3D 
Dataset image onto the Ultrasound image. Use the Overlay 
Brightness and Overlay Weight joysticks to adjust the intensity 
level of the 3D Dataset. 

By pointing at the overlay (Overlay XY) with the Windows 
pointer and clicking on it with the Left Set Key, the overlay can 
be dragged via the Trackball in X and Y directions in an effort to 
achieve a better registration. To lock in the adjustment, press the  
Left Set Key again. 

By pointing at the overlay with the Windows Pointer and clicking 
on it with the Right Set Key (Overlay Z), the overlay can be 
dragged via the Trackball in the Z direction in an effort to 
achieve a better registration. To lock in the adjustment, press the 
Left Set Key again. 

One technique to improve registration is to adjust the overlay in 
X and Y as stated above and to also do any necessary Z axis 
rotation as well. Then, turn the probe 90 degrees and repeat 
these same adjustments. These steps can be repeated 
iteratively. 

HINTS In an area with bony structures that show up bright with the 3D 
Dataset, applying an overlay with a low percentage can be a 
nice way to show bone structure with an Ultrasound tissue 
image. 

HINTS When performing Overlay XY or Overlay Z adjustments, it is 
important to hold the probe still from the time the adjustment 
key is pressed until it is pressed a second time to lock in the 
change. 
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Volume to Volume Registration

Datasets can come from different exams, can be from different 
orientations, and can be from different imaging modalities. 
Because datasets are not registered to one another, the system 
allows auto or manual volume-to-volume registration

To register multiple volumes, 

1. Load multiple volumes (not restricted to one exam). 

2. Clicks on the “link” icon. The “Select volumes for 
registration’ pop-up window appears. 

3. Select the primary and secondary moving volumes. The 
primary volume is used for registration, the secondary 
volumes are transformed using the registration parameters 
of the primary volume. 

For example, If the user has a CT1 volume and a CT2 + 
PET volume loaded, they would select the CT1 as the fixed 
and the CT2 as primary, and the PET as the secondary 
moving volumes. After the registration they will have CT2 + 
PET registered to CT1. 

4. Specify if the result should be added as a new registered 
volume or overwrite the moving dataset. You can also or 
create the result as an additional volume (‘Add registered 
volume’ is not an option if 5 volumes already exist). 

A user can perform two types of manual registration: a 
registration based off of a single common point pair 
identified in each volume (Translation); or a registration 
based off of three or more common point pairs identified in 
each volume (Registration). 
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Volume to Volume Registration  (continued)

5. Choose Manual, Auto, Semi Auto or Indirect volume to 
volume registration. 

Figure 13-120. Select volumes for registration

NOTE: If you select Auto registration, also choose the type (bone, 
tissue or some combination). If you select Manual 
registration, identify three point pairs between the two 
volumes. Only one point pair is usually needed for datasets 
with different orientations from the same exam.

During manual volume to volume registration, the user is 
able to scroll through either the fixed volume (shown on the 
left) or the moving volume (shown on the right) by moving 
the Windows Pointer over the image, pressing the trackball 
key labeled Scroll Z and then using the trackball to perform 
the scrolling. 
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Volume to Volume Registration  (continued)

NOTE: During manual volume to volume registration, the user is 
able to move the volume up and down or left and right on 
the screen by moving the Windows pointer over the image, 
switching from Primary to Secondary with the top trackball 
key, pressing the trackball key labeled Move XY and then 
using the trackball to perform the XY movement.

When doing manual registration, the left volume is the fixed 
volume and the right volume is the moving volume. The right 
trackball key is used to scroll through the datasets and find 
anatomical points while the left trackball key is used to mark the 
points. Once a single point pair is marked, the bottom trackball 
key is labeled Apply Translation which is all that is needed to 
register the moving volume (oblique, e.g.) to the fixed volume 
(axial,  e.g.). 

NOTE: A single point pair is sufficient if the two datasets have the same 
orientation but are shifted with respect to each other. 

Once three point pairs are marked, the bottom trackball key is 
labeled Calculate Registration which then registers the moving 
volume to the fixed volume.

NOTE: Three point pairs or more are needed if the datasets do not have 
the same orientation or are at oblique angles with respect to 
each other. 

Figure 13-121. Volume to Volume Registration
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Volume to Volume Registration  (continued)

Once three point pairs are marked, the bottom trackball key is 
labeled Calculate Registration which then registers the moving 
volume to the fixed volume. 

Figure 13-122. Trackball key status

1. No point pairs identified
2. One point pairs identified
3. Three or more point pairs identified
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Compare Volume

You can compare pre-registered volumes in a side by side 
display.

1. Press Volume Compare button in the multi volume menu.

2. The dialog for selecting left and right side volumes displays. 
Multiple selection is possible.

NOTE: Volumes need to be from the same group of pre-registered 
volumes.

Figure 13-123. Select volumes for comparison

3. The selected volumes is shown side by side and any 
interaction (scroll, zoom, rotation etc.) is applied to both 
sides simultaneously. 

Figure 13-124. Compare Volume
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Advanced GPS Markers

"GPS" -- Position Marking V Nav

Position markers can be ‘placed’ on a stationary anatomical 
structure within the body and then tracked with the existing 
position sensing system. The marker position is projected onto 
the current Ultrasound image in a graphical way that indicates 
the relative position of the point compared to the image. GPS 
markers track a particular point in space. 

Controls

Selecting the GPS tab switches trackball control to GPS 
markers with 2D Marker or 3D Marker activated.

Table 13-57:  GPS Controls 

Preset Parameter Description

2D Marker Allows the user to select between a Point Marker and a Target Marker.

3D Marker Allows the user to select between an Ellipsoid and Spherical Marker.

Show All Markers Shows all markers, independent of Active State.

Show Active Markers Shows/Hides all markers with Active State "On".

Active State An individual GPS marker can be shown/hidden using the Active State 
control (turn to select, push to toggle state).

Delete Rotate the control to select a specific GPS Marker to delete; then push the 
control to delete the marker.

Delete Markers Deletes all active GPS Markers following the user's confirmation.

Mark Needle Tip Mark Needle Tip allows a 2D or 3D GPS Marker (whichever is selected) to be 
put at the current tracked needle tip location. The marker is not attached to 
the needle and will not move as the needle moves.

Show Distance Toggles between showing and hiding all defined distances.

Attach to Needle If the 3D Marker key is selected and needle tracking is active, the "Attach To 
Needle" key initiates a 3D GPS Marker whose center (in the case of a 
sphere) or whose first long axis point (in the case of an ellipsoid) is placed at 
the needle tip.

3D Edit The 3D Edit key is available only if a 3D GPS Marker is currently selected via 
the Delete or Active State rotaries. Selecting the Edit key causes the Edit 
GPS Touch Panel menu to appear.
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2D GPS Markers

GPS Markers track a particular point in space. As you adjust the 
probe/image position, the point is projected onto the current 
image. If the point intersects the current image, it is displayed as 
a green cross. As the point gets further away from the current 
image, the cross turns into a bigger and bigger square. The 
color of the square indicates the direction; red represents one 
direction and blue represents the other direction. You can use 
’GPS’ to track an anatomical marker on the Ultrasound image or 
for biopsy needle guidance, for example. 

You can use GPS Markers with an imported dataset, or 
independently of an imported dataset. 

There are two types of GPS Markers: Point and Target. A Point 
Marker assigns a number. Each point marker you set has a 
unique number. A Target Marker only allows one target point. If 
you try to place another target marker, the target moves to the 
newly-indicated position. 

To place a Target or Point Marker, use GPS Marker to specify 
Target or Point. Place the Windows Pointer in the location where 
you want to set the marker, then press the Set GPS Key. 

Dist Start/Dist End/Clear Rotating the Distance Start and Distance End rotaries cycles through the list 
of GPS markers including the Needle Tip if needle tracking is active. When 
two different GPS markers are identified on the Distance Start and Distance 
End Rotaries, the Distance End rotary is labeled "Define" or "Clear". If the 
distance is not already defined, the label is "Define". If the user then pushes 
the rotary, the distance between the Start and End GPS Markers is defined, 
and the label to switches to "Clear".
The initial value of the Distance Start rotary is the first GPS marker. The initial 
value of the Distance End rotary is the needle tip if needle tracking is active or 
the 2nd GPS marker if not. In the case of a 3D GPS Marker, it's center point 
is used for all distance calculations.

Table 13-57:  GPS Controls  (Continued)

Preset Parameter Description
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3D GPS Markers

Figure 13-125. 3D GPS Marker example

NOTE: When using GPS Markers with a registered 3D dataset, a point 
marked in either image shows up in both images. GPS Markers 
are stored with the image. 

NOTE: All 3D GPS Markers are appended with the letter "V" (for 
volume). 

NOTE: The inner surface of the 3D GPS marker and margin contours 
can be colored using the colors of the marker/margin. This color 
is transparently overlaid on top of the US image below. 

Type of Markers

• Ellipsoid

The user places one GPS Marker (Set GPS on the right 
trackball key) at one end of the desired long axis. The point 
is marked with a marker named LA that behaves like a point 
marker. The distance between this first long axis point and 
the current cursor position is displayed in the status bar to 
allow the user to mark an ellipsoid with a defined long axis 
length. The user then places a second GPS Marker (Set 
GPS on the right trackball key) at the other end of the 
desired long axis. The ellipsoid will be drawn and the long 
axis endpoints will be marked with crosses that will be 
displayed only if they are hit by the plane.

• Spherical

The user places the GPS Marker (Set GPS key on right 
trackball key) at the center point of the anatomical structure 
of interest. The center of the sphere is marked with a cross, 
that is only displayed if the plane hits the center.
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Editing a 3D Marker

Upon creating a 3D GPS marker, the Edit GPS menu appears 
on the Touch Panel.

Table 13-58:  Edit GPS Marker - Sphere/Ellipsoid 

Preset Parameter Description

Done Return to main GPS Touch Panel.

Reposition Set Key on the image will reposition the sphere when Reposition key is on 
(otherwise Set Key creates a new sphere).

Select Select attributes that were previously saved.

Save As Save and name the current sphere attributes (size, margin, colors and 
transparency).

Color Change color (yellow, Red, orange, blue, purple, pink or white).

Margin Color Change margin color.

Margin Dist. Adjust margin size.

a. Diameter
b. Margin

Diameter Adjust sphere diameter.

Inner Alpha/Margin Alpha Adjust transparency of main area and margin in percent i.e. between 0 (= only 
ultrasound image) and 100 (= only marker/margin color).

Detach from Needle The Detach From Needle key is only available if the 3D GPS Marker being 
edited is attached to the needle. Pressing the key causes the 3D GPS Marker 
to be removed from the needle and placed at the current location of the 
tracked needle tip. It will no longer move with the needle tip.
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NOTE: Default of the parameters is configurable in Utility -> System -> 
System Imaging -> V Nav 3D Marker.

a. The length of the red ellipse is the long 
axis of the ellipsoid. 
b. The diameter of the blue circle is the short 
axis of the ellipsoid. 

Shift/Rotate (Ellipsoid) Shift along long axis or rotate about end of long axis.

Short Axis/Long Axis 
(Ellipsoid)

Adjust short and long axis lengths.

Show Ablation Needle 
Path

For ellipsoids, the user can display the needle path and tip position.

Table 13-58:  Edit GPS Marker - Sphere/Ellipsoid  (Continued)

Preset Parameter Description
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Editing a 3D Marker  (continued)

Move XY GPS allows the 3D Marker to be dragged to a new 
location in the current image plane.

Repos. GPS allows the 3D Marker to be recentered on the 
current image plane.

Figure 13-126. Trackball key for GPS Marker

NOTE: The initial attributes of a 3D GPS marker match the last 3D GPS 
marker that was created. 

NOTE: While on the Edit Menu, the 3D GPS marker being edited is 
shown in its normal color while all other 3D GPS markers are 
dimmed. After exiting the Edit Menu, all markers are returned to 
their normal color appearance. 



Volume Navigation

LOGIQ Totus – User Manual 13-287
5929163-1EN Rev. 3

Saving and Selecting a 3D GPS Marker

To save a 3D GPS Marker, 

1. For markers that are used often, such as kill zones 
associated with a particular ablation needle, select Save As
from the Edit GPS Touch Panel. 

2. The Save 3D GPS Marker pop-up menu appears. Name the 
GPS Marker. 

Figure 13-127. Saving a 3D GPS Marker

To select a 3D GPS Marker, 

1. Select Select from the Edit GPS Touch Panel. The Select 
3D GPS Marker pop-up menu appears. 

Figure 13-128. Select 3D GPS Marker

2. Highlight the desired Sphere or Ellipsoid, then press Select.
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Attach to Needle/Detach from Needle

The user attaches (and detach) 3D GPS markers to (from) a 
tracked needle tip and places a 2D GPS marker at the location 
of a tracked needle tip.

If the 3D Marker key is selected and needle tracking is active, 
the Attach To Needle key initiates a 3D GPS Marker whose 
center (in the case of a sphere) or whose first long axis point (in 
the case of an ellipsoid) is placed at the needle tip. 

In the case of an Ellipsoid, it's long axis is aligned with the 
needle direction, i.e. both long axis points are placed on the 
needle axis. The 3D GPS Marker is not in a fixed location, but is 
attached to the needle and therefore moves with the needle tip.

The key is only available if needle tracking is enabled and the 
3D Marker key is selected.

To detach the 3D Marker from the needle, the user can either 
press the Detach from Needle  button on the GPS Edit page or 
the Mark Needle Tip on the GPS page.

Mark Needle Tip

Mark Needle Tip allows a 2D or 3D GPS Marker (whichever is 
selected) to be put at the current tracked needle tip location. The 
marker is not attached to the needle and will not move as the 
needle moves. 

NOTE: You must use Tip Tracking or Virtual Tip Tracking. 

1. Place a needle.

2. Before extracting the needle, select Mark Needle Tip to get 
a 2D or 3D GPS marker at the needle tip.

Figure 13-129. Mark Needle Tip - Example
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GPS Distance

The user displays the distance between two GPS markers or a 
GPS marker and a tracked needle. 

• Between any two GPS markers (2D Point, 2D Target, 3D 
Sphere, 3D Ellipsoid)

• Between any GPS Marker and the tracked needle tip 
(Tip-Tracked, virtual tip-tracked)

Figure 13-130. GPS Distance - Example

Procedure

1. After marking GPS locations, rotate Dist. Start to select 1st 
marker.

NOTE: Cycle through the list of GPS markers including the Needle 
Tip if needle tracking is active. 

2. Rotate Dist. End to select 2nd Marker. Push Define to 
display the distance.

NOTE: If the distance is not already defined, the label is "Define". If 
the user then pushes the rotary and the distance between 
the Start and End GPS Markers is defined, the label 
switches to "Clear". 

In the case of a 3D GPS Marker, it's center point is used for all 
distance calculations. 

When distances are defined to be displayed, they are displayed 
in the same location as 3D measurement results. When regular 
3D measurements are displayed, the distance measurements 
are not shown. The label of a distance measurement is the 
numerically lowest GPS Marker followed by the numerically 
larger GPS Marker. If the needle tip is one of the markers, it is 
listed second. Some examples are "1-2V", "3X-Needle", and 
"5-7P".
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V Nav Trackers

V Nav supports the V Nav Needle Tip Tracker, the Virtual 
Tracker and Active Tracker. 

Figure 13-131. Volume Navigation Connections

NOTE: Pink probe brackets and sensors are necessary when using the 
Needle Tracker or Virtual Tracker

1. V Nav Receiver Connector (2 cables)
2. V Nav Needle Tip Tracker/Virtual Tracker Sensor Connector
3. V Nav Active Tracker Connector
4. V Nav Transmitter Indicator
5. V Nav Transmitter Connector 
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V Nav Trackers  (continued)

HINTS • Remember to exit V Nav with the V Nav control BEFORE 
disconnecting and connecting the V Nav Trackers. 

• With the V Nav Trackers attached, tracking can be turned 
on/off using the Show Needle Tip button. 

• When using V Nav Tracking, it is important to have high 
Environmental Quality readings. 

• When Needle Tracking is turned on, the Needle Tracking 
graphics show the: 

• Needle Tip and projected path on the live image

• The intersection point with the current image when not 
in plane

• Markers to assist with guiding the needle in plane with 
the current image

• The combination of Fusion and Needle Tracking is 
available once the volume dataset is registered. By 
selecting the Needle in Plane button, the volume dataset 
can show the needle in plane rather than the same plane 
as the live Ultrasound image. 

• You can push the Z-Rotation Rotary to rotate the needle 
path plane about the needle axis (coarse adjustments). 
Rotating the Z-Rotation Rotary can be used for fine 
adjustments. 
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Setting up the V Nav Needle Tip Tracker 

The V Nav Needle Tip Tracker allows you to insert a V Nav 
tracker inside the Needle to track where the needle tip is inside 
the body. The Needle Tip Tracker makes use of a needle 
assembly (combination of stylet and sheath) where the stylet 
has a hollow core in which a position sensor receiver may be 
placed, thereby placing the sensor near the tip of the stylet. The 
Needle Tip Tracker tip is annotated with an “N.” 

To set up the V Nav Needle Tip Tracker, you need the CIVCO 
eTRAX Needle System Starter Kit.  

1. The Kit includes the eTRAX Sensor as well as 5 sterile 
packages. Each sterile package contains a needle assembly 
(combination of stylet and sheath) and a cover for the 
sensor handle and cable. 

Figure 13-132. Needle Tip Sensor and Cable Close-up

2. The Needle Sensor fits inside the needle assembly. Prior to 
performing the procedure, you need to cover the sensor 
handle and cable.  

3. Advance the sensor all the way into the needle assembly.
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Setting up the V Nav Needle Tip Tracker  (continued)

4. The Needle assembly locks into place with the Sensor 
handle.

5. Using proper sterile technique, insert needle sensor through 
opening in cover, taking care to minimize bending of needle 
sensor. 

6. Extend cover over needle handle. 

7. Inspect cover to ensure there are no holes or tears. 

8. After you have the Needle Assembly placed at the desired 
anatomical location, you can unscrew the stylet from the 
sheath and remove the stylet (and sensor). The procedure 
needle can be placed in the sheath to perform the 
procedure.  

9. Remove the Sensor and Needle

10. The site is now ready for the procedure (core biopsy, 
ablation, etc.). 

CAUTION
For illustration purposes only, the needle sensor is shown 
without a cover. Always place a cover over needle sensor to 
protect patients and users from cross-contamination. 
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Setting up the V Nav Needle Tip Tracker  (continued)

NOTE: Dispose of the needle assembly and sensor cover. The Needle 
sensor should not be disposed.  

NOTE: You DO NOT need to sterilize the Needle Sensor. Instead, clean 
and disinfect the needle sensor the same way you would a 
probe, taking care not to bend the sensor. 

NOTE: The Tracker must be used in conjunction with a probe that has a  
V Nav Bracket. You need three (3) sensors: two (2) sensors 
attached to the probe and one (1) Tracker sensor. However, if 
you are using a V Nav Inside probe, no sensors need to be 
attached to the probe and only the sensor for the tracker is 
needed. 

V Nav Virtual Tracker (Part of V Nav Option)

The V Nav Virtual Tracker allows you to attach a sensor to the 
shaft of the needle (away from the tip). The position of the 
needle tip and the projected needle path are projected onto the 
2D Ultrasound image. The virtual needle tip is annotated with a 
“V.”
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Setting up the V Nav Virtual Tracker

To set up the Virtual Tracker, you need the CIVCO VirtuTRAX 
Starter Kit.  

Figure 13-133. V Nav Virtual Tracker

1. The kit includes the VirtuTRAX Sensor as well as 5 sterile 
packages. Each sterile package contains a sensor bracket, 
a cover for the sensor, and rubber bands for the cover.

Insert sensor inside cover. Place covered sensor in sensor 
bracket. Push down on sensor. Push down until sensor 
snaps into place. 
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Setting up the V Nav Virtual Tracker  (continued)

2. Insert needle into insertion point of the bracket, making sure 
that the arrow on the side of the bracket points toward the 
needle tip. Rotate knob to tighten needle holder to adjust it 
to the needle’s gauge. 

3. Assembled V Nav Virtual Tracker

4. Attach Virtual Sensor to the system. Connect V Nav sensors 
to the system.

5. You are ready to calibrate the Virtual Tracker. See 
Calibrating the V Nav Virtual Tracker procedure below.

6. To track the needle, the system needs to know the distance 
from the sensor bracket to the needle tip.

7. To provide the distance, select the V Nav Virtual Tracker 
control. Details are provided below. 

8. On the display the virtual needle tracker appears like the 
needle tip tracker except that the needle tip is annotated 
with a “V.” 

NOTE: Dispose of the sensor bracket and sensor cover. The sensor 
should not be disposed.  

NOTE: You DO NOT need to sterilize the sensor. Instead, clean and 
disinfect the sensor the same way you would a probe. 

NOTE: The Tracker must be used in conjunction with a probe that has a 
V Nav Bracket. You need three (3) sensors: two (2) sensors 
attached to the probe and one (1) sensor attaching to the needle 
sensor bracket. 

CAUTION
Because the sensor is away from the tip of the needle, the 
system cannot detect needle bending. When the needle bends, 
the projection of the needle trajectory and the representation of 
the needle tip will vary with respect to the actual needle 
trajectory and tip position. 
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Calibrating the V Nav Virtual Tracker

Method 1. You enter the needle length. 

1. Select Virtual Tracker.

2. Enter a device name and specify a length. Press OK  
(Length is measured from the tip of the needle inserted to 
the far surface of the sensor bracket, measured along the 
needle shaft). 

3. Check the length by placing the needle tip on the center of 
the probe face.

4. There should be a ‘V’ on the probe face in the image.

Method 2. You define the needle length via the image. 

1. Select Virtual Tracker. 

2. Enter a device name, and click on Define via Image. Press 
OK in the dialog.

3. Set the tip on the center of the probe face, move windows 
cursor to that point on the image and press Set.

4. The tip becomes marked with a ‘V’ on the image, initially on 
the probe face.

Existing Virtual Tracker devices can be selected and their 
calibrations modified if needed.
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Active Tracker

The Active Tracker is a device that consists of four markers that 
show up in a volume imaging dataset such as CT or MR. The 
markers are in known positions relative to each other such that 
the orientation of the Active Tracker can be uniquely determined 
based on the marker positions in the image. The device also 
holds a position sensor in a known position relative to the 
markers. Holes are provided in the Active Tracker so that its 
location can be marked on the body.

When the Active Tracker sensor is attached to the Active 
Tracker device, it can be used as a reference sensor. This 
means that all tracking is done in relationship to this sensor 
rather than in relationship to the transmitter. 

Figure 13-134. Left, Active Tracker - Right, CT of Active 
Tracker

 Figure 13-135. MR Active Tracker
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Active Tracker  (continued)

The Active Tracker adds sensor-based auto registration for CT/
MR. An Active Tracker device, which can hold a sensor, is 
placed on the patient during the CT/MR scan and then detected 
in the CT/MR images to facilitate an auto registration. CT/MR 
uses the same Active Tracker device as a Reference Sensor, 
meaning that tracking is done relative to the sensor attached to 
the Active Tracker. Provides some breathing compensation, and 
allows registration and GPS markers to be maintained in case 
the transmitter/patient moves. 

 Figure 13-136. Active Tracker Setup and Positioning

1. Connect the following sensors to the V Nav Module. V Nav 
Probe Connectors (into Slots 1 and 2). Active Tracker 
Connector. Transmitter Connector. 

2. Ensure that the probe has the V Nav attachment in place, 
along with the two V Nav Sensors.

3. Attach the CT/MR Active Tracker to the sensor.

4. Position the Active Tracker on the patient.
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Using the Active Tracker

Perform CT/MR exam. 

1. Apply sensor. 

For an MR Exam, avoid having the MR coil touch the MR 
Active Tracker. 

a. Place the MR Active Tracker where there is a gap in the 
coil.

NOTE: The MR Active Tracker must be in the area being 
scanned during the MR. It is good to place the Active 
Tracker on a rigid area, such as the xyphoid, and good 
to place it in the vicinity of the intervention, but still out of 
the way. 

b. Use pads (available in the MR suite) to keep the coil 
from touching the MR Active Tracker. 

2. Perform CT/MR scan. 

Scanning the patient, 

1. Use the Active Tracker to hold the sensor. 

2. Tape the sensor to the body. First, clean the area, then peal 
and stick the sensor to the body. 

3. Choose the reference sensor on the Touch Panel. 

NOTE: If you choose the Active Tracker for Auto Registration, the 
sensor is automatically selected as the reference. 

4. Load MR/CT dataset. 
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With Sensor and Active Tracker 

In order to acquire an ultrasound volume and auto register live 
ultrasound to it at a future time, perform the following steps:

1. Use a probe with VNav position sensors attached to or built 
into the ultrasound probe. 

2. Attach the Active Tracker device to the patient and connect 
the active tracker sensor to the device. 

3. Using a body marking pen, mark the position of the Active 
Tracker on the body using a body marking pen and the four 
holes in the base of the Active Tracker. 

4. Enter Tru3D and select the acquisition as "With Sensor + 
Active Tracker"

5. Perform a Tru3D sweep as usual and store it as usual.

Entering VNav directly from Tru3D or entering VNav and then 
loading the saved Tru3D data set will allow automatic 
registration of the live ultrasound to the Tru3D data set. If you 
want to automatically register to the Tru3D data acquired with 
Active Tracker at a future time, perform the following steps:

1. Follow steps 1 and 2 above except when placing the Active 
Tracker device use the four body marks to recreate the 
same position as before. 

2. Enter VNav and load the Tru3D data set that was previously 
acquired with the active tracker attached. Perform 
sensor-based auto registration in the same way as for CT/
MR.

3. Manually adjust the registration as needed. 
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Breast Productivity Package

Overview

There are three features in the Breast Productivity Package:

• Breast Lesion M&A — includes lesion measurement folders, 
show features, summary, etc.

• Breast Measure Assistant — contains the Auto Contour 
feature. It also has measurements related to Breast 
(distance to nipple, ratio).

• Breast Assistant, Powered by Koios DS — breast lesion 
analysis option. 

Breast Lesion M&A

Breast Lesion M&A allows you to document up to 30 breast 
lesions for each breast. Lesion Height/Width/Length, Distance to 
Nipple and A/B Ratio are available. Distance to Nipple allows 
you to enter the value (this is not a calculated measurement).

ACR BI-RADS® lesion classification can be notated via Show 
Features and Show Assessment. 

The Breast Measure Assistant (Auto Contour) feature can also 
be used to automatically detect and outline the breast lesion. 

Worksheet and Summary Worksheets show all the documented 
right/left breast lesions. 
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Breast Lesion M&A  (continued)

From the Small Parts Application Preset, select the Breast 
Application. Next, select the Right/Left Lesion (Select RtSide/
LtSide below the Touch Panel).  

Table 13-59:  Breast Lesion M&A Touch Panel Controls

Preset Parameter Description

Position Specify the position of the lesion: Clock position 1-12 O’Clock, Areolar, 
SubAreolar, Axillary, or “-” (default).

Segment Specify A, B, C, None, or “-” (default).

Show Features Press to activate the Show Features notations. To add notations for each 
feature, position the Trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature. If a Feature has an asterisk next to it (*), then you can select multiple 
notations -- select all that apply and then select ‘Done.’ These features are 
displayed on the Trackball. Below is a list of each Feature with its possible 
notations: 
• Shape: Oval, Round, Irregular, None (-)
• Orientation: Parallel, Not Parallel, None (-)
• Margin: Circumscribed, Indistinct, Angular, Microlobulated, Spiculated, 

None (-)
• Echo Pattern: Anechoic, Hyperechoic, Complex, Hypoechoic, Isoechoic, 

Heterogeneous, None(-)
• Posterior Features: No posterior features, Enhancement, Shadowing, 

Combined Pattern, None(-)
• Associated features: Architectural distortion, Duct changes, Skin thickening, 

Skin retraction, Edema, Absent, Internal vascularity, Vessels in rim, Soft, 
Intermediate, Hard, None(-)

• Calcifications: Calcifications in a mass, Calcifications outside of mass, 
Intraductal calcifications, None(-)

• Special Cases:  Simple Cyst, Clustered microcysts, Complicated cysts, 
Mass in or on skin, Foreign body including implants, Lymph 
nodes-intramammary, Lymph nodes-axillary, Vascular abnormalities AVMs, 
Vascular abnormalities, Mondor disease, Postsurgical fluid collection, Fat 
Necrosis, None(-)

Show Assessment Specify the ACR BI-RADS Assessment: None (-), 0, 1, 2, 3, 4a, 4b, 4c, 5, 6. 
A comment field is available directly below the ACR BI-RADS Assessment. 

Return Press to return to the previous Touch Panel. 

Lesion # Indicates which lesion you are viewing (Lesion # of Total Number of Lesions). 
Press the left/right arrow to move from lesion to lesion. 

L Lesion Length

H Lesion Height

W Lesion Width

Distance to Nipple Used to manually enter the distance the lesion is from the nipple. 
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Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all 
documented Breast Lesions. 

 Figure 13-137. Breast Lesion Worksheet and Summary

To move to the next page, select the Page Change control 
beneath the Touch Panel. 

NOTE: Only defined features are displayed on the Summary. To display 
the undefined features, select “Show Undefined Features” at the 
bottom of the Summary Worksheet. 

Auto Contour (HxL) Press to activate the Auto Contour feature, using the height and length. 

Auto Contour (HxW) Press to activate the Auto Contour feature, using the height and width. 

Rt or Lt A/B Ratio Right or Left Lesion A/B Ratio, measured by Area or Diameter. 

Composition Specify the composition of the lesion: None (-), Homogeneous background 
echotexture-fat, Homogeneous background echotexture-fibroglandular, or 
Heterogenous background echotexture. 

Delete Lesion Press to delete this lesion. 

Table 13-59:  Breast Lesion M&A Touch Panel Controls (Continued)

Preset Parameter Description
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Breast Measure Assistant (Auto Contour) 

You can request that the system trace/outline the border of a  
breast lesion using Breast Measure Assistant (Auto Contour). 
You do this by setting the Region of Interest (ROI) around the 
lesion; the system can then measure the lesion by drawing the 
contour around it. 

To automatically detect the breast lesion on the display, 

1. Press Measure.

2. Press Auto Contour (HxW) on the Touch Panel. 

3. Place the Cursor in the center of the lesion and press Set.
Size the ROI around the lesion. Use the Trackball to resize 
the ROI.

• To increase the size of the circle, move the Trackball 
down and to the right. 

• To decrease the size of the circle, move the Trackball up 
and to the left. 

NOTE: Include the entire lesion, even if additional surrounding 
tissue is included. 

4. Press Set on the Trackball. A trace appears around the 
lesion. 

NOTE: Multiple breast lesion traces may be generated by the 
system. To cycle through the generated contours, use the 
Select Contours rotary on the Touch Panel. 

5. Inspect the generated contour for accuracy. If edits are 
necessary, execute steps 6-7 to edit the contour prior to 
accepting the measurement. Otherwise, skip to step 8.

6. To edit the selected contour, move the Trackball to 
appropriately size the edit region and then press Set on the 
Trackball. 

7. The blue portion of the contour can be edited by moving the 
Trackball to the portion of the contour you want to edit. 

NOTE: The Caliper closest to the cursor enables editing. 

NOTE: To limit the horizontal/vertical editing capabilities, you can 
set a preset via Utility--> Measure--> Advanced--> Small 
Parts--> Restrict Breast Contour Caliper Edit. 

8. After you have completed your edits, press Done on the 
bottom Set Key or press Print to accept the measurement. 
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Breast Assistant, Powered by Koios DS (not available in all 

countries)

Breast Assistant, Powered by Koios DS is a Breast Lesion 
Analysis Option. Koios DS is integrated with the LOGIQ Totus 
via DICOM. Koios DS is configured similar to a DICOM Service. 
The user can accept/dismiss analysis results. If accepted, these 
results are included in the DICOM Structured Report.  

To perform Breast lesion analysis using Koios DS: 

1. In B-Mode in the Breast Application, select the Breast 
Productivity Package Lesion # then press Koios via the 
Touch Panel. 

Figure 13-138. B-Mode Touch Panel in Breast Application

NOTE: Koios DS analysis requires a frozen dual B-Mode image 
with a Length, Width, and Height measurement.

2. Measure the breast lesion (Length, Width, Height) over 2 
orthogonal scan planes; or measure the lesion using Auto 
Contour. 

3. Using the Trackball control, press Analyze.
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Breast Assistant, Powered by Koios DS (not available in all 

countries)  (continued)

4. Koios DS analyzes the lesion (a pop-up appears, 
“Analyzing”).    

Figure 13-139. Koios DS Analysis

5. A pop-up appears with the result of the Koios DS risk 
assessment and its alignment to an ACR BI-RADS® or 
U1-U5 risk category. 

6. If the assessment is accepted, it becomes part of the exam 
including being displayed on the exam's Summary Report 
and included in the DICOM SR data associated with the 
exam. If the assessment is dismissed, the results are not 
stored as part of the exam.

NOTE: For additional details of the Koios DS assessment, refer to 
Koios Medical's Koios DS product documentation.
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Thyroid Productivity Package

Overview

A Thyroid Productivity Package is available. 

Table 13-60:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls

Preset Parameter Description

Side Specify the side: Right, Left, Isthmus.

Worksheet/Summary Select to view the Worksheet/Summary Worksheet. 

Add#1, Add#2, etc. Cycles through the available lesions, or adds a new lesion/node/nodule, etc. 

Rt/Lt Thyroid
Rt/Lt Parathyroid
Rt/Lt/Isthmus Lymph Node
Rt/Lt/Isthmus Nodule

To initiate a Left/Right Thyroid/Parathyroid or Left/Right/Isthmus Lymph 
Node/Nodule, select the corresponding folder on the Touch Panel. 
Length, Height, and Width are available for all thyroid measurements. The 
Cortical Thickness measurement is available for the Lymph Node. Show 
Features is available for all thyroid measurements.  

Location Parathyroid: Specify Upper Gland or Lower Gland
Lymph Node: Supraclavicular fossa, Lower cervical, Middle cervical, Upper 
cervical, Parotid, Submandibular, Submental, Posterior triangle
Nodule:
• Location A: Upper, Lower, Mid, None
• Location B: Lateral, Medial, Midline, None

Show Features - Overall 
Thyroid

Press to activate the Show Features notations. To add notations for each 
feature, position the Trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature and on the Summary Worksheet. 
Below is a list of each Feature with its possible notations by measurement 
type:
• Overall Thyroid (Top Level Touch Panel)

• Resected: Totally, Partially, None (-)
• Appearance: Within normal limits, Abnormal, Symmetric, Asymmetric 

R>L, Asymmetric L>R, None (-)
• Comment
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Show Features - Lt/Rt 
Thyroid / Parathyroid and/ 
Lt/Rt/Isthmus Lymph Node 
/ Nodule

Press to activate the Show Features notations. To add notations for each 
feature, position the Trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature and on the Summary Worksheet. 
Below is a list of each Feature with its possible notations by measurement 
type:
• Lt/Rt Thyroid

• Resected: Totally, Partially, None (-)
• Echogenicity: Homogeneous; Coarse; Heterogeneous; Hashimoto, 

Classic; Hashimoto, Probable; None (-)
• Vascularity: Normal, Increased, Decreased, None (-)
• Size: Normal, Enlarged, Small, None (-)
• Comment
• Isthmus Comment

• Lt/Rt Parathyroid -- Upper/Lower Gland
• Visibility: Visualized, Not Visualized, None (-)
• Comment

• Lt/Rt/Isthmus Lymph Node
• Appearance: Within normal limits, Suspicious, Pathologic, None (-)
• Composition: Cystic, Complex, Solid, None (-)
• Vascularity: Normal, Increased hilar, Increased non-hilar, None (-)
• Comment

Table 13-60:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls 

Preset Parameter Description
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Show Features - Lt/Rt 
Thyroid / Parathyroid and/ 
Lt/Rt/Isthmus Lymph Node 
/ Nodule

• Lt/Rt/Isthmus Nodule 
The selections for each category/feature and associated points match the 
ACR® TI-RADS™ (Thyroid Imaging Reporting & Data System) 
risk-stratification system as published in 2017 by ACR*. Once one or more 
values are assigned for each feature, the points are summed and the 
corresponding ACR TI-RADS level is determined. Additional information 
including feature assignment guidelines and criteria for fine needle 
aspiration or follow up ultrasound can be found at the American College of 
Radiology website at: https://www.acr.org/-/media/ACR/Files/RADS/
TI-RADS/TI-RADS-chart.pdf?la=en

• Composition (choose one): Cystic (0 point), Spongiform (1 point), Mixed 
cystic and solid (1 point), Solid (2 points), -

• Echogenicity (choose one): Anechoic (0 point), Hyperechoic (1 point), 
Isoechoic (1 point), Hypoechoic (2 points), Very hypoechoic (3 points), -

• Shape (choose one): Wider-than-tall (0 point), Taller-than-wide (3 
points), -

• Margin (if more than one type, choose the most suspicious one): 
Smooth (0 point), Ill-defined (0 point), Lobulated (2 points), Irregular (2 
points), Extra-thyroidal extension (3 points), -. Note: If more than one 
type, choose the most suspicious.

• Echogenic foci (choose all that apply): None (0 point), Comet (0 point), 
Macrocalcifications (1 point), Peripheral calcifications (2 points), 
Punctate echogenic foci (3 points), -

• Comment
• TI-RADS level: TR1, TR2, TR3, TR4, TR5

- TR1 - 0 points - Benign
- TR2 - 2 points - Not Suspicious
- TR3 - 3 points - Mildly Suspicious
- TR4 - 4-6 points - Moderately Suspicious
- TR5 - 7+ points - Highly Suspicious
NOTE: Although it is possible for a nodule to be awarded zero points 
and hence be characterized as TR1, all other nodules merit at least two 
points because a nodule that has a mixed cystic and solid composition 
(one point) will also gain at least one more point for the echogenicity of 
its solid component.

• Koios DS Assessment

* Tessler FN, Middleton WD, Grant EG, Hoang JK, Berland LL, Teefey 
SA, Cronan, JJ, Beland MD, Desser TS, Frates MC, Hammers LW, 
Hamper UM, Langer JE, Reading CC, Scoutt LM, Stavros AT. ACR 
Thyroid Imaging, Reporting and Data System(TI-RADS): White Paper 
of the ACR TI-RADS Committee. J Am Coll Radiol. 
2017May;14(5):587-595. doi: 10.1016/j.jacr.2017.01.046. Epub 2017 
Apr 2. PubMed PMID:28372962.

Return Press to return to the previous Touch Panel. 

H Height

W Width

L Length

Isthmus AP Used to measure the Isthmus anterior to posterior distance. 

Table 13-60:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls 

Preset Parameter Description
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Cortical Thickness Cortical thickness of the lymph node.  

Delete Press to delete this anatomy. 

Table 13-60:  Thyroid/Parathyroid/Lymph Node/Nodule Touch Panel Controls 

Preset Parameter Description
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Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all 
documented Thyroid anatomies. 

 Figure 13-140. Thyroid Worksheet

To move to the next page, select the Page Change control 
beneath the Touch Panel. 

NOTE: Only defined features are displayed on the Summary Report. To 
display the undefined features, select “Show Undefined 
Features” at the bottom of the Summary Worksheet. 

NOTE: To exit back to the previous measurement screen, press Set on 
exit. 

NOTE: To exit back to the scan screen, press Worksheet/Summary on 
the Touch Panel. 
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Thyroid Assistant, Powered by Koios DS (not available in all 

countries)

Thyroid Assistant, Powered by Koios DS is a Thyroid Nodule 
Analysis Option. Koios DS is integrated with the LOGIQ Totus 
via DICOM. Koios DS is configured similar to a DICOM Service. 
The user can accept/dismiss analysis results. If accepted, these 
results are included in the DICOM Structured Report.  

To perform Thyroid nodule analysis using Koios DS: 

1. In B-Mode in the Thyroid Application, select the Thyroid 
Productivity Package Nodule # then press Koios via the 
Touch Panel. 

Figure 13-141. B-Mode Touch Panel in Thyroid Application

NOTE: Koios DS analysis requires a frozen dual B-Mode image 
with a Length, Width, and Height measurement.

2. Measure the thyroid nodule (Length, Width, Height) over 2 
orthogonal scan planes; or measure the nodule using Auto 
Contour. 

3. Using the Trackball control, press Analyze.

4. Koios DS analyzes the nodule (a pop-up appears, 
“Analyzing”).    
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Thyroid Assistant, Powered by Koios DS (not available in all 

countries)  (continued)

Figure 13-142. Koios DS Analysis

5. A pop-up appears with the result of the Koios DS risk 
assessment and its alignment to an ACR TI-RADS® risk 
category. 

6. If the assessment is accepted, it becomes part of the exam 
including being displayed on the exam's Summary Report 
and included in the DICOM SR data associated with the 
exam. If the assessment is dismissed, the results are not 
stored as part of the exam.

NOTE: For additional details of the Koios DS assessment, refer to 
Koios Medical's Koios DS product documentation.
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Start Assistant

Introduction

Start Assistant automatically saves exam settings as Exam 
Mappings when the first image is acquired during an exam. 
Saved Exam Mappings are automatically recalled when a 
Worklist item is loaded, keying off the Worklist Exam 
Description.

Start Assistant has two functional modes:

• On: Use Exam Description (default mode)

• On: Use Scan Assistant only

Figure 13-143. Start Assistant Modes

NOTE: An Exam Description or Scan Assistant program entry must be 
present for Start Assistant to save the Mapping.
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On: Use Exam Description Mode

In On: Use Exam Description mode, Start Assistant saves and 
loads the following exam settings:

• Exam Description - Populated from the Worklist item, the 
Exam Description is the default key by which the exam 
Mapping is saved.

• Category

• Scan Assistant

• Preset

• Probe

If a new Patient is entered manually (without using a Worklist), 
and no Exam Description is entered, Scan Assistant will become 
the key by which the Mapping is saved. 

On: Use Scan Assistant only Mode

In On: Use Scan Assistant only mode, the exam description is 
ignored and the selection of the Preset and Probe is based on 
the Scan Assistant protocol only. The Exam Category and Scan 
Assistant program are not automatically selected and Start 
Assistant Editor does not show the Exam Description column. 
Manual entry of an Exam Description for table entry is 
prevented.

Saved Start Assistant Exam Mappings can also be added, 
edited or deleted with the Start Assistant Mapping Editor - See 
‘Start Assistant Mapping Editor’ on page 13-317 for more 
information.

NOTE: When using Start Assistant Mapping Editor in “On: Use Scan 
Assistant only” mode, the Exam Description field will not appear  
on the Start Assistant Mapping Editor, Add Start Assistant 
Mapping or Edit Start Assistant Mapping screens.
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Start Assistant Mapping Editor

The Start Assistant Mapping Editor can be accessed from the 
Utility->System->General screen by selecting “Create/Edit”
under the Start Assistant section (see Figure 13-144).

Figure 13-144. Start Assistant Create/Edit

On the Start Assistant Mapping Editor screen you can Add, Edit 
or Remove a Start Assistant map (see Figure 13-145). 

Figure 13-145. Start Assistant Mapping Editor

NOTE: When using Start Assistant Mapping Editor in “On: Use Scan 
Assistant only” mode, the Exam Description field will not appear  
on the Start Assistant Mapping Editor, Add Start Assistant 
Mapping or Edit Start Assistant Mapping screens.
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Add a Start Assistant Mapping

Select Add from the Start Assistant Mapping Editor screen to 
add a new mapping (see Figure 13-146). 

Figure 13-146. Add Start Assistant Mapping

Edit a Start Assistant Mapping

Highlight an existing mapping on the Start Assistant Mapping 
Editor screen and select Edit or double-click the item to edit a 
mapping (see Figure 13-147).

Figure 13-147. Edit Start Assistant Mapping

Delete a Start Assistant Mapping

Highlight one or more existing mappings and select Delete to 
delete.
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Save and Exit Start Assistant Mapping Editor

Before exiting Start Assistant Mapping Editor, select Save to 
save any changes you have made. 

Select Exit to exit Start Assistant Mapping Editor.
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Scan Assistant

Introduction

Scan Assistant provides an automated exam script that moves 
you through an exam step-by-step. This allows you to focus on 
performing the exam rather than on controlling the system and 
can help you to increase consistency while reducing keystrokes. 
The system automatically invokes the correct mode and imaging 
parameters, advances to the next step in an exam, annotates 
the image, initiates measurements, and assigns the 
measurements to the worksheet/report. 

NOTE: Scan Assistant Creator (off-board) only supports 64-bit 
Windows. 

Availability

The following additional imaging parameters and preferences 
are available for use in a Scan Assistant program: Contrast, 
Contrast Clock, CW Doppler, Dual on Freeze, Depth, Color 
Scale, PW Doppler Scale, PW Sample Volume size, and Flow 
Model Selection.

You can initiate one or more manual Doppler measurements/
calculations.

Body Patterns are available for use during a Scan Assistant 
program. You can turn a Body Pattern on/off, select a particular 
Body Pattern graphic, and specify the position of the probe mark 
on the Body Pattern graphic. 

The footswitch can be used with Scan Assistant.  You can map 
Pause/Resume, Previous Step, and Next Step to the footswitch.

The “Always Use Doppler Cursor” preset, available on the 
Utility --> System --> General page, allows all PW Doppler steps 
to start with full screen 2D image plus mode cursor. You can 
specify the Store Order in Scan Assistant to set the Reading 
Order for the radiologist. The Learn Probe attribute can be set to 
learn and change the probe for the user in the middle of the 
exam.
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Scan Assistant Definitions

Scan Assistant definitions: 

• Scan Assistant Manager. Available via the Utility -> Scan 
Assistant page to import/export Programs created via the 
Scan Assistant Creator and to assign Programs to a user/
exam category. 

• Import. Used to load Programs created via the Scan 
Assistant Creator on to the LOGIQ Totus. 

• Export. Used to move Programs from one LOGIQ Totus 
system to another LOGIQ Totus. 

• Scan Assistant Creator. Used to create Scan Assistant 
Programs.
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Scan Assistant Description

Figure 13-148. Scan Assistant Display Description

1. Program name, completed steps/out of total number of steps, and step 
description area.  

2. Program step status (Complete/Incomplete), step number, step name. A 
checkmark indicates that this step has been completed. You can also 
manually check the box to bypass this step. 

3. This column indicates the mode or when a measurement needs to be 
made.

4. This column indicates that the action moves the Program to the next 
step.

5. Active step The box is green when the program is active or yellow when it 
is paused. 

6. Navigation: Stop, Pause, Pause/Resume. Edit (Pencil Icon). Also 
available via the left/right keyboard arrow keys. Stop also allows the 
program to be stopped, restarted, or a new program selected.  
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Setting up Scan Assistant

To set up Scan Assistant, 

1. Import the Scan Assistant Program created using the Scan 
Assistant Creator or exported from another LOGIQ Totus 
program. 

a. Insert the media with the saved Program from the Scan 
Assistant Creator or exported program from another 
LOGIQ Totus. 

b. Press Utility -> Scan Assistant. 

c. Select Import from the Scan Assistant Manager page. 

d. In the Source field at the top of the Import Programs 
pop-up, select the media that the Program is stored on. 

e. Highlight the Program(s) to be imported. If a folder is 
highlighted, all programs in the folder are selected.  

f. Select Import. The Program(s) you selected are stored 
to the LOGIQ Totus. You can add it to the exam 
category and user. 

2. Assign the imported Program to the exam category and 
user. Under Program Selections on the right-hand side of 
the Scan Assistant Manager page, specify the Exam 
Category and User for this Program. You can select All 
Users, or a specific user. If you specify All Users, all users 
will have the ability to use this Program while in the specified 
exam category, unless the user has his/her own list defined. 

3. Select the imported Program from Available Programs-> 
Custom Programs on the left-hand side of the page. Then 
press the right arrow button to move the imported Program 
to the exam category and user selected above. 
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Setting up Scan Assistant  (continued)

4. The Program list you created in Utility ->Scan Assistant is  
visible in the Program field on the Patient menu. Pressing 
New Patient erases any patient data and Scan Assistant 
program you entered. First press New Patient and then set 
up patient data, Scan Assistant program, and finally, press 
Register Patient. 

You can access the Scan Assistant Creator to edit the exam’s 
program from the imaging display via the Creator Icon located at 
the bottom, left-hand corner of the Scan Assistant Program 
monitor on the display. You can activate the Scan Assistant 
Creator from the image screen, make edits, and then run Scan 
Assistant to test your changes. 

NOTE: If you edit the program after you have already stored several 
images, and your edits change the number of program steps, 
you are prompted to Restart or Continue the Scan Assistant 
program. 

NOTE: If you edit the program after you have already completed several 
steps, checkmarked steps remain checkmarked, even if you 
insert a new step between checkmarked steps. If this is not 
correct, you can edit the checkmarks or restart the program. 
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Using Scan Assistant

After you have set up Scan Assistant, the Program is active 
when you exit the Patient menu. The Program is located on the 
left-hand side of the display and as you can see in the example 
below, the annotation for the first step has been automatically 
noted on the image, ready for you to scan the specified 
anatomy. 

Figure 13-149. Scan Assistant Display

1. Follow the steps indicated in the Program: image/measure 
the appropriate anatomy. 

2. Perform the indicated trigger to move to the next step in the 
Program. 

NOTE: The footswitch can be used with Scan Assistant.  You can 
map Pause/Resume, Previous Step, and Next Step to the 
footswitch.

3. To pause or unpause Scan Assistant, press the pause 
button on the display or press the left/right arrow on the 
keyboard.

4. To stop or restart a Program, press the Stop icon at the 
bottom of the Scan Assistant Program. A dialog pops up. 
This dialog lets you restart the current Program, start 
another Program, or stop Scan Assistant. 

5. To skip a step or move to a certain step, press the up/down 
arrows on the keyboard or select the step you want to move 
to using the Trackball and Set keys. 
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Reference Images

Overview

Reference images can be attached to a step of Scan Assistant 
protocol. The reference image is displayed in an extra window 
on the scan screen during scanning with the protocol. 

Any image (JPEG/DICOM) can be attached to (or removed 
from) a protocol with Scan Assistant Creator.

Using Reference Images

A reference image window appears when a protocol with a 
reference image attached is active. The window is positioned 
over the preview window and can be moved anywhere on the 
screen (the system will remember the last image position).

Figure 13-150. Reference Image Window

1. Minimize window by clicking minimize button in upper left 
window corner. 

2. Change window size by dragging window corners.

3. Drag to move window anywhere on screen.
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Inserting a step

1. To insert a pre-defined step to the active Scan Assistant 
Program, press the Plus Sign (+) on the Scan Assistant 
Display. 

Figure 13-151. Insert Steps

The Insert Steps Pop-Up Menu appears. 

2. Select the steps to be inserted via the pull-down Scan 
Assistant menu.  

Figure 13-152. Select from pull-down menu

3. Press Insert. All the steps in the inserted program are added 
immediately after the active step in the current program. 

To undo inserted steps, use Edit button to edit the program 
and delete the recently inserted steps.

NOTE: After the exam is completed, the system removes the 
temporarily saved Scan Assistant program with inserted steps.

NOTE: The inserted steps is not adapt the annotation and body pattern 
from the active step.
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Breast Measurement Auto Insert Steps

To add a program to be inserted whenever the Add Lesion key is 
selected, 

1. Press the Plus Sign (+) on the Scan Assistant Display. 

Figure 13-153. Insert Steps

2. Select the "Add Lesion" tab.  

3. Identify a breast lesion while using a breast scan assistant 
program. Freeze on the lesion and press “Add Lesion” on 
the measurement menu.

4. Complete the length measurement of the lesion. Unfreeze 
the image.

5. Upon unfreeze, the predefined program is inserted into the 
existing program and the next step is started.

Figure 13-154. “BreastLesionAssess”

In this example, BreastLesionAssess contains four (4) 
steps, as indicated within the brackets on the figure above. 
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Exporting Scan Assistant Programs to Another LOGIQ Totus 

Exporting Scan Assistant Programs allows them to be imported 
to another LOGIQ Totus or to be edited offline with the Scan 
Assistant Creator tool. To export a Program, 

1. Insert the media to save the Program to.  

2. Press Utility -> Scan Assistant. 

3. Select Export from the Scan Assistant Manager page. 

4. In the Source field at the top of the Export Programs pop-up, 
select the media that the Program is to be stored on. 

5. Specify the Program Directory using the drop-down menu if 
the desired Program Directory already exists on the media. 
If not, or if you want to export the Program to a new Program 
Directory, type a new Program Directory name in the field. 

6. Highlight the Program(s) to be exported. If a folder is 
highlighted, all programs in the folder are selected. 

7. Select Export. The Program(s) you selected are stored to 
the media. You can now import it to a new LOGIQ Totus. 
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Scan Assistant Creator

Overview

Scan Assistant Creator is used to build customized Programs 
that can be imported onto the LOGIQ Totus. These Programs 
automate many of the steps normally performed manually by the 
user, thereby reducing the number of user actions and the 
amount of time to perform an exam.

The Scan Assistant Creator tool can be used both on the 
scanner and as an off scanner tool. 

 Figure 13-155. Tool Layout Overview

1. Menu
2. Toolbars
3. Steps

4. Step Attributes
5. Rule Checking
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Help

Help is available via the F1 key.

File Handling

When using Scan Assistant Creator off the scanner, it is very 
important to organize the programs in a way that will make it 
easy to import the programs onto the scanner. Each Program is 
a computer file. While these computer files can be copied, 
pasted and deleted like any other computer file, the Program 
files are only viewable using the Scan Assistant Creator.

File Extensions

Factory defined Programs have an .ep (exam Program) 
extension while user-defined Programs have an .uep (user 
exam Program) extension. Both factory and user-defined 
Programs can be read into the Scan Assistant Creator, but only 
user-defined Programs are created. If a factory Program is read 
into the Scan Assistant Creator and then edited, it is saved as a 
user-defined Program.

Off-Scanner Directory Structure

The Scan Assistant Creator organizes the Programs in a 
directory structure that allows easy importing into the LOGIQ 
Totus. In order to be imported, all Programs must be stored in a 
LOGIQ_SCAN_ASSISTANT Programs Directory. Within this 
directory, one or more user-specified directories are created. 
Within each of these user-specified directories are the category 
directories (VAS, ABD, etc.) that hold the actual Programs.

The dialog in the figure below allows the user to specify the 
location of the LOGIQ_SCAN_ASSISTANT directory (root 
directory) and to either select an existing User Program 
Directory or create a new one.

Figure 13-156. Directory Structure
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Exporting Programs from LOGIQ Totus

Factory or user-defined Programs on the LOGIQ Totus are 
easily exported for editing with the Scan Assistant Creator.

On the LOGIQ Totus:

1. Insert a USB storage device.

2. Select Utility -> Scan Assistant.

3. Select Export.

4. Select the media type and specify a directory. If a directory 
is specified that already exists, the Export adds the 
Programs along with any existing Programs. If the names of 
Programs are the same, use the resulting dialog to decide 
how to continue.

5. Select the Program to be exported and export them.

On the computer with the Scan Assistant Creator installed:

1. Insert the USB storage device used above.

2. Copy the LOGIQ_SCAN_ASSISTANT directory from the 
USB storage device to the hard drive. The hard drive 
directory that you copy to is the root directory. If you want to 
work with the Programs directly on the USB storage device, 
this step can be skipped.

3. Either open a Program by double-clicking it or selecting 
File ‘-> Open from the Scan Assistant Creator.
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Importing Programs to LOGIQ Totus

Programs created with the Scan Assistant Creator are easily 
imported to the LOGIQ Totus.

On the computer with the Scan Assistant Creator installed:

Copy the complete LOGIQ_SCAN_ASSISTANT directory from 
the computer hard drive to a USB device. The 
LOGIQ_SCAN_ASSISTANT directory needs to be at the top 
level (not in a subdirectory) on the USB device.

On the LOGIQ Totus:

1. Insert the USB device.

2. Select Utility -> Scan Assistant.

3. Select Import.

4. Select the media type.

5. Select the Programs to be imported and import them. If you 
attempt to import Programs that already exist with the same 
name, use the resulting dialog to decide how to continue.

Table 13-61:  Directory Structure Example

LOGIQ_SCAN_ASSISTANT 

MyUserNameDirectory

ABD

CARD

GYN

OB

PED

SMP

UR

VAS
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Sharing Programs

To share a program with someone else, the file can be sent via 
e-mail as an attachment or copied onto a media. If the person 
receiving the program has the Scan Assistant Creator tool 
installed, open the file and use “Save As” to save it to an 
appropriate directory. 

If the person receiving the program does not have the Scan 
Assistant Creator tool installed, the program can still be loaded 
onto a scanner by creating the following structure at the top level 
directory on a media device, copying the file to one of the 
category directories and then importing the protocol onto the 
scanner.

To share an entire portfolio of programs with someone else, the 
entire user program directory can be zipped. Make sure to set 
the options to include subfolders and to include relative path 
information. On the receiving end, the user can unzip the 
directory into a LOGIQ_SCAN_ASSISTANT directory. 

Table 13-62:  Media Directory Structure

LOGIQ_SCAN_ASSISTANT 

User Program Directory (Any user name)

Category Directories (e.g. ABD, CARD)
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Exporting the Scan Assistant Creator to a PC

To export the Scan Assistant Creator to a PC, 

1. Insert a USB Flash Drive in a USB port on the Control 
Panel.

2. Press Utility -> Scan Assistant.

3. Press Export.

4. Place a checkmark in the Export Scan Assistant Creator 
Installation. 

5. Press Export.
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Creating and Editing Programs

To access Scan Assistant Creator on the LOGIQ Totus: 

1. Select Utility -> Scan Assistant.

2. Select Creator on the Scan Assistant Manager tab on the 
monitor.

Creating New Programs

1. Select File -> New. 

2. Before creating a New Program, select Single Step or Multi 
Step in the Toolbar.

 Figure 13-157. File Toolbar

3. Proceed to add/update your settings for the Step: Step 
Name, Instructions, etc.

4. Once finished, highlight the finished Step.

5. Select Edit -> Copy

6. In the Toolbar along the left, select Insert Step Before 
Selected or Insert Step After Selected.

Figure 13-158. Insert Step

7. Highlight the copied step and proceed to edit accordingly.

8. Proceed to follow the same procedure to add more steps to 
your Program.
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Creating New Programs  (continued)

9. When done, select Check to verify your Steps.

Figure 13-159. Rule Check and results area

10. The results are listed as to whether the Scan Assistant Rule 
Check Passed or if any Issues were detected. Issues found 
when running the check do not mean the Program is 
unusable. 

NOTE: The rule check may report an unequal number of left and 
right steps. This may or may not be the expected result. If a 
change is made in response to the rule check results, a new 
rule check can be run to see if the issue has been resolved.
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Editing Programs

When editing Programs, changes can be made at both the step 
level and the step attribute level. Steps can be added, inserted, 
moved, deleted, copied and pasted. Step attributes can be 
modified for a given step or across multiple steps.

Editing Steps

The step toolbar allows steps to be inserted, moved up and 
down, and deleted. For steps to be moved, one or more 
consecutive steps must be selected.

When the last step in a Program is selected, the Enter key 
automatically appends a new step to the end of the Program 
and selects the new step. When the Enter key is pressed on any 
other step, the next step is activated. The up and down arrows 
can also be used to move between steps.

 Figure 13-160. Step Toolbar and Edit Toolbar and Menu

When selecting multiple steps for Cutting or Copying, the Shift + 
Left Mouse and Ctrl + Left Mouse key combinations can be 
used.

1. Insert Step above selected step (Ctrl+l)
2. Insert Step below selected step
3. Move selected step(s) up (Ctrl+Up Arrow)
4. Move selected step(s) down (Ctrl+Down Arrow)

5. Delete selected step(s)
6. Edit Toolbar  (Undo, Redo, Cut, Copy, Paste 

and Paste Special)
7. Edit Menu (same toolset as the Edit Toolbar)
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Editing Steps  (continued)

Paste Special The Paste Special control allows copied steps to be pasted with 
some modification. Select the desired Conversion and select 
Paste. An added feature to the Paste Special control is the 
Define Conversions function, which is used to define the text 
that is converted. An example is shown in the figure below. If an 
exact case match is found, it is used for the conversion. If there 
is a match, but with a different case, it is used only if there is not 
an exact case match.

There are 3 user-defined conversions that can be edited and 
named. These user-defined conversions can also be used to 
perform a find and replace capability.

Figure 13-161. Define Conversions Dialog
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Editing Step Attributes

To edit a step attribute, select the step attribute and edit it, such 
as picking from a drop down menu, checking or unchecking a 
box, or typing in text. To edit multiple steps in a Multi Step view, 
select the step attribute of choice and do the following actions:

• Set the value of the step attribute as desired.

• Left click (and release) in the square in the bottom 
right-hand corner of the attribute.                                                                       

• Drag to highlight the other steps to be changed in the same 
way.

• Left click (and release) again.

This will take the original step's content and copy it down the 
highlighted steps. This is also available when multiple attributes 
are selected within the same step.

To edit multiple steps in the single step view, highlight the 
multiple steps that you want to edit and then change the step 
attribute. If a step attribute is highlighted in green, this indicates 
that its current value varies across the selected steps.

If a step attribute is not editable, it may be because the attribute 
requires a different attribute to be set a particular way in order to 
become enabled. These dependencies are outlined below.

Table 13-63:  Step Attribute Dependencies

Step Attribute Dependency

PDI Color step attribute must be checked

Color / Dop Steer Color or PW step attribute must be checked

Measure 1 Measure Trigger must not be set to None

Measure 2 Measure 1 must be set

Measure 3 Measure 1 and Measure 2 must be set
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Editing the Current Program on the Scanner

If you are currently using a Scan Assistant program and choose 
to edit that program while using it (by selecting the pencil icon at 
the bottom of the Scan Assistant steps), the program will be 
reloaded when scanning is restarted. If the number of steps is 
changed, the checkmarks that were in place before editing are 
cleared.  If the number of steps in the program has not changed, 
the checkmarks that were in place before editing are 
maintained.

The current program can be restarted at any time by selecting 
the Stop button on the Scan Assistant navigation window and 
selecting restart.

Opening Existing Programs

Multiple Programs can be open at the same time by selecting 
File -> Open. Each Program will open within the primary Scan 
Assistant Creator window. Finding the Program file (.ep or .uep) 
and opening the file automatically opens the file in the Scan 
Assistant Creator. 

To switch between Programs, the title banner of the window is 
selected or the Program is selected from the Window Menu. An 
asterisk indicates that the Program has been edited but not 
saved.

With multiple Programs open, steps copied from one Program 
can be inserted into another Program via the paste or paste 
special features.

Saving Programs

Programs are saved via Save or Save As.

When Saving a Program, the Scan Assistant Creator provides 
an opportunity to run a rule check on the Program before saving.

NOTE: The name of a Program is appended with an asterisk (*) when 
the Program has been changed, but those changes have not yet 
been saved
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Views

A Program is made up of a series of steps. Each step is made 
up of various step attributes. The step and step attribute data 
can be viewed in many ways using the Scan Assistant Creator. 
The different ways to look at the data are called Views.

Single Step Views

There are two Single Step views: Basic and All. The Basic view 
shows the most common attributes of the selected step. The All 
view shows all of the attributes of a given step.

For both views, the step names are shown on the left with the 
active step highlighted. The step attributes appear on the right 
and are separated into four groupings:

• General attributes at the top

• Imaging and Comment attributes on the left

• Measure attributes on the right.

 Figure 13-162. Basic Single Step View

1. Steps 2. Step Attributes
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Multi Step Views

Multi Step views show certain step attributes for all the steps in a 
Program. There are six Multi Step views: General, Comment, 
Scan, Measure, Custom and All. 

 Figure 13-163. Multi Step Scan View

1. Steps 2. Step Attributes



Advanced Features

13-344 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Customizing Multi Step Views and HTML Export

The contents of the Multi Step Views and the HTML Export is 
configurable via the Customize Menu or the small downward 
pointing arrow next to the word "Custom" on the View Toolbar 
Menu. 

Figure 13-164. Customize Menu

The Language selection allows the Scan Assistant Creator 
language to be configured. 

The column widths of the steps and step attributes are 
customizable. The desired width is set by selecting and dragging 
the line separating column headers. These adjustments are 
remembered for the next time the Scan Assistant Creator is 
used.

The locations of the toolbars are customizable. The location is 
set by selecting and dragging the toolbar gripper as shown in 
the figure below. The toolbars can be placed at the top, left, right 
or bottom of the Scan Assistant Creator.

 Figure 13-165. Gripper used for Toolbar placement

1. Toolbar Gripper
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Customizing Multi Step Views and HTML Export  (continued)

Multi Step View In the Customize Multi Step Views dialog, each tab represents a 
different Multi Step view. Within a tab, the checked boxes are the 
step attributes that are displayed in that Multi Step view. The 
views are independent of one another, so if a step attribute is 
desired in both views, it needs to be selected in both views.

 Figure 13-166. Customize Multi Step Views Dialog
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Customizing Multi Step Views and HTML Export  (continued)

HTML Export The HTML Export feature allows a Program to be stored in a file 
format (*.mht) that is compatible with Windows Internet Explorer. 
This file is useful for printing the Program or viewing the 
Program, but is not useful for editing the Program. HTML Export 
is available via the File Menu.

An example of how a Program looks in HTML format is shown 
below.

 Figure 13-167. HTML Export
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Keyboard Navigation

In addition to moving the windows pointer and selecting an item, 
there are several keyboard controls to help navigate through the 
Views.

Table 13-64:  Keyboard Program Navigation

Keyboard Entry Step Selected Step Attribute Selected

Enter Moves to next step. If on the last 
step, it creates a new step and 
selects it.

Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to same step 
attribute in the next step. If on the 
last step, it creates a new step and 
selects it.

Tab Single Step View: Moves to next 
step. On the last step it moves to the 
first step attribute.
Multi Step View: Moves to the first 
step attribute.

Moves to next step attribute. If last 
attribute for the step, moves to next 
step.

Alt+Tab Single Step View: Moves to previous 
step. On the first step it moves to the 
last step attribute.
Multi Step View: Moves to the last 
step attribute of the previous step.

Moves to next step attribute. If first 
attribute for the step, moves to 
previous step.

Up Arrow Moves to previous step Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to same step 
attribute in the previous step.

Down Arrow Moves to next step Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to same step 
attribute in the next step.

Left Arrow No action Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to the 
previous step attribute.

Right Arrow Single Step View: No action.
Multi Step View: Moves to the first 
step attribute.

Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to next step 
attribute.

Page Up Scrolls to previous page of steps Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to same step 
attribute in the previous step.

Page Down Scroll to next page of steps Single Step View: Varies based on 
the step attribute selected.
Multi Step View: Moves to same step 
attribute in the next step.
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Scan Assistant Features

Scan Assistant allows the user to program the steps in an exam 
and to program certain attributes for each step. The attributes 
are what give the Scan Assistant Program behavior.  The tables 
below provide the names of all attributes along with a 
description.

General Attributes

Table 13-65:  General Attributes

Attribute Name Description

Store Order Specify Used to enable the Store Order Definition dialog so that the Store Order can 
be set

Store Order Specifies the Store Order number associated with the Step

Step Number Number of the step that appears in the Scan Assistant Navigation menu

Step Name Name of the step that appears in the Scan Assistant Navigation menu

Advance On • Print: Advance to the next step and go live after Print / Image Store (e.g P1 
key). This can be a single image store or a loop store. 

• Print & Unfreeze: Advance to the next step after Print / Image Store (e.g. P1 
key) and unfreeze. This can be a single image store or a loop store.

• User Selection: Advance to next step only after next step is manually 
selected (e.g. down arrow)

Instructions User notes displayed in the Scan Assistant Navigation menu when the step is 
active

Optional Optional: An optional step is given a check mark during Program execution 
even if no image is acquired
Mandatory: A mandatory step is give a check mark only if an image is 
acquired for the step

Learn Probe On or Off.  Learn and change the probe for the user, when selected.
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Comment Attributes

Table 13-66:  Comment Attributes

Attribute Name Description

Comment 1, Comment 2 User annotation associated with the step. When editing in a Multi Step View, 
use Alt+Enter to create a new line.

Location 1, Location 2 Choose where the annotation is located on the image area for single or dual 
screens.

BP 1,2 Blank: Body Pattern not specified. 
Selected Body pattern graphic with or without probe position will be set, if 
selected

BP Specify Used to enable the Body Pattern Selection dialog so that the Body Pattern 
graphic can be selected and probe position can be set

BP Clear Clears BP 1, BP 2 defined for the step

BP Probe BP Probe mark set by Scan Assistant, when selected

BP X/Y/Rot Displays the X/Y/Rot information of the Probe mark set from Body Pattern 
Selection dialog
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Imaging Mode and Imaging Preference Attributes

The probe and application associated with a program is not 
configurable. Instead, the scanner remembers the last probe 
and application used for a given Scan Assistant program and 
automatically selects them the next time the program is started. 

 Figure 13-168. Imaging Mode and Imaging Preference Attributes

Table 13-67:  Imaging Mode Attributes

Attribute Name Description

Color, PDI, MVI, PW, CW, 
M Mode, B Flow, B FLow 
Color, 3D, LOGIQView, 
Contrast, Contrast Clock, 
Elasto (Strain 
Elastography) and SWE 
(Shear Wave Elastography)

• On - when selected, the mode is on.
• Off - when not selected, the mode is off. 

Dual • Off - Dual screen is not in use.
• Left Active - Dual screen is active and the left image is the active image.
• Right Active - Dual screen is active and the right image is the active image.
• DualView (simul) - DualView is active (both left and right images are live).
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Imaging Mode and Imaging Preference Attributes  (continued)

NOTE: B Flow Color is not supported by the LOGIQ Totus. It still exists 
in Scan Assistant Creator because other products that offer B 
Flow Color use the Scan Assistant Creator program. 

Imaging Preferences work slightly different than other attributes. 
For example, if an abdomen Program has 20 steps and all steps 
have the Harmonics attribute set to Default, then Scan Assistant 
will not affect the harmonics setting. Now, assume that steps 
10-12 are gallbladder steps and that the harmonics attribute has 
been set to on for these steps. When transitioning into this group 
of steps (step 9 to step 10), harmonics will be turned on (or 
remain on if it was previously on). If harmonics is then manually 
turned off in step 10 then Scan Assistant will not turn it back on 
when advancing to step 11. In other words, a group of 
consecutive steps with the same Imaging Preference are treated 
as a group by Scan Assistant and not as individual steps.

Table 13-68:  Imaging Preference Attributes

Attribute Name Description

Harmonics • On - when selected
• Off - when unchecked
• Default - Not specified so Scan Assistant does not set this attribute.Virtual Convex

CrossXBeam

Color/Doppler  Steer • Left - Color/Doppler steered to the left
• Center - Color/Doppler not steered
• Right - Color/Doppler steered to the right

Flow Model • Specified Flow Model is selected - Aorta, Renal, Penetration, Slow Flow, 
Med Flow, Fast Flow 

• Default - Not specified so Scan Assistant does not set this attribute.

Depth • 2.0 to 36.0.
• Default - Not specified so Scan Assistant does not set this attribute.

Color Scale • 1 to 200.
• Default - Not specified so Scan Assistant does not set this attribute.

Doppler Scale

SV • 1 to 16.
• Default - Not specified so Scan Assistant does not set this attribute.

B-Flow Sensitivity • 1.0 to 50.
• Default - Not specified so Scan Assistant does not set this attribute.

B-Flow Color Scale • 0.02 to 1.5.
• Default - Not specified so Scan Assistant does not set this attribute.

Color Baseline • 0 to 100.
• Default - Not specified so Scan Assistant does not set this attribute.

Doppler Baseline • 5 to 95.
• Default - Not specified so Scan Assistant does not set this attribute.
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Measurement Attributes

Figure 13-169. Measurement Attributes

Table 13-69:  Measure Attributes

Attribute Name Description

Side When selected, the side measurement qualifier is set to:
• Rt - Right side of the body
• Lt - Left side of the body
• None - Not used (neither Right nor Left)
• Default - Side not specified so Scan Assistant does not set Side

Location When selected, the location measurement qualifier is set to:
• Prox - Proximal
• Mid - Middle
• Dist - Distal
• None - Not used
• Default - Location not specified. Scan Assistant does not set Location

Dop Vessel Assign Various Doppler measurement Vessel folders
Specifies the Vessel folder to assign auto calcs to. The assignment happens 
when the image is stored / printed (e.g. P1 key).

Auto Calcs When selected, the Auto Calcs state is set to:
• Frozen
• Live
• Off
• Default - Auto Calcs state not specified. Scan Assistant does not set Auto 

Calcs state.

Auto Calc Params • Various Auto Calc parameters - specifies the auto calc parameters to be 
used.

• Default - Auto Calc parameters are not specified. Scan Assistant does not 
set the Auto Calc parameters.

Auto Calc Specify Used to enable the Auto Calcs Parameter Selection dialog so that the Auto 
Calc Params attribute can be set

Auto Calc Default Used to set the Auto Calcs Params attribute to Default.
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Fetus When selected, the fetus measurement qualifier is set to:
• A - Fetus A
• B - Fetus B
• C - Fetus C
• D - Fetus D
• Default - Fetus not specified so Scan Assistant does not set Fetus

B/M Measure Trigger When selected, the following action initiates the “Measure 1” attribute:
• Measure Key 
• Freeze Key 
• Image Store - when the Measure key is manually selected or the image is 

stored. This is used to store / print an image and then measure on it and 
then store it again. Therefore, the Advance On Print attribute is ignored on 
the first store / print when the Measure Trigger attribute is set to Image 
Store.

• None - Measurements are not triggered by Scan Assistant. The "Measure 
1" attribute is ignored.

B/M Measure 1 Various 2D or M-Mode measurements
Specifies the first 2D or M-Mode measurement to be initiated. The point at 
which the measurement is initiated is based upon the Measure Trigger 
attribute.

B/M Measure 2 Various 2D or M-Mode measurements
Specifies the second 2D or M-Mode measurement to be initiated after the 
measurement associated with the Measure 1 attribute is completed. 

B/M Measure 3 Various 2D or M-Mode measurements
Specifies the third 2D or M-Mode measurement to be initiated after the 
measurement associated with the Measure 2 attribute is completed.

Double Print - Meas • On - If an Image Store / Print (e.g. P1 key) is performed on an image with 
measurements, the image is stored / printed two times, once with the 
measurements and once without.

• Off - No special Store / Print behavior.

Double Print - Color • On - If an Image Store / Print (e.g. P1 key) is performed on an image with 
color, the image is stored / printed two times, once with color and once 
without. If double print on color and double print on measurements are both 
configured to be on, the image is stored / printed two times, once with the 
measurements and once without.

• Off - No special Store / Print behavior.

View Worksheet • On - The worksheet is turned on
• Off - The worksheet is not turned on

Table 13-69:  Measure Attributes (Continued)

Attribute Name Description
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Measurements

Because there are many measurements available on the LOGIQ 
Totus and because the measurement package is highly 
customizable, there is some special handling for measurements. 
The Measurement attributes affected by this special handling 
are Measure 1-3 and Vessel.

Selecting a Measurement Package

The Measurement selection menu can be used to specify which 
measurement package is to be used for the Program. The 
Measurements packages are organized by category and 
subcategory. The choices for the Measure 1-3 and Vessel 
attributes are limited by the selection of category and 
subcategory. To select a subcategory, select a category, move to 
the subcategory list and select a subcategory. To select all 
subcategories for a given category, select the category and then 
reselect the Measurements menu item to remove the menu.

A single Program is not allowed to have measurements from 
multiple categories, but it may have measurements from 
multiple subcategories.

Figure 13-170. Measurements Menu
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User-Defined Measurements

User-defined subcategories and individual measurements can 
be used with the Scan Assistant feature. To do so, the Scan 
Assistant Creator needs to know about the user-defined 
measurements on the LOGIQ Totus.

On the LOGIQ Totus, use the Scan Assistant utility menu to 
Export Programs to a USB storage device. On the export menu, 
check the "Export user config data" checkbox to store the 
user-defined measurement information to the Program User 
Directory on the media. The name of the file is 
UserConfigSystemFile.res. When this file exists in the Program 
User Directory, then it is used. Otherwise, the default file 
installed with the Scan Assistant Creator is used.
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Rule Checking

Scan Assistant Creator allows Programs to be checked. During 
a rule check, Scan Assistant Creator applies a series of rules 
against the Program being checked and reports any 
inconsistencies between the rules and the Program. This rule 
check is intended to find potential issues in the Program before 
it is tested on a LOGIQ Totus. Issues found when running the 
check do not mean the Program is unusable. It means that if 
there happens to be a problem with running the Program, the 
first place to look would be at the Issue noted when you ran the 
Check.

For example, if there is a step name Right Kidney and the 
Measurement Location is set to "Left", the rule check would 
report this inconsistency. 

Running a Rule Check

The "Check" button below the Program area is used to initiate a 
rule check. The results are displayed in the Rule Check Results 
window to the right of the button. A rule check is also initiated 
when attempting to save a Program that has not previously 
passed a rule check.

 Figure 13-171. Rule Check Button and Rule Check Results
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Rule Check Results

If the issue is specific to a particular step, double-clicking on the 
issue number in the Rule Check Results window selects the 
step associated with the issue. The results are intended to be 
potential issues and therefore may be ignored at the discretion 
of the user. For example, the rule check may report that there 
are an unequal number of left and right steps. For a particular 
Program, this may be the expected result. If a change is made in 
response to the rule check results, a new rule check can be run 
to see if the issue has been resolved.
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Compare Assistant

Overview

Compare Assistant allows you to perform serial scans on a 
patient when you can compare the images from a patient’s 
previous exam(s) to the patient’s current exam.

NOTE: In order to reload imaging parameters from a previous exam, the 
image must have been stored as raw data.

NOTE: Side-by-side scanning comparison is present whether or not you 
are able to import the scanning parameters.

In Comparison Mode the system can automatically reload  
scanning parameters from a previous exam performed on a 
LOGIQ Totus archived as raw data and allow for side-by-side 
scanning for image comparison. This allows you to use 
consistent scanning parameters from exam to exam on the 
same patient and may assist in assessing the progress of the 
patient.

Compare Assistant is available in B-Mode, Harmonics, Contrast, 
and in Color Flow and Power Doppler Imaging Modes. 

In B-Mode the following parameters can be transferred from the 
Compared Image to the Active B-Mode Image: Gain, Depth, 
Frequency, CrossXBeam, Virtual Convex (linear probes), SRI, 
Frame Averaging, Map, Dynamic Range, Acoustic Output, 
Harmonic state, Focal Zone Number and Position, Width, and 
Line Density. 

In Color Flow/PDI Mode the following parameters can be 
transferred from the Compared Image to the Active Color Flow/
PDI Mode image: Gain, ROI Size/Position, Frequency, Frame 
Averaging, Packet Size, Flow Model, Scale (PRF), Wall Filter, 
Spatial Filter, Acoustic Output, Invert, Threshold, Sample 
Volume, Color Map, Virtual Convex (linear probes), and Line 
Density.  
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Overview  (continued)

Image parameter copy is supported for the following additional 
modes: Contrast (supports depth, focal zone position, acoustic 
output, and frequency), Elasto (supports ROI size, ROI position, 
frequency, and scale), and B-Flow (supports depth, frequency, 
focal zones, and sensitivity). 

Annotations and Body Patterns can also be transferred from a 
patient’s previous exam to the patient’s current active exam. 

Up to four (4) exams, three (3) other exams and the current 
active exam, can be compared. Each exam is displayed on the 
bottom of the display, with Tabs indicating each exam. Tabs are 
shown in chronological order with the most recent exam 
displayed on the left. 

Compare Assistant is not supported with V Nav, 3D/4D, 
Quantitative Analysis, Stress Echo, or LOGIQView. 

Only measurements taken during the active exam are 
transferred to the current exam’s Worksheet; previous exam 
measurement information is not included on active worksheets. 

In order to utilize the Compare Assistant tool, images should 
have RawDICOM data. The RawDICOM data is saved locally 
when available. Some scanning modes do not provide raw data. 
If the raw data associated with the comparison image cannot be 
displayed in dual image format, the DICOM image data is used 
to display the image. RawDICOM data is typically removed 
when images are sent to PACS; therefore, images that are 
loaded using Query/Retrieve will likely be standard DICOM only.  

NOTE: Images from some other ‘unsupported’ modes (PW Mode, CW 
Mode, and M-Mode) can be recalled in Compare Assistant, but 
the tool will not attempt to copy over imaging parameters unless 
it is one of the types listed above (it will still attempt annotation 
copy). Imaging parameter copy will also not be attempted unless 
the current probe is the same as the probe used to capture the 
original image and RawDICOM data for the original image is 
available.
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Workflow example

NOTE: If you use DICOM images for comparison, check the "Compare" 
checkbox on the DICOM Image folder and press Compare on 
the Image History page.

1. Place the cursor on the Compare Assistant icon and press 
Set to activate Compare Assistant.

2. Place the cursor on the date tab of the desired comparison 
exam and press Set.

3. Place the cursor on the desired comparison image and 
press Set.

4. Start scan and freeze the image at the same position to 
make a comparison.

Use Copy Setting Icon as necessary. Comparison Image 
parameters transfer to the Active Image based on your 
preset (automatic or manual)

5. Place the cursor on the Compare Assistant icon and press 
Set to deactivate Compare Assistant.

 Figure 13-172. Compare Assistant Screen (example)

1. Active Image
2. Comparison Image
3. Active Exam clipboard
4. Date tab of comparison exam
5. Comparison exam clipboard
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Setting Up Compare Assistant

Compare Assistant allows you to set the following parameters: 

• Side to place the compared image (left/right)

• Date settings for the compared image

• Imaging and Annotation parameters to be copied from the 
patient’s Compared to the Current image

• Clipboard, Active Image, and Image History Label Layout 
and Color

You can set these parameters on the System Imaging page via 
Utility--> System--> System Imaging. 

Figure 13-173. Setting Up Compare Assistant Parameters

Table 13-70:  Compare Assistant Parameters

Parameter Settings

Comparison Image Side • Left
• Right (Default)

Comparison Image Date • All Dates (Default): The date is always displayed on the comparison image. 
• Different Date: Date only displayed when the date of the comparison image 

is different than the active exam date. 
• None: No comparison image date is displayed. 
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To set Compare Assistant print parameters, select Utility--> 
Connectivity--> Button--> Advanced. You can set the system to 
print the Comparison image only, to store the New Image only; 
or to store both the Comparison and New Image. 

Copying Settings You can set the default Compare settings on the  System Imaging Utility page 
or you can select the Compare setting via the On-screen controls. 
Comparison Image parameters transfer to the Active Image based on your 
preset (automatic or manual). 
Automatic Settings are copied from the Comparison Image to the current 
image as soon as the comparison image is loaded. 
• Automatic: Imaging & Annotations (Default): Imaging Parameters, 

Annotations, and Body Patterns copied
• Automatic: Imaging Only:  Only Imaging Parameters copied
• Automatic: Annotation Only:  Only Annotations and Body Patterns copied
Manual Settings are copied from the Comparison Image to the current 
image when you manually select the control. 
• Manual: Imaging & Annotations: (Default) Imaging parameters, 

Annotations, and Body Patterns copied
• Manual: Imaging Only: Only Imaging Parameters copied
• Manual: Annotations Only: Only Annotations and Body Patterns copied
Off: No parameters copied. 

Note: Copy settings are restored to the default whenever Compare Assistant is turned on and the active 
exam or current patient has changed since the last time it was on.  

Image Label Layout:
Clipboard
Active Images
Image History

• No Label
• 1-Line Label (Default)
• 2-Line Label

Image Label Color: 
Clipboard
Active Images
Image History

• Bright/Soft White
• Bright/Soft Yellow
• Bright/Soft Red
• Bright/Soft Orange
• Bright/Soft Blue
• Bright/Soft Purple

Table 13-70:  Compare Assistant Parameters

Parameter Settings
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Compare Assistant Controls

The following controls can be used while in Compare Assistant: 

Table 13-71:  Compare Assistant Controls

Control Description

1. Image Display Area Icon
2. Worksheet
3. Active Image Screen
4. Compare Assistant On/Off. Select the Compare Assistant Icon to activate 

Compare Assistant. 
5. Copying Settings
6. Save As Menu
7. Next/Previous Image, or Press [Ctrl]+[Next Image Arrow] to start a Slide 

Show. 

Keyboard Arrow Keys You can also use the Arrow Keys on the Keyboard to move to the next/
previous clipboard image. 

Operator Panel L/R Keys If comparison mode is on and the single image display is active, to enter dual 
comparison display press the L (Left) or R (Right) key. 
If dual comparison display is on and the dual comparison display is active, to 
enter single image display, press the L (Left) or R (Right) key. 

Freeze Key To deactivate Comparison Mode, select the comparison image side while in 
Dual Comparison Display and press Freeze. 

Print Key When you store an image while in Dual Comparison Display, the system 
automatically switches to the active exam side prior to storing the image. 
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Compare Assistant Controls  (continued)

NOTE: Compare Assistant icon is disabled when the system does not 
have Compare Assistant Option.

Table 13-72:  Compare Assistant icon and Copy Setting icon

Compare Assistant On. Copy to 
Right.

Compare Assistant On. Copy to 
Left.

Off Off

Automatic: Imaging and 
Annotations

Automatic: Imaging Only

Automatic: Annotation Only Manual: Imaging & Annotations

Manual: Imaging Only Manual: Annotations Only

Off. No parameters copied. Disabled.
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Comparison Clipboard

In Comparison Mode two (2) image clipboard areas display 
images from the active exam and the selected comparison 
exam. The Comparison Clipboard can display up to four (4) 
exams, including the active exam. Each exam has a tab that you 
click on to select the desired comparison or active exam. The 
active exam is always displayed.

 Figure 13-174. Comparison Clipboard

The comparison exam(s) are identified by the date of the exam 
on the tab; the active exam is identified by the word, “Active” and 
by the asterisk (*). You can activate the Image History screen by 
clicking on the “...” tab.  

Each image clipboard has its own scroll bar that can be used to 
scroll through all the images. 

The highlighted image in the clipboard is the image that’s 
displayed along with the exam’s active image. 
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Query/Retrieve

You can use DICOM Query/Retrieve to search for a patient’s 
previous exams. When you select a patient on the Patient 
Screen, select the “Query” button. This automatically registers 
the patient (if needed) and initiates a query via the Data Transfer 
page. Select the exams you wish to be transferred and press the 
“Transfer” button.  

After the retrieve completes, the system automatically returns to 
the Patient Screen with the same patient and exam active as 
when you selected to Query this patient. 

Figure 13-175. Patient Exam View

You can also push the data from the PACS device to the system.
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Activating Compare Assistant

Compare Assistant displays an image associated with the active 
exam (live, frozen, or CINE) and the other side contains an 
image from the comparison exam. 

Comparison Image parameters transfer to the Active Image 
based on your preset (automatic or manual). You can also use 
the Display Copying control adjacent to the clipboard to copy 
settings from the comparison image to the active image. 

NOTE: If an imaging parameter is not available for the current probe, a 
message in the status bar indicates that this parameter is not 
available.

You activate Compare Assistant via the Comparison Mode Key 
adjacent to the Image Clipboard and On-screen Trackball 
Controls or you can activate Compare Assistant via the Patient 
Image History screen by selecting the image and pressing 
“Compare.”   

 Figure 13-176. Image History

At the start of an exam the system automatically checkmarks the 
three (3) most recent exams, excluding active exams and 
exams without any images as the comparison exams. You can 
adjust this by placing a checkmark next to the exam you wish to 
include in Compare Mode (the system automatically deselects 
the oldest checked exam). To activate Comparison Mode, select 
which specific image you would like to compare to the current 
image from the clipboard on the Image History screen. Select 
the image and press the “Compare” button. 
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Exiting Compare Assistant

To exit Compare Assistant Mode, select the Comparison Mode 
Key adjacent to the Image Clipboard, or change the exam 
Application Preset, change active exam, change patient, or 
recall an image from the active clipboard.  
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OB Measure Assistant

Overview

The user can request the system to trace/outline the borders of  
specified OB measurements using the OB Measure Assistant 
feature. You can auto-detect the Biparietal Diameter, Head 
Circumference, Abdominal Circumference, Femur Length and 
Humerus Length.  

To automatically trace the fetal anatomy on the display, 

1. Press Measure Assist Settings on the OB Touch Panel to 
set OB Measure Assistant parameters. 

2. Press the measurement (BPD, HC, AC, FL or HL). The 
trace is auto generated on the display. 

Table 13-73:  OB Measure Assistant Touch Panel

Touch Panel Settings Description

Default When you first activate the Measure Assistant Touch Panel, the following 
measurements are highlighted: BPD, HC, AC, and FL. This means that OB 
Measure Assistant is active for all these measurements. 

There are four (4) BPD Auto Custom Settings: 

1. BPD Highlighted BPD and HC OB Measure Assistant is generated one at a time. BPD is auto 
generated--> Edit/Set--> HC is auto generated--> Edit/Set--> Done

2. BPD + AutoSet BPD BPD and HC generated at the same time. BPD and HC are auto 
generated--> Edit/Set HC--> Edit/Set BPD--> Done.  

3. BPD + BPD Only Only the BPD is auto generated--> Edit/Set--> Done. 

4. No Highlight User must perform these measurements manually
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Overview  (continued)

3. To edit the selected measurement graphics: 

• Move the Trackball to appropriately size the edit region 
of interest 

• Edit the Calipers via Cursor Select. 

• Adjust the circumference using the Ellipse key. 

Press Set on the Trackball to complete the measurement. 

NOTE: Specify the mode to measure the BPD: Outer to Inner, or 
Outer to Outer via Utility--> Measure--> Advanced-->
Obstetrics-->  Measure Assistant BPD Method. 

If the system was not able to detect the anatomy automatically, 
measurement calipers are displayed in the center of the screen 
in an editable state and a message is displayed on the status 
bar. 
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Hepatic Assistant

Overview

Hepatic Assistant is supported on C1-6-D and C1-6VN-D (Abd 
(Abdomen), AbdPen (Abdomen Penetration) and AbdDetail 
(Abdomen Detail)) to measure SWE and UGAP simultaneously.

See ‘Shear Wave Elastography’ on page 13-111 and 
‘Ultrasound-Guided Attenuation Parameter (UGAP) Option’ on 
page 13-141 for detailed workflows.
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Activate Hepatic Assistant

1. Configure presets for Hepatic Assistant in Utility > Imaging > 
UGAP > Abdomen/Abdomen Pen/Abdomen Detail - C1-6 
(Hepatid Assistant), as needed.

• Visualization: 

UGAP/SWE (A/E)

UGAP Q/SWE (A Qual./E)

B/SWE & UGAP/UGAP A (BE -> A/Att.)

SWE Q/SWE & UGAP Q/UGAP (E Qual./E -> A/Qual.)

SWE Q/SWE & UGAP Q/UGAP (Qual./E -> Qual./Att.)

• SWE Display Side: Right or Left.

• Frames to store: UGAP frames to store for Auto 
Measurement Multi can be configured in increments of 
10 from 0 to 300 (0, 10, 20, etc.).

• UGAP ROI Display in PreMode: On or Off.

• Pause before beginning UGAP acquisistion: The 
Pause functionality can be selected On or Off on the 
Touch panel prior to entering UGAP when using 
Multi-Measurement configuration.

Figure 13-177. Presets for Hepatic Assistant

2. Assign Hepatic Assistant to any User Defined key in Utility 
-> System -> User Configurable key. Press Save.

3. Select C16-D/C1-6-VN-D probe and Abd, AbdPen or 
AbdDetail for application. 
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Activate Hepatic Assistant  (continued)

4. Press assigned User Defined key. Pre Mode is displayed.

Figure 13-178. Pre Mode

5. Move SWE ROI to desired position, if needed.

6. Press Start to begin SWE and UGAP live data acquisition.

The UGAP measurement is activated when the SWE 
measurement is completed.

• The LOGIQ Totus acquires one SWE frame data and 
one UGAP frame data for Auto Measurement Single.

• The LOGIQ Totus acquires SWE frames data until the 
user presses Freeze, and the specified number of 
UGAP data frames for Auto Measurement Multi.

• The LOGIQ Totus acquires SWE data frames until the 
user presses Freeze, and UGAP data frames until the 
user presses Store (when Auto Measurement is set to 
Off).

7. Press assigned User Defined Key to exit Hepatic Assistant.
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Visualization

The below Visualizations are selectable in Utility.

• Dual view of UGAP and SWE

Figure 13-179. Example - UGAP/SWE (A/E)

• Dual view of UGAP Quality Map and SWE

Figure 13-180. Example - UGAP Q/SWE (A Qual./E)
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Visualization  (continued)

• Dual view of B-Mode and SWE to UGAP and UGAP 
Attenuation Map

Figure 13-181. Example - B/SWE & UGAP/UGAP A (B/E ¨ A/
Att.)
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Visualization  (continued)

• Dual view of SWE Quality Map and SWE and dual view of 
UGAP Quality Map and UGAP 

Figure 13-182. Example - SWE Q/SWE & UGAP Q/UGAP (E 
Qual./E ¨ A/Qual.)
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Visualization  (continued)

Dual view of SWE Quality Map and SWE to UGAP Quality 
Map and UGAP Attenuation Map

Figure 13-183. Example - SWE Q/SWE & UGAP Q/UGAP  
(Qual./E -> Qual./Att.)
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Vscan AirTM CL (Option)

Overview

LOGIQ supports Vscan AirTM‚ - The Vscan Air is a 
battery-operated, wireless, general-purpose diagnostic 
handheld ultrasound imaging system which consists of a 
dual-headed probe. More information about the Vscan Air CL, 
care and handling, can be found in the Vscan AirTM, User 
Manual on the GE HealthCare Customer Documentation Portal 
website at: http://gehealthcare.com/usermanual 

The Vscan Air CL acquires and forms the ultrasound image, 
sends the image data in real time through Wi-Fi to the 
ultrasound system, and the console displays the image. LOGIQ 
console provides the needed software to use the console as the 
display and the UI control unit.

 Figure 13-184. Vscan Air and Ultrasound System as Display and User Interface

The Vscan Air CL probe supports B mode and Color flow mode. 
Currently, PW and M mode are not supported on LOGIQ 
systems
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Table 13-74:  Clinical Applications - Additional Capabilities and Features

Clinical Applications
Additional Capabilities and 

Features

Curved probe • Abdomen (incl.Pleural)
• OB/GYN
• Pediatric
• Peripheral Vascular
• Musculoskeletal

Overwrite and create application 
presets
Retain FOV
Easy3D
LOGIQ View
LOGIQ Apps
ATO (B Mode)
Auto Doppler (Colorflow Mode - 
Linear)
Rawdata (B & CF)
Scan Assistant
Compare Assistant
Measurement Package (by 
application)
Annotation package (by application)
Body Pattern (by application)
Imaging controls on Utility page
Imaging display (dual/quad, B|CF 
simultaneous)
Print / Recall / change order

Patient page/Exam Category

Linear probe • Abdomen (incl.Pleural)
• OB/GYN
• Small Parts
• Pediatric
• Peripheral Vascular
• Musculoskeletal
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Prepare the Vscan Air CL Probe for Use

NOTE: Ensure only one Vscan Air CL is around the console. The 
ultrasound system will try to pair with the VScan Air CL with 
strongest signal.

NOTE: To guarantee the maximum performance with Vscan Air CL on 
the ultrasound system, check the environment and avoid other 
Wi-Fi devices.

NOTE: Make sure the ultrasound system is connected to an access 
point (if needed) BEFORE pairing with Vscan Air CL. 
Connecting to an access point after pairing with Vscan Air CL 
will result in significant performance degradation.

NOTE: Connect to the network infrastructure through an ethernet 
connection, if possible, to avoid any possible Wi-Fi interference.

NOTE: The VScan Air CL must be activated from a mobile (Android, 
iOS) device first through the Vscan Air app. The ultrasound 
system does not provide a workflow for activating a new VScan 
Air CL.

CAUTION
The ultrasound system with Vscan Air CL is not intended for 
ophthalmic use or any use causing the acoustic beam to pass 
through the eye.

CAUTION
Only use GE HealthCare provided chargers or a Qi compliant 
charger with the Vscan Air CL probe. Failure to use a compliant 
charger may result in the probe not charging, or possible 
damage to the probe.

CAUTION
Scanning stops within 10 seconds if the Wi-Fi link to the Vscan 
Air CL probe is lost. Ensure the Wi-Fi connection is sufficient to 
avoid loss of image and delay of care.

CAUTION
The probe will not begin a scan if the Vscan Air CL probe 
battery is critically low. Ensure probe is sufficiently charged 
before beginning scan to avoid delay of care.

CAUTION
Scanning stops within 10 seconds when the Vscan Air CL 
probe battery becomes critically low. Ensure probe is 
sufficiently charged before beginning scan to avoid delay of 
care.
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Vscan Air CL Probe Charger

FCC Statement

This device complies with Part 15 of the FCC Rules. Operation 
is subject to the following two conditions: (1) This device may 
not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause 
undesired operation.

NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential 
installation.

This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: (1) Reorient or 
relocate the receiving antenna. (2) Increase the separation 
between the equipment and receiver. (3) Connect the equipment 
into an outlet on a circuit different from that to which the receiver 
is connected. (4) Consult the dealer or an experienced radio / 
TV technician for help.

CAUTION
The Vscan Air CL probe charger must ONLY be used to charge 
the Vscan Air CL probe. DO NOT charge a mobile phone or 
any other device with the Vscan Air CL probe charger. Failure 
to follow these instructions may damage the charger or other 
device.

WARNING Changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to 
operate the equipment.
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Radiation Exposure Statement

This equipment complies with FCC radiation exposure limits set 
forth for an uncontrolled environment. This equipment should be 
installed and operated with minimum distance of 20cm between 
the radiator and your body.

IC Statement

This device complies with RSS-216 of Industry Canada. 
Operation is subject to the condition that this device does not 
cause harmful interference.

This device contains license-exempt transmitter(s)/receiver(s) 
that comply with Innovation, Science and Economic 
Development Canada’s license-exempt RSS(s). Operation is 
subject to the following two conditions:

(1) This device may not cause interference.

(2) Any changes or modifications not expressly approved by the 
party responsible for compliance could void the user's authority 
to operate the equipment.

RF exposure statement: The equipment complies with IC 
Radiation exposure limit set forth for uncontrolled environment. 
This equipment should be installed and operated with minimum 
distance 20cm between the radiator and your body.
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Install the Vscan Air CL Probe Charger

1. Install the probe holder onto the probe charger by sliding 
down until it latches into place.

 Figure 13-185. Install Probe Holder on Charger

2. Select the probe holder location on the system to install the 
charger assembly and insert the probe charger post through 
the holder location.

3. Thread the nut onto the bottom end of the charger mounting 
post and tighten the nut by hand until the charger is secured 
firmly to the system.

4. Connect the USB charging cable to a USB port under the 
control panel.

 Figure 13-186. LOGIQ Totus USB Ports with Vscan Air CL Probe charger Installed

5. Place the Vscan Air CL probe into the charger to begin 
charging.
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Charge the Vscan Air CL Probe

To charge the Vscan Air CL probe, place the probe inside of the 
plastic probe holder on the probe charger. 

Table 13-75:  Vscan Air CL Battery Charger LED Charging Status Indicator

LED Color Charging Status

Blue Charger initially plugged in - no probe on charger.

Blinking Green Probe battery charging.

Blinking Green and Static Blue Probe battery fully charged - probe on charger.

Blue No probe on charger.

Orange Charging failure. Probe battery not full, charging paused.
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Pair Vscan Air CL to the Ultrasound System

To pair the Vscan Air CL to the ultrasound system:

1. Turn the ultrasound system on.

2. Press and hold the Vscan Air CL power button for 
approximately two seconds, while watching the probe LED 
lights.

NOTE: Do not continuously hold the button for longer than 
5 seconds, or the probe will shut down after booting up. 

The LED lights will first briefly display the battery level 
(green, yellow, or orange), then the display power up (two 
blue lights). Release the Vscan Air CL power button when 
you see the power up light.

3. Touch the first probe connector (Vscan Air CL shares the 
probe port menu with the CW-only probe) to start the pairing 
process.

4. The LED lights will enter the booting up state (two white 
lights blinking alternately), followed by the searching state 
(two white lights blinking synchronously). Tap the power 
button to allow connection during searching state.
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Pair Vscan Air CL to the Ultrasound System  (continued)

5. Pairing will take 5-30 seconds to complete. When pairing is 
complete, the two LED lights will shine steady blue, 
indicating the connection is established. At the same time, 
the Vscan Air CL probe icon will appear on the ultrasound 
system Touch Panel

 Figure 13-187. Vscan Air Cl Touch Panel Icon

 Figure 13-188. Vscan Air CL Battery and Wi-Fi Icons

1. Battery Level
2. Wi-Fi Signal Strength
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Vscan Air CL Battery Indicator

Wireless Connection Quality Indicator

A wireless probe has a limited inherent risk of a disrupted 
connection due to various factorsn that could lead to loss of real 
time imaging. The ‘Wireless Connection Quality Indicator’ 
provides a visual indication of the connection quality between 
the probe and the ultrasound system during scanning. An 
unstable connection may result in loss of image quality or slow 
image update during real time imaging.

 Figure 13-189. Wi-Fi Connection Quality Indicator Icons - Left: Compromised, Right: 
Good

Table 13-76:  Vscan Air CL Battery Indicator

Icon Description

Battery charged 90-100%

Battery charged 60-80%

Battery charged 40-60%

Battery charged 20-40%

Battery charged <20 - prepare to recharge the a batter.



Advanced Features

13-388 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Vscan Air CL Temperature Indicator and Thermal Management

When the Vscan Air CL operating temperature is increased, the 
thermal management system inside the probe may 
automatically decrease frame rates and/or reduce image width, 
to keep the probe temperature within optimal functional levels to 
support continuous scans up to 50 minutes. There are five 
thermal management levels (0-4). Level 0 is the initial state 
when starting with a cool probe, and at Level 4 the probe 
temperature reaches the maximal allowed level. At Level 4 a 
user notification will appear on screen and the probe will 
automatically shut down.

The ‘Probe temperature indicator’ tracks and displays changes 
in the operating temperature of the probe during scanning. 
Factors affecting probe temperature are:

• Transducer: The curved array transducer gets warm more 
quickly than linear array due to higher power consumption.

• Preset: Certain presets like Abdominal and Cardiac have 
higher power requirements, depending on the image 
settings, causing the probe to warm up faster than other 
presets.

• Mode: Operating in Color Flow mode warms up the probe 
faster than Black and white mode.

• Length of scan: The duration of continuous scanning.

• Ambient temperature: Higher ambient temperatures can 
cause the probe to warm faster.

NOTE: The probe temperature and related user notifications are 
independent of the probe battery status.

 Figure 13-190. Thermal Status Icons - Level 0 to 4
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Scanning

To begin scanning with the Vscan Air CL:

1. Select the Vscan Air CL probe icon on the Touch panel.

 Figure 13-191. Vscan Air CL Touch Panel Icon

2. Select the Curved or Linear tab on the Touch Panel.

 Figure 13-192. Vscan Air CL Curved and Linear Applications

 Figure 13-193. Vscan Air CL Curved and Linear Applications

3. Select a preset on the Touch Panel. The Vscan Air CL probe 
begins scanning and the system displays the images.

 Figure 13-194. Vscan Air CL Image Display on Ultrasound System

HINTS The power button on the Vscan Air CL probe can be configured 
as a Freeze/Unfreeze button during scanning.
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Preparing for a Guided Procedure with Vscan Air CL

A wireless probe has a limited inherent risk of a disrupted 
connection due to various factors that could lead to loss of real 
time imaging.

WARNING If a temporary, unexpected disruption to real time imaging is 
determined to have a severely negative adverse effect on the 
patient’s health, outweighing the benefits of using an 
ergonomic wireless probe at the point of care, it is 
recommended to consider using a wired ultrasound device for 
the specific procedure guidance.

CAUTION
When performing a guided procedure or a freehand biopsy 
(without a biopsy guide), it is the user’s responsibility to use the 
appropriate equipment. Ensure that the needle (especially the 
needle tip) is always visible in the ultrasound image during the 
entire procedure.

CAUTION
Always use only B-Mode when performing guided procedures 
or a freehand biopsy.
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Prepare Vscan Air CL probe and check Wi-Fi connection prior to a procedure

Prior to setting up for a guided procedure, it is recommended to 
prepare the Vscan Air CL probe to be in optimal condition, and if 
assess if a stable Wi-Fi connection can be maintained during the 
procedure. Follow the below steps for the assessment.

Use a Cool Probe

Ensure the probe is sufficiently cooled down after any previous 
scanning. Disruption or reduced scan quality may occur due to 
the probe overheating if a lengthy procedure is anticipated. 
Leaving the probe on a desk (outside the pocket or the case) 
after it is powered off will cool it down faster. It should take 
approximately 30-60 minutes to get to a reasonably cool state, 
depending upon how warm it was from the previous scan, and 
the ambient temperature. If accelerated cooling of the probe is 
required, place the probe, while turned off, in front of a fan, run 
under cold water, or apply a cooling pack.

Ensure the Probe is Sufficiently Charged

Ensure the probe battery is sufficiently charged before 
beginning a procedure. Battery levels of 50% and above are 
recommended before starting. The battery level of the probe can 
be checked on the top left of the imaging screen after 
connecting with the system. A green battery icon indicates 
sufficient battery level.

 Figure 13-195. Battery Icon - Fully Charged
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Check Wi-Fi Environment

Whenever possible, check the Wi-Fi connection between the 
probe and ultrasound system in the environment where the 
procedure is expected to be performed. This will help detect any 
unexpected challenges before the actual procedure.

Select Small Parts from the Linear presets menu (Small Parts is 
the most Wi-Fi-challenging preset due to its high image data 
rate) and turn up the B-Mode gain. Ensure that the connection 
quality indicator is steadily green on the imaging screen. 
Observe the noise pattern, and the random movement of noisy 
pixels should not appear to pause occasionally.

 Figure 13-196. Wi-Fi Icon

The probe temperature indicator is also visible on the right upper 
corner of the image screen. A gray colored thermometer icon 
confirms a cool probe.

 Figure 13-197. Probe Temperature Indicator
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Disconnect the Vscan Air CL Probe

To disconnect the Vscan Air CL probe from the ultrasound 
system, simply turn off the probe by pressing and holding the 
power button until the LED lights appear purple, which indicates 
the probe is powering down.

You can also shut down the Vscan Air CL probe by selecting the 
Vscan Air power button on the Touch Panel, or by selecting the 
battery icon on the title bar and selecting Yes in the Vscan Air 
Battery Icon dialog box.

 Figure 13-198. Vscan Air Power Button

 Figure 13-199. Vscan Air Battery Icon Dialog Box
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Supported Features

Most features on the ultrasound system (measurement, 
annotation, image tag, etc.) are supported on the Vscan Air CL 
probe.

Table 13-77:  Features Available on the Vscan Air

Feature Name

Scan Mode: B Mode

Scan Mode: CF Mode

Overwrite and create application presets

Retain FOV

Easy3D

LOGIQ View

LOGIQ Apps

ATO (B Mode)

Auto Doppler (Colorflow Mode - Linear)

Rawdata (B & CF)

Scan Assistant

Compare Assistant

Measurement Package (by application)

Annotation package (by application)

Body Pattern (by application)

Imaging controls on Utility page

Imaging display (dual/quad, B|CF simultaneous)

Print / Recall / change order

Patient page/Exam Category
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Charger Cleaning and Disinfection

For approved charger cleaners and disinfectants, refer to 
"Cleaning and Disinfecting the System" in Chapter 12 "User 
Maintenance" of this manual.

To clean and disinfect the Vscan Air probe holder and charger:

1.  Remove the Vscan Air probe from the charger probe holder 
and place in a safe location.

2. Remove the clear probe holder from the charger.

 Figure 13-200. Remove Vscan Air Probe Holder

3. Clean the probe holder and the charger with an approved 
cleaning agent.

4. Disinfect the probe holder and the charger with an approved 
disinfectant; allow to dry for the manufacturer's 
recommended contact time.

5. Reassemble the probe holder on the charger.

CAUTION
Avoid using ALCOHOL (ISOPROPANOL) 70% on the Vscan 
Air probe holder and charger. ALCOHOL (ISOPROPANOL) 
70% may compromise the durability of the probe holder and 
charger.

CAUTION
To prevent cross-contamination, clean and disinfect the Vscan 
Air probe holder and charger after every exam.
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Regulatory Requirements

The Vscan Air CL probe complies with regulatory requirements 
of the European Directive 93/42/EEC concerning medical 
devices.

NOTE: Regulatory information regarding the Vscan Air can be found 
from Utility > Admin > Vscan Air.

NOTE: All applications may not be supported with the different 
variations of the Vscan Air (e.g. Vscan Air SL - Sector/Linear). 
Check which VScan Air products are supported from Utility > 
Admin > Vscan Air.

Vscan Air On Console Charger Rating Plate

 Figure 13-201. Vscan Air CL Charger Rating Plates

CAUTION
The Qi compliant wireless charger supplied as an accessory 
with the product is verified for use with the Vscan Air CL probe. 
The wireless charger is considered to be information 
technology equipment that does not affect the basic safety or 
essential performance of the Vscan Air CL product. The 
wireless charger is compliant to the IEC/EN 62368-1 standard, 
which applies to audio/video, information and communication 
technology equipment.

CAUTION
To prevent cross-contamination, clean and disinfect the Vscan 
Air probe holder and charger after every exam.
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Acoustic Output Reporting Tables for Track 3/EN/IEC 60601-2-37

The ultrasound system does not control any acoustic output for 
the Vscan Air CL. For acoustic output reporting tables for the 
Vscan Air CL, refer to the manual provided by the manufacturer 
of the Vscan Air CL probe or on http://gehealthcare.com/
usermanual.

NOTE: These acoustic output reporting tables are produced according 
to IEC 62359 Ed.2.

NOTE: The Acoustic Output tables are in English only.
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EZ Imaging

Overview

EZ Imaging provides an efficient workflow to complete exams 
with minimal operator button input. EZ Touch Panel allows the 
operator quick access to change model, flow modes and 
Doppler modes without searching through multiple pages or 
many different parameters.

Quick Patient Change allows you to start a new exam without 
entering the patient page.

Activate EZ Touch Panel

1. Check EZ Touch Panel Page in Utility > System > System 
Imaging > EZ Settings. 

2. Select “By Probe” (Default) or “By Category” for MyPreset 
Shortcuts.

Figure 13-202. EZ Settings
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Activate EZ Touch Panel  (continued)

3. EZ Touch Panel appears on the first page of B, flow and 
Doppler mode tabs.

Figure 13-203. B-Mode - EZ Touch Panel (Example)

1. MyPreset Shortcuts
• Change model quickly on the Touch Panel.

2. Image Shortcut
• Change imaging frequency (Res > Gen > Pen). (Frequencies are not 

editable.)
3. Essential Control: Virtual Convex (or Max Angle), Advanced SRI
4. MyPreset Shortcut: Last used or current model displays in the 4th 

position.
5. Essential Control (Configurable) - Configurable essential controls display 

in the 3rd and 4th positions. A desired control can be assigned in the 3rd 
and 4th positions.
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Activate EZ Touch Panel  (continued)

Figure 13-204. CF/PDI/MVI/TVI - EZ Touch Panel (Example)

1. Flow mode buttons
• Change Flow Technology quickly on the Touch Panel.

2. Flow Shortcut
• CF/PDI: Displays available existing shortcuts.
• MVI/TVI: No shortcut.

3. Essential Control
CF/PDI/MVI: Virtual Convex, Invert, Simultaneous
TVI: Map Compress and Map

4. Essential Control (Configurable) : Configurable essential controls display 
in the 4th and 5th position. A desired control can be assigned in the 4th 
and 5th position.
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Activate EZ Touch Panel  (continued)

Figure 13-205. B-Flow - EZ Touch Panel (Example)

1. Flow mode buttons - Change Flow Technology quickly on the Touch 

Panel.
2. Flow Shortcut - Displays flow shortcut to change Sensitivity/PRI
3. Essential Control - Virtual Convex, Advanced SR
4. Essential Control (Configurable) - Configurable essential controls display 

in the in the 4th and 5th position. A desired control can be assigned in 
the 4th and 5th position.



Advanced Features

13-402 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Activate EZ Touch Panel  (continued)

Figure 13-206. Doppler Mode - EZ Touch Panel (Example)

1. Doppler mode buttons - Change Doppler Technology quickly on the 
Touch Panel (if both PW and CW are supported).

2. Essential Control (Non-Configurable)
• Invert, Sweep Speed, SV Length (for PW)
• Wall Filter, Sweep Speed, Colorize (for CW)

3. Essential Control (Configurable) - Configurable essential control displays 
in the 4th position. You can assign a desired control in the 4th position.
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Activate EZ Touch Panel  (continued)

4. Switch to conventional Touch Panel by selecting to turn the 
Touch Panel page.

 Figure 13-207. Switch between EZ Touch Panel and Conventional Touch Panel
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MyPreset Shortcuts “By Probe”

 Figure 13-208. By Probe

• TOP 3 models on My Preset for the probe is displayed on the Touch Panel. 
•  * (Asterisk) indicates the preset appears on the MyPreset Shortcut.
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MyPreset Shortcuts “By Category”

 Figure 13-209. By Category

• TOP 3 models in same exam category on My Preset for the probe is displayed on the Touch Panel. 
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Quick Patient Change

1. Complete current patient exam.

2. Press the BT key assigned to Quick Patient Change.

3. All Patient data is stored for the current patient and the 
Patient ID for the next patient is generated automatically.

NOTE: If you turn off Auto Patient Archive, a Confirmation Dialog 
for Data Archive appears. Select Store All, Delete All, or 
Cancel.  

Figure 13-210. Confirmation Dialog for Data Archive

4. An information dialog displays to inform the user that the 
patient has been created.

Figure 13-211. Information Dialog

5. Start the exam for the new patient. The B-Mode screen 
displays with the default preset for the connected probe. 
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Anonymize the  patient

Overview

The LOGIQ Totus offers an option to extract all measurements 
and DICOM tags from a selected patient in the Patient List when 
that patient is not active. This option makes the exam(s) 
anonymous and attaches this information to a newly created 
Anonymous Patient.

The LOGIQ Totus warns the user on possible data loss, data 
mismatch and data that cannot be copied anonymously, 
including:

• Image data may have patient information burned into the 
pixel data.  This information wil not match the updated 
patient data in the DICOM tags.

• Patient identification on image pixel data which the user 
annotated. This information cannot be removed.

• Links to Reports will be lost.

• Non-ultrasound exams will not be anonymous.
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Anonymize the patient

1. Ensure that you are logged in as an Administrator on the 
system. 

2. Select the Local Archive dataflow. 

3. Select the patient from the Patient View list and left click to 
bring up the “Anonymize” pop-up menu.

4. A confirmation dialog displays. Select OK.

5. The “Anonymize Patient” dialog displays. All the fields 
inherit the values from the original patient’s exam, except for 
Patient ID.

Fill in the Patient information fields. 

Press OK to continue.

NOTE: If the newly entered Patient ID is not unique in the database, 
the Patient ID turns to red and an error message displays on 
the status bar.

• Empty Other DICOM Tags: Check to clear all DICOM 
Tags.

• Manage DICOM Tags: Manage DICOM tags dialog 
displays. Select DICOM tags individually.

 Figure 13-212. Manage DICOM Tags
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Report Writer

Introduction

The LOGIQ Totus enables the generation of patient reports 
based on the examination performed and the analyses that were 
made during the exam. The reports are generated using the 
data stored in the system with pre-selected templates.

You may edit a report while performing the exam; customize, 
delete, or add measurements; and save changes until you use 
the Store command. Once Stored, the reports are read-only.

It is recommended that the data be saved often, and then 
carefully reviewed before the report is Stored. Use the 
worksheet to facilitate the review and adjust data before storing 
a report. The final report can be printed on a standard printer.
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Creating a report

Reports summarize the data obtained in the examination. They 
can contain data, images, and cine loops.

Once generated, the report can be viewed, images can be 
added, and the patient’s personal data can be modified. The 
examination data itself CANNOT be changed.

Figure 13-213. Report Example

Name : GE Test     Patient ID : 123-4567            Date : 07/09/2004

Comments

Test exam
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Activating the Report

1. Select Reports on the Touch Panel. 

2. The system displays the default report for the current 
application on the monitor. 

The information entered during the examination is 
automatically filled in the appropriate fields (e.g. 
demographic, diagnosis, comments).

The preview image appears when the cursor is over the 
clipboard image.

NOTE: The template is the skeleton of your report. It is composed 
of different objects that can be customized by the user.

3. Adjust the Page Change control to move down the page.

 Figure 13-214. Report Page Example
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Activating the Report  (continued)

Table 13-78:  Report Button Controls

Button Description

Print Prints out the report to the default printer.

Store Stores the report page into Archive as CHM* file.

Retrieve Retrieves the report page from Archive.
Stored Date/Time is appended to the name of stored report.

Template Selects template from the list of selected applications. 

Designer Accesses template editor screen.

Save As Exports the report page to storage media as CHM or PDF format. 

Delete Deletes the report page from Archive.

Worksheet Accesses Worksheet Page.

Graph Accesses OB Graph page (applies only to OB).

Anatomical Page Accesses Anatomical Survey page (applies only to OB).

*CHM is a compressed HTML help file.
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Selecting another template

You can select another template for the current patient:

1. Select TEMPLATE at the bottom of the monitor display or 
the Touch Panel.

2. A list of available templates and exam categories 
(Abdomen, Adult, Carotid, etc.) displays.

3. Select the desired template using the Trackball/Trackball
and press Set.

The selected template displays on the monitor.

NOTE: If you select another exam category, the template list of the 
selected category displays. Select the desired template.

Figure 13-215. Available Template list

4. Select the desired template name and press Set.

5. The report changes to the selected template.
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Factory Templates

The system has factory templates for each application. You can 
modify these templates or create user-defined templates. You 
need to save revised/new templates with unique names. 

A template may include one or more of the following:

• Measurements

• Worksheet or Vessel Summary Images

• Anatomical Surveys or Biophysical Profiles

• Anatomical Graphics

• Graphs

• Images areas

• Score Boxes

NOTE: Additional factory templates can be added from the 
Utility-->Report menu (OB for multiple gestation, Renal, etc.). 
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Editing a Report

Entering the hospital address

When using a factory template, the area for the hospital 
information is usually placed in the upper portion of the report.

To make a new area, see ‘Fixed Text’ on page 13-453 for more 
information.

To modify the factory template:

1. Select Reports.

2. Select Designer.

3. Double-click on the area for the hospital information in the 
template. The Fixed Text dialogue box displays.

Figure 13-216. Fixed Text Dialogue Box

4. Make changes as necessary.

a. Enter the hospital address in the text area.

b. Modify Box Properties (box width, box border line width, 
text align, box height, box left margin, and font).

5. Select OK.
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Entering the hospital address  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
appends “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and appends “[user]”. 
For example, NewReport[user].

7. Exit the Report Designer. The report with the hospital 
address displays.
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Inserting the hospital logo

When using a factory template, the area for the logo is usually 
placed in the upper left portion of the report.

To make a new area, see ‘Fixed Text’ on page 13-453 for more 
information.

To modify the factory template:

1. Save the preferred hospital logo in either a jpeg or bmp 
format on USB.

NOTE: Label the logo with a unique name (e.g. 
HospitalNameLogo.bmp).

2. Insert the USB into the USB drive.

3. Select Reports.

4. Select Designer.

5. Double-click the GE HealthCare Logo so that the frame is 
highlighted. The logo box displays.

Figure 13-217. Logo Box
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Inserting the hospital logo  (continued)

6. Select Import Logo (1). Select the USB drive first and then 
the  hospital logo.

7. Select OK. The hospital logo displays in the logo list (2). 
Click the logo to select.

NOTE: Scroll the logo list using the left/right arrow key (3).

8. Modify Appearance (4).

9. Select OK.

10. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

11. Exit the Report Designer. The template with the hospital 
logo displays.

NOTE: If a different logo prints on the report, rename the logo image 
which you want on the report and insert it into the report 
template again.
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Changing the Archive Information

When using a factory template, the Archive Information is 
usually placed below the hospital name and logo. 

The contents of the Archive Information is inserted through the 
related page automatically. If you want to change the 
description, such as Information or Comments that was entered 
in the patient menu:

1. Select the yellow text to be changed, e.g. Information or 
Comments.

The area where the description was entered (e.g. Patient 
menu) displays.

2. Change the existing data as necessary.

3. Select Report to return to the report.

Figure 13-218. Patient Information Area (Example)
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Modifying the displayed objects of Archive Information

1. Select Designer.

2. Double click on the area for the Archive Information in the 
template. The Archive Information Box displays.

Figure 13-219. Archive Information Box

3. Click the checkboxes to select and deselect the objects. 

Objects with checkmarks will appear in the report template.

4. Select Box Properties to change the font, font size, font 
color, or box size, and select OK.

5. Select OK to return to the Report Designer.
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Modifying the displayed objects of Archive Information  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

7. Select File -> Exit to leave the Report Designer.

Entering free text

You can enter free text to the report using the alphanumeric 
keyboard.

The factory template terms their text area as “Summary or 
Comments”. 

1. Move the cursor to the text field and press Set.

NOTE: You can enter the text only to the field set as free text in the 
Report Designer.

NOTE: DO NOT enter “%s” in a free text field and then try to edit/
save the template in the Report Designer. 

2. Type the text.
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Inserting Text

1. Select Designer.

2. Move the cursor where the text is to be inserted and press 
Set.

3. Select the Text Field from the Insert menu. The Text Field 
dialog box displays.

Figure 13-220. Text Field Dialogue Box

4. Select the appropriate display items:

• Ref. Reasons: Retrieves this information from the Direct 
Report

• Comments: Retrieves this information from the 
Comment field of the patient screen and the Exam 
Comment field of the worksheet.

• Diagnosis: Retrieves this information from the Direct 
Report

• Free Text 1 - 8
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Inserting Text  (continued)

5. Type the heading Text.

6. Modify box properties, the heading text and font, and data.

7. Select OK or Cancel. 

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

Inserting an image to the report

Some factory templates include an image area. If you want to 
insert or modify the image area, see ‘Image Display Fields’ on 
page 13-445 for more information.

To insert images from clipboard into the image field of the report:

1. Move the cursor to the desired image on the clipboard.

NOTE: The preview image appears when the cursor is over a 
clipboard image.

2. Press and hold down the Set key and drag the selected 
image to the report by using the Trackball or double click 
the Set key on the desired image. 

3. To move images between image areas, press and hold 
down the Set key and using the Trackball, drag the 
selected image to the new location.

To remove an image from the report, press and hold down 
the Set key and using the Trackball, drag the select image 
back to the clipboard.
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Measurement result section

Measurement results for the current patient display 
automatically if you have the measurement section in the report 
template.

The factory template has an appropriate measurement result 
area. If you want to insert or modify the measurement area, see 
‘Measurements’ on page 13-451 for more information.

 Figure 13-221. Measurement section
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Inserting the worksheet

You can insert the worksheet (like you can insert an image) to 
the image display field.  To set an image display field in the 
report template, see ‘Image Display Fields’ on page 13-445 for 
more information.

1. Display the worksheet on the monitor display.

2. Save the worksheet using the Print key.

3. Press Report.

4. Drag the worksheet into the report.

a. Move the cursor to the desired worksheet on the 
clipboard.

b. Press and hold down the Set key. Use the Trackball to 
drag the selected worksheet into the Image Display 
Field.

c. Release Set.

NOTE: You can also move the cursor to the desired worksheet on 
the clipboard, double-click the worksheet, move the cursor 
to the Image Display Field, and select Set.

5. The worksheet displays on the report.

NOTE: You can double-click the worksheet in the report to change 
the background color to white to save ink during printing. 
Double-click the worksheet again to return the worksheet to 
the original color.
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Placing objects side-by-side

If you want to place images, the image and comment, 
anatomical graphic and comment, etc. side-by-side, you must 
first place a table, which has two (or more) columns, into the 
report template.

1. Select Report.

2. Select Designer to display the Report Designer.

3. Place the cursor where you want to insert the object.

4. Select Table from the Insert menu. Insert Table box 
displays.

Figure 13-222. Insert Table Box

5. Set the number of columns to 2 (or more, as required) and 
change the table parameters, if needed. Select OK.

NOTE: If you do not need a table border, set the Border to 0. Add 
additional rows if required.

6. Place the cursor in the column and select the desired items 
from the Insert menu (e.g. logo, image, free text). Specify 
those items.

7. Repeat step 6 for each column as required.

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 
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Placing objects side-by-side  (continued)

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

You can insert the images in the order preferred, by row or 
column, on the factory templates. See ‘Inserting the Table’ on 
page 13-437 for more information.
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Accessing Worksheet, OB Graph and Anatomical Survey Pages

If the Worksheet, OB Graph, and/or Anatomical Survey pages 
have been saved for the current patient, you can access these 
pages from the report page.

NOTE: OB Graph and Anatomical Survey pages applies to OB, GYN 
and Abdomen.

1. Select either Worksheet, Graph or Anatomical Page on 
the Touch Panel.

NOTE: There is also Fixed Text set up as hyperlinks for these 
pages. Cursor to the fixed text and press Set.

2. The system displays the appropriate page (Worksheet, OB 
Graph or Anatomical Survey) with the corresponding Touch 
Panel.

3. Select Report to return to the Report page.

Storing the Report

1. Select Store.

The Report is saved as a CHM file to Archive. 

NOTE: The archived report cannot be edited; therefore, it is 
recommended that the data is carefully reviewed before the 
report is saved.

Retrieving an Archived Report 

1. Select Retrieve. The Retrieve menu displays.

Figure 13-223. Retrieve Menu (Prefix “User1\” may not 
appear)

2. Select the desired report and press Set.

NOTE: The retrieved report cannot be edited.
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Deleting a Report from Archive

1. Select Delete. The Retrieve menu appears on the screen.

Figure 13-224. Delete Reports Menu (Prefix “User1\” may not 
appear)

2. Select the report to delete and press Set.

Printing the Report

To preview the Print Layout before printing, see ‘Preview the 
Print Layout’ on page 13-435 for more information.

NOTE: Double-click the worksheet and/or image in the report to change 
the background color to white A white background will save ink 
during printing. Double-click the worksheet or image again to 
return to the original color.

1. Select Print to print out the report.

The Report is printed on the default printer.
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Exporting the Report to Media

1. Select More.

2. Select Save As.

The Save As dialog box appears on the screen.

3. Enter the Report title and select the file format.

4. Select the media to export the Report. The system supplies 
a name (numeric DICOM UID, unique identifier).  

Figure 13-225. Save as Dialog Box

5. Select Save.

Exiting the report

1. Select Store to save the report.

NOTE: If the user is working on a report and leaves the report 
screen for any reason, all information added to the report is 
automatically saved without loss of data.

2. Select another key to close the report page.
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Designing Your Own Template

Template Designer

You can design and create your own customized template from 
a blank template page, or you can use an existing template 
(factory or user-defined) and save the changes.

Display the desired template and select Designer to open the 
Template Designer page.

 Figure 13-226. Report Designer
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File Menu

Create a new  template

To design a new template without using a pre-existing factory 
template:

1. Select Designer to open the Report Designer.

2. Select New from the File menu, and press Set.

The blank template displays.

3. Create the report template as needed.

4. Select Save from the File menu, and press Set.

The Save Template As dialogue box displays.

5. Enter a template name and click OK.

6. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

Table 13-79:  File Menu

Description

New Creates a new template. A blank template appears. 

Save Overwrites the existing template.

Save As Saves as a new name.

Page Setup Enters Print Layout screen.

Print Preview Executes print preview.

Exit Exits Report Designer page.
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Create a new template and save as a factory template name 

To design a new template by modifying an existing factory 
template and keeping the same name of the factory template:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. To save changes, select Save from the File menu, and 
press Set.

The Save Template dialog box displays.

• Yes: Saves changes.

• No: Does not save changes.

• Cancel: Returns to Report Designer.

NOTE: The template name displays in the template list, retains the 
same name, and adds “[user]”. For example, 
“OB23-Basic[user]”. You do not lose the original factory 
template.

5. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

HINTS Save changes frequently as you modify your template. Saving 
often reduces the risk of losing all your changes.
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Create a new template and save  with a new name

To design a new template by modifying or copying an existing 
factory template and saving it with a new name:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. Select Save as from File menu and press Set.

 The Save Template As dialog box displays.

5. Type the new template name and click OK.

6. Select Exit from the File menu and Set.

7. The Report Designer closes and returns to the Report Page.

NOTE: The template receives the new name and adds “[user]”. For 
example, NewReport[user].

Page Setup

1. Modify the factory template as necessary in Designer.

2. Select Page Setup from File menu and press Set.

3. Change the paper size or orientation to fit the print layout, as 
necessary.

To define the header and footer for the printed report, type 
text and enter the required variables listed in the table 
below. Select “Different for first page” and enter a specific 
header/footer for that page.

NOTE: Default is left aligned. Report will appear as black ink on 
white background.

Table 13-80:  Variable and Definition

Variable Definition Variable Definition

{pid} Patient ID {prt} Current time (printing time)

{pnm} Patient name {cp} Current page

{pbd} Patient date of birth {tp} Page count

{exd} Examination date {c} Subsequent text is centered

{prd} Current date (printing date) {r} Subsequent text is right aligned.

{inm} Institution name
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Page Setup  (continued)

4. Select OK or Cancel.

Figure 13-227. Page Setup with Header Example

Preview the Print Layout

1. Select Template to choose the Report Template.

2. The Print Preview screen displays.

If changes need to be made, select Close to exit the 
Preview page. Modify the template or return to the Report 
and modify the contents.

Edit Menu

Deleting a template object

1. Select the object to be deleted.

2. Select Delete from the Edit menu, and press Set. The 
object is deleted from the template.

Undoing the operation

1. Select Undo from the Edit menu, and press Set.

2. Repeat as required.

Table 13-81:  Edit Menu

Description

Delete Deletes the selected object from the report template.

Undo Restores the previous state(s) of the report template.
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Insert Menu

Inserting the Page Break

1. Place the cursor where the Page Break is to be inserted and 
press Set.

2. Select Page Break from the Insert menu and press Set. The 
page break line displays on the template.

NOTE: To edit the page break line, select the line and double click 
the Set key.

Table 13-82:  Insert Menu

Description

Page Break Inserts a Page Break.

Table Inserts a Table.

Logo Inserts a Logo Bitmap File.

Archive Info Inserts Archive Information.

Anatomical Graphics Selects anatomical graphics by category to be inserted into a field.

Anatomical Survey Selects OB, GYN or Abdomen.

Image Inserts the image display field to the template.

Wall Motion Analysis Selects Cut Planes, Bull’s Eye, or Score Table Box.

OB/GYN Selects OB Graph, Bar Graph or Anatomy.

Small Parts Selects Breast or Thyroid.

Measurements Inserts the measurement display field in the template.

Text Field Edits text field.

Fixed Text Enters any comments as Fixed Text.
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Inserting the Table

1. Place the cursor where the table is to be inserted and press 
Set.

2. Select Table from the Insert menu and press Set. The Insert 
Table dialog box displays.

Figure 13-228. Insert Table Dialog

3. Specify each parameter as required.

NOTE: To set the table border as not visible, set “Border” parameter 
to 0 (zero)

4. Select OK to insert the table or Cancel. 

NOTE: To insert/delete a row/column from the table or access table 
properties, double click the Set key in any empty area inside 
the table. A table menu appears with those options.
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Inserting Images in a Table

You can choose the order in which images are inserted into 
tables: by row (default) or by column.

Image Order by Row

The system default inserts images in the cells of the first row, 
then to the next row. 

Figure 13-229. Image Order—Row Preference 
(System Default)

1. Follow the instruction for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, insert an image box in each cell of 
the table.  

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the table.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed in the default order.
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Inserting Images in a Table  (continued)

Image Order by Column

If you prefer to have the image placement by column, images 
are inserted in each cell of the first column, then the next 
column.

Figure 13-230. Image Order—Column preference

In order to achieve the column preference, you need to create a 
table with 2 columns and 1 row. In each cell of this table, you 
need to insert another table.

1. Follow the instructions for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=1

2. After inserting the table, create a table inside each of the 
existing table’s cells.  

a. Move the cursor to the left column’s cell and press Set.

b. Select Table from the Insert menu and press Set.

c. When specifying parameters, specify:

No. of Columns=2; No. of Rows=1; Width=290 pixels.

Select OK.

d. Repeat steps a-c for the next column.

3. Insert an image box to each table cell. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the 2  tables.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed with your column preference.
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Inserting Logos

1. Place the cursor where you want to insert the logo and 
press Set.

2. Select Logo from the Insert menu and press Set. The Logo 
Box displays.

Figure 13-231. Logo Box

3. Select a logo that you want to insert (1). or import a bmp or 
jpg file from the removable media (2). Scroll the images 
using the arrow key (3). Specify the appearance (4).

4. Select OK to insert the logo or Cancel.

Changing a logo:

1. Place the cursor on the logo to be changed and press Set
twice. The Logo Box displays.

2. Select a different logo. If the desired logo is not shown, 
select Import Logo to import a different logo.

3. Specify the appearance.

4. Select OK or Cancel.
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Inserting Archive Information

Archive information contains all the objects from the different 
information menus (Patient, Exam, and Site Information). This 
box accumulates different information menu selections that can 
be grouped together and displayed in one table.

1. Place the cursor where you want to enter the archive 
information and press Set.

If you use a factory template, double click on the current 
archive information area to display the Archive Information 
Box.

2. Select Archive Info from the Insert menu and press Set.
The Archive Info Box displays.

Figure 13-232. Archive Information Box

3. Type the Heading, select a heading link from the pull-down 
menu, and select the parameters you want to display in the 
report.
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Inserting Archive Information  (continued)

4. Select Box Properties to change the Font, Alignment, 
Appearance, etc.

NOTE: To set the same font to all fields, select Set All fields.  

Figure 13-233. Table Properties

5. Select OK or Cancel. The contents of the Archive 
Information is inserted to the related page automatically.

Figure 13-234. Patient (Archive) Information Example
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Inserting Archive Information  (continued)

Editing displayed Archive Information:

1. Select Designer.

2. Move the cursor to Archive Information field to be edited.

3. Press Set twice. The Archive Information Box displays.

4. Edit the heading, the Heading Link and Information 
parameters, as necessary.

5. Select OK to save or Cancel.
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Anatomical graphics

1. Place the cursor where you want to insert the Anatomical 
Graphics and press Set.

2. Select Anatomical Graphics from the Insert menu.

3. Select the desired category and press Set. The graphic box 
displays.

Figure 13-235. Anatomical Graphics Box Example

4. Select the graphic to be inserted to the template or import a 
bmp or jpg file from the removable media. Scroll the images 
using the arrow key. 

5. Select Appearance.

6. Select OK or Cancel.
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Image Display Fields

1. Place the cursor where you want to insert the image.

2. Select  image from the Insert menu and press Set. The 
Ultrasound Image Box displays.

Figure 13-236. Ultrasound Image Box

3. Type the Heading text, modify the box properties, and 
change the heading text font, as necessary.

NOTE: For no heading, type a Space in the Heading text.

To keep the monitor image appearance, the ratio of width to 
height (W:H) should be 4:3. So, basically 640:480 for large 
images and 300:225 for two side-by-side images.

4. Select OK or Cancel.

Cardiac Studies Wall Motion Analysis

1. Place the cursor where you want to insert the wall motion 
analysis and press Set.

2. Select Wall Motion Analysis from the Insert menu.
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Cardiac Studies Wall Motion Analysis  (continued)

3. Select and set up the desired parameter.

• Bull’s Eye

Figure 13-237. Bull’s Eye Dialog Box

 Figure 13-238. Bull’s Eye Report Example
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Cardiac Studies Wall Motion Analysis  (continued)

• Cut Planes

NOTE: The Cut Planes dialog box parameters are similar to the 
Bull’s Eye Dialog Box shown previously.

 Figure 13-239. Cut Planes Report Example

• Score Table Box

Figure 13-240. Score Table Box Dialog Box
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OB/GYN (OB and GYN Only)

The OB Graph, Bar Graph and Anatomy can be entered into the 
Report.

1. Place the cursor where you want to insert the graph or 
anatomy and press Set.

2. From the Insert menu, select OB/GYN. The selection menu 
displays.

3. Select the appropriate item as necessary. A dialog box 
displays.

• OB Graph

Figure 13-241. OB Graph Dialog Box

a. Select the Measurement and Fetus Number.

b. Check Fetus Trending and Fetus Compare, if 
appropriate.

c. Modify the Layout, if necessary.

d. Select OK
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OB/GYN (OB and GYN Only)  (continued)

• Bar Graph

Figure 13-242. Bar Graph Dialog Box

a. Select the exam and fetus number.

b. Modify the Layout, if necessary.

c. Select OK.

NOTE: The Bar Graph already contains default application 
measurements.
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OB/GYN (OB and GYN Only)  (continued)

• Anatomy

Figure 13-243. Anatomy Dialog Box

a. Type the Heading.

b. Select qualifiers from the pull-down menu.

c. Select “Add all” to copy all measurements to the right 
column

d. Check the box in front of the measurement you need in 
the left column and select “Add”. The select 
measurements copy to the right column.

e. To remove measurements you do not need, check the 
boxes in front of those measurements in the right 
column, and select “Remove” or “Remove all”.

f. If you want to modify the properties, select Box 
Properties and set required parameters.
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Measurements

Insert a field to display the measurements. The measured 
parameters displayed in the measurement display field are 
configured.

1. Place the cursor where you want to insert the measurement 
and press Set.

2. Select Measurements from the Insert menu and press Set.
The Measurements Box displays.

Figure 13-244. Measurement Box

3. Type the Heading text, select the Filter Criteria and 
measurements from the tree, as necessary.

4. Select OK or Cancel.
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Text Fields

1. Place the cursor where you want to insert the text and press 
Set.

2. Select Text Field from the Insert menu and press Set. The 
Text Field dialog box displays.

Figure 13-245. Text Field Dialog Box

3. Type the Heading Text. If you do not need the heading, type 
a space.

4. Select Display item.

• Ref.Reason: Reason for Referral.

• Comments: Gets information from the Comment field of 
the Patient screen and the Exam Comment field of the 
Worksheet.

• Diagnosis.

• Free Text: 1 - 8

5. Specify the border of the Text Field and Font as necessary.

6. Select OK or Cancel. 

The text is saved automatically into the corresponding area 
selected on this dialog box.
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Text Fields  (continued)

Editing an existing text field:

1. Move the cursor to the Text Field to be edited.

2. Press Set twice. The Text Field dialog box displays.

3. Edit the heading, the settings, or font, as necessary.

4. Select OK or Cancel.

Fixed Text

1. Place the cursor where you want to insert the fixed text and 
press Set.

2. Select Text Field from the Customize menu and press Set.
The Fixed Text dialog box displays.

Figure 13-246. Fixed Text Dialog Box

3. Type the text (e.g. hospital information, report title, or table 
title) and specify the border and font.

4. Select OK or Cancel.

Editing existing Fixed Text:

1. Move the cursor to the Fixed Text to be edited.

2. Press Set twice. The Fixed Text dialog box displays.

3. Edit the text, the border or font, as necessary.

4. Select OK or Cancel.
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Customize Menu

Page Color

1. To change the page color, select Page Color from the 
Customize Menu and press Set. The Color dialog box 
displays.

Figure 13-247. Color Dialog

2. Choose the desired color or create a new color.

3. Select OK or Cancel.

Table 13-83:  Customize Menu

Description

Page Color Changes the template color.

Preference The Preference menu for Archive Information field displays.
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Setting  Preferences

To set preferences for the Archive Information:

1. Select Preferences from the Customize menu and press 
Set. The Preference Box displays. 

Figure 13-248. Preferences Box

2. Select the information to be modified and set the desired 
preferences.

3. Select OK or Cancel.

4. Save the template.
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Direct Report

Direct Report

You can use Direct Report to enter Comments, Diagnosis, and 
Referral Reasons at any time during the examination that will be 
part of the final report. The comments are reflected on the 
Report if the Report is configured for those parameters. 

1. Select Direct Rep. on the measurement Summary window. 
The Direct Report displays on the left side of the monitor 
display.

Figure 13-249. Measurement Summary Window
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Direct Report  (continued)

2. The Direct Report displays on the left side of the screen.

Figure 13-250. Direct Report

1. Select the type of information
NOTE: Comments entered under Diagnosis appear in the Clinical 
Diagnosis section of the final report. Commentes entered under Referral 
Reasons appear in the Referral Diagnosi section of the final report.   

2. Create/insert pre-defined text
3. Text field
4. List of measurements completed 

The measurement results display on the Measurement Overview field.
Double Click: inserts value only for selected line, e.g. 5.98 cm
Shift + Double Click: inserts whole line for selected line, e.g. BPD 5.98 
cm

5. Exits the Direct report
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Direct Report  (continued)

3. Select the appropriate parameter and type the free text with 
the alphanumeric keyboard or use Insert Text.

NOTE: You can configure the pre-defined text at the Utility Report 
screen.

a. Select Insert Text to display the Insert Text Window.

b. Use the Trackball to select the text to be inserted.

c. Press Set. The selected text displays on the Direct 
Report.

Figure 13-251. Full Insert Text Window

• New: Enters the new text

• Edit: Edits the existing text

• Delete: Deletes the existing text

• Close: Closes the insert text window

• More>>: Displays the Full Insert Text Window

• <<Less: Minimizes the insert text window

• Move up/Move down: Moves the text up or down

4. Move the cursor over the measurement result displayed in 
the overview window, and double click the Set key. 
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Direct Report  (continued)

5. Select Done at the bottom of Direct Report to exit.

If you configure the field of comment, diagnosis, referral 
reasons or Measurement on the Report, the text and/or 
measurement results entered in the Direct Report are 
automatically displayed on the Report.

 Figure 13-252. Direct Report and Report (Example)
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Report Presets

Utility Report Page

You can edit the report template, diagnosis code, and text on the 
Utility Report page.

Templates

Left Column: The list of all templates (Factory Default, User 
defined, etc) 

Right Column: The list of templates displayed on the template 
list.

Figure 13-253. Report Template Tab
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Templates  (continued)

• To insert the template on the template list:

a. Select the application which you want to insert into the 
template from the pull-down menu above the right 
column.

b. Select the category (categories) and/or the template(s) 
in the left column by the check the box.

c. Select the right arrow to copy the template to the right 
column.

• To remove the template from the template list but not from 
the system):

a. Select the template in the right column.

b. Use the left arrow to remove the template from the right 
column.

• To edit the template or to make a new template:

a. Enter Utility -> Report -> Template tab.

b. Select the appropriate template in the left column.

c. Select Edit Template. The Template Designer page 
displays.

d. Edit the template and save or save as with a new name.

If you use Save As with a new name, the new template 
is added to the left column. See ‘Designing Your Own 
Template’ on page 13-431 for more information.

• To delete the template:

a. Select the template to be deleted.

b. Press Delete.
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Templates  (continued)

• To export the template:

a. Insert the removable media in the drive.

b. Move the cursor to “Export Templates” and press Set.
The available user-defined templates display in the 
Export Templates window.

Figure 13-254. Export Templates

c. Select the template(s) to be exported.

NOTE: To select multiple templates, use the Ctrl or Shift keys.

d. Select the desired removable media under the Select 
Target Device field.

e. Select OK.

f. Press F3 to eject the media.

HINTS Export templates to removable media (USBs) so, at a later 
time, you can import those templates to a different system or a 
system with a different software version.   Export only works on 
templates, not data.
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Templates  (continued)

• To import the template:

a. Insert the removable media with the report template(s) 
to be imported.

b. Select Import Template. The Import Template window 
displays.

c. Select the Source Device from the pull-down menu. 
Select OK.

d. Press F3 to eject the media.

NOTE: Imported templates are stored in the User defined 
templates\General directory. 

• To move the template from the left column to the right, or 
from the right to the left:

a. Select the template to be moved.

b. Select the Right Arrow or Left Arrow button.

• To move the template up or down in the right column:

a. Select the template to be moved.

b. Press the Up Arrow or Down Arrow button.

HINTS Import templates from a different system or a system with a 
different software version.   Import only works on templates, not 
data.
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Comment Texts

You can edit the comment text on the Comment Texts tab.

 Figure 13-255. Comment Texts Tab

• New: Enters the new comment.

• Edit: Edits the existing comment.

• Delete: Deletes the existing comment.

• Move up/Move down: Moves the comment up or down.
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Backup/Restore Report Templates

Backup moves templates to removable media (USBs).

Restore moves templates, that were backed up onto media, to a 
similar system or a system with the same software version. For 
example, it allows templates to move from one LOGIQ Totus to 
another LOGIQ Totus.

To backup the report template:

1. Select Utility.

2. Select System and select the Backup/Restore tab.

3. Select the media.

4. Check User Defined configuration box of the Backup field.

5. Select Backup.

6. Select Save and eject the media.

To restore the report template:

1. Insert the media.

2. Select Utility.

3. Select System and select Backup/Restore tab.

4. Check Report Template box of the Detailed Restore of User 
Defined.

5. Select Restore.

6. After the system reboot, select Utility and Report.

7. Select the Template tab.

8. Select the appropriate template (See ‘Templates’ on 
page 13-460 for more information.)
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Configuring DICOM

Overview

If you follow these instructions, you will be able to set up a 
DICOM PACS environment suitable for a typical daily routine in 
a typical Ultrasound clinical environment: 

In these instructions, you will ensure that your LOGIQ Totus and 
DICOM PACS are connected to and communicating back and 
forth on the hospital/clinic’s network and between the devices. 
We will be setting up the most commonly used DICOM features 
typically used in a clinical setting. 

NOTE: For additional information on the DICOM parameters, detailed 
information is provided in Chapter 10, Customizing Your 
System.

NOTE: To set up the connectivity  configuration, See ‘Configuring 
Connectivity’ on page 10-61 for more information. 
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DICOM Job Spooler

To check the status of each job, open the DICOM Job Spooler 
by pressing F4 (see Figure 13-256). 

 Figure 13-256. DICOM Job Spooler Active Jobs

The DICOM Job Spooler lists Pending, Active, Completed 
(identified as “Done”) and Failed jobs, with the status listed in 
the “Status” column on the far right. Select the desired job to see 
the job details in the Details Pane on the right side of the screen. 

Failed jobs will include an Error Description and 
Recommendations to correct the error in the Details Pane (see 
Figure 13-257 on page 13-467).

 Figure 13-257. DICOM Job Spooler Failed Job

NOTE: Deleting jobs from the spooler does not delete images from the 
hard drive. They can be re-sent via the “Send To” function on the 
Patient--> Patient View, Exam View, or Image Review.  
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Patient Menu DICOM Functionality

Additional DICOM functionality can be performed via the Patient 
Menu: 

Table 13-84:  Patient View Functions

You can also send studies to the DICOM destination 
by selecting Send To. :

And, access the Worklist or perform Query/Retrieve 
to/from the PACS via the Patient screen. To start 
Query/Retrieve  for a patient: Select the patient, 
select Query, the LOGIQ Totus then displays a list of 
exams. Select the desired exam, then select 
Transfer. 

You can also specify which Dataflow to use on the 
Patient page. This is the dataflow that will be used 
for Copy to Dataflow on print keys.  
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Troubleshooting DICOM Connectivity Issues

• If you ping/verify the device and receive a frown, confirm 
with your IT Team that you are using the correct IP Address, 
AE Title, Port Number, etc. 

• If the image/clip is stuck in the Print Spooler, select the job 
and resend or send to an alternate device. 

For Detailed descriptions of every DICOM parameter, refer to 
Chapter 10 of the Basic User Manual’s (Configuration chapter). 
For more detailed instructions on setting up each DICOM page, 
refer to Chapter 3 of the Basic Service Manual (System Setup). 
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Configuring the Wireless Network

Wireless LAN (WLAN)

A Wireless Network (WLAN) is available on the LOGIQ Totus. 
When the WLAN is active, an icon appears in the status bar to 
indicate whether the WLAN is installed or disconnected. See 
‘Network and Spooler Status Icons’ on page 13-474 for a 
description of the network icons.   
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Wireless LAN (WLAN) Specifications

The Wireless LAN (WLAN) supports the following network 
protocols: 

Supported Standards

• Conforms to IEEE 802.11 a/b/g/n/ac Wi-Fi with Bluetooth 
5.2 Standard. 

• FCC Part 15 Class B

• Japan’s Radio Law

• Radio Equipment Directive

• Canada Requirements

Security Methods

• WPA2

• WPA3

Encryption

• 128-bit AES-CCMP

• 256-bit AES-GCMP

Internet Protocol

• The LOGIQ Totus supports IPv4 or IPv6. 

Intel declaration of conformity 

You can find the Intel Declaration of Conformity at this web link: 

https://www.intel.com/content/dam/support/us/en/documents/
network-and-i-o/wireless-networking/ax210ngw-eu-red-doc.pdf
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Wireless LAN (WLAN) Specifications  (continued)

Authentication

• None

• Microsoft PEAP using MSCHAP v2

• Username/password

• Limited support for server certificate verification using 
pre-installed trusted root CAs

• Client certificates not supported

• User authentication/confirmation prompts not supported

Antenna

• 2 integrated internal wireless antenna

Radio Data Rate

• 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54, 08, 140, 246, and 
300 Mbps (Auto Rate Sensing)

Frequency

• 2.4, 5, 6 GHz (160MHz)

Country Compliance

The WLAN subsystem automatically detects location and 
adjusts the output to be compliant to country regulations.  The 
following is a partial list of countries that the product is compliant 
with:

• United States: FCC Part 15 Class B

• Canada: Industry Canada Radio Standards Specification 
(RSS) license-exempt

• European Union: Radio Equipment Directive (RED) 2014/
53/EU

• Japan: Japan Radio Law

• Brazil: National Telecommunications Agency (Anatel)

• Malaysia: Malaysian Communications and Multimedia 
Commission (MCMC)

• Singapore: Infocomm Development Authority of Singapore 
(IDA)
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Connecting to the WLAN 

To connect the LOGIQ Totus to the WLAN,  

1. Press Utility --> Connectivity --> TCP/IP --> Wireless 
Network --> Configuration (located under Wireless 
Network). 

The Wireless Network Configuration tool appears. If 
enabled, Wireless Networks broadcasting in your area 
appear in the list.  

2. If necessary, check the box for “Enable Wireless 
Connection”.

3. Select the wireless network you want to use or set up. 

4. Press Connect from the bottom of the Configuration tool. If 
prompted, enter the correct settings for this wireless 
network.   

NOTE: If the WLAN fails to connect, review and/or recreate the 
Wireless connection on the Security Tab. 
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Network and Spooler Status Icons

The following icons identify network and spooler statuses: 

Table 13-85:  Network and Spooler Status Icons 

Network and Spooler Status Icons

Ethernet Active Ethernet Error Ethernet Active 
Spooler Active

Ethernet Active 
Spooler Error

Mobile

Mobile Error Mobile Bluetooth Mobile Wifi Spooler Active Spooler Active 
Error

Spooler Inactive Spooler Inactive 
Error

Wifi 1 Bar Wifi 2 Bars Wifi 3 Bars

Wifi 4 Bars Wifi Alert Wifi Spooler Active Wifi Spooler Error Wifi Error
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Adding a Wireless Network

To add a WLAN profile (even for a network which is not yet 
available), 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Security. The Wireless Network Configuration 
tool appears. Available Wireless Networks appear.  

2. Select the Security tab. 

3. Select Add...

4. Obtain and enter the correct information for each wireless 
network setting: 

a. Enter a Network Name (SSID), pre-select the security 
type, then press OK. 

A new window appears so you can enter the settings for 
this network. 

b. On the connection page, check the appropriate boxes 
based on how you want the LOGIQ Totus to connect to 
this network. 

The LOGIQ Totus attempts to connect to available 
wireless networks based on the options you enable. If 
multiple networks are available, connection attempts 
begin with the network appearing topmost on the list. 

c. Select the Security page. 

d. Select the Security Type from the available options. 

NOTE: Dialog boxes vary, depending on the Security Type 
selected. 

e. Select the Encryption Type from the available options. 

f. For Personal networks, enter the Network key. 
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Adding a Wireless Network  (continued)

g. For Enterprise networks, choose the network 
authentication method and press Settings. 

Detailed settings for Enterprise networks are complex 
and must be correct for the connection to succeed. 
Ensure you have all the required information/settings 
and work with your site’s IT Network Administrator as 
needed. 

NOTE: Credentials must be entered at this time. The LOGIQ 
Totus does not support automatic prompting for user 
credentials. 

• For Microsoft PEAP networks, press Advanced and 
enter User authentication credentials (username and 
password). 

• For Cisco networks, enter user credentials in the PEAP 
Properties dialog after pressing the Settings button. 

NOTE: IMPORTANT: User credentials are not validated until 
you attempt to connect to the network. 

h. When you have correctly entered all required settings, 
press OK in the Wireless Network Properties dialog. 

Your settings will be validated and you may be 
prompted about certain settings which are not 
recommended or supported. 

Examples: “Automatic connection to unencrypted 
networks is not recommended. Reminder to enter user 
credentials for Enterprise networks.” 

i. If changes are necessary, press Customize. Make 
corrections, then press OK. Settings will be validated 
again. 

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel.

Removing a WLAN

To remove a WLAN profile (even for a network which is not  
available), 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Security. The Wireless Network Configuration 
tool appears. Available Wireless Networks appear.  

2. Select the Security tab. 

3. Select Remove.
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Customizing Wireless Network Settings

To customize an existing WLAN profile, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Security tab. 

3. Select Customize...

4. Obtain and enter the correct information for each wireless 
network setting: 

a. Enter a Network Name (SSID), then press OK. 

A new window appears so you can enter the settings for 
this network. 

b. On the connection page, check the appropriate boxes 
based on how you want the LOGIQ Totus to connect to 
this network. 

The LOGIQ Totus attempts to connect to available 
wireless networks based on the options you enable. If 
multiple networks are available, connection attempts 
begin with the network appearing topmost on the list. 

c. Select the Security page. 

d. Select the Security Type from the available options. 

NOTE: Dialog boxes vary, depending on the Security Type 
selected. 

e. Select the Encryption Type from the available options. 

f. For Personal networks, enter the Network key. 
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Customizing Wireless Network Settings  (continued)

g. For Enterprise networks, choose the network 
authentication method and press Settings. 

Detailed settings for Enterprise networks are complex 
and must be correct for the connection to succeed. 
Ensure you have all the required information/settings 
and work with your site’s IT Network Administrator as 
needed. 

NOTE: Credentials must be entered at this time. The LOGIQ 
Totus does not support automatic prompting for user 
credentials. 

• For Microsoft PEAP networks, press Advanced and 
enter User authentication credentials (username and 
password). 

• For Cisco networks, enter user credentials in the PEAP 
Properties dialog after pressing the Settings button. 

NOTE: IMPORTANT: User credentials are not validated until 
you attempt to connect to the network. 

h. When you have correctly entered all required settings, 
press OK in the Wireless Network Properties dialog. 

Your settings will be validated and you may be 
prompted about certain settings which are not 
recommended or supported. 

Examples: “Automatic connection to unencrypted 
networks is not recommended. Reminder to enter user 
credentials for Enterprise networks.” 

i. If changes are necessary, press Customize. Make 
corrections, then press OK. Settings will be validated 
again. 

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel.

Setting an IP Address

To set an IP Address (Static or Dynamic), select Utility--> 
Connectivity--> TCP/IP--> Properties. 
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Refreshing a WLAN

Refreshes the list of available Wireless Networks. To refresh the 
Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Press Refresh from the bottom of the Configuration tool. 

Managing Connectivity to a Wireless Network

You can control which wireless networks can be connected to 
and which networks are preferred over other networks. 

• Networks appearing on the Security page, Preferred 
Wireless Networks list are listed in decreasing preference. 

The network listed at the top of the list is the most preferred, 
and therefore the most likely to get connected. 

The network listed at the bottom of the list is the least 
preferred, and therefore the least likely to get connected. 

• Networks with the check box unchecked for automatic 
connection will never connect unless you manually press 
the Connect button.  

• Non-broadcasting networks will never connect unless the 
corresponding checkbox is checked; or, you manually press 
the Connect button.

• Once connected to a network, the system will not 
automatically switch over to a more preferred network 
unless the check box is checked. 

Monitoring the WLAN

If there are wireless network communication problems, you can 
monitor the wireless network events.

To monitor Wireless Networking events, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Monitor Tab.
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WLAN Diagnostics

If the wireless network is connected, you can run diagnostics to 
determine how well, or poorly, the network itself is working. The 
diagnostic information displayed can help pinpoint causes of 
networking problems. Tests which pass are shown in green; 
tests which fail are shown in red. 

To run diagnostics for the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Diagnostics Tab. 

3. Select Run Diagnostics.

Repairing the WLAN

Occasionally you may need to repair a WLAN that has lost its 
connection to the LOGIQ Totus. To repair the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Diagnostics Tab. 

3. Select Repair.

NOTE: DO NOT cancel the Repair operation after you have 
selected to repair the Wireless LAN connection. 
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Available WLAN Channels

The available WLAN channels show availability of wireless 
connect points that the scanner can talk to. Each channel 
supports a finite number of users and has limited signal 
strength. This may effect the ability to connect, the throughput 
and the connection dropping out.

To check the available WLAN channels, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Properties Tab. 

3. Select Available Channels....

Disconnecting from the  WLAN

To disconnect from the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears.   

2. Select Disconnect.
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Tricefy Uplink

Introduction

Tricefy is a cloud-based image viewer and a platform to archive, 
collaborate, and share. The Tricefy DICOM server may be used 
in the way any DICOM server on the product may be used, i.e., 
Print keys, Send To, etc. The corresponding DICOM 
destinations can be used via the Print keys. An internet 
connection is necessary for uploading data to Tricefy. 

NOTE: To engage in service offerings with Tricefy, confirm that your 
country has entered into an agreement with Tricefy. 

NOTE: Tricefy DOES NOT support IPV6 and cannot be used in 
conjunction with Tricefy. 

Figure 13-258. Tricefy Account
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Introduction  (continued)

The tab displays a general info area with a short description of 
Tricefy, an uplink ID, and an info badge for how to configure 
Print buttons on system setup (only available when an account 
is active). Furthermore the account area displays controls and 
information about the Tricefy account while the test connection 
area enables you to test a connection and gives detailed 
information about it.
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Uploading Exam Information to the Tricefy Cloud

Enabling Tricefy

1. To enable Tricefy, fill out the information on Utility -> 
Connectivity -> Special Devices -> Tricefy. As soon as this 
option is enabled, relevant Tricefy items are displayed (e.g. 
email text field, Activate button,.... and options within the 
system setup to share or store data to Tricefy via the print 
key or status bar icons (described below). 

2. Enter your email address to register and click Activate 
account. (If you want to deactivate an active account, click 
Deactivate account.) 

3. Depending on the account status, different account 
information is displayed:

• green badge containing the account info, email address, 
account name, customer name and account status- 
account activated

• blue badge - information about a disconnected account

• orange badge - connection to Tricefy™ failed (due to 
timeout,...)

4. For testing the connection click Activate. Depending on the 
connection status, different information is displayed:

• green badge - connection ok

• blue badge - instruction for testing the connection (only 
displayed as long as Activate is not pressed)

• orange badge - connection failed

5. Upon success activation, you will receive an Uplink ID. 

NOTE: When tricefy is successfully activated an image storage and 
Query//Retrieve service will be created with port number 
8104. 
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Configuring Tricefy

1. Set up the Tricefy Service via Utility > Connectivity > 
Service. Set the DICOM Image Storage and Query/Retrieve 
ports to Port 8104. Refer to the DICOM sections in this 
chapter and in Chapter 10 for more information. Verify the 
service.

2. Set up a Dataflow for Tricefy. Refer to the DICOM sections 
in this chapter and in Chapter 10 for more information. Verify 
the Dataflow. 

3. Configure the Print buttons via Utility > Connectivity > 
button. Refer to the DICOM sections in this chapter and in 
Chapter 10 for more information. Verify the Print button(s). 
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Using Tricefy

You can send a patient’s exam to the Tricefy Image Storage 
service via the Exam Tab.

1. Select the patient’s exam and press the Send To button. 
Select the Tricefy Image Storage service. Press OK.  

You can check the job status by pressing F4 (DICOM Job 
Spooler).

You can confirm the exam is on the Tricefy Server via a web 
browser. Navigate to https://tricefy4.com. Log in with your 
account information. The patient and image(s) you sent are 
on the Tricefy cloud. 

2. To Query patient information on the Tricefy cloud, on the 
Patient page, go to the Data Transfer page. Select the Q/R 
radial button, then press Query. A list of patients on the 
Tricefy cloud is displayed. Select the patient you want to 
retrieve, then select Transfer. 
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Tricefy Icons

Tricefy icons are explained below. 

Tricefy Activation

Refer to Chapter 10 for more information. 

Table 13-86:  Tricefy Icons

Connection Icons Store Icons Share Icons

Connected to Tricefy. Ready to 
Store and Share

Upload Image to Tricefy Share Image with Patient via 
Tricefy. 

Disconnected from Tricefy. Upload CINE to Tricefy Share CINE with Patient via 
Tricefy. 

Registration incomplete. Upload 4D Image to Tricefy

Upload 3D Image to Tricefy
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Device Mgmt

Overview

Device Mgmt is a remote device management tool that enables 
bi-directional management capabilities on the device.

Device Mgmt allows Cloud management of system preset 
configurations to a fleet of systems on network, as well as one to 
one system preset configuration Cloud backup and restore. 

NOTE: For Cloud operation please refer to Device Mgmt online user 
manual after sign-up at http://AVURI.gehealthcare.com/signup

Device Mgmt Fleet Management

Figure 13-259. Device Mgmt Fleet Management

An account on the Cloud with access to Device Mgmt is 
required.

1. Upload preset configurations for fleet of systems

2. On the Cloud, assign configuration to fleet of systems

3. Receive installation notification (on each system in the fleet)

4. Install preset configuration (on each system in the fleet)
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Device Mgmt Cloud Backup/Restore

Figure 13-260. Device Mgmt Cloud Backup/Restore

An account on the Cloud with access to Device Mgmt is 
required.

1. Backup to the Cloud

2. On the Cloud, assign configuration to restore to originating 
system

3. Receive restore notification

4. Restore on system

NOTE: Restoring to a system other than the originating system is 
not allowed.

NOTE: Cloud Backup jobs are queued and processed in the 
background and do not disturb user operation.
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Upload For Fleet and Manual Backup (Cloud Backup)

To upload preset information from the master system for the 
fleet:

1. Go to Utility > System > Backup/Restore.

2. Select Upload For Fleet.

3. Set Comment to identify configuration on the Cloud.

4. Press Upload.

5. The system displays the result in the status bar and the 
Notification dialog.

Figure 13-261. Upload For Fleet

NOTE: Upload For Fleet can share the preset configuration across 
Fleet, while Cloud Backup can restore only to the originating 
device.

NOTE: Upload For Fleet and Cloud Backup copies all “User Defined 
Configuration” to the Cloud.

NOTE: The user must have Device Mgmt Administration Group Rights 
to begin the Upload For Fleet.
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Backup Automatically (Local and Cloud Backup)

1. Check Backup Automatically under Local and Cloud 
Backup.

2. Press Save.

3. User Defined Configuration files are automatically backed 
up to Cloud when configuration is changed and then saved.

NOTE: Cloud Backup requires activation. Even if it is not activated, files 
will automatically copy to Local Backup.

NOTE: If the administrator (ADM) login password is reset and 
reconfigured, a manual backup should be created to save the 
ADM password change.

Manual Backup (Cloud Backup)

To backup user defined configuration for Cloud manually:

1. Go to Utility > System > Backup/Restore.

2. Select Cloud under Backup To/Restore From.

3. Check User Defined Configuration under Backup

4. Press Backup under Backup.

5. Set Comment to identify fleet configuration on the Cloud.

6. Press Backup.

7. The system displays the result in the status bar and 
Notification dialog.
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Assign Configuration to Fleet or to the Device (on Cloud)

Installation assignment for configuration files uploaded to the 
Cloud is performed on the Cloud (not on the device). 

• Upload For Fleet - Configuration files can be assigned to the 
Fleet (group of devices).

• Cloud Backup - Configuration files can be assigned only to 
the device where they were backed up from.

NOTE: Configuration files that have been uploaded to the Cloud with 
Upload For Fleet and Cloud Backup are displayed in different 
lists on the Cloud.
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Receive Installation Notification

When a configuration file is assigned for installation from the 
Cloud, the system displays a pop-up dialog notifying that a 
download is available by selecting the download icon in the 
status bar. The pop-up appears only at the following operation 
points, to avoid interrupting an exam:

• New Patient/End Current Patient

• Unlock Lock-screen

• Log off/Log on

The download icon also appears in the status bar.

Figure 13-262. Notification Dialog and Installation Icon

NOTE: The user must have Configuration Group Rights to begin the 
configuration download and installation. If the user does not 
have Configuration Group Rights, a Warning message is 
displayed (see Figure 13-265).
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Installation Dialog

Figure 13-263. Installation Icon

Selecting the Installation Icon in the status-bar initiates the 
Installation Dialog with three options:

• Install

• Delay Install Until Shutdown

• Download Only

• Discard

Figure 13-264. Installation Dialog

NOTE: Discard and Download Only are available only when the 
Installation is marked as optional on the Cloud. Otherwise, no 
Discard or Download Only buttons appear in the Installation 
Dialog.
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Installation Dialog  (continued)

NOTE: Installation requires Advanced Configuration Group Rights. If 
the user does not have Advanced Configuration Group Rights, 
selecting the Installation Icon displays a Warning.

Figure 13-265. Advanced Configuration Group Rights Warning
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Install

1. Select the Installation Icon in the status bar.

Figure 13-266. Installation Icon

2. Select Install.

Figure 13-267. Install

3. Select Continue to acknowledge. The configuration 
installation begins and the result is displayed.

Figure 13-268. Continue Install
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Install  (continued)

4. Select OK to restart.

Figure 13-269. Select to Restart System
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Delay Install Until Shutdown

1. Select the Installation Icon in the status bar.

Figure 13-270. Installation Icon

2. Select Delay Install Until Shutdown.

Figure 13-271. Select Delay Install Until Shutdown

3. Select Continue to acknowledge. Continue the exam.

Figure 13-272.  Continue Delay Install Until Shutdown

NOTE: Icon changes to “Delay Install Until Shutdown”.

Figure 13-273. Delay Install Until Shutdown Icon
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Delay Install Until Shutdown  (continued)

4. Press Power button to display Exit dialog.

5. Select Shutdown. Installation begins automatically and the 
result is displayed.

Figure 13-274. Shutdown to Begin Installation

6. When installation is complete the system will shutdown 
automatically. 

NOTE: If the installation fails for any reason, a notification will be 
displayed after the system restarts.
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Discard

1. Select the Installation Icon in the status bar.

Figure 13-275. Installation Icon

2. Select Discard.

NOTE: Discard is available only when the Installation is marked as 
optional on the Cloud. Otherwise, no Discard button 
appears in the Installation Dialog.

Figure 13-276. Select Discard

3. Select Continue to acknowledge.

Figure 13-277. Continue Discard
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Detailed Restore from Cloud

Download Only from Cloud

NOTE: Because Download from Cloud runs in the background, the 
download is already completed when selecting Install Icon.

1. Select the Install icon.

Figure 13-278. Install icon

2. Select Download Only which creates local backup of the 
preset.

Figure 13-279. Select Dowonload Only

NOTE: If installation of the preset is set as Mandatory, then the 
dialog enables only the Install or Delay Install until 
Shutdown.
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Download Only from Cloud  (continued)

3. Information displays when the download is completed.

Download completed. To install the downloaded 
configuration, go to Utility -> System -> Backup/Restore and 
select Cloud as the Location.

Figure 13-280. Download Completed

Detailed Restore From Cloud

1. Go to Utility > System > Backup/Restore.

2. Select Cloud as Location of Restore From

3. Select categories and press Detailed Restore under 
Detailed Restore of User Defined.

Restore from Cloud

1. Go to Utility > System > Backup/Restore.

2. Select Cloud as Location of Restore From

3. Select categories and press Restore under Restore.
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Cancel a Failed Job

1. Select Notification Icon.

Figure 13-281. Notification Icon

2. The notification dialog displays on the monitor. Select a 
failed job and press Cancel Selected Job.

Figure 13-282. Select Failed Job

3. Select Continue on the dialog.

Figure 13-283. Warning Dialog

NOTE: Successful jobs are removed automatically after a period of 
time. Failed jobs are deleted automatically after 2 weeks.
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Icon and Notification

One of the following icons is displayed in the status bar:

When there is a notification, clicking on the icon displays a 
message (see Icon Message example below).

Figure 13-284. Icon Message

Table 13-87:  Device Mgmt Icons

Icon Description

Activated/Not Activated

Unread/Read Error message

Unread/Read Warning message

Unread/Read information
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Smart Device Apps

LOGIQ Apps

Smart Device LOGIQ Apps are available for Android devices 
(both a phone and tablet) via Bluetooth: LOGIQ Remote Control 
App and LOGIQ Photo/Barcode Reader App. 

Figure 13-285. Smart LOGIQ Apps Devices

NOTE: The communication between the LOGIQ Apps and the 
ultrasound system is Bluetooth which is a wireless, secure 
transmission. At no time is patient data stored on the device 
hosting the LOGIQ Apps. For the LOGIQ Photo App, photos are 
never written to a file, but rather directly transferred to the 
LOGIQ ultrasound system. Once on the ultrasound system they 
can be included with the diagnostic images sent to the 
reviewing/reading physician.
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LOGIQ Apps  (continued)

NOTE: DO NOT use the USB Ports on the LOGIQ Totus to charge 
LOGIQ Apps devices as these devices are not approved 
devices to connect to a medical device. 

Connecting the Device

To link to the device: 

DANGER DO NOT use the Smart Device Apps if the patient has a 
life-sustaining device, such as a pacemaker or defibrillator. 
Failure to follow this instruction could lead to interference with 
patient electronic device(s). 

Table 13-88:  Linking the Device to the LOGIQ Totus 

Steps On LOGIQ Totus On Device

1. Press the Mobile Icon on the 
LOGIQ Totus that’s located 
on the display. 
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2. On the LOGIQ Totus, the QR 
code appears on the display. 

3. On the device, press the 
LOGIQ Remote App. 

4. Follow the instructions on the 
device.
a. Press “Connect.” 
b. Scan the QR Code with the 

device.

Table 13-88:  Linking the Device to the LOGIQ Totus  (Continued)

Steps On LOGIQ Totus On Device
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5. Place the device in front of  
the LOGIQ Totus as directed. 
“Scan QR code with your 
mobile application to pair and 
connect.” 

The LOGIQ Totus and the device 
are now ready to pair. 

6. The device displays the 
Bluetooth pairing request, 
“Confirm passkey is ##### to 
pair with the LOGIQ Totus.” 
Press OK.  

Table 13-88:  Linking the Device to the LOGIQ Totus  (Continued)

Steps On LOGIQ Totus On Device
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7. The Bluetooth icon on the 
LOGIQ Totus is now paired to 
the device. 

8. The LOGIQ Remote 
application appears on the 
device. The Phone App and 
Tablet App displays are 
shown to the right. 

To switch to the LOGIQ Photo 
App, press the Camera icon 
located on the top of the remote 
device’s display. 
Note: The Camera Icon only 
appears if LOGIQ Photo App is 
already installed. 

Table 13-88:  Linking the Device to the LOGIQ Totus  (Continued)

Steps On LOGIQ Totus On Device
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To completely break the association between the LOGIQ Totus 
and the device (unpair the device from the LOGIQ Totus): 

1. Access the Utility-> Connectivity-> Miscellaneous screen. 

2. In the LOGIQApps section, select Unpair Bluetooth 
Devices.

To disconnect the LOGIQ Totus 
from the device, click on the 
“Bluetooth Connected to the 
Device” icon on the bottom of the 
display and select to disconnect.  
Or, 
You can press “Disconnect” on 
the Device. 

To Unpair a Device from the 
LOGIQ Totus, press “Unpair 
Bluetooth Devices” via Utility> 
Connectivity> Miscellaneous> 
LOGIQ Apps. 

Table 13-88:  Linking the Device to the LOGIQ Totus  (Continued)

Steps On LOGIQ Totus On Device
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Assigning LOGIQ Apps to a User Defined Key

To assign LOGIQ Apps to a User Define key, select “LOGIQ 
Apps” to a User Defined key (restart needed)” via Utility> 
System> User Configurable Key.

Figure 13-286. Assign LOGIQ Apps to a User Defined Key

Using the Apps

Table 13-89:  Using Smart Device LOGIQ Apps 

Tablet/Phone Remote Control and Photo/Barcode reader Apps

1. LOGIQ Remote Control App
2. LOGIQ Photo/Barcode Reader App



Advanced Features

13-512 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

LOGIQ Remote Control App:  

Via the Tablet LOGIQ Remote Control App, you will 
be able to adjust the following controls: 
Depth, Gain (B-Mode, Color Flow Mode, PW 
Mode), Left/Right, Measure, Comment, Clear, 
Trackball, Freeze, Store, Color Flow Scale, and 
Cursor. 

Via the Phone LOGIQ Remote Control App, you will 
be able to adjust the following controls: 
Activate PW, CF, or B-Mode, adjust the Cursor, 
Freeze the image, and sent images to the P1 
control. 

Photo/Barcode Reader App 

You can use the LOGIQ Photo App to capture 
photos that will go to the patient’s exam and to use 
as a barcode reader to scan in patient exam 
information. 
Note: The photo does not go directly into the exam; 
instead the image must be stored from the LOGIQ 
Totus. 
Note: The barcode scanner scans the barcode into 
the Patient ID field on the Patient menu. 

Table 13-89:  Using Smart Device LOGIQ Apps  (Continued)

Tablet/Phone Remote Control and Photo/Barcode reader Apps
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Barcode - Input Mode

Off

Enter the Patient ID using the keyboard.

Patient ID

Scan the barcode for the Patient ID or enter the Patient ID using 
the keyboard. 

Complexation

Patient demographics can be entered by scanning the barcode, 
or manually, using the keyboard.

To enter patient demographics manually with the keyboard 
(instead of the barcode), select Cancel.

1. Enter a string in the Input Data field by scanning from a 
barcode or typing with the keyboard.

2. Scan a sample barcode. The following items can be 
included in the barcode:

• Patient ID

• First Name, Last Name, Middle Name

• Birth Year, Month, Day

NOTE: The character length for Year is four characters, Month 
is two characters and Day is two characters. The Year, 
Month and Day should always be provided together.

• Gender
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Complexation  (continued)

3. Configure the Start and End position for each item.

NOTE: If the barcode does not contain information for an item, 
configure the Start and End position as “0.“

For example, if the scanned barcode is 
“000001LastNameFirstName191990101F,“ the 
configuration and results display as seen in Figure 13-287.

 Figure 13-287. Barcode Configuration Page Example
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Digital Expert

Digital Expert Remote Training

Digital Expert is a purchasable option which enables remote 
training between users and the GE HealthCare Clinical 
Applications team, through scheduled and real-time sessions. 
Digital Expert is a self-contained, app-based companion 
solution, designed to pair with GE HealthCare medical devices. 
Digtal Expert utilizes Intelehealth software for remote 
connectivity.

NOTE: This tool is not for clinical diagnostics purposes.

Digital expert also enables customer to customer Enterprise 
Collaboration, where users can connect with each other within 
their own network. This provides on-demand access for 
guidance and consultation for clinicians from in-house experts.

Refer to the user manual included with Digital Expert for 
information on setting up and using Digital Expert. 
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Service and Applications Support

GE HealthCare Connect Guide

The GE HealthCare Connect Guide helps the user follow the 
necessary steps to setup the InSite ExC connectivity. To use the 
GE HealthCare Connect Guide to begin the GE HealthCare 
Backoffice Connectivity Troubleshooting wizard: 

1. Select the Insite icon at the bottom of the display screen to 
open up the InSite ExC Icon Menu.

Figure 13-288. InSite ExC Icon Menu with Connection 
Unconfigured

2. Select GE HealthCare Connect Guide from the menu to 
open the GE HealthCare Backoffice Connectivity 
Troubleshooting wizard.
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GE HealthCare Backoffice Connectivity Troubleshooting Wizard

Use the following GE HealthCare Backoffice Connectivity 
Troubleshooting wizard screens to setup the GE HealthCare 
Backoffice connection.

1. Agent Configuration - The Serial ID is displayed (not 
editable). Verify CRM ID; edit if necessary and save 
changes. Select Next.

Figure 13-289. Agent Configuration

2. Network Connection - Ensure you are connected to the 
Network with a wired or wireless connection. Select Next.

Figure 13-290. Network Connection
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GE HealthCare Backoffice Connectivity Troubleshooting Wizard  

(continued)

3. Agent Proxy Configuration - Ensure proxy configuration 
details and credentials are accurate. Edit if necessary, save 
changes and select Next.

Figure 13-291. Agent Proxy Configuration

4. DNS Configuration - Ensure DNS is configured correctly for 
the system. Select Next.

Figure 13-292. DNS Configuration
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GE HealthCare Backoffice Connectivity Troubleshooting Wizard  

(continued)

5. Network Firewall - Ensure the network firewall in the facility 
is configured correctly to allow GE HealthCare InSite 
communication. Select Next.

Figure 13-293. Network Firewall

6. Summary Page - The Summary page will check the agent 
configuration and connection status for all configuration 
steps. When the process completes (may take up to five 
minutes) the status for each step is listed as “OK” or “Not 
OK.” If any step is reported as “Not OK” select the step from 
the menu on the left and correct the information on that 
screen, then proceed to the Summary page again for a 
connection status update.

Figure 13-294. Summary Page
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Support Requests

InSite ExC

InSite ExC is your direct link with a GE HealthCare Online 
Service Engineer or Applications Support Engineer by creating a 
Request for Service via the InSite ExC link at the bottom of the 
display screen.    

NOTE: The Insite connection must already be configured with the GE 
HealthCare backoffice for the InSite ExC Menu to appear. See 
‘GE HealthCare Connect Guide’ on page 13-516 for more 
information. 

Figure 13-295. InSite ExC Menu

Types of InSite ExC Service

1. Contact GE HealthCare - Opens a service dispatch with 
GE HealthCare Service. 

2. Connect Clinical Lifeline - Sets the system in a state of 
readiness for Virtual Console Observation. 

3. Connect To GE HealthCare - Initiates a connection to the 
GE HealthCare Backoffice.
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Initiating a Request for Service (RFS)

To initiate an RFS: 

1. Position the Windows pointer on top of the GE HealthCare 
InSite ExC icon at the bottom of the display. 

2. Press the Right Trackball Set Key. Select Contact GE 
HealthCare. This opens the RFS screen which sends a 
service dispatch directly to the Remote Service or 
Applications Team after you fill in the following information: 

• Last Name, First Name, Phone Number

• Select correct Problem type

• Choose Problem area

• Type in Problem description

3. After you have completed filling in all of this information, 
press Send to initiate the Request for Service. 

You can confirm if your RFS has been sent as well as RFS’s 
automatically sent by the system. The LOGIQ Totus can 
automatically submit a Request for Service. These are displayed 
on the Machine Queue. 

In addition, you can use the Users screen to identify your 
institution’s point of contact for service dispatches. 
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Initiating a Technical or Clinical Support Request

When the Remote Applications or Service person reaches you, 
they will ask you to you click on the InSite icon and choose 
either Connect to GE HealthCare or Connect Clinical Lifeline, 

1. Position the Windows pointer on top of the GE HealthCare 
InSite ExC icon at the bottom of the display. 

2. Press the Left Trackball Set Key. This opens the following 
pop-up:  

• Connect to GE HealthCare,

• Connect Clinical Lifeline, or

• Cancel

3. Select the option the GE HealthCare representative asks 
you to select.  

NOTE: SIelecting Connect to GE HealthCare changes the polling time 
from 15 minutes to 15 seconds so that your call can be 
answered as quickly as possible. Selecting Connect Clinical 
Lifeline also actives disruptive mode. 
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Initiating a Technical or Clinical Support Request  (continued)

InSite ExC icons appear differently, depending on their state: 

Table 13-90:  InSite Icons

GE HealthCare InSite - Connected - Disruptive Mode - 
Enabled

GE HealthCare InSite - Connected - Disruptive Mode - 
Disabled

GE HealthCare InSite - Idle - Disruptive Mode - Enabled

GE HealthCare InSite - Idle

GE HealthCare InSIte - Not Configured

For more info on the configuring the connection to the GE 
HealthCare Backoffice, see ‘GE HealthCare Connect 
Guide’ on page 13-516.
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InSite ExC Definitions

Here are definitions for the different InSite ExC states: 

Virtual Console Observation (VCO). Allows Technical Support 
to control LOGIQ Totus functionality remotely. 

Disruptive. Allows GE HealthCare’s Technical Support person 
to connect to your system via VCO, to run diagnostics directly 
on your LOGIQ Totus system, and to collect system logs. When 
the system is in Disruptive Mode, the icons are red. There are 
two disruptive states. If you see a telephone with a clock, then 
the system is in Disruptive, Not Connected Mode. If you see a 
telephone with GE HealthCare, then the system is in Disruptive, 
Connected Mode. 

Non-Disruptive. Allows GE HealthCare’s Technical support 
person to look around on your system, but cannot perform any 
service-related functions, depending on whether InSite has 
connected or not connected. There are two Non-Disruptive 
states. If you see a black and white icon, InSite ExC is activated, 
but not open for Technical Support access. If you see a yellow 
icon, InSite ExC is activated and the Technical Support person 
can look around on your system, but cannot perform any 
service-related functions.  

Connected. InSite ExC is connected.   

Not Connected. InSite ExC is not connected. 

NOTE: When Disruptive mode has been activated or a diagnostic has 
been run, the message, “Service Mode is Activated. Reboot 
required before patient use” appears in red at the bottom of the 
display. It is recommended that you reboot the system before 
use. Make sure you disable disruptive mode before rebooting or 
the message will not be cleared.

Exiting InSite ExC

To exit InSite ExC: 

1. The GE HealthCare Technical Support person will exit 
Disruptive Mode and VCO, then ask you to reboot your 
system. 

2. Reboot your LOGIQ Totus system before patient use. 

For more information on InSite ExC refer to the LOGIQ Totus 
Basic Service Manual.
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Service Desktop

Overview

The Administrator (and others granted the “Access Service 
Desktop” privilege) can access the Service Desktop to: 

• Access the Service Home Page. 

• Perform the following Utilities

• Change Password

• Data Transfer

• Delete Files

• SSA License

• Gather Logs

• View Third Party Licenses

• Disruptive Mode Utility

• View Installed Options

• InSite Agent Configuration

Figure 13-296. Service Desktop

For more information on Service Desktop, refer to the LOGIQ 
Totus Basic Service Manual.

Accessing the Service Desktop

1. Select Utility and go to Page 2 of the Utility Menus. 

2. Select Service.
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Battery Power Mode

Overview

The LOGIQ Totus supports either the 3 pack battery Option or 
the 6 pack Battery option. 

NOTE: Only GE HealthCare Service personnel have access to the 
batteries. Please contact the technical service department or 
your local GE HealthCare representative for replacement. Also, 
replace all battery packs at the same time to avoid confusing 
used and new battery packs.
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Scan on Battery Option (ScoB)

Overview

Scan on Battery Option allows the user to scan using battery 
power (AC unplugged).

While running on the battery power, the LOGIQ Totus can scan 
or perform post-processing and switch to Power Saving Mode.

With a fresh battery that is fully charged, the LOGIQ Totus stays 
powered for approximately  1h in 3 battery pack / 2h in 6 battery 
pack.

Before starting Scan on Battery

CAUTION
It is recommended to complete the following before unplugging 
the AC cable.

• Any access to the external media, such as USB HDD via 
Export, Import, Save As, EZBackup.

• Any access to the Network device, such as DICOM 
transfer or Network Storage.

• Volume Navigation should be exited by Exit and Clear 
Control.

• Processing 3D/4D images in live mode.
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Before starting Scan on Battery  (continued)

Before starting Scan on Battery, go to Utility -> System > 
General page and select the appropriate value for “Auto Switch 
to Power Saving Mode” and “Freeze when AC is Unplugged” 
(Default: Off). 

Figure 13-297. Extended Battery for Scanning

Auto Switch to Power Saving Mode

• Select 15, 30 minutes or 1 hour to automatically switch to 
Power Saving Mode after the time specified on battery 
operation.

• Select “Never” to never switch to Power Saving Mode.

• Select “Always” to always switch to Power Saving Mode. 

Freeze when AC is Unplugged 

• On: When selected, the system goes into Freeze mode 
when the AC cable is unplugged. 
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Starting Scan on Battery

When the AC cable is unplugged from AC power, the system 
automatically transitions to Scan on Battery Mode.

NOTE: If the system does not transition to Scan on Battery Mode, 
contact the technical service department or your local GE 
HealthCare representative.

 Figure 13-298. Warning message

Recommendation

Plug in AC power if possible, keep using the battery power can 
impact to the battery life.

When the battery capacity becomes low

The LOGIQ Totus displays a dialog for the user to guide to 
switch to Power Saving Mode when the battery capacity 
becomes low. User can either keep scanning until the system 
shuts down or go to Power Saving Mode to extend time before 
shutdown.

WARNING Do not use Scan on Battery Mode when you need to 
handle (transfer/ export/ import) patient data. (Export/
Import/ Backup/ Burn Media, Dicom Transfer, etc.) The system 
can unexpectedly shutdown when the battery capacity is too 
low and result in patient data loss. Please note the message in 
the status bar when Scan on Battery is activated. It is strongly 
recommend to use AC power when transferring, importing or 
exporting patient data.
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Switch to Power Saving Mode

You can switch to Power Saving Mode by selecting “Switch to 
power-saving” in the battery status popup anytime you want.

Figure 13-299. Battery status pop-up

The LOGIQ Totus allows going back to Scan on battery mode by 
pressing the Power button or Freeze button.

Figure 13-300. Dialog during Power Saving Mode

WARNING The system switches to Power Saving Mode automatically 
when the capacity is low.
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View current battery status

When the system is running under Power Assistant/Scan on 
Battery, battery icons appear in the title bar and on the status 
bar, indicating how much charge is left in the battery.

Battery Status Icon on the status bar

The system displays the battery’s current charge and posts a 
notification message on the display when battery power needs 
attention. 

Detailed battery information is available by clicking on the icon 
and display the popup, which includes the battery’s current 
capacity displaying.

Figure 13-301. Battery status pop-up

NOTE: When the Front Battery LED is blinking, the system is in standby 
mode and the batteries are charging. 

Table 13-91:  Battery status icons

Icon Description

No icon AC Plugged; no battery present

AC Unplugged; battery is fully charged (81 - 100%)

AC Unplugged; battery is partially charged (61 - 80%)

AC Unplugged; battery is partially charged (31 - 60%)

AC Unplugged; battery is partially charged (0 - 30%)



Advanced Features

13-532 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

AC Plugged; battery is fully charged (81 - 100%) and charging

AC Plugged; battery is partially charged (61 - 80%) and charging

AC Plugged; battery is partially charged (31 - 60%) and charging

AC Plugged; battery is partially charged (0 - 30%) and charging

Battery error icon
When an abnormal status of the battery is detected, the system displays the 
following icon:
• Battery Temperature error
• Communication error or battery charge error
NOTE: If this icon displays, do not initiate Power Assistant. Contact the 
technical service department or your local GE HealthCare representative. 

Table 13-91:  Battery status icons (Continued)

Icon Description
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Battery status Icon in the title bar

Fuel Gauge icon appears in the title bar.

Figure 13-302. Fuel Gauge icon

NOTE: To avoid an unintended shutdown of the system, and to avoid 
risk of losing patient data, it is strongly recommended to connect 
to AC power when the fuel gauge icon is yellow or red.

Table 13-92:  Battery status icons (AC unplugged)

Icon Description Icon Description

91 - 100% 41 - 50%

81 - 90% 31 - 40%

71 - 80% 16 - 30%

61 - 70% 0 - 15%

51 - 60%
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Battery charging

NOTE: Whether the LOGIQ Totus is on or off, the battery will charge as 
long as the system is connected to AC power via the power 
cable, and the break is on.

While the battery is charging, the front battery LED will blink. 
When the battery is fully charged, the LED will stop blinking and 
remain on.

Figure 13-303. LED location of the battery

Approximate charging time (from empty to full)

Wait until the battery is fully charged. It takes at least 1 hour 40 
minutes (3 battery pack) / 3 hour 20 minutes (6 battery pack) to 
fully charge the battery. (depend on the remaining battery 
capacity).
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Refreshing the battery

To maintain battery life and accuracy of the fuel gauge, and to 
avoid unexpected shutdowns, it is recommended to refresh the 
battery every 6 months with the following procedure:

1. Plug the AC cable to the wall outlet and turn on the circuit 
breaker.

2. Wait until the battery is fully charged. It takes about 2.5 
hours to fully charge the battery (depend on the remaining 
battery capacity).

3. Wait at least 1 hour.

4. Remove all probes.

5. Turn on the system.

6. Unplug the AC cable, letting the system run on battery until 
it automatically shuts down. It may take at least 30 minutes 
(Power Assistant Battery)/ 50 minutes (Scan on Battery) to 
complete shutdown.

7. Wait at least 5 hours.

8. Plug the AC cable to the wall outlet and turn on the circuit 
breaker.

9. Wait until the battery is fully charged. It takes about 2.5 
hours to fully charge the battery.
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Battery deterioration

When the system detects battery deterioration, the following 
dialog displays:

Figure 13-304. Battery life message

If this message appears, the LOGIQ Totus disables both of 
Power Assistant and Scan on Battery. 

Contact the technical service department or your local GE 
HealthCare representative.

Battery Disposal

Lithium Ion

Used batteries must be disposed of properly and as chemical 
waste. They cannot be treated as regular waste. Contact your 
building administration for proper disposal. 

NOTE: When removing a defective battery, ensure that it is disposed of 
in accordance with local regulations. Alternatively, provide it to 
GE HealthCare for proper disposal.
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Magstripe Card Reader

Magstripe Magnetic Card Reader

The Magstripe Card Reader can be attached to the LOGIQ 
Totus by connecting it to any LOGIQ Totus USB port.

Figure 13-305. Magstripe Card Reader

The Magstripe Card Reader can be used in Patient screen, 
Worklist and Image Display.

• Patient screen: Patient ID, First Name, Last Name, Middle 
Name, Perf. Physician, Ref. Physician

• Worklist: Patient ID, Search String

• Image Display: Comments (Annotation)
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Footswitch

Wired Footswitch

You can attach this Footswitch to the system by connecting it to 
any USB port on the system. 

Figure 13-306. Footswitch and USB Cable

This is a 3-pedal Footswitch. You can configure its functionality 
via the Utility -> Applications -> Footswitch parameters. 

CAUTION
When using the Footswitch, DO NOT hold down the footswitch 
pedal. Press and release the Footswitch pedal. Pushing and 
holding down the pedal behaves the same way as pushing and 
holding down a key on the keyboard. 
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DVR

Setting up the DVR

To set up the Digital Video Recorder (DVR), configure the 
LOGIQ Totus PRIOR TO using the DVR since the system MUST
BE restarted after updating these configuration parameters. 

1. Set up following parameters in Utility --> System --> 
Peripherals.

• Media: USB

NOTE: Pre-format USB device as NTFS

• Picture Quality: HQ, SP, LP, EP

• Microphone Level: 1 to 5

• USB Playback Skip Interval (sec.): 15, 30, 60, 120

2. If needed, assign [DVR Record/Pause] to a Print key in 
following steps.

a.  Add [Video Capture] and select [DVR Record/Pause] 
as the Type, in Utility -> Connectivity -> Service.

b. Assign the [Video Capture] to the Print Button, in Utility 
-> Connectivity -> Button.

3. Restart the system. 

DVR functionality is now set to record the scan. 
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Using the DVR

1. Create a patient record or open an existing one.

2. Press the Video-assigned key.

3. Insert USB storage, which is selected as DVR media (Utility 
-> System -> Peripherals).

4. Press Record to start recording.

The status bar updates with the recording information. While 
recording, you can only pause or stop the recording and 
cannot perform any other DVR functionalities.

NOTE: Recording automatically pauses when you access the Utility 
screen.

NOTE: When more than one USB storage is connected, the DVR 
records to the first drive letter, in alphabetical order.

NOTE: The system does not start the recording while the following 
operation is in progress: Data Transfer, EZBackup, Utility 
screen.

5. Press Record or Pause to pause/resume recording.

6. Press Stop on the Touch Panel to stop recording.

When you stop recording, the DVR writes the title data. 
During this period of time, the busy state icon is displayed in 
the status bar (green arrow circling) and you cannot operate 
any DVR functionalities.

NOTE: The DVR automatically stops recording before the media 
fills up.

7. Press Eject on the Touch Panel or the F3 key to eject.

8. Press Scan tab to return to scanning.

WARNING Loss of patient data may occur during an AC failure. Ensure 
that you are not using Power Assistant and that you do not 
disconnect AC power while saving an exam to the DVR. 
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Recording Functionality - USB Storage

Supported media

USB-HDD (NTFS only), USB Flash Device (NTFS only) 

NOTE: You cannot record or play FAT (exFAT, FAT32, etc) on a USB 
Device. Please format the USB device to the NTFS file system 
on a PC.

Supported format

MPEG video file

Recording to USB storage creates an mpeg video file (*.mpg) 
(\LOGIQ_Series_DVR\folder) for each title. The file size can be 
up to 2GB.

NOTE:  The mpeg video file does not have a chapter.

Support Picture Quality

• HQ (Record length: approx. 30 minutes)

• SP (Record length: approx. 40 minutes)

• LP (Record length: approx. 60 minutes)

• EP (Record length: approx. 130 minutes)

NOTE: The maximum size of each video file: 4GB.
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Video file name

The mpeg video file name is titled as follows: 
<Date>_<Time>_<Patient Last name>_<Patient First name>..

When the patient’s name is not provided, then the video file 
name is as follows, <Date>_<Time>_<serial number> where the 
serial number is the number of video files on the media plus one.



DVR

LOGIQ Totus – User Manual 13-543
5929163-1EN Rev. 3

Video Touch Panel Menu

DVR Touch Panel menus:

 Figure 13-307. Video Touch Panel

Table 13-93:  Touch Panel Keys

Touch Panel Key Explanation

Skip (I<</>>l) USB storage: Skip specific time to forward/backward.

4x Skip (4x I<</>>l 4x) USB storage: Quad time interval skip to backward/forward.

Search Press Search to start the Search dialog. Select Title, adjust offset then press 
Search Counter to start the Search. 
The title name is as follows: <Date>_<Time>_<Patient’s Last 
name>_<Patient’s First name>

Record (Red circle with 
Media Inserted)

Start recording. 

Pause ( II ) Pauses and resume Recording and Playback.  
NOTE: The Freeze key works the same as the Pause button, when in 
Playback.

Open Media Drawer Press to open the Media Drawer.

Eject Eject the USB storage device. Also you can eject media pressing the F3 key. 

Play ( > with Media 
Inserted)

Play a video from USB storage device.

Stop ( Box ) Stop playback or recording. 
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DVR Display Icons

Displays the following icons in the status bar: 

Figure 13-308. DVR Disk Status

Table 13-94:  DVR icons

1. DVR status

Recording Stopping

Pause Recording Pause Playback

Playback Busy

No media

2. USB storage status
Displays the device availability and the free space size.

USB Storage is attached

3. Current Title Number. Displays while recording

4. Time counter.
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Auto Preset Assistant

This AI-based framework recognizes some anatomy by 
analyzing live B-Mode images. The system then automatically 
adjusts the B-Mode model (user preset) or suggests the user 
change the preset manually. While live scanning, the system 
analyzes the B-Mode image at regular time intervals. When the 
anatomy is recognized for a specific model (user preset), the 
associated B-Mode model is enabled.

This feature works on 9L-D, M6-15L-D, L3-12L-D and L6-24-D 
and Supports 10(ten) B-Mode Anatomical areas: Abdomen, 
Breast, Carotid, Leg, MSK, Scrotal, Thyroid, Thyroid/Carotid 
Axial, Air and Other.

NOTE: This view recognition algorithm was trained on 14,333 images 
and validated on 339 images which were independent data sets 
for the training algorithm. 

Based on the validation test, Minimum Acceptable Algorithmic 
Performance was confirmed to 80% accuracy.

WARNING This feature uses AI based computer algorithms to determine 
the anatomical area. There is an inherent risk that these 
algorithms may sometimes give suboptimal or incorrect results. 
Verify that automatically selected presets are appropriate for 
the scanned anatomy type.
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Auto Preset Assistant Configuration in Imaging Preset Manager

The Imaging Preset Manager can incorporate the Auto Preset 
selections, or manually added presets.

1. Select Utility > Imaging Preset Manager > Auto Preset in 
Category.

2. Available Imaging Presets on the left side includes all 
available presets (including the “Auto Preset” selections).

Figure 13-309. Auto Preset Assistant Configuration

For example, in Figure 13-309 "Auto Preset Assistant 
Configuration" , if the algorithm percentage result meets the 
MSK preset, the preset that is automatically selected is 
“MSK Gen.” If no preset was defined, the system does not 
recommend or automatically change any presets.
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Auto Preset Assistant Configuration in System Imaging

1. Select Utility > System > System Imaging on the Touch 
Panel.

2. “Auto Preset Assistant” configuration column is shown in 
Utility System Imaging menu.

3. Turn on check box of Enable in Auto preset Assistant in 
Utility System Imaging menu.

4. See Table 13-95 Auto Preset Assistant for detail 
parameters.

Table 13-95:  Parameters and Description

Parameter Description

Enable Select to enable the Auto Preset Assistant feature.

Default Auto Mode in new 
patient

Off: the system does not automatically change to the recommended preset.

Automatic: the system automatically changes to the recommended preset 
when the algorithm percentage is higher than the defined Auto Threshold.

Air detected:The system automatically changes to the recommended preset 
when the algorithm percentage is higher than the Auto Threshold and is 
immediately recognized as Preset of Air. By selecting “Air detected” the 
system automatically changes to the recommended preset, if the confidence 
result is higher than the automatic threshold and is immediately recognized 
as Preset of Air.

Turn off Auto after 
changing preset

If selected, once the preset changes, no automatic preset changes are 
allowed.

Automatically Retain Field 
of View

Selecting this ensures that the Imaging Parameters. Retain Field of View stay 
constant over Probe and Preset changes by Auto Preset Assistant.

Check before automatic 
change

Requires confirmation before the preset changes.

Recommendation without 
specifying preset

If there are presets to recommend, the “Check your preset” messgae 
displays.

Show detected view A tool displays the detected view result.
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Auto Preset Assistant Configuration in User Defined Trackball Set Key 

Menu

In addition to making this function work automatically, it is 
possible to confirm the recommended preset using the Trackball 
Set key. These operations can be assigned to the trackball 
sub-set key in the User Configurable Key menu. The B-Mode 
preset can be changed to the recommended preset without 
moving hands from the operator panel.

1. Select Utility > System > User Configurable Key menu.

2. Select “Auto Preset” check in B/BF/Con category of User 
Defined Trackball Set Key menu.

Figure 13-310. User Defined Trackball Set key

Table 13-96:  Parameters and Description

Parameter Description

AUTO On: Automatically changes to the recommended preset as defined in the 
Auto Preset Assistant parameters.

Off: Does not automatically change to the recommended preset.

Change Displayed if there is a suggested preset change. If preset should change to 
the recommended preset, press Change.
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Using Auto Preset Assistant

1. Perform the required setup in the configuration menu.

2. Select Linear probe and start B-Mode scan.

3. Scan the same plane continuously for more than one 
second.

4. During live scan, Auto Preset Assistant uses computer 
algorithms to estimate which of the B-Mode presets is 
closest to the current scan plane.

5. If the algorithm percentage result exceeds the Assist 
Threshold and the confidence level is different from the 
current preset, a message displays to press the Change key 
to change to the appropriate preset. The Change key is then 
assigned to the right side of the Sub-set key.

6. If the “Change” key is pressed while the above message is 
displayed, the system changes from the current to the 
proposed preset.
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Using Auto Preset Assistant  (continued)

7. If the returned confidence result exceeds the Auto threshold 
and inferencing is different from the current preset, a system 
message similar to “Changing to Thyroid Preset” appears. 
The preset change algorithm is automatically executed.

This feature only starts if certain conditions are met:

• Simplex B-Mode live images

• When there is a link between the preset and the 
confidence preset

• Depth > 2 cm

• Does not work with a contrast application

• Does not work in write zoom.

• Does not work with Scan Assistant

This algorithm may display suboptimal or incorrect results, 
especially in the following cases.

• When the target or probe is moving significantly.

• In case of poor visualization due to probe contact, deep 
attenuation, artifacts, etc..

• When it is not a typical scan cross section. For example, 
including tumors, cysts, or diffuse changes.

• Affected by B-Mode display settings such as Compress 
and Gain, or user adjustments for post-processing.

• When multiple different organs coexist. Algorithms tend 
to make more important decisions based on image 
information close to the center.

• MSK anatomical area is limited to only scan views that 
contain bone structures of knee and elbow.
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Using Auto Preset Assistant  (continued)

• LEG(Arm) anatomical Area is limited to only scan views 
that contain vessel structures of Leg and Arm.

• The “Thyroid/Carotid Axial” anatomical area is specific 
to the short axis view of the carotid artery that also 
captures the thyroid lobe. When the user is scanning in 
the “Thyroid” preset and the “Thyroid/Carotid Axial” 
anatomical area is detected, no change is made to the 
preset. And when the user is scanning in the “Carotid” 
preset and the “Thyroid/Carotid Axial” anatomical area 
is detected, no change is made to the preset. This 
allows the user to stay in the existing preset.

• The system does not actively change presets if a preset 
within same categories is already selected. For 
example, if MSK sup and UEA are selected, do not 
automatic change to MSK gen or LEA, respectively.
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Auto Abdominal Color Assistant

This AI-based framework recognizes some anatomy by 
analyzing live B-Mode images. When the user enters Color 
Doppler, the system automatically adjusts to a flow shortcut 
based on a confidence level. While live scanning, the system 
analyzes the B-Mode image at regular time intervals. When the 
anatomy is recognized for a specific model (user preset) in 
B-Mode and Color mode is entered, the associated flow shortcut 
is activated.

This feature works on C1-6-D, C1-6(VN)-D, C2-7-D, 
C2-7(VN)-D, C3-10D, RAB6-D, 9L-D, L3-12-D, M5Sc-D probes 
while scanning in an Abdomen application (Abdomen, Abdomen 
Detail, Abdomen Penetration, Abdomen Biopsy and Renal). The 
algorithm supports five abdominal areas: “Aorta”, “Liver/IVC/
Spleen”, “Gallbladder/Urinary Bladder”, “Kidney” and 
“Pancreas.”

This feature is trained to classify views among five anatomical 
areas, and two labels called "Unknown/Other" and “Probe in 
Air.”

NOTE: This view recognition algorithm was trained on 11,478 images 
and validated on 285 images which were independent data sets 
for the training algorithm. 

Based on the validation test, Minimum Acceptable Algorithmic 
Performance was confirmed to 80% accuracy.

WARNING This feature uses AI based computer algorithms to determine 
the abdominal model presets. There is an inherent risk that 
these algorithms may sometimes give suboptimal or incorrect 
results. Verify that automatically selected Flow models are 
appropriate for the scanned anatomy type.
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Auto Abdominal Color Assistant Configuration for System Imaging

1. Select Utility > System > System Imaging on the Touch 
Panel.

2. “Auto Abodminal Color Assistant” configuration column is 
shown.

3. Turn on check box of Enable in Auto Abdominal Color 
Assistant.

4. See Figure 13-311 for detail parameters.

Figure 13-311. Configuration for Auto Abdominal Color 
Assistant

Table 13-97:  Parameters and Description

Parameter Description

Enable To use this feature, turn on check box of Enable Auto Abdominal Color 
Assistant.

Auto Flow Model selection Turn on check box, selecting recommended Flow model automatically at the 
timing of entering color mode.

Turn off Auto after manual 
Flow Model selection

If the Flow Model is selected by manual operation from the Touch Panel, 
automatic change function will be turned off tentatively. After selecting a new 
patient or probe, it becomes valid again.

Show detected view A tool displays the detected view result.
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Auto Abdominal Color Assistant Configuration in User Defined Trackball 

Set Key Menu

In addition to making this function work automatically, it is also 
possible to accept user confirmation operations based on the 
confidence results. These operations can be assigned to the 
trackball sub-set key in the Configuration Menu below. The Flow 
model can be changed while still touching the operator panel.

1. Select Utility > System > User Configurable Key menu.

2. Select “Auto Preset” check in CF/TVI/PDI category of User 
Defined Trackball Set Key menu.

Figure 13-312. User Configurable Key for Auto Flow Model

Table 13-98:  Parameters and Description

Parameter Description

Reset CF System turns off any Flow model. This can be easily reverted if the Flow 
model proposed by the algorithm and automatically modified does not meet 
expectations.

Change Displayed it if there is a proposed Flow model. Press to change to the 
proposed
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Auto Flow Model Selection Configuration in Imaging Menu

Each confidence preset can be freely associated with any of the 
four pre-prepared flow models. Each flow model name and 
parameters can be customized.

1. Select Utility > Imaging > CF-tab.

2. The left side of “Auto Preset - Flow Model” shows bundled 
view confidence preset as Aorta, Liver/Spleen/IVC, Renal, 
Gall/Urinary Bladder and Pancreas. Select the 
corresponding Flow Model from the column of right side.

Figure 13-313. Configuration for Auto Abdominal Color 
Assistant

Using the above sample settings as an example, when the 
confidence algorithm estimates the Aorta Preset, the “Flow 
Model 1” is automatically or semi-automatically selected by 
entering color mode. For the Pancreas Preset (“-” is selected), 
the system does not recommend or automatically change any 
Flow model. For the Liver/Spleen Preset (“None” is selected), 
the system turns off any Flow model and changes to the default 
setting. The settings of these four pre-prepared flow models 
(Flow Model 1...4) can be confirmed and adjusted on the setting 
screen. 

Figure 13-314. Setting screen example - Auto Abdominal 
Color Assistant
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Using Auto Abdominal Color Assistant

1. Perform the required setup in the configuration menu.

2. Select a probe that supports abdominal applications and 
start the B-Mode scan.

3. Scan the same plane continuously for more than three 
seconds.

4. By entering color mode, the Auto Abdominal Color Assistant 
uses computer algorithms to estimate which of the 11 
abdominal presets is closest to the current scan plane.

5. If the returned confidence result exceeds the Assist 
threshold and inferencing is different from the current Flow 
model, a system message similar to "Recommend changing 
to Aorta flow model" appears on the bottom of the display 
(information area). The "Change" key is then assigned to 
the right side of the Sub-set key. 

6. If the "Change" key is pressed while the above message is 
displayed, the system changes from the current to the 
proposed Flow model.
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Auto Abdominal Color Assistant  (continued)

7. If the returned confidence result exceeds Auto threshold 
and inferencing is different from the current Flow model, a 
system message similar to "Changing to Aorta flow model" 
displays. The preset change algorithm is automatically 
executed.

This feature only starts if certain conditions are met:

• Using Abdomen, Abdomen2, AbdBiopsy and AbdDetail 
or an application created based on one of them.

• When color or PDI mode is activated from the B-Mode 
Live scan.

• When there is a link between the Flow model and the 
confidence preset.

• When there is live information of B-Mode for more than 
3 seconds. This feature does not work if Color Flow is 
activated immediately after starting Auto Flow mode 
Model, or if the color mode is turned on/off in a shorter 
time frame.

• Does not work with a contrast application or other flow 
modes (only with Color and PDI).

• Does not work with Scan Assistant.

This algorithm may display suboptimal or incorrect results, 
especially in the following cases:

• When the target or probe is moving significantly.

• In case of poor visualization due to probe contact, deep 
attenuation, artifacts, etc.

• When it is not a typical scan cross section. For example, 
including tumors, cysts, or diffuse changes.

• Affected by B-mode display settings such as Compress 
and Gain, or user adjustments for post-processing.

• When multiple different organs coexist. Algorithms tend 
to make more important decisions based on image 
information close to the center.

• The algorithm uses only information for the entire B 
mode, not the position of the color ROI or blood flow 
information. Therefore, depending on the location or 
size of CF ROI, algorithm may sometimes give 
suboptimal or incorrect results.



Advanced Features

13-558 LOGIQ Totus – User Manual
5929163-1EN Rev. 3

Voice Control

Voice Control lets you activate certain functions by speaking 
recognized commands.

NOTE: Voice Control is not available in all languages. To choose the 
language you want to use for Voice Control, Utility --> System 
--> General --> Language.

Set up Voice Control

1. Go to Utility --> System --> General.

2. Check the box for "Enable Voice Control".

CAUTION
Voice recognition accuracy may be affected by background 
noise, speech clarity/accent, or microphone configuration. 
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Start Voice Control

1. You can start by performing one of the following :

• If “Wake with ‘Hey LOGIQ’” is checked, you can say 
"Hey LOGIQ"

• On the scan screen, click the Voice Control icon on the 
status bar.

• Press the User Defined key assigned to Voice Control. 
(You can set up the User Defined key via Utility --> 
System --> User Configurable Key.)

• Push the footswitch pedal mapped to Voice Control. 
(You can set up the footswitch via Utility --> Application 
--> Footswitch.)

2. Say a command, such as "Freeze."

NOTE: Voice Control might activate when you didn't say "Hey LOGIQ." 
This can happen when it detects something that sounds similar. 
If this happens often, you can make it less sensitive. Also, Voice 
Control might not activate when you say "Hey LOGIQ," 
particularly in a noisy environment. If this happens often, you 
can make it more sensitive. You can adjust ‘Hey LOGIQ’ 
Sensitivity via Utility --> System --> General --> Voice Control. 

NOTE: To protect your privacy, Voice Control does not log any audio 
data or transcripts.

Table 13-99:  Icon description

Icon Description

Mute:
Not listening for a wake word.

Standby:
Listening for a wake word.

Listening:
Listening for a command.

Busy:
Responding and not listening.
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Command Set

The following list of commands shall be supported. There are 
many varied expressions for the same intent. The list has only 
the simplest forms composed of essential keywords.

HINTS In the list, [n] is an index and X is a value, such as:

• [n] is a relative index if the command is a type of 
incremental or decremental. e.g., "Gain up 10"

• [n] is an absolute index if the command is a type of direct 
setting. e.g., "SRI 2"

• X is always an absolute value. e.g., "Gain 50"

Table 13-100:  Essential keywords and command

Category Command

Freeze/Unfreeze • Freeze
• Unfreeze

Print • Print [1/2/3/4/Screen]

Imaging • Gain up/down [n]
• Gain X
• Depth up/down [n]
• Depth X
• Frequency up/down [n]
• Frequency X

B/BFlow • B Mode
• CHI [on/off]
• CrossXBeam [on/off]
• Advanced SRI [on/off]
• SRI n
• Virtual Convex [on/off]
• Near/Far/Overall TGC up/down [n]
• Dual/Split [left/right/simultaneous]

CF/PDI/MVI/TVI • Color Flow [on/off]
• PDI [on/off]
• MVI [on/off]
• TVI [on/off]
• Scale up/down [n]
• Scale X
• Steer [left/right]
• Virtual Convex [on/off]
• Dual/Split [left/right/simultaneous]

Biopsy Kit • Biopsy [on/off]
• Biopsy n

BSteer+ • BSteer+ [on/off]
• Needle left/right
• Needle Angle X
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NOTE:  Keep the Doppler volume at its lowest acceptable level.

NOTE:  Do not speak too loudly.

Comment • Type <text>

Clear • Clear
• Clear all

Probe and Preset • Probe n
• Preset <preset>

Other Controls • M mode [on/off]
• PW [on/off]
• CW [on/off]
• LOGIQView [on/off]
• Contrast [on/off]
• Elasto [on/off]
• UGAP [on/off]
• Quick Patient Change
• Reverse

Table 13-100:  Essential keywords and command

Category Command
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Stop Voice Control

To stop Voice Control, you can do any of the followings:

• Say "Stop listening."

• If you select a timeout period for "Time Out After No 
Speech" in Voice Control settings, wait the specified time.

• Click the Voice Control icon on the scan screen.

• Press the User Defined key assigned to Voice Control.

• Push the footswitch pedal mapped to Voice Control.

NOTE: Clicking the icon, pressing the User Defined key, or pushing the 
footswitch pedal is to either start or stop Voice Control. 

NOTE: To turn off Voice Control entirely, go to Utility --> System --> 
General, and then uncheck "Enable Voice Control".
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Change Voice Control settings

To view or change your Voice Control settings:

1. Select Utility --> System --> General.

2. Select Voice Control settings.

Figure 13-315. Voice Control Setting

Refer to the followings for the detail.

• Enable Voice Control: Select to enable Voice Control.

• Language: Select the language you want to use for 
Voice Control. Voice Control is currently available only 
for US English.

• Wake with ‘Hey LOGIQ’: Select to activate Voice Control 
with your voice.

• ‘Hey LOGIQ’ Sensitivity: Choose how sensitive Voice 
Control to be when it responds to "Hey LOGIQ" (0, 1, 2, 
3, 4).

• Time Out after No Speech: Stop Voice Control after a 
specified period of no speech.  (5, 15, 30, 120, Always).

• Show Live Captions: Display live captions in real-time.

• Continuous Mode: Keep listening for a next command 
continuously.

• Cine Back on Freeze (sec) : Select time by which cine 
back after recognition of the Freeze command (0.0, 1.0, 
1.5, 2.0).
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• Audio Input: Adjust the audio input volume.

Figure 13-316. Audio Input

NOTE: The input level monitor bar should not rise above 
approximately 3/4 of its maximum width. It goes greater than 
that, the volume is too loud, and the recording will probably 
experience clipping. This may cause the quality of the 
speech recognition to be poor. If there is no sound coming 
from the audio source, the bar will not move.



Data Streaming (Option)

LOGIQ Totus – User Manual 13-565
5929163-1EN Rev. 3

Data Streaming (Option)

NOTE: The Data Streaming option key should be installed to enable 
streaming live/recall/CINE ultrasound data.

The system has the capability to stream live/recall/CINE 
ultrasound image data over the network connection to enabled 
devices. The data stream will contain grayscale, color map, 
geometry, view settings (flip/rotate/reverse), probe and system 
information, VNav position information and ultrasound data. No 
patient information is transferred with the streamed data.

The following table represents the types of data streamed in 
different modes on the ultrasound system.

NOTE: It is recommended to use a 1 Gbps network connection for Data 
Streaming. The required bandwidth often lies in the 100-300 
Mbps range. Usage of a 100 Mbps network leads to dropped 
frames and the risk of latency buildup.

Table 13-101:  Icon description

Data Type Modes

2D Image B Mode, B-Flow Mode, Contrast Mode
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User Setup for Data Streaming

Only a member of the group "ReceiveStreaming" will have 
permission to receive streamed data. See example of users who 
can receive streaming data below. 

Figure 13-317. User Setup for Data Streaming

If LDAP authentication is enabled, at least one of the LDAP 
groups that the user belongs to must be mapped to the group 
"ReceiveStreaming" to allow the device to receive streaming 
data.
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Enable Data Streaming

1. Press UTILITY+ on the Touch Panel.

2. Press Utility on the Touch Panel.

3. Press Connectivity on the Touch Panel.

4. Select Data Streaming on SmartConnect.

5. Turn on Enable Streaming.

6. Enter the Port No (or use the default port).

Figure 13-318. Data Streaming settings
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Enable Data Streaming

1. On the device, connect to the ultrasound system with the IP 
address, Port Number, user account and password currently 
used to log on to the ultrasound system.

2. The ultrasound sytem displays a PIN code. Enter the PIN 
code on the device.

3. The device and the ultrasound system establish the Data 
Streaming connection.

NOTE: Once the device establishes the connection, the ultrasound 
system stores the connection as a certificate. The PIN code 
is NOT necessary in the next connection.

Figure 13-319. Certificates

NOTE: The certificate is valid for one year. After the certificate expires, 
a new PIN code displays on the ultrasound system at the next 
connection attempt.

NOTE: When the certificate for the device is no longer needed, the 
certificate can be revoked.

1. Press APPS+ on the Touch Panel.

2. Press Utility on the Touch Panel.

3. Press Connectivity on the Touch Panel.

4. Select Data Streaming on SmartConnect.

5. Select the certificate.

6. Click Revoke Selected.
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Data Streaming in Process

Data Streaming is initiated and terminated from an enabled 
device (e.g. a smart phone/tablet or PC connected to the same 
network and capable of receiving the streamed data over a 
custom protocol). An enabled device can only receive data when 
streaming has been enabled on the system.

Streaming status is indicated on the screen as follows:

Figure 13-320. Data Streaming is in active (example)

Table 13-102:  Streaming status

Indication (Icon) Status

• The streaming device is connected.
• The system is in freeze mode, or PW/CW when 2D is not live.
• Data is NOT streaming.

• The streaming device is connected.
• Data is streaming.

• The streaming device is connected.
• The system is in a mode not supported in Data Streaming.
• Data is NOT streaming.
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Data Streaming can be stopped by the following operations:

• Changing a patient or ending an exam when Close Stream 
on Patient/Exam Change is turned on.

• Pressing the Pointer Key to display the pointer on the 
monitor. Hover the pointer over the Streaming status icon 
and select the icon.
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Index

Symbols

% Stenosis
generic measurement, 7-20

Numerics

3D/4D imaging
introduction, 13-4
manipulating the volume of interest, 13-27
operational controls, 13-13
prinicples of operation, 13-5, 13-558, 13-559, 

13-562, 13-563
3D/4D presets, changing, 10-56

Advanced, 10-60
Render Setting, 10-59
ROI (Region of Interest), 10-58
Scalpel, 10-59

3D/4D presets, overview, 10-56

A

A/B Ratio
Doppler generic measurement, 7-35
generic measurement, 7-27
M-Mode generic measurement, 7-29

Acceleration time (AT)
OB/GYN vessel measurement, 7-36

Acceleration, measuring, 7-36
accessories

ordering, 1-12
requesting a catalog, 1-12

accessory
connector panel, 3-13

Acclimation time, 3-90
Accumulation, B-Flow, 5-16
accuracy

clinical calculation, 12-10
clinical measurement, 12-7

acoustic output
default levels, 2-44

Activating Continous Capture, 13-184
Active Images, 9-11
active images, description, 4-3
Admin

overview of Utility screen, 10-141
Admin screen

Logon, 10-154

System Admin, 10-150
Users, 10-153

administrator
specifying system, 10-153

AFI
AVC Timing Adjustment, 13-222

AFI, see Amniotic Fluid Index (AFI)
air filter

removing, 12-43, 12-44
ALARA (as low as reasonably achievable), bioeffects,
2-5
Alpha Hip, pediatric measurement, 8-84
Amniotic Fluid Index (AFI), measuring, 8-13
Analysis

Stress Echo, 13-194
Anatomical M-Mode

activating, 5-33
adjusting, 5-33
overview, 5-33

Angle, B-Mode generic measurement, 7-26
annotating an image

introduction, 6-23
text overlays, 6-26
using the annotation library, 6-28
using typed words, 6-33

Annotation mapping
Breast lesion, 10-39

Annotations Libraries Presets Menu, 10-33, 10-37
annotations, presets, 10-36
anonymize, 13-407
Anonymize Patient

patient data, 13-407
application presets

user-defined, 10-182
Applications

setting presets, 10-47
Applications Preset Menu, 10-45
area measurements

ellipse, 7-41
spline, 7-43
trace, 7-40, 7-42, 7-43

AUA
OB worksheet, 7-65

audio, speakers, 3-10
Auto Calcs

modifying, 5-55
Auto Calcs, modifying, 5-55
Auto sequence
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using, 7-85
Auto Vascular Calculation, see also Manual Vascular 
calculations

activating, 8-65
Auto Vascular Calculation, see also Manual Vasuclar 
calculations

setting up calculation parameters, 8-65
AutoEF

Tracking validation, 13-233

B

B Steer plus, adjusting, 5-21
Background, B-Flow, 5-16
Backup and Restore Preset Menu, 10-22, 10-189
Battery status, 13-531
Battery, refresh, 13-535
biological hazards, 2-12
Bladder volume, measuring, 8-75
B-Mode imaging

intended uses, 5-2
optimizing, 5-2
scanning hints, 5-3
typical exam protocol, 5-2

B-Mode measurements
Echo Level, 7-45
Gynecology exam, 8-42

B-Mode measurements, general, 7-38
B-Mode measurements, generic

% Stenosis, 7-20
A/B Ratio, 7-27
Angle, 7-26
Volume, 7-22

B-Mode measurements, mode
circumference and area (ellipse), 7-41
circumference and area (spline trace), 7-43
circumference and area (trace), 7-42
distance, 7-39

body pattern application libraries, selecting, 10-45
Body Patterns, 6-35

General tab, 10-44
Body Patterns Preset Menu, 10-44
Breast lesion

Annotation mapping, 10-39

C

calculations
OB worksheet, 7-66
selecting, 7-12
urology, 8-75

calipers, description, 7-14
Capture Recon., B-Flow, 6-11
Capture, B-Flow, 5-17
Care and maintenance

cleaning the system, 12-34
footswitch, 12-50
operator controls, 12-41

system cabinet, 12-37
Caution icon, defined, 2-4
Change the display format, 3-79
CINE capture, 6-10

Enhancement, 6-12
CINE loop

previewing only, 9-8
storing and previewing, 9-7
storing without previewing, 9-8

CINE mode
introduction, 6-3
synchronizing loops, 6-6
using, 6-5

circuit breaker
description, 3-21

circumference measurements
ellipse, 7-41
spline, 7-43
trace, 7-40, 7-42, 7-43

Clinical
calculation accuracy, 12-10
measurement accuracy, 12-7

Color Flow imaging
activating, 5-37
intended uses, 5-35
M-Mode, 5-48
optimizing, 5-35
Power Doppler, 5-44

comments, see annotating an image
Compare Assistant

Control, 13-363
Set up, 13-361
Workflow, 13-360

Connectivity
configuring, 10-61
presets, 10-61

console
moving, 3-85
transporting, 3-89
wheels, 3-86

contacts
clinical questions, 1-12
Internet, 1-12
service questions, 1-12

Continuous Capture
Stress Echo, 13-182

contraindications, 1-10
Contrast Imaging

overview, 13-57
Control Panel

description, 3-52
Control panel

replacing key caps, 12-50
replacing key lamps, 12-50

controls
annotation function, 3-61
display function, 3-60
keyboard, 3-55
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measurement function, 3-61
mode function, 3-60
operator, 3-52
print function, 3-60
Touch Panel, 3-58

CUA
OB worksheet, 7-65

Curved Anatomical M-Mode, 5-34
CW Doppler

activating, 13-148
exiting, 13-148
non-imaging, 13-147
overview, 13-147
steerable, 13-147

D

D/S ratio, 7-34
Danger icon, defined, 2-4
Data Transfer, description, 4-3
dD Ratio, pediatric measurement, 8-85
device labels, 2-48
devices

acceptable, 2-40
Digital Expert, 13-515
disinfecting probes, 11-41
disinfecting solutions, probes, 11-41
distance measurement

general, 7-39
Doppler Auto Calc Average Cycle, using, 7-49
Doppler measurements, generic

A/B Ratio, 7-35
D/S ratio, 7-34
Heart Rate, 7-34
Pulsatility Index (PI), 7-33
Resistive Index (RI), 7-33

Doppler measurements, mode
TAMAX and TAMEAN, 7-47
time interval, 7-46
velocity, 7-46

Doppler Mode
generic study, 7-32

Doppler Mode, general measurements, 7-45
Doppler Mode, PW

intended uses, 5-49
optimizing, 5-49
typical exam protocol, 5-50

dual image mode, see split-screen imaging
DVD Multi drive

location, 3-9

E

Echo level measurements, 7-45
editing

patient information, 4-24
user-defined calculations, 7-98

EFW growth percentile

OB worksheet, 7-66
electrical

configurations, 3-3
electrical hazard, 2-11
electromagnetic compatiblity (EMC), 2-19
ellipse measurement, general, 7-41
EMC (electromagnetic compatiblity), 2-19
End diastole (ED)

OB/GYN vessel measurement, 7-36
Endometrium thickness (Endo), GYN exam, 8-43
Enhancement, 6-12
environmental requirements, 3-4
equipment safety, 2-11
Erasing

measurements, 7-13
exam

definition of terms, 7-11
deleting, 4-25
OB, 4-7
workflow, 7-11

explosion hazard, 2-12

F

Fast Key, 6-44
Federal law (USA), requirements, 1-10
Fetal growth bar graph, 8-17, 8-25
Fetal growth curve graph, 8-17

description, 8-18
multiple fetus, 8-27
quad view, 8-20
selecting, 8-19

Fetal trending
fetal growth curve graph, 8-22
multiple fetuses, 8-28

Fetus
entering number of, 8-26
selecting on an OB worksheet, 7-65

Fetus Compare
multiple fetus, 8-27

Flow Volume, 7-52
folders, measurement

adding, 7-87
Follicle measurements, GYN exam, 8-43
Footswitch, 13-538
freezing an image, 6-2
front panel, location, 3-16
FV, 7-52

G

Gels, coupling, 11-46
General imaging

changing presets, 10-31
generic studies and measurements, 7-18
Generic study

Doppler mode, 7-32
Gestational Sac (GS), 8-12
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GYN exam
endometrium thickness, 8-43
follicle measurements, 8-43
ovaries measurements, 8-44
uterus measurements, 8-44

Gynecology exam, 8-42
B-Mode measurements, 8-42

H

hazards, 11-39
biological, 11-14
electrical, 11-13

hazards, safety symbols, 2-5
hazards, types

biological, 2-12
electrical, 2-9, 2-11
explosion, 2-12
mechanical, 2-9

Heart Rate
Doppler generic measurement, 7-34
M-Mode generic measurement, 7-31

Hip Dysplasia, pediatric measurement, 8-82

I

Image acquisition
Stress Echo, 13-176

Image History, description, 4-3
Image Zoom, 6-14
images

deleting, 4-25
recalling from clipboard, 9-23
reviewing, 9-11

Imaging presets, changing
General, 10-31

Imaging presets, overview, 10-30
information, requesting, 1-12
InSite, using, 13-520
Intravessel ratio, calculating, 8-70

K

keyboard
special keys, 3-55

L

labeling probes, 2-59
Libraries Preset Menu, 10-42
Lock the monitor, 3-65
log on procedures

defining, 10-154
LOGIQ system

contraindications, 1-10
LOGIQView, 5-19
Logon

Admin screen, 10-154

M

managing images
media handling tips, 9-4
media requirements, 9-4

Manual Vascular Calculation, 8-69
Measurement

Tool
Copy, Past&Move, 7-15

Measurement & Analysis screen
accessing, 7-75, 8-28, 8-31

measurement controls, location, 7-6
Measurements

erasing, 7-13
general instructions, 7-13
OB

AFI, 8-13
measurements, general, 7-4
measurements, generic

overview, 7-18
measurements, types

amniotic fluid index (AFI), 8-13, 8-14
gestational sac, 8-12

measurements, using
adding, 7-87
automatically starting in workflow, 7-85
calipers, 7-14
changing, 7-86
deleting, 7-99
selecting in different category, 7-8

Minimum diastole (MD)
OB/GYN vessel measurement, 7-36

M-Mode
CAMM, 5-34

M-Mode imaging
color flow, activating, 5-48
intended uses, 5-31
optimizing, 5-31
typical exam protocol, 5-32

M-Mode measurements, generic
% Stenosis, 7-29
A/B Ratio, 7-29
Heart Rate, 7-31

M-Mode measurements, mode
time interval, 7-57
tissue depth, 7-56

M-Mode, general measurements, 7-56
MO drive

location, 3-9
Mode Cursor, displaying

Doppler Mode, 5-55
monitor

speakers, 3-10
moving the system, 3-82

during transport, 3-89
precautions, 3-85
wheels, 3-86

Multiple fetuses, 8-26
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fetal trending, 8-28
identifying, 8-27
on OB worksheet, 8-28

My Desktop
set up, 3-77

N

network status indicator,location, 3-16
new patient

scanning, 4-10

O

OB
graph, 8-17
identifying multiple fetuses, 8-27
Patient data, 4-9, 8-9
studies, 8-11

OB exam
preparing, 4-7
starting, 4-9, 8-8

OB graphs, 8-17
fetal growth bar graph, 8-25
patient data, 8-24
viewing, 8-17

OB measurements, types
amniotic fluid index, 8-14
amniotic fluid index (AFI), 8-13
gestational sac, 8-12

OB mulitgestational, 8-26
OB worksheet

AUA, 7-65
calculations, 7-66
CUA, 7-65
EFW growth percentile, 7-66
multiple fetuses, 8-28
patient data, 7-65
selecting ultrasound age, 7-65

OB/GYN vessel measurements, 7-36
acceleration, 7-36
acceleration time, 7-36
end diastole, 7-36
minimum diastole, 7-36
peak systole, 7-36

Operator controls, 12-41
optimizing images

B-Mode, 5-2
Color Flow, 5-35
Doppler, PW, 5-49
M-Mode, 5-31

options
system, 10-150

Orientation Help, 3D/4D imaging, 13-19
ovaries, measurement, 8-44

P

past exam

entering patient data, 8-23
Patient Cardiac and ECG Connections

location, 3-18
Patient data

deleting, 4-25
OB, 4-9, 8-9
OB graphs, 8-24
OB worksheet, 7-65
searching, 4-21

patient exam
reviewing, 9-10

patient safety, 2-7
Patient Screen

active images, 4-3
Data Transfer, 4-3
Image History, 4-3

Peak systole (PS)
OB/GYN vessel measurement, 7-36

Peak systole/end diastole ratio, Doppler generic 
measurements, 7-34
pediatric exam

calculations, 8-81
pediatric measurements, types

alpha HIP, 8-84
dD ratio, 8-85
hip dysplasia, 8-82

peripherals
connector panel, 3-13

peripherals, digital
setting up, 9-46

Phantoms, 12-53
Plot Both, fetal trending, 8-22
Plot Control

line style, 13-167
vertical auto scaling, 13-166

portable exam
performing, 9-58

Power, 3-19
circuit breaker, 3-21
connection

USA, 3-19
Cord, 3-83
On/Off, 3-22
shut down, 3-37
switch, location, 3-22

power
power up sequence, 3-23

Power Assistant, 13-526
Power Doppler imaging, 5-44
prescription device, caution, 1-10
Preset Program menu

Acoustic Output
Fetal Exposure, 4-8
Prudent Use, 4-8

presets
organizing folders and measurements, 7-80

presets, changing
Anotations/Libraries, 10-33
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Body Patterns, 10-42, 10-44, 10-45
Connectivity, 10-61
Imaging, 10-30
System, 10-6

presets, overview, 10-2
previous exam data

entering manually, 8-23
Probe handling and infection control, 11-16
probe orientation, 3D.4D imaging

abdominal, 13-11
endocavity, 13-12

probes
cable handling, 3-48
connecting, 3-46
coupling gels

coupling gels, probes, 11-46
deactivating, 3-50
disconnecting, 3-50
disinfecting, 11-41
ergonomics, 11-2
labeling, 2-59
planned maintenance, 11-49
probe orientation, 11-10
safety, 11-11

using protective sheaths, 11-14
storing, 3-51

Prostate volume, measuring, 8-76
prudent use, 2-4
PS/ED or ED/PS Ratio, measuring, 7-34
Pulsatility Index (PI), Doppler generic measurement,
7-33

Q

QAnalysis, 13-106, 13-152
Drift Compensation, 13-156
Exit, 13-171
generating a trace, 13-159
manipulating the sample area, 13-161
Plot Control, 13-156, 13-166
Select Image Range, 13-158
smoothing, 13-167

QAPlot Control
horizontal sweep, 13-167

Quality Assurance, 12-51
baselines, 12-54
frequency of tests, 12-52
Introduction, 12-51
periodic checks, 12-54
phantoms, 12-53
record keeping, 12-65
system setup, 12-55
test descriptions, 12-56
typical tests, 12-52

R

real-time 4D imaging

acquiring data, 13-22
stopping acquisition, 13-29

Record keeping, 12-65
reference images, 3D/4D, 13-9
Renal volume, measuring, 8-76
Render view, 3D/4D imaging, 13-18
Report

Wall Motion Analysis, 13-206
Report Writer report templates, customizing, 13-431
Report Writer reports

activating, 13-411
creating, 13-410
Direct Report, using, 13-456
editing, 13-415
factory templates, 13-414
inserting images, 13-423

Resistive Index (RI), Doppler generic measurement,
7-33
Results window, 7-12

S

S/D Ratio, Doppler measurement, 7-34
safety

electromagnetic compatibility (EMC), 2-19
equipment, 2-11
hazards, 2-5, 2-11, 2-12, 2-44, 11-13, 11-14

biological, 11-39
smoke and fire, 2-12

labels, 2-48
patient, 2-7

acoustic output hazard
hazard, types

acoustic output, 2-10
electrical hazards, 2-9
mechanical hazards, 2-9
patient identification, 2-7

patient training, ALARA, 2-10
personnel, 2-11
precaution icons, defined, 2-4
precaution levels, defined, 2-4
probes, 11-11

handling precautions, 11-16
Scalpel, 3D/4D imaging, 13-35
Scan Assistant

Availability, 13-317, 13-320
Definitions, 13-321
Description, 13-322
Exporting Programs, 13-329
Setting Up, 13-323
Using, 13-325

Scan Assistant Creator
Attributes, 13-348
Features, 13-348
File Handling, 13-331
Help, 13-331
Keyboard

Navigating, 13-347
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Measurements, 13-354
Overview, 13-330
Programs

Editing, 13-338
Views, 13-342

Scoring
Stress Echo, 13-196

Sectional view, 3D/4D imaging, 13-17
Sensitivity/PRI, B-Flow, 5-17
service, requesting, 1-12
Shear wave imaging

Activating Shear wave, 13-117
Configuring Shear wave, 13-113
Intended Uses, 13-113
Measurement Bias Information Tables, 13-125
Overview, 13-111
Scanning Hints, 13-140
Shear wave Measurements, 13-132
Typical Exam Protocol (Liver), 13-130
Using Shear wave, 13-129

site requirements, before the system arrives, 3-3
small parts exam

thyroid measurements, 8-5
speakers, description, 3-10
Speckle Reduction Imaging-High Detection (SRI-HD) 
see SRI-HD, adjusting
Spectral Doppler, see Doppler Mode, PW
Speed of Sound, 5-28
Split Screen, 6-18
split-screen imaging, 3-60
SRI-HD, adjusting, 5-11
starting an OB exam, 4-9, 8-8
Static 3D imaging, 13-31

acquiring data, 13-31
storage area

location, 3-10
Strain Elastography, 13-100
Stress Echo

create a template, 13-198
studies

OB, 8-11
study

adding, 7-87
definition, 7-11
deleting, 7-99
generic, 7-18
organizing, 7-80

system
acclimation time, 3-90
electrical configurations, 3-3
environmental requirements, 3-4
options, 10-150
power down, 3-37

System Admin
Admin screen, 10-150

System cabinet, 12-37
System Imaging Preset Menu, 10-15
System Measure Preset menu, 10-19

System presets, changing
General, 10-8
System About, 10-29
System Imaging, 10-15
System Measure, 10-19
System Peripherals, 10-24
System/Backup and Restore, 10-22, 10-189

System presets, overview, 10-6
System/General Preset Menu, 10-8

T

TAMAX and TAMEAN, Doppler mode measurement
manual trace, 7-47

Test Patterns
overview, 3-72

TGC, adjusting, 5-26
Thyroid measurements, 8-5
TIC analysis

activating, 13-69
curve fitting, 13-91
exiting, 13-69
generating a trace, 13-77
manipulating the sample area, 13-84
overview, 13-68
smoothing, 13-87

TIC Plot Control
horizontal scale, 13-87
line style, 13-87
overview, 13-86
vertical auto scaling, 13-86

Time Gain Compensation, see TGC, adjusting, 5-26
Time interval

Doppler mode measurement, 7-46
M-Mode measurement, 7-57

Time-Based Store, 10-50
Timers

Stress Echo, 13-181
Tissue depth, M-Mode measurement, 7-56
Tissue Velocity Imaging, 13-149
Trace measurement, general, 7-40, 7-42, 7-43
TVD, 13-151
TVI, 13-151

U

Ultrasound age
selecting on OB worksheet, 7-65

Ultrasound-Guided Attenuation Parameter (UGAP) 
Option, 13-141
Unlock the monitor, 3-65
urology exam, preparing, 7-12, 8-2
urology measurements

bladder volume, 8-75
prostate volume, 8-76
renal volume, 8-76

USB Quick Save, 9-45
user IDs
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defining, 10-153
User label

set up, 3-78
user-defined calculations, editing, 7-98
user-defined measurement, adding, 7-89
Users

Admin screen, 10-153
Uterine cavity, amniotic fluid index (AFI), 8-13
Uterus measurements, 8-44
Utility screens

Admin, 10-141
connectivity, 10-61

V

Vascular measurements, selecting, 8-69
Vascular worksheets

saving and printing, 7-64, 7-70
vessel summary, 7-68

Velocity, Doppler measurement, 7-46
Vessel summary, vascular exam, 7-68
Volume measurement, B-Mode generic 
measurement, 7-22
Volume Navigation ConnectionssolIndicator

location, 3-18

W

Warning icon, defined, 2-4
wheels, console, 3-86
word wrap, annotation, 6-33
Worksheet

viewing, 7-58
Write Zoom, activating, 6-15

XYZ

zooming an image
bioeffects, 6-15

bioeffects, 6-15
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